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New Features in Skillport Administrator 

Skillport Administrator has many new features and enhancements to enhance your organization's 
elearning experience. 

Patch 27 (November 2014) 

When creating Instructor-led Training (ILT) courses, External Learning Objects (ELOs), and Learning 
Programs in Skillport, a new Content Language field is available. Selecting a language in this field 
places these content types in a learner's search results when they've opted to search for content in 
that content language.  

Language support for Instructor-led Training (ILT) Courses 

When creating a new or editing an existing ILT course, you can specify both the Spoken Language 
(that of the Instructor) and the Content Language (that of the course itself). Sessions inherit both the 
Spoken and Content Language of their parent ILT course. 

Note: Selecting Not Specified ensures the course displays in a learner's search results regardless of 

their chosen content language.  
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Language support for External Learning Objects (ELOs) 

When creating a new or editing an existing ELO, you can specify its content language.  

Note: Selecting Not Specified ensures the ELO displays in a learner's search results regardless of 
their chosen content language.  

 

Language support for Learning Programs 

When creating a new on page 258 or editing an existing Learning Program on page 263, you can 
specify its content language.  

Note: Selecting Not Specified ensures the Learning Program displays in a learner's search results 
regardless of their chosen content language.  
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Patch 22 (July 2014) 

Java-free and Java-dependent content control 

As part of Skillsoft's Java-free initiative, content in Skillport can now be identified as either Java-free or 
Java-dependent. This allows sites without custom content installed to control what content is made 
visible to learners based on whether the content is Java-free or not.  

If your site is configured (using the enable_java_free_content SKP parameter) to support the new 
Java-free content feature, Skillport Administrator uses icons to differentiate between Java-free and 
Java-dependent content wherever content is displayed.  

Note: Skillport sites that have custom content installed should keep their enable_java_free_content 
SKP parameter setting at 0, Disabled (default) because the Java status of previously-installed custom 

content is unknown. 

An example of Java-dependent and Java-free content icons displayed in the Library is shown below: 

 



12 ©2015 Skillsoft Skillport 8 Administrator Guide 

 

 Getting Started 
 
 

Depending on the Java-free configuration settings, Java-dependent content is available to learners in 
certain circumstances. 

For more information, see Java-Free and Java-Dependent Content. 

Patch 20 (May 2014) 

Updates to the Batch Add (Users, Groups and Waivers) CSV template file and 

workflow 

With the release of Skillport 8 Patch 20 (8.0.3285), the Batch Add functionality in Skillport 
Administrator has been enhanced. Updates include the following: 

 For all Batch Add functionality, the file size limit has been removed. 

 For all Batch Add functionality, the manual validation step is no longer necessary. Clicking 

Upload validates and uploads the CSV file. 

 A simpler set of Batch Add screens in Skillport Administrator are available. There are now 

three tabs: Users, Groups, and Waivers: 

 

 For Users, a new screen is available, as shown above.  

 A single batch import process now accepts new user records and updates to existing ones. 

 Customers can now submit a CSV template file with both types of changes (add and 

update), and the import process determines which records are new, updated, or 

unchanged. This replaces the previous workflow. See Add or Update Multiple Users 

(Batch Add). 

 A new User CSV template is introduced with this release. Two of the column names 

have changed (sys_userid and sys_password), and the order of the columns has also 

changed. If customers are using a version they downloaded prior to this release, the 

upload will fail. They must either download a new template, or modify their existing 

template to match the new column headers and column order.  
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 For Groups, a new screen is available. Documentation has been enhanced for completing the 

group CSV file, see Completing the Group CSV Template. 

 

 For Waivers, a new screen is available, and it clearly states that this is for Learning Program 

Waivers. See Grant Multiple Waivers for a Learning Program (Batch Add). 
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Search for Assets and Folders 

Some pages in Skillport include a search tool you can use to search for folders and content within the 
Library. 

 

Because this search uses the same underlying search engine as the one used by learners, you can 
use it create several different kinds of search expressions. However, unlike the search tool learners 
use, you can use it to search for folders, but you cannot use it to perform "searches within search 
results." 

Note: The Evaluation search function does not allow search at the folder level. 

To use the search tool 

1. In Search for, enter a keyword or phrase. 

For examples of search expressions, see the Search Tips section at the end of this topic. 

2. Select a Category. You can: 

 choose a specific type of learning asset to search for (such as Courses, 

KnowledgeCenters, or Books), 

 select All to return all types of learning assets and folders, or  

 select Folders to search for folders only. 

Note: The options listed in the Category list depend on your context. For example, when 
you're viewing the Library contents, you cannot search directly for Job Aids, SkillBriefs, 
videos, and books because you cannot add these types of assets to the Library. Similarly, 
in the Learning Program Manager, you cannot search directly for KnowledgeCenters 
because you cannot add these types of assets to a learning program. 

3. Select a Language. This is for the returned search results' asset language (for example, if you 
choose French, only assets written in French display in the search results).  

Note: You must enter your search term(s) in the language specified. This setting is disabled 
when you select Folders from the Category drop-down list.  

4. Click Search. 
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Search Tips 

The search engine ranks all search results not only by the number of occurrences of the search term, 
but also by their location. Results found in titles and headings are given greater weight than 
occurrences in the body of the text. Not only are search results listed in relevant order, but sections 
and topics within each course, book, or simulation are also ranked by relevancy, presenting the top 
results for single-click access to the content. 

You may specify words or phrases alone or grouped in Boolean combinations. Phrases are groups of 
words enclosed in quotation marks. 

The search engine is not case-sensitive. 

The following are examples of search expressions: 

 Word proximity search: Content with the words closest together is ranked higher. 

Example: advanced project management 

 Exact phrase search: Content must match the phrase exactly to be part of the search results. 

Example: "advanced project management" 

 Boolean expressions: Boolean operators are AND, OR, and NOT. The NOT operator cannot 

be used alone; use the NOT operator with the AND operator. Use quotes to group search 

terms. 

Example: "project management" and not "cost estimating" 

 Word Truncation Expression: Use of the wildcard (*) character. You can use the wildcard 

operator at the end of a word, but not at the start or in the middle of a word. 

Example: project plan* 

Searching for Specific Learning Assets 

For the best results, search for the learning asset's ID number (such as a course number). If you are 
searching for a learning asset by its title, place the title in quotes to conduct an exact phrase search. 
This is particularly important if the title contains a Boolean operator (AND, OR, or NOT). 

Example: "Budgeting and Financial Management: Planning Your Budget" 
 

Search Configuration 

You can modify the order of appearance of the search categories in Skillport. For more details, see 
Search (on page 479) in the Configuration chapter. 
 

Manage Information in Tables 

Many pages of the Skillport Administrator display information in a table. You can make it easier to 
work with large amounts of data by: 

 Sorting by a specific column. 

 Showing and hiding columns. 

 Filtering the information to include only that which meets specific criteria. 

Note: Not all tables support all features. 
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To sort by a specific column 

5. Click the column header.  

6. To change the sort order from ascending to descending or vice versa, click the header again. 

 

To show or hide columns 

1. Click the down arrow on the right end of any column header. 

2. Select Columns from the context menu. 

3. Select the check box beside each column that you want to show, and clear the check box 
beside each column that you want to hide. 

 

To filter information to include specific criteria 

1. Click the down arrow on the right end of the column that contains the information for which 
you want to apply a filter. 

2. Select Filters from the context menu. 

3. Specify the criteria using the available controls. The type of controls available to you depends 
on the type of information shown in the column. 
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For example, on the Notification Management page, you can select any of the available 
features  to show only those Notification email templates related to the selected feature. 

 

A column with a filter applied to it has a column header in bold and italics, so you can easily 
understand that a filter is in use. 

 

 

To remove a filter 

1. Click the down arrow on the right end of the column that contains the filter(s) you want to 
remove. 

2. Click Filters from the context menu. 

3. Clear the check box next to each filter you wish to remove. 
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Resize Panes 

If desired, you can resize the panes on those pages in the Skillport Administrator that utilize them, 
such as the Library or User Management page. 

To resize a pane 

1. Hover your mouse over the edge of the pane.  

The mouse pointer changes: 

 

2. Click the edge of the pane, and drag it to the desired place. 

 
 



Skillport 8 Administrator Guide ©2015 Skillsoft  19 
 

Getting Started   
 
 

Hyperlinks 

You can add hyperlinks to custom pages within Skillport. These links can point to other custom pages 
in Skillport or to external documents and web sites. Restrictions and best practices for working with 
hyperlinks are described in the following sections. 

Absolute Paths and Relative Paths 

You can use either an absolute path or a relative path for the hyperlinks. A hyperlink must be a valid, 
fully qualified URL.  

An absolute path Uniform Resource Locator (URL): 

 Must start with http:// or https:// 

 If the URL starts with http, then the string length should be at least nine (9) characters. 

 If the URL is in the format <string>.action, then the length of any string should be at least 

two (2) characters. 

A relative path URL: 

 Must start with either / or ./. 

 Should be followed by a folder name or a file name. 

 Should end with a file name (file name is a string that has one occurrence of '.'). 

Examples of valid URLs: 

 goodbyepageurl: goodbye.action 

 segment URL: main.action?rightPanel=learningplan&rightAction=home 

 segment URL: /custom/customPage.html 

 Background Image URL: ./images/Skillport-bckgrd.jpg 

 segment URL: http://www.skillsoft.com 

Hyperlinks to Non-HTML Documents 

You cannot create direct links to non-HyperText Markup Language (HTML) documents (such as a 
Microsoft Word document). You can save the target document as HTML and link to it, or you can 
define it as custom content on the Library page in Skillport Administrator. 

Hyperlinks to External Documents 

You can add links to pages outside Skillport using HTML or HTML with JavaScript. To add a link using 
just HTML, add the code shown below: 
 
<a href="http://<domain>/<path>/<filename>" target="_blank">Link Text</a> 

Example: 

<a href="http://office.microsoft.com/support_materials/using_excel.doc" 

target="_blank">Using Excel</a> 

You can also add JavaScript to control the size of the new window with a window.open JavaScript 

event. The following code opens a window in front of, but not obscuring, the Skillport window: 
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<a href="#" 

onClick='window.open("http://office.microsoft.com/support_materials/using_e

xcel.xls","Using Excel","height=800,width=400")'>Link Text</a></li> 

Note: You cannot add content to a page by using an Internet Protocol (IP) address. 

Pages with Redirection 

Some URLs use a redirection in the web page to send visitors to a different URL. These pages fail to 
launch from Skillport and, when the user attempts to view the URL, an error message displays.  

To correct this problem, open the desired site in a separate browser, copy the actual URL from the 
address bar, and paste it as the custom link URL. 

Email Links 

Add code for email links as shown below: 

<a href="mailto: support@Skillsoft.com">Skillsoft Technical Support</a> 
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User Roles 

A user's role determines his privileges to the various functions in the Skillport Administrator.  

For details about specific privileges each role has within Skillport, see User Privileges by Role. For 
details about additional privileges you can assign to each role, see Custom User Privileges. 

The following roles are available in Skillport: 

 Company Admin: This user has access to most features and functions in Skillport; this is 

your site-wide administrator. Company Admins can administer all users on the site, regardless 

of group membership, and administer Advanced Groups. 

 Admin: This user has access to a subset of features and functions in the Skillport 

Administrator. Admins can administer only those users in the group hierarchies to which they 

are a member. 

 Manager: This user has even more limited access to the Skillport Administrator than an 

administrator. Managers can administer only those users in the group hierarchies to which 

they are a member. 

 End User: This user does not have access to the Skillport Administrator. A user with this role 

uses the site only to use the instructional content. 

 ILT Roles: If your organization uses Instructor Led Training, see ILT Roles for a complete 

description of the available roles.  

 



Skillport 8 Administrator Guide ©2015 Skillsoft  22 
 

Users and Groups   
 
 

User Privileges 

Important Information about Custom User Privileges 

An administrator user has access to specific features in the Skillport Administrator based on his user 
profile. If your site has been configured to support it, you can further define a user's access to 
administrative features by customizing their user privileges. As you do so, keep in mind the following: 

 If you clear a privilege check box (to remove the privilege for the user), all subordinate 

privileges are no longer available to the user. For example, if you clear the Users & Groups 

check box, the user cannot access any of the user, group, and asset assignment features. 

 If a privilege is removed for a user, the user cannot access the related feature in the Skillport 

Administrator. 

 By default, only super administrators have the privilege to delete users and groups. To grant 

this privilege to users with other administrator or manager profiles, you must customize the 

user's privileges as described in this section and ensure that you select the check box for the 

privilege. 

 You cannot customize user privileges for users with the Super Admin profile. 

 If a user has been customized with a removed user privilege, that user cannot grant that 

particular privilege to any other admins he creates. For example, if he does not have access to 

delete users, no other admins he creates will have the option to delete users.  

 Users with a Manager profile cannot set custom user privileges for other users. 

 Users with custom privileges are represented by icons that include a wrench, for example,  

for custom administrators. 
 

User Privileges by Role 

Note: You can customize the privileges of a company administrator, administrator, and manager using 
custom user privileges. 
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User and Group-specific Privileges 

 A Company Admin can view and manage all users and groups on the site (company). She can 

also configure Configuration and Display settings for the site or for any advanced group. 

 An admin can view and manage the users and subgroups contained in her normal 

(organizational) group or advanced group. If she is not in an advanced group, she can 

configure some Configuration and Display settings for the site. If she is in an advanced group, 

she can configure some Configuration and Display settings for only her advanced group. 

 Like an admin, a manager can view and manage the users and subgroups contained in her 

group, but these management functions are limited to the assignment of content: Catalog 

assignments, Learning Plan assignments, enrollments and waivers, and Books24x7 

assignments. A manager cannot configure Configuration and Display settings. 

Content-specific Privileges 

When assigning content to users and groups: 

 A company administrator can select from all active assets in the Catalog. 

 An administrator or manager can select from only the assets that are assigned (available) to 

her in the Catalog. 

Reporting Privileges 

 A company administrator can run reports on all users, groups, and content. 

 An administrator or manager can run reports on the users and subgroups contained in her 

normal (organizational) group or advanced group. Additionally, she can run reports on the 

assets that are assigned (available) to her in the Catalog. 

Note: In the Reporting feature, User and Group visibility is controlled by the User and Group 
Privileges setting in the Administrator tool. For more information see User and Administrator 
Privileges on page 501. This setting does not affect report results, nor is it available in Legacy 
Reporting. 

Instructor Led Training (ILT) Privileges 

The table below shows the ILT features available for the different Admin user roles. 

Privilege Admin Course 
Admin 

Session 
Admin 

Session 
Approver 

Instructor 

View ILT courses and 
sessions through SkillPort 
catalog  

X X X X X 

Enroll in ILT sessions X X X X X 

Watch ILT courses X X X X X 

Assign user roles in ILT Admin 
interface 

X     

Create a course X X    

Edit a course X X    

Delete a course X X    

Create a session X X X   
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Edit a session X X X   

Delete a session X X X   

Approve session registration 
requests 

X   X X 

Applies only 
when Instructor 
Can Manage 
Roster is set to 
Yes for the 
session. 

Reject session registration 
requests 

X   X X 

Applies only 
when Instructor 
Can Manage 
Roster is set to 
Yes for the 
session. 

E-mail all learners enrolled in 
a session  

X X X  X 

Close a session X X X   

Force enroll learners into a 
session 

X X X  X 

Applies only 
when Instructor 
Can Manage 
Roster is set to 
Yes for the 
session. 

Enter test scores/attendance 
for a session 

X X X  X 

Edit/preview an e-mail 
template  

X     

 

Users & Groups page Privileges 

Page/Setting/Function Company 
Admin 

Admin 
(not in 
advanced 
group) 

Admin  
(in 
advanced 
group) 

Manager 

Search x x x x 

New User/Group x x x - 

Upload (Users/Groups) x - - - 

User/Group Info x x x - 

(Group) Membership x x x - 

Catalog Assignment x x x x 

Learning Plan Assignment x x x x 
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Enrollments and Waivers x x x x 

Books24x7 Assignment x x x x 

Enrollments and Waivers x x x x 

Send Email x x x x 

 

 

Content page Privileges 

Page/Setting/Function Company 
Admin 

Admin 
(not in 
advanced 
group) 

Admin  
(in 
advanced 
group) 

Manager 

Catalog x x x x 

Learning Programs x x x - 

Evaluations x x x - 

Credentials x x x - 

 

 

Display page Privileges 

Page/Setting/Function Company 
Admin 

Admin 
(not in 
advanced 
group) 

Admin  
(in 
advanced 
group) 

Manager 

Home Page x x x - 

Default View x x x - 

Login/Logout Options x x - - 

Navigation: Navigation Buttons x x x - 

Navigation: Shortcuts x x x - 

Navigation: Top Links x x x - 

Navigation: Toolbar x x x - 

Player Skins x x - - 

Registration x x - - 

Colors x x x - 

Text: Login Text Customizations  x x - - 

Web Site Settings x x x - 
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Configuration page Privileges 

Page/Setting/Function Company 
Admin 

Admin  
(not in 
advanced 
group) 

Admin 
(in 
advanced 
group) 

Manager 

Features: Ask the Experts x x x  

Features: Books24x7 x x x - 

Features: inGenius x x - - 

Completion Criteria x x - - 

Email x - - - 

Search x x - - 

Self-Registration x x - - 

User Profile x x - - 

Language x x x - 

Report Configuration x x x - 

Web Site Switches 

 

Allow Learning Plan Reminders x x x - 

Allow Learning Plan Due Dates x x x - 

Show PalmLink x x x - 

Enable LP Enrollment/Approval Emails x - - - 

Enable Credentials x x - - 

Enable Forced Restart x - - - 

 

 

 

Reporting page Privileges 

Page/Setting/Function Company 
Admin 

Admin 
(not in 
advanced 
group) 

Admin  
(in 
advanced 
group) 

Manager 

View and Edit My Dashboard Charts x x x x 

Create Personal Report Templates x x x x 

Run Reports x x x x 

Schedule Reports x x x x 
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Manage Saved Reports x x x x 

View Reports x x x x 

 
 

Custom User Privileges 

Custom Privilege Function Company 
Admin 

Admin Manager End 
User 

Configuration Provides access to Configuration area of 
Skillport Administrator. 

x x   

 InGenius 

Settings 

Allows the user to specify social 
community settings. A social community 
administrator moderates comments 
reported as abuse on the Moderate 
Community page in Skillport 
Administrator (Content > Moderate 
Community).  

x x   

 Multiple 

Completio

n Access 

Allows the user to set specific courses to 
allow multiple completions. 

x    

 Notification 

Access 

Provides access to the Notification 
Management area of Skillport 
Administrator to manage Skillport email 
notifications. This privilege is granted by 
default to company admins, but it can be 
revoked. 

x    

 Delete 

Email 

Templates 

Allows the user to delete email 
templates. This privilege is not granted 
by default to company administrators, 
but it can be granted. 

x    

Display Provides access to the Display area of 
Skillport Administrator. 

x x   

Users & Groups Provides access to the Users & Groups 
area of Skillport Administrator. 

x x x  
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 User/Grou

p Info 

Allows the user to view and edit user and 
group information. 

x x   

 User/Grou

p Delete 

Allows the user to delete users and 
groups. 

x x   

 Catalog 

Assignmen

t 

Allows the user to assign (expose) 
assets in the Skillport Library to users 
and groups. 

x x x  

 Learning 

Plan 

Assignmen

t 

Allows the user to assign assets to the 
Learning Plan for individual learners and 
groups. 

x x x  

 Enrollment

s and 

Waivers 

Allows the user to enroll other users and 
groups in assets such as learning 
programs or ILT sessions, and grant 
associated waivers for specific assets in 
those learning programs. 

x x x  

 Books24x7 

Assignmen

t 

Allows the user to assign Books24x7 
collections to users and groups. 

x x x  

 Assignmen

t Group 

Access 

Allows the user to see and manage 
assignment groups, where the specific 
capabilities granted depend on the user's 
role. This custom privilege only displays 
if your site has been configured to 
support assignment groups. 

x x x  

Content Provides access to the Content area of 
Skillport Administrator. 

x x x  
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 Catalogs Allows the user to make changes to the 
Skillport Library. 

x x x  

 Publisher Allows the user access to access the 
Skillsoft Publisher, which is used to 
upload custom content to Skillport. 
Specifically, this privilege provides 
access to perform the following two 
Publisher-related tasks:  

 General Publish: Access to the 

Publisher, to upload custom 

content. 

 Passive Content: Access to the 

Publisher for publishing passive 

content. 

x x   

 Course 

Evaluation

s 

Allows the user to create and manage 
evaluations. 

x x   

 Learning 

Programs 

Allows the user to create and manage 
learning programs. 

x x   

 Keywords Allows the user to create and manage 
keywords. This privilege is granted by 
default to company administrators, but it 
can be revoked. It is also available to 
administrators, but it is not granted to 
them by default. 

x x   

Reports Provides access to the Skillport Reports. x x x  

Curator The user can add and remove assets 
within an active Featured Topics folder in 
the Library. Selecting this option displays 
the Add to Featured Topics option on 
an asset's Details page in Skillport. 

x x x x 

Moderator The user receives notifications when 
comment are flagged as abuse in the 
community, and can take action against 
that comment (remove it) if deemed 
inappropriate. 

x x x  

 
 

Create a User with Custom User Privileges 

To create a user with custom administrator privileges 

1. Click Users & Groups > User Management on the navigation bar. 

2. Navigate the tree of user groups, and select the parent group for the new user. 

3. Click New User at the top of the page. 

4. Enter the appropriate information in the fields provided. 
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5. In Role, select Company Admin, Admin, Manager or End User. 

6. Beside Role, click Customize. 

The Privileges dialog box displays. The list of available privileges is based on the selected 
role.  

7. Select or clear the appropriate boxes to customize the user's administrator privileges. See 
Custom User Privileges for a complete listing of each available custom privilege by role. 

8. Click OK. 

9. Click Save. 
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User Management 

Create a New User 

If you have Company Admin or Admin privileges, you can create users. 

To create a user manually 

1. Click Users & Groups > User Management on the navigation bar. 

 

2. In the group hierarchy, navigate to the group to contain the new user, and select it. 

By default, the new user inherits the content assignments of any groups to which he belongs. 

3. Click New User. 

The New User dialog box displays. 

4. Enter information for the user in the fields provided. 

Note: The user profile fields (both standard and custom) that display for entering new user 
information are determined by the settings specified on the Manage User Profile Fields page. 
See Configure User Profile Settings for more information.  

Refer to the following table for accepted characters for the text fields. If you do not supply a 
password, first name, or last name, the User ID value is used. For Status, select Activated if 
the user should be able to sign in to Skillport; select Deactivated if the user should not be 
able to sign in. 

The following information is helpful when creating a new user: 

 Single-byte characters are the letters of the alphabet in most languages (such as 

English, French, German, Hebrew, Russian, and Turkish). 

 Multi-byte characters are the letters of the alphabet in Asian languages (such as 

Chinese, Japanese, and Korean). 

 Latin 1 characters: These include numbers 0-9, accented letters in various European 

languages (such as ç, è and ñ), and the following special characters: 

! " # $ % & ' ( ) * + , - . / [] | : ; < = > ? @  
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Field Accepted Characters 

User ID (login 
name) 

 abcdefghijklmnopqrstuvwxyz0123456789@$_.~'- 

 Login names cannot start with apostrophe (') or dash (-) 

 Non-breaking white spaces (space, tab, new line) are not allowed in login 

names 

 All user-entered User IDs are converted to lower case before the validation 

 Multi-byte characters are not allowed 

 The following characters are not allowed: <> [ ] ( ) ; \ /  

Also, there is a list of reserved words that you cannot use (doing so produces an 
error). The following are the most common: 

add, all, block, count, down, force, link, mount, off, simple, tag, up 

Password  Passwords are case-sensitive 

 All single-byte characters are allowed except the following: 

 backslash (\) 

 plus (+) 

 double quote (") 

 Non-breaking white spaces (space, tab, new line) are not allowed 

 No blank passwords are allowed 

 Multi-byte characters are not allowed 

First Name, Last 
Name 

 All Latin1 and double-byte characters are accepted 

Email Address  abcdefghijklmnopqrstuvwxyz0123456789 - _ . * ^ + = @ ' 

 Capital letters are accepted 

1. To force the user to change his password immediately after logging in for the first time, select 
Force Password Change. 

2. To add the user to an additional group: 

a. In Group Membership, click Edit. 

b. In the Select Groups dialog box, select the desired group, then click Add. 

Repeat this process as many times as needed to add the user to multiple groups. A user 
can belong to any number of normal (organizational) groups, but he can only belong to 
one advanced group. 

You can also use the fields provided to search for the desired group. If needed, you can 
enter an asterisk (*) as a wildcard that represents one or more characters. 

c. To remove a group, in Group Membership, select the group name, and click Remove. 
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3. In Role, select a role (profile) for the user. 

Note: If custom user privileges have been enabled on your site, you can customize the 
user's privileges on page 22 to limit Administrator or Manager access to a subset of 
administrator features. Click Customize next to the Role drop-down list. 

4. If the manager approval feature has been enabled on your site, you can specify the approval 
manager who must approve or reject the user's requests to enroll in learning programs and 
Live Learning courses. 

d. In Approval Manager, click Edit. 

e. In the Select User dialog box, navigate to the user who will be the approval manager for 
the new user, and click OK. 

You can also use the fields provided to search for the desired approval manager. If 
needed, you can enter an asterisk (*) as a wildcard that represents one or more 
characters. 

5. To send an email to the newly created user:  

a. In Send Notification Email, select Send Welcome email. 

b. Select an email template from the drop-down list. 

6. Click Save & Add Another to save this user and add another new user, or click Save to save 
this user and return to the User Management page.  

 

Create a New Group 

If you are a Company Admin within Skillport, you can create groups. 

To create a group manually 

1. Click Users & Groups > New Group on the navigation bar. 

The New Group dialog box displays. 

2. Enter the information for the new group: 

 Name: Group names are limited to 240 characters. 

 Org Code: This code, limited to 240 characters, uniquely identifies the group in the 

system (group names do not have to be unique). If you do not specify an organizational 

code, the system assigns one automatically using the format org_<number> (for example, 

org_18). You can change the org code at any time. 

Acceptable characters include all Latin-1 characters (codes #161-#255 inclusive), a-z, A-
Z, 0-9, _ and - 

 Display on Registration Page: Select this option to make the group available on the self-

registration page. 

 Group Type: Depending on the configuration of your site, you may be able to select from 

one or more of the following: normal (organizational), assignment, and advanced. 

Note: By default, the new group inherits the content assignments of its parent group. The 

default is to create the new group at the top-level of the group hierarchy. 

3. To change the parent group for the new group: 
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a. Click Edit next to Parent Group. 

The Select Group dialog box displays: 

 

b. In the Group View tab, select the parent group. 

You can also search for a group by Group Name and/or Org Code. If needed, you can 
enter an asterisk (*) as a wild card that represents one or more characters. 

c. Click OK. 

The Select Group dialog box closes. 

4. Click Save. 
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Working with Users 

Find a User 

You can quickly search for a user that you need to view or modify. 

To find a user 

1. Click Users & Groups > User Management on the navigation bar. 

The User Management page displays. 

 

2. To search for active users: 

a. In Search, select User. 

b. Enter a user name, first name, last name, or email address.  

You can also use an asterisk (*) as a wild card that represents one or more characters. 

c. Click Search. 

Active users matching your search criteria display on the Search Results tab. 

3. To search for both active and deactivated users: 

a. Click Advanced Search. 

b. Specify your search criteria. 

c. Click Search. 

The results display on the Search Results tab in the left pane. To find a user’s location in the 
group hierarchy, click the corresponding Org Code link. 
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Activate or Deactivate a User 

Activating an account changes its status to Activated and allows the user to log in. Conversely, 
deactivating an account changes its status to Deactivated and denies the user the privilege to log in. 

Note: You can also activate or deactivate all members of a group at once. 

To activate or deactivate a user 

1. Click Users & Groups > User Management on the navigation bar. 

2. On the Users and Groups tab, navigate to the desired user in the group hierarchy, then 
select the user. 

A user with a deactivated account has an icon that contains a red slash, such as . A user 
with an activated account does not have this red slash. 

3. Click the User Info tab in the right pane, then click Activate or Deactivate, as appropriate. 
 

Unlock a User's Account 

If the account lockout feature is enabled for your site, a user who makes 5 failed login attempts is 
automatically locked out of the system. When this occurs, you must manually unlock the user's 
account. 

Note: To enable this feature, contact your Skillsoft representative. 

To unlock a user's account 

1. Click Users & Groups > User Management on the navigation bar. 

2. On the Users and Groups tab, navigate to the desired user in the group hierarchy, then 
select the user. 

A user with a locked account shows as . 

3. Click the User Info tab in the right pane 

4. Click Unlock. The user can now log in again. 
 

Force a Password Change 

If you have Company Administrator or Administrator privileges, you can force a password change for 
an individual user. This forces the user to change his or her password immediately after the next login. 

Note: You can also force a password change for all members of a group at once. 

To force a password change for a user 

1. Click Users & Groups > User Management on the navigation bar. 

2. On the Users and Groups tab, navigate to the desired user in the group hierarchy, then 
select the user. 

3. Click the User Info tab in the right pane, then click Force Password Change. 

4. When the message displays asking if you want to continue, click OK.  
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Delete a User 

Warning: By default, only Company Administrators can delete a user. Admins can delete users if they 
are granted the Delete a User privilege. Deleting a user will permanently remove all user progress and 
the user's account. Skillsoft recommends you deactivate the user instead, to preserve user progress. 

To delete a user 

1. Click Users & Groups > User Management on the navigation bar. 

2. On the Users and Groups tab, navigate to the desired user in the group hierarchy, and select 
the user. 

3. Click the User Info tab in the right pane. 

4. Click Delete. 

5. When the confirmation message displays, click OK. 

The user is deleted, and the account is permanently removed. 

 
 

Activate Pending Users 

If your site has been configured to allow self-registration, but requires the approval of an administrator 
for all self-registered users, you must approve those users before they can log in. 

To approve users with pending registrations 

1. Click Users & Groups > Pending Registrations on the navigation bar. 

By default, the Pending Registration page lists all users requiring self-registration approval: 

 

2. If desired, narrow the list of pending users by searching for those that match your criteria. For 
information on performing searches, see Find a User on page 35. 

The list of pending users is filtered to include only those that match the criteria you specified. 

Note: To view additional details for a user, hover your mouse over the user name. To change 
the sort order for a column, click the column header. To restore the view to include all pending 
users, click Refresh Display. 

3. To approve the self-registrations of one or more users: 

a. Select the check box beside each user name. 
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b. Click Register. 

c. Click OK. 

An email is sent to each user with their username and password to sign in to the site. 

4. To reject the self-registrations of one or more users: 

a. Select the check box beside each user name. 

b. Click Deny. 

c. Click OK. 

An email is sent to each user informing them that their self-registration request was rejected. 
 

Assign or Remove an Approval Manager 

Note: The Approval Manager feature must be enabled on your site to assign approval managers. Any 
user with Manager, Admin, or Company Admin privileges in addition to the Enrollments and Waivers 
privilege automatically has the ability to act as an approval manager over all users and groups within 
their administrative domain, and can also approve or deny each other's requests. Any user with 
Company Admin privileges always has the ability to act as an approval manager. 

Assigning a user to act as an approval manager allows that user access to the Approval Manager 
page in Skillport, where he can approve or deny asset requests and waivers for those learners 
assigned to him. To assign a user as an approval manager, you must first identify one or more 
learners who will send their requests to the user you want to set up as an approval manager. 

To assign or change a user's approval manager 

1. Click Users & Groups > User Management. 

The User Management page displays. 

2. In the left pane, select the user for whom to assign the approval manager. 

3. In the right pane, click Edit at the top of the User Info tab. 

The Edit User dialog box displays. 

 

4. Next to Approval Manager, click Edit. 
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The Select User dialog box displays. 

 

5. Select the user whom you wish to assign as an approval manager. 

Note: The selected user does not need any special privileges assigned to him to act as an 

approval manager. 

6. Click OK. 

7. If the Approval Manager Change check box is enabled on your site, you can now choose 
whether to send an email to the learner about the change. Select the check box to send the 
email. Alternatively, clear the check box if you do not want to send it. 

Note: No email is sent if an invalid email address is specified for the user. 

8. Click Save. 

To remove a user's approval manager 

1. Click Users & Groups > User Management. 

The User Management page displays. 

2. In the left pane, select the user whose approval manager you want to remove. 

3. In the right pane, click Edit at the top of the User Info tab. 
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The Edit User dialog box displays. 

 

4. Next to Approval Manager, click Remove. 

5. If the Approval Manager Change check box is enabled on your site, you can choose whether 
to send an email to the learner about the change. Select the check box to send the email. 
Alternatively, clear the check box if you do not want to send it. 

Note: No email is sent if an invalid email address is specified for the user. 

6. Click Save. 
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Working with Groups 

Organizational Groups 

You can add users to organizational groups (  ). You can then use the groups to control users' 
access to learning assets. The following are tips for working with organizational groups: 

 Users can be part of more than one group. No matter the number of groups in which a user 

appears, there is still only ONE record for that user in the database. 

 If a group contains a very large number of users, it is further subdivided alphanumerically into 

groups of 100 users. This enhances the performance of your site because all users do not 

have to be displayed at once. These "display only" groups are not actual organizational 

groups defined for your site. They are named using the names of both the first and last users 

contained therein, as shown in the following image: 

 

 Deleting a user removes the user record from the database. Removing a user from a group 

does not delete the user from the system (he is only removed from the group itself).  

 A user must be a part of at least one organizational group. 

 You cannot delete the original admin or administrator users in the root group. 

 If the Instructor Led Training (ILT) add-on module is installed and enabled, users with ILT 

history cannot be deleted. If you wish to delete a user from the system, you can either remove 

their ILT records using the ILT module and then delete them, or deactivate the user instead of 

deleting them. 

 If an Approval Manager is deleted, all users assigned to that account will be left without an 

Approval Manager. Prior to deleting an Approval Manager: 

 You should first assign those users to a new Approval Manager. 

 Run the Users Manager Report to locate all users assigned to the Approval Manager 

being deleted and assign those users to a new Approval Manager.  

 You can then delete the original Approval Manager account. 

 Only registered users are shown in the user tree in the User & Groups Management page. 

 Users are either active (able to log in and access learning events) or inactive (unable to log 

in). 
 

Find a Group 

You can quickly search for a group that you need to view or modify. 

To find a group 

1. Click Users & Groups > User Management on the navigation bar. 
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The User Management page displays. 

 

2. To perform a basic search: 

a. In Search, select Group.    

b. Enter a group name or org code.  

You can also use an asterisk (*) as a wild card that represents one or more characters. 

c. Click Search. Groups matching your search criteria display on the Search Results tab. 

3. To perform an advanced search: 

a. Click Advanced Search. 

b. Specify your search criteria. 

c. Click Search. 

The results display on the Search Results tab in the left pane. To find the group's location in 
the group hierarchy, click the corresponding Org Code link. 

 
 

Activate or Deactivate the Members of a Group 

Activating an account changes its status to Activated and allows a user to sign in. Conversely, 
deactivating an account changes its status to Deactivated and denies the user the privilege to sign in. 

You can activate all members of a group at once. This activates any deactivated members of the 
group and all subgroups. You also can deactivate all members of a group with the same type of effect. 

To activate or deactivate the members of a group 

1. Click Users & Groups > User Management on the navigation bar. 

2. On the Users and Groups tab, navigate to the desired group, and select it. 

A user with a deactivated account has an icon that contains a red slash ( ). A user with an 
activated account does not have this red slash. 
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3. In the right pane, click Activate Members or Deactivate Members, as appropriate. 

All users are activated or deactivated as needed. 
 

Modify the Members of a Group 

Note: A user must be a member of at least one organizational group. 

To modify the members of a group 

1. Click Users & Groups > User Management on the navigation bar. 

2. On the Users and Groups tab, navigate to the desired group in the group hierarchy, then 
select the group. 

3. Click the Membership tab in the right pane. 

4. To add existing users to the group: 

a. Click Copy/Move Users in the right pane. 

 

b. In the user hierarchy in the left pane, browse to or search for the user to copy to the new 
group. 

c. Select the user, and click Copy. 

The user is added to the group whose membership displays in the right pane. 

(You can also move users out of the group whose contents are displayed in the right 
pane: Select the users in the right pane, select the target group into which to move the 
users in the left pane, and click Move.) 

d. Repeat this process as many times as needed to add additional users. 

e. Click Done. 

5. To remove members from the group: 

a. In the user hierarchy in the left pane, browse to or search for the group, and select it. 
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b. In the right pane, click the Membership tab. 

 

c. Select the check box beside each user you want to remove from the group, and click 
Remove. 

 

Change the Parent Group for a Group 

You can change the parent group for a group at any time. Be aware that a group will inherit the 
content assignments of the new parent group unless the group has explicit content assignments 
(which override all inherited ones). 

To change the parent group for a group 

1. Click Users & Groups > User Management on the navigation bar. 

2. On the Users and Groups tab, navigate to the desired group in the group hierarchy, then 
select the group. 

3. Click the Edit tab in the right pane. 

4. Click the Edit link next to Parent Group. 

The Select Group dialog box displays. 

 

5. Navigate to the desired group, and select it.  

You can also search for a group by Group Name and/or Org Code. If needed, you can enter 
an asterisk (*) as a wild card that represents one or more characters. 

6. Click OK, and then click Save. 
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Force a Password Change for a Group 

If you are a user with a Super Administrator or Company Administrator role, you can force a password 
change for all members of a group. This forces both the members of the group and the members of all 
child groups to change their passwords immediately after the next login. 

To force a password change for a group 

1. Click Users & Groups > User Management on the navigation bar. 

2. On the Users and Groups tab, navigate to the desired group in the group hierarchy, then 
select the group. 

3. Click the Group Info tab in the right pane 

4. Click Force Password Change. 

5. Click OK. 
 

Delete a Group 

By default, only super administrators can delete groups. However, this ability can be granted to 
company administrators and administrators as a custom user privilege. 

If you are not a super administrator, you cannot delete a group if it contains users that are not also 
members of another group. You must manually delete or move these users (both immediate ones and 
those within subgroups, if any) before you can delete the group. This is to prevent the inadvertent 
deletion of users. 

To delete a group 

1. Click Users & Groups > User Management on the navigation bar. 

2. On the Users and Groups tab, navigate to the group you want to delete, then select the 
group. 

3. Click the Group Info tab in the right pane. 

4. Click Delete. 

5. Click OK. 

 

 



Skillport 8 Administrator Guide ©2015 Skillsoft  46 
 

Users and Groups   
 
 

Advanced Groups 

An advanced group  is a special class of user group that has different site settings from its parent 
company. Administrators can enable certain add-ons and different web site color schemes for each 
advanced group, while maintaining reporting capabilities for their entire company. 

Note: The maximum number of advanced groups supported on a site is 100. 

When creating advanced groups, remember the following: 

 Use advanced groups sparingly. Too many advanced groups will make it hard for you to keep 

track of the different settings for each group. 

 Advanced groups have their own settings and are not affected by changes to company 

settings. However, note that some settings are company-only and cannot be changed at the 

advanced group level. 

 You must create advanced groups directly under the All Users level of the company hierarchy. 

 An advanced group cannot be a member of another group. 

 If you create advanced groups and then install an add-on module, such as Books24x7 or Ask 

My Mentor, to your company, you need to enable the add-on module in the Configuration 

menu. 

 A user may belong to only one advanced group, although they can belong to more than one 

standard group. 

Example 

Your organization may have three separate divisions: sales, production, and administration. You may 
want to enable the Books24x7 add-on module for just two of those divisions, and the Ask My Mentor 
add-on module for the third. You may also want to use different color schemes for each division's 
implementation of the site. 

You could achieve this by creating three separate companies, each with its own installation, but this 
would not allow you to run reports across your entire organization. By creating an advanced group for 
each division, you can treat each advanced group as its own entity while retaining the capability to run 
reports on all of them. 
 

Create an Advanced Group 

 Users with a Company Administrator role can create advanced groups. They can also edit 

settings for the parent company and for any advanced groups. 

 Users with an Administrator role who belong to an advanced group cannot create advanced 

groups, but they can edit company settings and those for the advanced group to which they 

belong. Users with an Administrator role who do not belong to an advanced group can edit 

company settings, but they cannot edit advanced group settings. 

Note: To create an advanced group, the max_advanced_groups SKP parameter must be set to 1 or 

greater by a super administrator. 

To create an advanced group 

1. Click Users & Groups > New Group on the navigation bar. 
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2. In the New Group window, enter the information for the new group. You must select 
Advanced as the Group Type. For help with this step, see Create a Group Manually on 
page 33. 

3. Click Save. 

4. Make the advanced group that you just created the active advanced group. For help with this 
step, see Select an Advanced Group to Administer on page 47. 

5. Change the settings of the advanced group. Note that some settings can only be changed by 
a Super Administrator or Company Administrator. 

For information on the specific settings that you can configure for an advanced group, see 
Settings Configurable for Advanced Groups on page 48. Your access to the various 
administrative functions depends on your user privileges. 

Note: As you modify settings for an advanced group, other sitewide settings are available to 
you, such as Completion Criteria or Login Text Customizations. If you modify a sitewide 
setting, you do so for the entire Skillport site (company), not just the currently-selected 
advanced group. 

 

Select an Advanced Group to Administer 
You can configure settings for the entire Skillport site or for a specific advanced group. The context in 
which you are working is always indicated in the upper-right corner of the page, as shown in the 
following image. 

 

If you are configuring settings for the entire Skillport site, the name of the Advanced Group displays as 
None selected. 

Before you perform any Skillport administration tasks for an advanced group, you must make current 
the advanced group in which you want to work. The current advanced group is the one that will be 
affected by your changes (for example, creating new users or modifying settings). 

To select an advanced group to administer 

1. In the upper-right corner of the page, click None selected or the name of the current 
advanced group. 

The Select Advanced Group page appears. 

 

2. Select the name of the advanced group for which you want to configure settings. 

The name of the advanced group you selected displays in the upper-right corner of the page 
to indicate that it is now the current advanced group. 
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Settings Configurable for Advanced Groups 
The tables that follow list the Configuration and Display settings that are 1) available to company 
administrators and 2) configurable at the advanced group level. 

 

Configuration Settings  Settings Customizable for Advanced Groups 

Features: Books24x7 All settings 

Notification Management All settings 

Notification Settings All settings 

Self-Registration  Comma-separated list of Administrator e-mail addresses 

Language All settings 

Report Configuration  Certificates of Completion settings 

Web Site Switches  Allow Learning Plan Reminders 

 Allow Learning Plan Due Dates 

 Enable Forced Restart 

  

Display Settings  Settings Customizable for Advanced Groups 

What's New Page All settings 

Web Site Colors All settings 

Default View All settings 

Navigation All settings 

Quick Links All settings 

Toolbar All settings 

Web Site Settings All settings 
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Assignment Groups 

An assignment group  is a special class of user group that you can use to control Catalog and 
Learning Plan assignments for users based on factors other than your organization's existing group 
hierarchy. For example, assume your group hierarchy includes the following organizational groups: 

 Marketing 

 IT 

 Finance 

Your organization also has a Leadership Team with members from each of the preceding 
organizational groups, and you want to be able to assign assets to the Leadership Team. To 
accomplish this, you would create an assignment group with those members. 
 

Assignment Groups versus Organizational Groups 
To use organizational groups and assignment groups effectively, it is important to understand when to 
use these two types of groups. 

Organizational Groups Assignment Groups 

Have members who belong to the same 
organization, for example, the Marketing 
department. 

Have members who can belong to any organization. 

Control access to some Administrator 
functions such as reporting capabilities and 
the management of users and groups. For 
more information, see User Privileges by 
Role on page 22. 

Do not control access to functionality. Only control the 
assignment of learning assets to users. 

Can have a hierarchy. That is, organizational 
groups can contain other organizational 
groups. 

Are non-hierarchical. All assignment groups are located 
under a top-level group named Assignment Groups. 

Assignment groups cannot contain other groups—
neither organizational groups nor other assignment 
groups. 

Because assignment groups are non-hierarchical, you 
cannot copy or move other groups into them. 

Can be moved into other organizational 
groups. However, they cannot be moved into 
assignment groups. 

Cannot be moved into other groups.  Assignment 
groups can only exist under the top-level group named 
Assignment Groups. 

In addition, you cannot change an assignment group 
into an organizational group. 

Are required. Users must belong to at least 
one organizational group. 

Are optional. Users do not need to belong to 
assignment groups. 

Can be viewed and managed by company 
administrators, administrators, and managers 
depending on how the groups are set up. The 
specific functions available depend on his or 
her role. For more information, see User 
Privileges by Role on page 22. 

Can be viewed and managed by company 
administrators, administrators, and managers if they 
have the Assignment Group Access custom privilege. 
The specific functions available depend on his or her 
role. For more information, see Working with 
Assignment Groups. 

Allow you to create users within them and 
move users between them. 

Do not let you create users within them or move users 
between them. You can only copy users into 



50 ©2015 Skillsoft Skillport 8 Administrator Guide 

 

 Users and Groups 
 
 

assignment groups 

Are always accessible. Are only accessible if the feature has been enabled by a 
super administrator.  

 
 

Working with Assignment Groups 
Only super administrators can enable or disable the assignment groups feature as a whole. 

If this feature is enabled, in order to see the assignment groups on your site, you must have the 
Assignment Group Access custom privilege. If you have this custom privilege, then the specific 
capabilities available to you for managing them depend on your role. 

Company Administrators can: 

 See all assignment groups on the site. Moreover, they can see all users within those groups. 

 Manage all aspects of assignment groups. They can create, specify the members of, assign 

content to, delete, and report on assignment groups. 

Administrators and Managers can:  

 See all assignment groups on the site. However, within those assignments groups, they can 

only see the users that they have the privileges to see and manage, namely, the users in 

normal groups and advanced groups (or in one of their child groups) in which the administrator 

or manager is also a member. 

 See a read-only view of the content assignments for all assignment groups. 

 Add and remove users from assignment groups, but this capability is limited to the users that 

they have the privileges to see. They cannot perform any other operation on assignment 

groups. 

 Select from all assignment groups on the site when running reports, but the report output is 

limited to that for the users that they have the privileges to see and manage. 

Note: If your site has been configured to expose the Assignment Group Access custom privilege, by 
default the privilege is granted to company administrators but not to administrators or managers. As a 
result, if the privilege is removed from a company administrator or granted to an administrator or 
manager, the user's privileges are considered to be customized, and, therefore, a custom user icon is 
shown for the user. For images of the custom user icons, see Group and User Icons. 

 

Create an Assignment Group 
While only company administrators can create assignment groups, your site may be configured to 
allow administrators with other Skillport roles to copy users into them (see Working with Assignment 
Groups). 

To create an assignment group 

1. Click Users & Groups > New Group on the navigation bar. 

The New Group dialog box displays. 

2. Enter the information for the new group. Be sure to select Assignment in Group Type. For 
help with this step, see Create a Group Manually on page 33. 
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Note: If Assignment is not an option in Group Type, verify that your Skillsoft representative 
has enabled the feature. In addition, note that users cannot add themselves to assignment 
groups during self-registration. As a result, once you select Assignment in Group Type, the 
Display on Registration Page check box is disabled. 

3. Click Save. 

You cannot create a user within an assignment group or move a user to an assignment group. 
However, you can copy existing users to assignment groups; the users must already exist and 
must remain members of an organizational group. You can copy users to multiple assignment 
groups. 

4. Populate the new assignment group with users by copying existing users into the new group. 
For information on how to copy users into a group, see Modify the Members of a Group on 
page 43. 
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Granting Access to Content 

Entitlements vs. Assignments 

What are Entitlements? 

Entitlements are the assets a learner can access within Skillport. If a learner does not see an asset 
within his Skillport site (either in the Library or within a search), he is not entitled to it. 

To entitle content, use the Catalog Assignment tab on the Users and Groups Management page. 
See Entitle Content for procedures. 

What are Assignments? 

Assignments are assets a learner is entitled to, that are placed in a learning plan. If a learner can see 
an asset within the Skillport Library, he is entitled to it and can save it to the Personal Learning tab of 
his learning plan. 

To assign content, use the Learning Plan Assignment tab on the Users and Groups Management 
page. See Assign an Asset to a Learning Plan for procedures. 

Entitling and Assigning Assets in Skillport 

When a Manager, Admin or Company Admin within Skillport is entitled to an asset, he can assign it to 
himself, and he can assign it to someone in his hierarchical group. When he assigns the asset to 
another user, he grants that learner access to the content, but the learner will not see the asset in the 
Library (or within a search) unless the admin specifically entitles it to the learner.  
 

Java-Free and Java-Dependent Content 

If your site supports Java-free content, SkillPort Administrator uses icons to differentiate Java-

dependent content from Java-free content (for example,   and ). Admins can use this functionality 
to make decisions about whether or not to assign Java-dependent content to learners. This 
configuration can be applied at the Site or Advanced Group level. 

Content Icons 

Java-dependent content icons are visible on the following Skillport Administrator pages:  

 Users & Groups 

 User Management (Catalog Assignment, Learning Plan Assignment, Enrollments and 

Waivers) 

 Enrollment & Waivers 

 Content 

 Library 

 Learning Programs 

 Credentials 

 Keywords > Link Keyword 



Skillport 8 Administrator Guide ©2015 Skillsoft  53 
 

Users and Groups   
 
 

 Reports 

 License Manager  

 Configuration > Completion Criteria  

Availability to Learners 

Depending on Java-free configuration settings, Java-dependent content is available to learners as 
follows: 

 All Java-dependent content is hidden when learners browse the library and search for content. 

Exception: Java-dependent content has already been assigned to the learner.  

Note: To allow learners to complete previously-assigned or accessed content, pre-existing 
assignments, assets with learner transcript entries, learning program assignments, and 
bookmarks are not affected by the Java-Free configuration settings. 

 Job Aids and SkillBriefs associated with Java-dependent content are still available in the 

Library and via Search, even when the content itself is not available.  

 Java-dependent content is visible to Admins, and may still be assigned and included in a 

Learning Program.  

 If Java content is hidden, learners can still view previously-accessed Java-dependent content 

in their learning plan and learner transcript. 

 If Java-dependent content is republished and SkillPort determines that the content is no longer 

Java-dependent, the content automatically displays to learners. 

For more information, see Skillport Content Java-Free Status in the Skillsoft Support Knowledge 
Base. 
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Working with Entitlements 

An entitlement is a collection of content a learner is granted permission to access within the Skillport 
Library. If a learner does not have entitlements to certain assets, the learner does not see those 
assets when browsing the Library or searching for assets.  
 

Modify Books24x7 Collection Entitlements 
Entitling Books24x7 collections to users and groups makes those collections available to them. You 
can assign (place within the learning plan) specific books or individual book chapters to: 

 Groups 

 Advanced groups 

 Assignment groups 

 Individual users 

You can directly entitle Books24x7 collections to all top-level groups and sub-groups as needed. If you 
assign a collection to a group, it is inherited by all members of the group and all members of all child 
groups. 

Note: Directly assigning collections to a user or child group overrides all inherited assignments for that 
user or group. For this reason, when you make direct assignments, be sure to assign all of the 
intended collections. To restore the inherited assignments, you must change the assignment to 
INHERITED (as described below), which automatically removes all direct assignments. 

To modify the Books24x7 collection entitlements for a group or user 

1. In Skillport Administrator, click Users and Groups > User Management from the top 
navigation bar. 

The User Management page displays. 

2. In the left panel, find the group or find the user whose assignments you want to modify, and 
select the group or user. 

3. In the right panel, click Books24x7 Assignment. 

The entitled collections display. By default, individual users inherit their group's Books24x7 
collection. 

4. If you want to change the Books24x7 entitlements for a user or group, do the following: 

a. Click Edit Group Assignments (if assignments have not yet been made to the group) or 
Override Inherited Assignments (if the group currently has assignments). 

The Books24x7 Assignment dialog box displays. 

 

b. Specify the collections to entitle: 
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 The same as the parent group: Gives user or group access to the same collections the 

parent group is currently entitled, and any additional collections that are subsequently 

added to (or removed from) the parent group assignment. 

 All collections: Gives user or group access to all collections currently available in your 

organization's Books24x7 subscription, and all additional collections that are subsequently 

added to or removed from the subscription. 

 No collections: Removes the user or group access to your organization's Books24x7 

subscription, and all additional collections that are subsequently added to or removed 

from the subscription. 

 Only the selected collections: Give access to specific Books24x7 collections for the 

user or group. If you select this option and choose all currently-available collections in 

your organization's Books24x7 subscription, the user or group will not have access to any 

additional collections that are subsequently added to the subscription. 

Note: The list of collections available for individual selection is determined first by your 
organization's Books24x7 subscription, and second by the collections that are assigned to 
the selected user's group or the selected group's parent group. Subscription information is 
available in the Books24x7 System Settings. 

a. Click Save. 

5. To modify overridden user or group entitlements, click Edit Individual Assignments and 
make your selections. 
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Inherited versus Explicit/Individual Assignments 
You can make the following types of content assignments: 

 Catalog Assignments: These assignments determine what learning assets are exposed to 

users and groups in the Library and using Search. 

 Learning Plan Assignments: These assignments add learning assets to users' Learning 

Plan, which allows you or them to set goals, due dates, and reminders. 

 Enrollments and Waivers: These assignments enroll users in learning programs. You can 

also grant waivers to individual courses within a program on a per user basis. 

 Books 24x7 Assignments: These assignments determine what Books24x7 collections are 

exposed to users and groups. 

Groups can be assigned content by inheriting it due to their membership in their parent group; these 
assignments are referred to as inherited assignments. They can also be assigned content directly; 
these assignments are referred to as explicit assignments. 

Similarly, individual users can be assigned content by inheriting it due to their membership in a group; 
these assignments are referred to as inherited assignments. They can also be assigned content 
directly; these assignments are referred to as individual assignments. 

Inherited Assignments 

By default, any content assigned to a group is inherited by all users in that group and by any child 
groups. This enables administrators to assign specific content to a large number of users. Users in 
multiple groups inherit the assignments of all the groups in which they are a member. 

  

Explicit and Individual Assignments 

In the case of Library assignments and Books24x7 assignments, if you assign content to a group or 
user directly, that assignment overrides all inherited assignments. 

In the case of learning plan assignments and enrollments, learners can only remove content that they 
have assigned to themselves. This content is in the user's Personal Learning tab of the learning plan. 
 



Skillport 8 Administrator Guide ©2015 Skillsoft  57 
 

Users and Groups   
 
 

Entitle Content 
When you entitle content to a group, that content becomes an individual user's Inherited Assignment 
on his Catalog tab in the User Management page. Example of Inherited (Group) Assignment 

 

When you entitle a different set of content to a user (overriding the inherited assignments on his 
Catalog tab), that content becomes his Individual Assignments. Example of Individual Assignments 

 

Note: The Library contains all stock and custom content installed on your Skillport site. You can 
organize this content into one or more libraries to optimize learner browsing and searching, and to 
facilitate the entitling and assigning of content. 

To entitle an asset to a group (create Inherited Assignments) 

Note: When you entitle content to a group, all members of the group see that content when browsing 

the Library and in their search results. 

1. Click Users & Groups > User Management on the navigation bar. 

2. In the left panel, select the group to which you want to entitle content. 
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3. In the right panel, click the Catalog Assignment tab. 

 

4. Click Edit Group Assignments. 

The Catalog Assigner - Group dialog box displays: 

 

Note: For more information about the folder icons, see Folder Icons. 

5. To entitle the entire Catalog contents to a group, select all the folders in the Catalog top-level 
folder in the Browse Catalog pane and click Add, or drag the content to the right pane and 
drop it into the Catalog Assignment folder. 

6. To entitle specific content to a group, browse or search the Catalog to find the content that you 
want to entitle and click Add, or drag the content to the right pane and drop it into the Catalog 
Assignment folder. 

7. Click Save. 

To entitle an asset to a user (create Individual Assignments) 

1. Click Users & Groups > User Management on the navigation bar. 

2. In the left panel, select the user to which you want to entitle content. 
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3. In the right panel, click the Catalog Assignment tab. 

 

4. Click Override Inherited Assignment. 

The Catalog Assigner - User dialog box displays: 

 

Note: For more information about the folder icons, see Folder Icons. 

5. To entitle the entire Catalog contents to the user, select all the folders in the Catalog top-level 
folder in the Browse Catalog pane and click Add, or drag the content to the right pane and 
drop it into the Catalog Assignment folder. 

6. To entitle specific content to a user, browse or search the Catalog to find the content that you 
want to entitle and click Add, or drag the content to the right pane and drop it into the Catalog 
Assignment folder. 

Note: Ensure you add ALL the content to which you want the user entitled. Modifying a user's 
individual assignments removes the group entitlements, and only the content within the user's 
Catalog Assignment folder is available to him when he browses or searches the Library. 

7. Click Save. 
 

Remove Content Entitlements 

To remove content entitlements for a group 

Note: When you remove an entitlement from a group, all members of the group lose the entitlement. 
See Entitle Content to a User or Group if you want only specific users within the group to have 
entitlement to the content. 
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1. Click Users & Groups > User Management on the navigation bar. 

2. In the left panel, select the group from which you want to remove the entitlement. 

3. In the right panel, click the Catalog Assignment tab. 

 

4. Click Edit Group Assignments. 

The Catalog Assigner - Group dialog box displays. See Folder Icons for more information 
about the folder icons. 

5. In the Catalog Assignment folder in the right pane, locate the content for which you wish to 
remove entitlement. 

Note: You can remove top-level folders only. If you wish to remove entitlements for specific 
folders, but leave entitlement intact for others within the same top-level folder, you must 
remove the top-level folder, then follow the To entitle an asset to a user (create Individual 
Assignments) procedure in Entitle Content to a User or Group and assign just those folders to 

the user. 

6. Hover your mouse over the folder and click the Deassign link that displays:  

 

7. Click OK to close the confirmation message. 

8. Click Save. 

To remove content entitlements for a user 

1. Click Users & Groups > User Management on the navigation bar. 

2. In the left panel, select the user from which you want to remove the entitlement. 
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3. In the right panel, click the Catalog Assignment tab. 

The user's entitlements display: 

 

4. Click Override Inherited Assignments (if the user does not have individual assigments) or 
Edit Individual Assignments (if the user has individual assignments, such as in the image, 
above). 

The Catalog Assigner - User dialog box displays. See Folder Icons for more information about 
the folder icons. 

5. In the Catalog Assignment folder in the right pane, locate the content for which you wish to 
remove entitlement. 

6. Hover your mouse over the content and click the Deassign link that displays: 

 

7. Alternatively, to remove entitlements for all assignments, click Deassign All. 

8. Click OK to close the confirmation message. 

9. Click Save. 
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Working with Assignments 

For details about the different learning assets Skillsoft offers, see Types of Learning Assets. 
 

Asset Type/Subtype Map 
The following table lists the primary content types and sub-types that learners will see when searching 
and/or filtering search results in the Skillport Library. 

Content Types (formerly Content 
Bins) 

Content Sub-Type (formerly Asset Type) 

Courses  Assessments 

 Courses 

 Course Topics * 

 Learning Programs 

 Live Learning Courses 

 Live Learning Expert Live class ** 

 Live Learning Expert Encore (recorded classroom) ** 

 Live Learning Hands-On Labs ** 

 Live Learning Module Pre-Test ** 

 Live Learning Module Post-Test ** 

 Live Learning  

 Simulations 

Books  Audio Books 

 Blueprints 

 Books 

 Book Sections * 

 Journals 

 Newsletters 

 Recorded Sessions 

 Reports 

 Summaries 

Videos  Live Events 

 Videos 
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Instructor Led Training (ILT)  Dialogue Live 

 ILT Courses 

Resources  Business Impact 

 Challenges 

 Express Guides 

 Job Aids 

 Learning Sparks 

 Live Learning 

 Live Learning Class Notes ** 

 Live Learning Mentoring ** 

 Live Learning Student Guide: Slides ** 

 Mentoring 

 Practice Labs 

 Projects 

 SkillBriefs 

Portals  Business Exploration Series 

 KnowledgeCenters 

 Skillsoft Advantage 

Custom 

(courses, passive objects, custom 
content published by your 
organization) 

 External Learning Object (ELO) 

 Custom *** 

* - Course topics and book sections cannot have Community features, such as comments and 
recommendations. These are done at the parent level. 

** - This content item displays only in a Live Learning Course and is not browsable nor searchable on 
its own. 

*** - All Custom types except for ELOs also have a "Custom" sub-type. 
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Digital Books vs. Print Books 
Pages are rendered differently in digital books. Because the size of a page on screen can vary greatly 
from a traditional book page, Skillsoft uses the term "book section" to distinguish the sections of a 
chapter, instead of the traditional page number.  

In the example below, the top-level is the book title (Credibility: How Leaders Gain and Lose It, Why 
People Demand It). 

Next, the book's Table of Contents displays, showing the book chapters (Chapter 1 - Leadership in a 
Relationship). These are determined by the traditional format of the book in print format. 

Finally, within the chapter are the book sections - grouping of text as determined by the publisher 
(DOING WHAT WE SAY: THE CRITICAL DIFFERENCE). This helps the reader hone in on areas of 
chapters that are most beneficial to his or her particular learning needs. You can add these sections to 
a learning plan.  

 

Note: Only Skillport Administrators can add Book sections to a learning plan. 

 

Custom Content 
Administrators and managers can create custom content. 

 Administrators can assign curricula to any group or user.  

 However, managers can assign content only to groups and users below them in the group 

hierarchy. 

Before creating custom content using the Library page, there must be a location already in place for it; 

this location must be subordinate to the All Curricula folder. Contact your Skillsoft 

representative to set up this location. 

Depending on the needs of your organization, you can assign these areas to a group or individual 
users.  

Example: Assign a Custom Content Area to a Group 

1. You log in as an administrator, and you create a new user group called Managers. 
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2. You add the users Manager1 and Manager2 to the new Managers group, as shown in the 
following image: 

 

Manager1 and Manager2 now have multiple group assignments (they are both in the 
Managers group and the Users group). In order for them to assign content to the Users group 
(or to the individual members of that group), they must be a part of the My Company group 
because managers can only assign content to managers and other users who are below them 
in the organizational hierarchy: 

 

In order to create custom content, Manager1 and Manager2 must also be a part of the 
Managers group. This allows them to assign (expose) content to the Managers group that you 
do not expose to the Users group. 

3. Use the Library page to create a custom content area for managers. This is a folder that is 
referred to in the user interface as a curricula "group." Within the custom area, you also create 
separate areas for Manager1 and Manager2, as shown in the following image. 

 

4. On the User and Group Management page, assign the Manager-Created Custom Curricula 
folder to the Manager group. This has two effects in the Skillport Administrator: 
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 It exposes the folder in the Library to all members of the Manager group (in this case, 

Manager1 and Manager2). 

 It exposes the folder on the Catalog Assignment tab of the User and Group 

Management page, which means all members of the Manager group can assign the 

content (including the content in its subfolders) to users. 

Example: Assign a Custom Content Area to an Individual User 

If privacy is a concern, you can use the Library Manager to create a custom content folder under All 

Curricula for each individual manager and expose each folder to only the appropriate manager by 

assigning it to only that manager. 

For example, building upon the first example, the following image shows an additional custom 

curricula folder named Manager3 Custom. This folder lives outside of the Manager-Created 

Custom Curricula folder: 

 

If you assigned the Manager3 Custom folder to just Manager3, the folder would be visible to only 

Manager3. As a result, while Manager1 and Manager2 could see the contents of each other's custom 
content folders, they could not see the contents of Manager3's custom content folder, nor could 
Manager3 see the contents of theirs. 

 
 

Assign or Deassign Assets in the Library 
Assigning content (including learning programs and Live Learning courses) to users and groups 
makes it available within the Library and search to those specific users. You can assign content to: 

 Groups 

 Advanced groups 

 Assignment groups 

 Individual users 

If you assign content to a group, it is inherited by all members of the group and all members of all child 
groups. 

Note: Be aware that directly assigning content to a group or user overrides all inherited assignments 
from that group or user. For this reason, when you make direct assignments, be sure to assign all of 
the intended content. To restore the inherited assignments, you must manually remove all direct 
assignments. 
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You can also deassign content that you have directly assigned to a group or user. However, you 
cannot deassign inherited content. To remove inherited assignments, deassign the content from the 
group to which it was directly assigned. 

To assign or deassign content to a group or user 

1. Click Users & Groups > User Management on the navigation bar. 

The User Management page displays. 

2. In the left panel, find the group or find the user whose assignments you want to modify, and 
select that group or user. 

3. In the right panel, click the Catalog Assignment tab. 

The content assigned to the selected user or group displays. 

4. If the assignments are inherited, you can override the assignments. 

a. Click Override Inherited Assignment. 

The Catalog Assigner opens with the available content for assignment displayed: 

 

b. Browse or search the available content to find the asset(s) you want to assign. 

c. Select the asset that you want to assign. To select multiple assets, use the standard 
keyboard shortcuts (CTRL+click and SHIFT+click). 

d. Click Add. 

e. Click Save. 

5. If the assignments are explicit (directly assigned to the selected group) or individual (directly 
assigned to the selected user), and you want to remove one or more assignments: 

a. Click Edit Individual Assignments. 

b. Hover your mouse over the assignment. 
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c. Click the Deassign link that displays: 

 

d. Click OK. 

Note: If you remove all explicit (direct) assignments from a group, the assignments inherited 
from the parent group are restored. If you remove all individual (direct) assignments from a 
user, the assignments inherited due to membership in one or more groups are restored. 
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Managing Assets in Learning Plans 
You can manage assigned assets for: 

 Individual users 

 Groups 

 Advanced groups 

 Assignment groups 

When you add an asset to a learning plan, it displays in the learner's Assigned Learning tab in his 
learning plan. Before adding assets to a learning plan, note the following: 

 When you assign an asset to a group, all group and sub-group members inherit that asset. 

 When you assign an asset that a learner has already assigned to himself, the asset is moved 

from the learner's Personal Learning tab to the Assigned Learning tab within his learning 

plan. All progress is retained. 

 When a learner inherits an asset in his learning plan (for example, from a group assignment) 

but also has the same asset assigned to him (by an administrator), the asset displays twice in 

the learning plan. 

 Adding a learning program or Live Learning Course (LLC) to a learning plan for a group or 

individual learner does not automatically enroll the group or learner. You must enroll the group 

or learner as a separate, explicit action. Alternatively, each learner can withdraw himself. 
 

Assign an Asset to a Learning Plan 

Note: If your organization has enabled Skillport's recurrence feature, use the To add a recurring asset 
to the learning plan for a group or user drop-down. 

To add an asset to the learning plan for a group or user 

1. Click Users & Groups > User Management on the navigation bar. 

2. In the left panel, find the group or find the user whose assignments you want to modify, and 
select that group or user. 

3. In the right panel, click the Learning Plan Assignment tab. 

All Learning Plan assignments for the user or group display: 
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Note: While you can browse the inherited Learning Plan assignments for the user or group, to 

modify these, you must modify the assignments of the parent group. 

4. Do one of the following: 

 If you have selected a user, click Edit Individual Assignments. 

 If you have selected a group, click Edit Group Assignments. 

The Learning Plan Assigner page displays. 

 

5. Browse or search the library to find the learning asset that you want to add, and select it. 

6. Click  , or drag the asset to the right pane and drop it into the Assigned folder. 

Note: To add a specific section of a book or a specific topic in a course, you must move your 
mouse over the asset's title, and then click the Show Details link that displays. Next, click  to 
expand the relevant chapter or lesson, and click the Add link that appears beside the section 
or topic, as shown in the example below for a section. 
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The Add to Learning Plan dialog box displays.  

 

Depending on the configuration of your site, one or more of the settings shown in the image 
above might not be available. 

7. If the option exists, select Non-recurring. 

8. Enter a Note (for example, the objective of the learning asset) up to 100 characters.  

9. Select a Due Date. 

 Fixed date is a date you select from the calendar. 

 Period after assignment is the number of days, weeks or years from the date you assign 

the asset to the user. 

10. Select the type of Reminder. 

 Select Allow users to choose their own overdue notices to have the user set his own 

reminder. 

 Select a one-time or recurring email to be sent to the user automatically.  

Note: If you set a reminder, you must also enter the number of days before the asset's due 
date to send the initial or one-time reminder email. The reminder e-mail contains direct links to 
the asset itself and to its details page. 

11. Optionally, select  Overdue notices to send weekly email reminders if the asset is not 
completed by the specified Due Date.  

12. If applicable, select  Required.  
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Note: This setting does not affect the behavior of application; it is used for reporting. It 

differentiates required assets from optional ones. 

13. Click OK. The asset displays in the user's Development Plan set in the Assigned Learning 
tab in his learning plan, and is automatically in an approved state. 

14. Click Save. 

15. If your site is configured to do so, the Preview Email Template dialog box displays, where you 
can send an email about the assignment: 

a. If desired, enter a personal message in any language at the top of the body of the email, 
and click Send. You can enter a maximum of 1,024 characters. Click Don't Send if you 
do not want to send the email. 

b. In the case of a group assignment, click Send again in the confirmation window that 
displays to confirm the action. 

To add a recurring asset to the learning plan for a group or user 

Note: The types of assets you can restart include courses, test preps, SkillSims, custom content, 

practice labs, and recorded Dialogue sessions. For more information, see Compliance. 

1. Click Users & Groups > User Management on the navigation bar. 

2. In the left panel, find the group or find the user whose assignments you want to modify, and 
select that group or user. 

3. In the right panel, click the Learning Plan Assignment tab. 

All assignments for the user or group display: 

 

Note: While you can browse the inherited learning plan assignments for the user or group, to 

modify these, you must modify the learning plan assignments of the parent group. 

4. Do one of the following: 

 If you have selected a user, click Edit Individual Assignments. 

 If you have selected a group, click Edit Group Assignments. 
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The Learning Plan Assigner page displays. 

 

5. Browse or search the library to find the learning asset that you want to add, and select it. You 
can also add a specific book section or course topic to the Assigned folder. 

6. Move your mouse over the asset title.  

A Show Details link displays. 

7. Click Show Details. 

8. Click  to expand the relevant book chapter or course lesson. 

A list of the book sections or course topics display. 

9. Hover your mouse over the book section or course topic you want to add to the Assigned 
folder. 

An Add link displays: 

 

10. Click Add. 

The Add to Learning Plan dialog box displays. 

11. Click  , or drag the asset to the right pane and drop it into the Assigned folder. 
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The Add to Learning Plan dialog box displays.  

 

Note: Depending on the configuration of your site, one or more of the settings shown in the 

image above might not be available. 

12. Enter a Note (for example, the objective of the content) up to 100 characters.  

13. Select the Type of content. 

 Non-recurring content (see To add an asset to the learning plan for a group or user, 

above) 

 Recurring by completion date 

a Select  Recurring by completion date. 

b Enter the Initial Due Date. 

This date is the first time the assigned content will be due for completion. Enter a numeric 
value and select Days, Weeks or Years from the drop-down list. (For example, if you assign 
an asset on May 1, and enter the Initial Due Date as 30 Days, the assignment is due on May 
31.) 

c Enter the Recurrence. 

This becomes the date from which the reassignment value is based. Enter a numeric value 
and select Days, Weeks or Years from the drop-down list. For example, if you set the 
Recurring Due Date to May 1, 2014 and the user completes the asset on February 1, 2014 
(earlier than expected), the next due date remains May 1, 2015. 

d Set the Open window. 
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The time frame set here determines when the user can access the content. If, for example, a 
course repeats yearly, you may not want a user to take the course on December 31, 2014 and 
again on January 1, 2015 to fulfill the requirement. The Open Window option allows you to 
specify when you want the course available to the user for training. 

e For the Reminder, select one of the following: 

 Allow users to set their own reminders 

 Set your reminder: Select the frequency from the drop-down list and enter a number of 

days, weeks or months prior to the due date to send the reminder. (For example,  a Daily 

reminder set for 5 Days before the due date.) 

Note: If you set a reminder, users cannot change it. However, if you allow users to set 
their own reminders, you can override them with a reminder that you set (which also 
cannot be changed by users). 

f For Overdue notices, select one of the following: 

 Allow users to choose their own overdue notices 

 Send weekly overdue notices: The system sends an email the day after the due date 

and every 7 days thereafter until the user completes the course. The Overdue notices 

setting is not available if you are adding a series from the Library, because the series will 

contain multiple courses that may be in varying stages of completion. 

g If applicable, select  Required.  

Note: This setting does not affect the behavior of application; it is used for reporting. It 

differentiates required assets from optional ones. 

h Click OK. The Add to Learning Plan dialog box closes and the content displays in the Assigned 
Learning tab in the learning plan. If the content is for the Development Set, it displays in that 
set within the tab. 

 Recurring by due date 

i Select  Recurring by due date. 

j Enter the Initial Due Date. 

This date is the first time the assigned content will be due for completion. Enter a numeric 
value and select Days, Weeks or Years from the drop-down list. (For example, if you assign 
content on May 1, and enter the Initial Due Date as 30 Days, the assignment is due on May 
31.) 

k Enter the Recurrence. 

Reassign every x Days/Weeks/Years based on recurring due date: Enter the number of 
days, weeks or years when you want this assignment to reassign (reappear) in the user's 
learning plan. Enter a numeric value and select Days, Weeks or Years from the drop-down 
list. 

Recurring Due Date: This becomes the date from which the reassignment value is based. 
Enter a numeric value and select Days, Weeks or Years from the drop-down list. For 
example, if you set the Recurring Due Date to May 1, 2014 and the user completes the asset 
on February 1, 2014 (earlier than expected), the next due date remains May 1, 2015. 
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Note: For example, on May 1, 2014, you set the Initial Due Date to 30 days after the 
assignment, making the asset due on May 31, 2014. If the Recurring Due Date is set to May 
31, 2015 (because you want the user to take the course every year), and you set the 
Reassign every... field to 180 Days, then the content displays in the learning plan on 
November 27, 2014 and the next time the content is due is the date set in the Recurring Due 
Date field. 

l Set the Open window. 

The time frame set here determines when the user can access the content. If, for example, a 
course repeats yearly, you may not want a user to take the course on December 31, 2014 and 
again on January 1, 2015 to fulfill the requirement. The Open Window option allows you to 
specify when you want the course available to the user for training. 

m For the Reminder, select one of the following: 

 Allow users to set their own reminders 

 Set your reminder: Select the frequency from the drop-down list and enter a number of 

days, weeks or months prior to the due date to send the reminder. (For example,  a Daily 

reminder set for 5 Days before the due date.) 

Note: If you set a reminder, users cannot change it. However, if you allow users to set 
their own reminders, you can override them with a reminder that you set (which also 
cannot be changed by the user). 

n For Overdue notices, select one of the following: 

 Allow users to choose their own overdue notices 

 Send weekly overdue notices: The system sends an email the day after the due date 

and every 7 days thereafter until the user completes the course. Note that the Overdue 

notices setting is only available if you are assigning an individual course to a learning plan 

(and for no other type of content). It is not available if you are adding a curriculum folder of 

courses since the folder will contain multiple courses that may be in varying stages of 

completion. 

Note: If the content is a course, for Overdue notices, select one of the following: 
- users can choose whether to receive overdue notices by email, or  
- overdue notices should be sent (and users should not be given the choice to receive 
these notices)  

o Click OK. The Add to Learning Plan window closes and the content displays in the user's learning 
plan. If the content is for the Development Set, it displays in that set within the tab. 

14. Click OK. 

15. Click Save.  

16. If your site is configured to do so, the Preview Email Template dialog box displays, where you 
can send an email about the assignment: 

a. If desired, enter a personal message in any language at the top of the body of the email, 
and click Send. You can enter a maximum of 1,024 characters. Click Don't Send if you 
do not want to send the email. 

b. In the case of a group assignment, click Send again in the confirmation window that 
displays to confirm the action. 
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Remove an Asset from a User's Learning Plan 

Note: Removing a learning program or Live Learning Course (LLC) from a learning plan does not 
withdraw the learner from it. For information about withdrawing a learner, see Withdraw Users or 
Groups. 

To remove an asset from the learning plan for a group or user 

1. Click Users & Groups > User Management on the navigation bar. 

2. In the left panel, find the group or find the user whose assignments you want to modify, and 
select that group or user. 

3. In the right panel, click the Learning Plan Assignment tab. 

The current assignments display: 

 

Note: While you can browse the inherited learning plan assignments for the user or group, to 

modify these, you must modify the assignments of the parent group. 

4. Do one of the following: 

 If you have selected a user, click Edit Individual Assignments. 

 If you have selected a group, click Edit Group Assignments. 
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5. In the right pane, move the cursor over the asset in the displayed list, and click the Deassign 
link that displays: 

 

6. Click OK, and then click Save. 

7. If your site is configured to do so, the Preview Email Template dialog box displays, where you 
can send an email about the assignment: 

a. If desired, enter a personal message in any language at the top of the body of the email, 
and click Send. You can enter a maximum of 1,024 characters. Click Don't Send if you 
do not want to send the email. 

b. In the case of a group assignment, click Send again in the confirmation window that 
displays to confirm the action. 

 

Create and Assign a Learning Event in the Learning Plan 
You can use a learning event to track training completed outside of the Skillport LMS, such as a 
conference, training course, or webinar. You must create the learning event at the same time you 
assign it to a user or group. 

To assign a learning event to an individual learner's learning plan 

1. In Skillport Administrator, click Users and Groups > User Management from the top 
navigation bar. 

The User Management page displays. 

2. In the Users and Groups pane, navigate to the learner name.  

3. In the right pane, click the Learning Plan Assignment tab. 

4. Click Edit Individual Assignments. 

The Learning Plan Assigner dialog box displays. 

5. At the top right of the Learning Plan Assigner dialog box, click  Create LE.  
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The Add Learning Event dialog box displays: 

 

6. Enter the Title, Start Date and End Date. 

7. Optionally, enter a Goal (up to 100 characters), Description, URL, the Duration (in Hours or 
Days), and the Cost.  

8. If asset completion is required, select Required.  

Note: This setting has no impact on the system's behavior; it is an attribute that displays in 

generated reports. 

9. Click OK.  

The learning event displays in the Assigned Learning tab of the user's learning plan. 

To assign a learning event to a group's learning plan 

1. In Skillport Administrator, click Users and Groups > User Management from the top 
navigation bar. 

The User Management page displays. 

2. In the Users and Groups pane, navigate to the group name.  

3. In the right pane, click the Learning Plan Assignment tab. 

4. Click Edit Group Assignments. 

The Learning Plan Assigner dialog box displays. 

5. At the top right of the Learning Plan Assigner dialog box, click  Create LE.  
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The Add Learning Event dialog box displays: 

 

6. Enter the Title, Start Date and End Date. 

7. Optionally, enter a Goal (up to 100 characters), Description, URL, the Duration (in Hours or 
Days), and the Cost.  

8. If asset completion is required, select Required.  

Note: This setting has no impact on the system's behavior; it is an attribute that displays in 

generated reports. 

9. Click OK.  

The learning event displays in the Assigned Learning tab of each group member's learning 
plan. 
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Managing Development Plan Sets 
To use Development Plans in Skillport, your organization must enable this feature. Contact your 
Skillsoft representative to enable Development Plans. 
 

Development Plan Set 

What is the Development Plan Set? 

The Development Plan set is an area where both the learner and manager can collaboratively develop 
an approved, personalized development plan designed to achieve specific career development goals 
and keep track of assets. 

Development Plan Approval State 

The learner and his manager can add learning assets to the Development Plan set in the learning 
plan. When the learner's manager adds an asset to the Development Plan set, there is no submission 
required and the set displays as Approved.  
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Whenever the learner makes a change to the set, the Development Plan set title changes to display a 
Submit for Approval button. 

 

 the learner submits the Development Plan for approval and the manager approves the assets. 

The Development Plan set then displays as Approved. 

 the learner removes the new assets. The Development Plan set reverts back to the state it 

was in prior to any changes. 
 

Approve or Deny a Development Plan Set 
When a user adds an asset to the Development Plan folder, the folder is in a Pending state. The user 
can then click Request Approval to send the folder contents to the Approval Manager for review and 
approval or denial. 

To review, approve or deny a Development Plan request 

1. Click Quick Links > Approval Manager at the top of the page. 

The Approval Manager page displays: 

 

2. Locate the pending request you want to approve or deny. 
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Note: Once you approve or deny a Development Plan, it cannot be undone. Be sure you 

select the correct request prior to continuing. 

3. Click  in the Actions column corresponding to the request. 

A dialog box displays that includes information about the selected request. 

4. If applicable, review the learner's note. 

Note: If a learner's note exceeds the space restraints in a window, an ellipsis (...) appears at 
the end of the viewable text. To see the learner's note in its entirety, hover your mouse over 
the ellipsis and the full text appears in a pop-up window. 

5. In Details, view the contents of the request. 

6. If applicable, enter notes to the learner. 

7. Do one of the following: 

 Click Approve to approve the request. 

 Click Deny to deny the request.  

 Click Cancel to close the Request window without approving or denying the request. 

The status of the request displays on the Approval Manager page as either Approved or 
Denied. If you did not approve or deny the request, the status displays as Pending. 

8. To view a summary of the request, click  in the Actions column. 

9. To view and print a report of the request, click  in the Actions column. Or, click Print 
Report in the upper-right corner of the page. 

 

Assign an Asset to Users' Development Plan Folders 

Note: If your organization has enabled Skillport's recurrence feature, use the To add a recurring asset 
to a Development Plan set for a group or user drop-down. 

To add an asset to a Development Plan set for a group or user 

1. Click Users & Groups > User Management on the navigation bar. 

2. In the left panel, find the group or find the user whose assignments you want to modify, and 
select that group or user. 

3. In the right panel, click the Dev Plan Assignment tab. 

All Development Plan assignments for the user or group display: 
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Note: While you can browse the inherited Development Plan assignments for the user or 

group, to modify these, you must modify the assignments of the parent group. 

4. Do one of the following: 

 If you have selected a user, click Edit Individual Assignments. 

 If you have selected a group, click Edit Group Assignments. 

The Development Plan Assigner page displays. 

 

5. Browse or search the library to find the learning asset that you want to add, and select it. You 
can also add a specific book section or course topic to the Assigned folder. 

6. Move your mouse over the asset title.  

A Show Details link displays. 

7. Click Show Details. 

8. Click  to expand the relevant book chapter or course lesson. 

A list of the book sections or course topics display. 

9. Hover your mouse over the book section or course topic you want to add to the Assigned 
folder. 

An Add link displays: 

 

10. Click Add. 

The Add to Learning Plan dialog box displays. 

11. Click  , or drag the asset to the right pane and drop it into the Assigned folder. 
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The Add to Learning Plan dialog box displays.  

 

Depending on the configuration of your site, one or more of the settings shown in the image 
above might not be available. 

12. If the option exists, select Non-recurring. 

13. Enter a Note (for example, the objective of the learning asset) up to 100 characters.  

14. Select a Due Date. 

 Fixed date is a date you select from the calendar. 

 Period after assignment is the number of days, weeks or years from the date you assign 

the asset to the user. 

15. Select the type of Reminder. 

 Select Allow users to choose their own overdue notices to have the user set his own 

reminder. 

 Select a one-time or recurring email to be sent to the user automatically.  

Note: If you set a reminder, you must also enter the number of days before the asset's due 
date to send the initial or one-time reminder email. The reminder e-mail contains direct links to 
the asset itself and to its details page. 

16. Optionally, select  Overdue notices to send weekly email reminders if the asset is not 
completed by the specified Due Date.  

17. If applicable, select  Required.  
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Note: This setting does not affect the behavior of application; it is used for reporting. It 

differentiates required assets from optional ones. 

18. Click OK. The asset displays in the user's Development Plan set in the Assigned Learning 
tab in his learning plan, and is automatically in an approved state. 

19. Click Save. 

20. If your site is configured to do so, the Preview Email Template dialog box displays, where you 
can send an email about the assignment: 

a. If desired, enter a personal message in any language at the top of the body of the email, 
and click Send. You can enter a maximum of 1,024 characters. Click Don't Send if you 
do not want to send the email. 

b. In the case of a group assignment, click Send again in the confirmation window that 
displays to confirm the action. 

To add a recurring asset to a Development Plan set for a group or user 

Note: The types of assets you can restart include courses, test preps, SkillSims, custom content, 

practice labs, and recorded Dialogue sessions. For more information, see Compliance. 

1. Click Users & Groups > User Management on the navigation bar. 

2. In the left panel, find the group or find the user whose assignments you want to modify, and 
select that group or user. 

3. In the right panel, click the Development Plan Assignment tab. 

All assignments for the user or group display: 

 

Note: While you can browse the inherited learning plan assignments for the user or group, to 

modify these, you must modify the learning plan assignments of the parent group. 

4. Do one of the following: 

 If you have selected a user, click Edit Individual Assignments. 

 If you have selected a group, click Edit Group Assignments. 
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The Learning Plan Assigner page displays. 

 

5. Browse or search the library to find the learning asset that you want to add, and select it. You 
can also add a specific book section or course topic to the Assigned folder. 

6. Move your mouse over the asset title.  

A Show Details link displays. 

7. Click Show Details. 

8. Click  to expand the relevant book chapter or course lesson. 

A list of the book sections or course topics display. 

9. Hover your mouse over the book section or course topic you want to add to the Assigned 
folder. 

An Add link displays: 

 

10. Click Add. 

The Add to Learning Plan dialog box displays. 

11. Click  , or drag the asset to the right pane and drop it into the Assigned folder. 
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The Add to Learning Plan dialog box displays.  

 

Depending on the configuration of your site, one or more of the settings shown in the image 
above might not be available. 

12. Enter a Note (for example, the objective of the asset) up to 100 characters.  

13. Select the Type of asset. 

 Non-recurring asset (see To add an asset to the Development Plan for a group or user, 

above) 

 Recurring by completion date 

a Select  Recurring by completion date. 

b Enter the Initial Due Date. 

This date is the first time the assigned content will be due for completion. Enter a numeric 
value and select Days, Weeks or Years from the drop-down list. (For example, if you assign 
an asset on May 1, and enter the Initial Due Date as 30 Days, the assignment is due on May 
31.) 

c Enter the Recurrence. 

This becomes the date from which the reassignment value is based. Enter a numeric value 
and select Days, Weeks or Years from the drop-down list. For example, if you set the 
Recurring Due Date to May 1, 2014 and the user completes the asset on February 1, 2014 
(earlier than expected), the next due date remains May 1, 2015. 

d Set the Open window. 
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The time frame set here determines when the user can access the content. If, for example, a 
course repeats yearly, you may not want a user to take the course on December 31, 2014 and 
again on January 1, 2015 to fulfill the requirement. The Open Window option allows you to 
specify when you want the course available to the user for training. 

e For the Reminder, select one of the following: 

 Allow users to set their own reminders 

 Set your reminder: Select the frequency from the drop-down list and enter a number of 

days, weeks or months prior to the due date to send the reminder. (For example,  a Daily 

reminder set for 5 Days before the due date.) 

Note: If you set a reminder, users cannot change it. However, if you allow users to set 
their own reminders, you can override them with a reminder that you set (which also 
cannot be changed by users). 

f For Overdue notices, select one of the following: 

 Allow users to choose their own overdue notices 

 Send weekly overdue notices: The system sends an email the day after the due date 

and every 7 days thereafter until the user completes the course. The Overdue notices 

setting is not available if you are adding a series from the Library, because the series will 

contain multiple courses that may be in varying stages of completion. 

g If applicable, select  Required.  

Note: This setting does not affect the behavior of application; it is used for reporting. It 

differentiates required assets from optional ones. 

h Click OK. The Add to Learning Plan dialog box closes and the content displays in the Assigned 
Learning tab in the learning plan. If the content is for the Development Set, it displays in that 
set within the tab. 

 Recurring by due date 

i Select  Recurring by due date. 

j Enter the Initial Due Date. 

This date is the first time the assigned content will be due for completion. Enter a numeric 
value and select Days, Weeks or Years from the drop-down list. (For example, if you assign 
content on May 1, and enter the Initial Due Date as 30 Days, the assignment is due on May 
31.) 

k Enter the Recurrence. 

Reassign every x Days/Weeks/Years based on recurring due date: Enter the number of 
days, weeks or years when you want this assignment to reassign (reappear) in the user's 
learning plan. Enter a numeric value and select Days, Weeks or Years from the drop-down 
list. 

Recurring Due Date: This becomes the date from which the reassignment value is based. 
Enter a numeric value and select Days, Weeks or Years from the drop-down list. For 
example, if you set the Recurring Due Date to May 1, 2014 and the user completes the asset 
on February 1, 2014 (earlier than expected), the next due date remains May 1, 2015. 
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Note: For example, on May 1, 2014, you set the Initial Due Date to 30 days after the 
assignment, making the asset due on May 31, 2014. If the Recurring Due Date is set to May 
31, 2015 (because you want the user to take the course every year), and you set the 
Reassign every... field to 180 Days, then the content displays in the learning plan on 
November 27, 2014 and the next time the content is due is the date set in the Recurring Due 
Date field. 

l Set the Open window. 

The time frame set here determines when the user can access the content. If, for example, a 
course repeats yearly, you may not want a user to take the course on December 31, 2014 and 
again on January 1, 2015 to fulfill the requirement. The Open Window option allows you to 
specify when you want the course available to the user for training. 

m For the Reminder, select one of the following: 

 Allow users to set their own reminders 

 Set your reminder: Select the frequency from the drop-down list and enter a number of 

days, weeks or months prior to the due date to send the reminder. (For example,  a Daily 

reminder set for 5 Days before the due date.) 

Note: If you set a reminder, users cannot change it. However, if you allow users to set 
their own reminders, you can override them with a reminder that you set (which also 
cannot be changed by the user). 

n For Overdue notices, select one of the following: 

 Allow users to choose their own overdue notices 

 Send weekly overdue notices: The system sends an email the day after the due date 

and every 7 days thereafter until the user completes the course. Note that the Overdue 

notices setting is only available if you are assigning an individual course to a learning plan 

(and for no other type of content). It is not available if you are adding a curriculum folder of 

courses since the folder will contain multiple courses that may be in varying stages of 

completion. 

Note: If the content is a course, for Overdue notices, select one of the following: 
- users can choose whether to receive overdue notices by email, or  
- overdue notices should be sent (and users should not be given the choice to receive 
these notices)  

o Click OK. The Add to Learning Plan window closes and the content displays in the user's learning 
plan. If the content is for the Development Set, it displays in that set within the tab. 

14. Click OK. 

15. Click Save.  

16. If your site is configured to do so, the Preview Email Template dialog box displays, where you 
can send an email about the assignment: 

a. If desired, enter a personal message in any language at the top of the body of the email, 
and click Send. You can enter a maximum of 1,024 characters. Click Don't Send if you 
do not want to send the email. 

b. In the case of a group assignment, click Send again in the confirmation window that 
displays to confirm the action. 
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Create and Assign a Learning Event for a Development Plan 
You can use a learning event to track training completed outside of the Skillport LMS, such as a 
conference, training course or webinar. You must create the learning event at the same time you 
assign it to a user or group. 

To assign a learning event to an individual user's Development Plan set 

1. In Skillport Administrator, click Users and Groups > User Management from the top 
navigation bar. 

The User Management page displays. 

2. In the Users and Groups pane, navigate to the learner name.  

3. In the right pane, click the Dev Plan Assignment tab. 

4. Click Edit Individual Assignments. 

The Development Plan Assigner dialog box displays. 

5. At the top right of the Development Plan Assigner dialog box, click  Create LE.  

The Add Learning Event dialog box displays: 

 

6. Enter the Title, Start Date and End Date. 

7. Optionally, enter a Goal (up to 100 characters), Description, URL, the Duration (in Hours or 
Days), and the Cost.  

8. If asset completion is required, select Required.  

Note: This setting has no impact on the system's behavior; it is an attribute that displays in 

generated reports. 

9. Click OK.  

The learning event displays in the Development Plan set in the Assigned Learning tab of the 
user's learning plan. 

To assign a learning event to a group's Development Plan set 

1. In Skillport Administrator, click Users and Groups > User Management from the top 
navigation bar. 
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The User Management page displays. 

2. In the Users and Groups pane, navigate to the group name.  

3. In the right pane, click the Development Plan Assignment tab. 

4. Click Edit Group Assignments. 

The Development Plan Assigner dialog box displays. 

5. At the top right of the Development Plan Assigner dialog box, click  Create LE.  

The Add Learning Event dialog box displays: 

 

6. Enter the Title, Start Date and End Date. 

7. Optionally, enter a Goal (up to 100 characters), Description, URL, the Duration (in Hours or 
Days), and the Cost.  

8. If asset completion is required, select Required.  

Note: This setting has no impact on the system's behavior; it is an attribute that displays in 

generated reports. 

9. Click OK.  

The learning event displays in the Development Plan set on the Assigned Learning tab of 
each group member's learning plan. The Development Plan displays as Approved. 
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Recurring Assets (Compliance) 

Compliance 

What is Compliance? 

When you are in compliance within Skillport, you have successfully completed the specified learning 
asset(s) your organization set forth, by the specified due date. 

You are not in compliance within Skillport when the time period for asset completion has passed, and 
the asset is not successfully completed. If you are not in compliance, check with your organization to 
determine next steps to be in compliance. 
 

Understanding Recurring Assets 

What is a recurring asset? 

A recurring asset is an administrator-assigned asset that learners must retake at specified intervals 
(for example, every year to maintain a certification). When an Admin assigns a recurring asset to a 
learner, he can select what type of recurrence he wants the asset to follow: 
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Once assigned, and outside of the open window, the asset displays a Launch in Review link instead 
of the Launch link wherever the learner can access the asset (from his learning plan, search results, 
or Library Browse results). 

Where to designate an asset as recurring 

If recurring assets are enabled for the organization, there are slight differences when assigning 
content to learning plans. A new area (Type) appears in the Add to Learning Plan dialog box: 
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How recurring assets are presented within the learning plan 

When compliance is configured for your site, there are differences in how the assets are presented 
within learning plans. Stringency rules are the logic behind how Skillport prioritizes required assets. 
They are as follows: 

Individual Requirement (Overridden Assignments) or Group Requirement (Inherited 
Assignments) 

 The individual assignment is more stringent, and takes priority over the group (inherited) 

assignment. 

Required Asset or Optional Asset 

 The required asset is more stringent and takes priority over the optional asset. 

Recurring Assignment Type  

 An asset marked as Recurrence by Completion Date is more stringent than and takes priority 

over assets marked as Recurrence by Due Date. 

Due Date (Only for Recurring Due Date) 

 The closest due date, or the Most Overdue, is more stringent than other assets. 

Initial Training 

 The smallest period-based assignments take priority over assignments with longer periods. 

Enable a forced restart of assets 

Using the Enable Forced Restart web site switch, you can configure your Skillport site to force an 
asset to restart once it is completed. 

If the Enable Forced Restart web site switch is enabled: 

 This setting affects any self-assigned assets, and any non-recurring assignments (both self-

assigned and manager-assigned) where the asset has the "Allow Multiple Completions" flag 

set in the completion criteria. 

 When a user launches a completed course, a new progress record is automatically created, 

and the previous progress record is archived. 

If the Enable Forced Restart web site switch is disabled: 

 When launching an asset that has already been completed, learners are given a choice as to 

create a new progress record or not. They are presented with the following message: 

 

 Restart: This freezes the last completion record and creates a new record in the learner 

transcript that counts toward the next completion. 

 Continue: This does not create a new record in the learner transcript; instead, it allows 

the learner to re-enter the last completion with the goal of changing and improving its 

score. If the learner selects this option, he is returned to his previous bookmark, and the 

progress he makes is applied to his last completion. 
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Note: For procedures, see the To add a recurring asset to a learning plan drop-down in Assign an 
Asset to a Learning Plan. 

 

Recurring Assets vs. Assets That You Can Restart 

What is a Recurring Asset? 

A recurring asset is an administrator-assigned asset that learners must retake at specified intervals 
(for example, every year to maintain a certification). When an Admin assigns a recurring asset to a 
learner, he can select what type of recurrence he wants the asset to follow: 
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Once assigned, and outside of the open window, the asset displays a Launch in Review link instead 
of the Launch link wherever the learner can access the asset (from his learning plan, search results, 
or Library Browse results). 

What is an Asset that can be Restarted? 

An asset that learners can restart is a self-assigned asset that can be restarted at user-specified 
intervals (for example, every year as a memory refresher course). Assets that learners can restart are 
determined by the learner when he is adding an asset to his learning plan:  

 

For more information, see Recurring Assets and the Assets You Can Restart topics in the Skillport 
Learner help. 

 

Assets That Learners Can Restart 

If your site is configured for it, you can restart (take again) the following types of assignments: 

 Multiple Completions 

Typically, you can complete a course only once. However, your site may allow for a course to 
be completed multiple times, which gives you more chances to earn a higher score or satisfy 
specific qualifications for the course. Your learner transcript reflects the highest scores for all 
course completions, so you will see multiple records for a course you have completed multiple 
times. 

 Recurring Learning Plan Assignments 

When you launch an asset you've already completed within its open window timeframe, and it 
has been marked as recurring, you receive the following prompt: 
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 Restart: This freezes the last completion record and creates a new record in the learner 

transcript that counts toward the next completion. 

 Continue: This does not create a new record in the learner transcript; instead, it allows 

you to re-enter the last completion with the goal of changing and improving its score. If 

you select this option, you are returned to your previous bookmark, and the progress 

made is applied to your last completion. 

See Recurring Assets for more information. 

 

 
 

Important Information About Recurring Assets 

As you work with recurring assets, keep in the mind the following: 

 The Skillsoft Course Manager (SCM) is an application that manages downloaded course 

content. Because the SCM is not aware of multiple progress records, learners cannot use it to 

record any assets that they can restart. 

 Each completion of a recurring asset has its own record within reports. 

 Your site might be configured to force learners to always restart the 2 types of assets 

described above. For more information, see the Enable a Forced Restart of Assets section in 

Understanding Recurring Assets and the Enable Forced Restart setting in the Web Site 

Switches topic. 

Note: A restart only occurs when, once an asset is completed, the learner launches the asset 
again. The learner is presented with a message about restarting the asset before any 
progress is made on the new launch. 
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 Assets that can be restarted display special icons in the learning plan. See Learning Plan 

Icons for more information. 

 Some assets may only be available for credit during a specific time period (the Open Window). 

Click a recurring asset within the learning plan to view the Open Window dates: 
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Advanced Compliance 

Advanced Compliance is a feature set in Skillport that provides a more complex implementation of 
compliance programs for your organization. 

As an administrator, you can configure and manage Advanced Compliance to: 

 Create demographic groups to assign learning programs to groups of users 

 Create and edit learning plan assignments for users and groups 

 Grant completions for non-web-based (non-WBT) courses 

 Assign exemptions and equivalencies 

 Create prerequisites 

 Create and activate automated emails for users, supervisors, and administrators 

 Run reports 

 Set up security levels and grant other administrators access to certain Advanced Compliance 

features 

Note: The Advanced Compliance feature set is only available if it has been enabled on your site. 
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Overview 

If you are assigned a Company Admin, Admin, or Manager role within Skillport, you can access the 
Advanced Compliance Administrator to configure your organization's Advanced Compliance features. 
A Skillsoft representative will work with you to achieve the desired level of functionality.  

To access the Advanced Compliance Administrator: 

1. Click Quick Links > Admin in the Skillport Learner. 

2. Click Access Advanced Compliance in the Users & Groups section on the Skillport 
Administrator home page.  

The Advanced Compliance Administrator Home page displays. 
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From the Advanced Compliance Administrator home page, you can access the following options on 
the navigation bar: 

 Users: View user information, create individual learning plan assignments, create individual 

exemptions and equivalencies, and assign completions.  

 Demographic Groups: Create demographic groups using Skillport User Profile fields, create 

group learning plan assignments, and create group exemptions and equivalencies. 

 Content: View available Advanced Compliance courses, create learning programs, create 

prerequisites, and designate equivalent courses. 

 Reports: View and print training reports for individual users and groups of users. 

 Setup: Specify security levels for administrators and whether to use email notifications. 

From any of these areas, you can select: 

 Close to return to the Skillport Administrator home page.  

 Help for instructions on how to use the Advanced Compliance Administrator.  

 

Advanced Compliance Limitations in Skillport 

There are several limitations to be aware of when using Advanced Compliance in Skillport 8: 

 Advanced Compliance assets are not available to be Featured Topics on the Skillport 8 

What's New page. 

 Advanced Compliance assets cannot be searched or browsed for in Skillport 8. 

 No community features are available for Advanced Compliance assets. 

 Assets available through the Advanced Compliance feature set are not available in the 

Skillport Catalog. 

 Reports for Advanced Compliance assignments are separate from other Skillport 

assignments, and are accessible only through the Advanced Compliance Administrator. 

 ILT content cannot be assigned using the Advanced Compliance feature set. 
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Working with Users 

You can perform user-specific administrative functions, such as editing user email settings, making 
learning plan assignments for individual users, assigning exemptions or equivalencies, assigning 
completions, or running reports.  
 

View or Edit User Information 

All user data is maintained in Skillport and is passed to Advanced Compliance on a nightly basis. 
There is no capability within Advanced Compliance to add new users. 

To utilize Advanced Compliance features for new users, the user must first be added to your Skillport 
site. The new user will display in the Advanced Compliance Administrator after the user has accessed 
Skillport or after the next nightly data synchronization process has run, whichever occurs first. 

You can view the user information from Skillport in the Advanced Compliance Administrator. However, 
the only field you can edit is the Send Email to User field. 

To view or edit user information 

1. Click Users > User Information on the navigation bar.  

2. In the Select administrative function drop-down list, select Edit User Info. 

3. Search for the user by entering the first letter(s) of the last name, then click Find.  

You can also search by User ID or one of the two customer-defined text fields, if they are 
included in your user information (for example, account number or corporate ID).  

4. Click the desired user name from the list. 

5. On the Edit User page, view the user's information.  

6. (Optional) Select a different value for the Send Email to User field. Valid values are Yes and 
No. 

7. Click Submit. 
 

Assign a Learning Plan to a User 

If a particular user has a unique learning plan assignment different from the requirements designated 
for a demographic group, you can assign training to an individual user as needed. 

To assign a learning plan to a user 

1. Click Users > Learning Plan Assignments on the navigation bar.  

The Assign Individual Learning Plan Assignments page displays. 

2. To search for the user by Last Name, enter the first letter(s) of the last name. 

Or, use the drop-down menu to select a different search criteria.  

3. Click Find. A list of users matching your search criteria displays.  

4. Click the desired user name from the list.  
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The Individual Learning Assignments page displays. 

 

5. In the Select from Library section, select a requirement (or use Ctrl+Click to select multiple 
requirements) from the library. Alternately, you can enter a search term in Search Course 
Title. You can enter a full course title, a partial title, or partial words. 

6. In Type, specify whether the requirement is Required or Optional. Required assignments 
have a due date; optional assignments do not have a due date. 

7. In Passing Threshold, specify the score required for the user to achieve a completion. The 
default value is 100%. 

Note: Some SCORM course players control the passing threshold in the course player and 

will not adhere to the passing threshold set in the LMS.  

8. In Initial Training:    

a. Select the option for when the course is due. Then, enter the number of days after 
receiving the course requirement that the course is due, or enter the calendar date when 
the course is due, depending on the selected option. 

Note: If a past calendar date is entered, the due date defaults to the same date the 
following year. For example, if an Initial Training date of 1/1/2014 is entered on 3/1/2014, 
the due date defaults to 1/1/2015. 
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b. In Course will be available for initial training X days prior to due date, specify how 
many days prior to the due date the course will become available on the user’s learning 
plan.  

To make the course available immediately, this number must be equal to or greater than 
the number of days until the course is due. For example, if you select the Initial Training to 
be due 90 days after the user receives the course and you want to make the course 
available to the user immediately, the availability value must be set to at least 90 days. 

9. In Retraining Assignment Type, specify whether training is considered "retraining" and how 
long the training is valid, or whether the training is considered "one time only" training. 

 Recurring, by Completion Date (RCD): This is the most stringent assignment type. 

Users will be required to take the course on a recurring basis, and their next due date is 

calculated from their last completion date. Recurrence is based on the number of days, 

weeks, or years you enter. After a user completes the course, his next due date will be 

calculated as last completion plus the validity period. 

 Recurring, by Due Date (RDD): This allows you to specify a calendar date when the 

learning plan is due, regardless of past completion dates. This assignment type is also 

required on a recurring basis depending on the number of days, weeks, or years you 

enter. The next due date is calculated as previous due date plus the validity period. You 

can also specify how many days prior to the recurring due date the course will become 

available on the user’s learning plan. To make the course available immediately, this 

number must be one day less than the recurrence period. For example, if you specify that 

the course is due 365 days from the user’s previous completions, and you want to make 

the course available to the user immediately, the availability value must be set to 364 

days. 

 Course will be available for retraining X days prior to due date: For RCD and RDD 

training, specify when courses will be made available for retraining. This time period 

indicates when a course will move from the Completed Training section of a user’s 

Learning Plan back to the Current Training section. 

 One Time Only: Learning plan assignments of this type are required only once for users. 

10. If desired, enter information in Notes. Notes are for administrator use only and do not display 
on administrative reports. 

11. Click Add. The new learning plan assignment displays in the Course(s) list at the bottom of 
the page, and on the user's Learning Plan. 

12. Repeat steps 5-11 until all desired learning plans have been assigned to the user. 

13. Click Done.  

Note: Individual learning plan assignments take precedence over all other assignments for a 
user. If a user has the same course assigned through a group and as an individual learning 
plan assignment, the individual assignment takes precedence. This means individual 
requirements can be made less stringent than group requirements. For more information, see 
Stringency Rules. 
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Assign an Exemption or Equivalency to a User 

You can give a user credit for a learning plan assignment by assigning an equivalency for a course. If 
a user is exempt from training and therefore can have the learning plan assignment waived, you can 
assign an exemption for the course. 

Once exemptions or equivalencies have been assigned, the learning plan assignment no longer 
displays on the user’s learning plan. The exemption or equivalency is listed in the user’s transcript. 

To assign an exemption or equivalency to a user 

1. Click Users > Exemptions and Equivalencies on the navigation bar. 

The Exemptions and Equivalencies page displays. 

 

2. To search for the user by Last Name, enter the first letter(s) of the last name. 

Or, use the drop-down menu to select a different search criteria.  

3. Click Find. A list of users matching your search criteria displays.  

4. Click the desired user name from the list. 

The Exemptions and Equivalencies page displays, showing the list of learning plan 
assignments for the selected user.  

5. To assign an exemption:  

a. Select the corresponding check box in the EX column for the desired course. 

b. In Exemption Expiration Date, enter the date the course exemption expires.  

c. In EX/EQ Date Granted, enter the date the exemption was granted. 

d. (Optional) In Justification, enter the reason for the exemption.  

6. To assign an equivalency:  

a. Select the corresponding check box in the EQ column for the desired course. 

b. In EX/EQ Date Granted, enter the date the equivalency was granted. 

c. (Optional) In Justification, enter the reason for the equivalency.  
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7. Click Submit. 
 

Delete an Exemption or Equivalency from a User 

When an equivalency or exemption is deleted, the learning plan assignment will be displayed on the 
user's learning plan under Current Training. 

To delete an exemption or equivalency from a user 

1. Click Users > Exemptions and Equivalencies on the navigation bar. 

The Assign Exemptions and Equivalencies page displays. 

2. To search for the user by Last Name, enter the first letter(s) of the last name. 

Or, use the drop-down menu to select a different search criteria.  

3. Click Find. A list of users matching your search criteria displays.  

4. Click the desired user name from the list. 

The Exemptions and Equivalencies page displays, showing the list of learning plan 
assignments for the selected user.  

5. To delete an exemption, clear the corresponding check box in the EX column for the desired 
course. 

6. To delete an equivalency, clear the corresponding check box in the EQ column for the desired 
course. 

7. Click Submit. 
 

Assign User Completions 

If you have made a learning plan assignment with a non-web-based training (non-WBT) delivery 
method (such as video, classroom, or CD), you can record a training completion for individual users.  

Note: If an HTML link has been assigned and the Completion dialogue box is enabled, the user will 
get a completion for that non-WBT assignment by accepting the confirmation upon closing the HTML 
link.  

To assign user completions 

1. Click Users > Assign Completions on the navigation bar.  
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The Assign Completions page displays.  

 

2. To search for the user by Last Name, enter the first letter(s) of the last name. 

Or, use the drop-down menu to select a different search criteria.  

3. Click Find. A list of users matching your search criteria displays.  

4. Click the desired user name from the list. 

The Assign Completions page displays with the user's list of learning plan assignments. 

5. For the desired assignment, select the Completed check box, then enter a date in Date 
Complete. 

Note: The Score and Comment fields are optional.  

6. Click Submit. 
 

Run a User Report 

To run a user report 

1. Click Users > User Information on the navigation bar.  

The User Information page displays. 

2. In the Select administrative function drop-down list, select the desired user report: 

3. Search for the user by entering the first letter(s) of the last name, then click Find.  

You can also search by User ID or one of the two customer-defined text fields, if they are 
included in your user information (for example, account number or corporate ID).  

4. Click the desired user name from the list. 

5. To specify filter criteria for all reports except the User Report, Email report: 

a. To filter the library by delivery method, select the desired Delivery Method from the drop-
down list.  
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b. To filter the library by course status, select the desired Course Status from the drop-
down list. 

c. Select one or more courses to include in the report filter, then click Select Course. 

To select multiple courses, use Ctrl+Click.  

d. Enter date filters, if needed. 

6. To specify filter criteria for the User Report, Email report:  

a. Specify the Email Type, either All, Non-recurring, or Recurring. 

b. In Sent in Last, enter the desired time period. For example, to view emails sent to a user 
in the past week, enter a 1 in the Sent in Last box, then select Week from the drop-down 
list. 

7. Select the report output format, either Web browser, PDF, or CSV (spreadsheet). 

8. Click Run Report. 
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Working with Demographic Groups 

You can create demographic groups, and then make learning plan assignments, assign exemptions or 
equivalencies, and assign completions to the them.  

 
 

About Demographic Groups 

Demographics refers to the information associated with each user. Demographics are mapped into 
your Advanced Compliance feature set using the user profile fields from your Skillport site. For 
information on mapping learning profiles to demographics, contact your Skillsoft representative. 

All your reports and assignments are based on the types of demographics you specify. The user 
demographics enable you to sort reports by this information and make learning plan assignments to 
specific groups of users.   

A demographic group is created to enable groups of users having a defined demographic to share the 
same learning plan assignments. Groups are created using the demographic labels that have already 
been created in Skillport. 

Note: You must create a demographic group before making learning plan assignments. 

It is recommended that you spend time analyzing the user demographics to determine which 
demographic groups share the same learning plan assignments and which demographic groups have 
unique learning plan assignments. For example, if a demographic category (such as Job Function) 
which includes electricians, welders, and operations shares the same learning plan assignments, you 
can designate just one demographic group (Job Function = All). However, if your organization has 
unique learning plan assignments for each job function, the best approach is to create a demographic 
group for each job function (select a defined job function, such as "electrician"). 
 

Create a Demographic Group 

To create a demographic group 

1. Click the Demographic Groups > Group Information on the navigation bar.  

The Create Demographic Groups page displays. 

 

2. In the Create Demographic Group(s) section, for each of the demographic categories, 
selecting the appropriate demographic label from the drop-down list. 
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Note: To create demographic groups using only demographic labels associated with user 
data, select the Apply automatic demographic filtering option. 

3. Click Add.  

The demographic group displays in the Existing Demographic Group(s) list. Click Users to 
view the users who are included in the group. 

4. When you have defined each demographic group, click Done.  

The Create Learning Plan Assignments page displays. 

5. To create learning plan assignments, see Create a Learning Plan Assignment for a Group. 
 

Delete a Demographic Group 

If learning plan assignments have been assigned to a demographic group, you must delete the 
learning plan assignments before deleting the demographic group. 

To delete a demographic group 

1. Click Demographic Groups > Group Information on the navigation bar.  

The Create Demographic Groups page displays. The list of demographic groups displays in 
the Existing Demographic Groups section. 

2. For the demographic group you want to delete, click the corresponding Delete button. 

3. When the message displays asking if you are sure you want to delete the group, click OK. 
 

Assign a Learning Plan to a Demographic Group 

To create a learning plan assignment for a group 

1. Click the Demographic Groups > Learning Plan Assignments on the navigation bar.  

The Create Learning Plan Assignments page displays. 

2. To search for a demographic group, enter the search criteria in Filter Groups. You can enter 
either a full or partial group title. 

3. In the Demographic Group(s) list, click Assign next to the desired group.  
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The Learning Plan Assignments page displays. 

 

4. In the Select from Course Catalog section, select a requirement (or use Ctrl+Click to select 
multiple requirements) from the library. Alternately, you can enter a search term in Search 
Course Title. You can enter a full course title, a partial title, or partial words. 

5. In Type, specify whether the requirement is Required or Optional. Required assignments 
have a due date; optional assignments do not have a due date. 

6. In Passing Threshold, specify the score (percentage) required for the user to achieve a 
completion. The default value is 100%. 

Note: Some SCORM course players control the passing threshold in the course player and 

will not adhere to the passing threshold set in the LMS.  

7. In Initial Training:    

a. Select the option for when the course is due. Then, enter the number of days after 
receiving the course requirement that the course is due, or enter the calendar date when 
the course is due, depending on the selected option. 

Note: If a past calendar date is entered, the due date defaults to the same date the 
following year. For example, if an Initial Training date of 1/1/2014 is entered on 3/1/2014, 
the due date defaults to 1/1/2015. 

b. In Course will be available for initial training X days prior to due date, specify how 
many days prior to the due date the course will become available on the users' learning 
plans.  
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To make the course available immediately, this number must be equal to or greater than 
the number of days until the course is due. For example, if you select the Initial Training to 
be due 90 days after the user receives the course and you want to make the course 
available to the user immediately, the availability value must be set to at least 90 days. 

8. In Retraining Assignment Type, select one of the following options to specify whether 
training is considered "retraining" and how long the training is valid, or if it is "one time only" 
training: 

 Recurring, by Completion Date (RCD): This is the most stringent assignment type. 

Users will be required to take the course on a recurring basis, and their next due date is 

calculated from their last completion date. Recurrence is based on the number of days, 

weeks, or years you enter. After a user completes the course, his next due date will be 

calculated as last completion plus the specified validity period. 

 Recurring, by Due Date (RDD): This allows you to specify a calendar date when the 

learning plan is due for all users, regardless of past completion dates. This assignment 

type is also required on a recurring basis depending on the number of days, weeks, or 

years you enter. The next due date is calculated as previous due date plus the validity 

period. You can also specify how many days prior to the recurring due date the course will 

become available on the users' learning plans. To make the course available immediately, 

this number must be one day less than the recurrence period. For example, if you specify 

that the course is due 365 days from the user’s previous completions, and you want to 

make the course available to the user immediately, the availability value must be set to 

364 days. 

 Course will be available for retraining X days prior to due date: For RCD and RDD 

training, specify when courses will be made available for retraining. This time period 

indicates when a course will move from the Completed Training section of a user’s 

Learning Plan back to the Current Training section. 

 One Time Only: Learning plan assignments of this type are required only once for users. 

9. If desired, enter information in Notes. Notes are for administrator use only and do not display 
on administrative reports. 

10. Click Add. The new learning plan assignment displays in the Course(s) list at the bottom of 
the page, and on the users' Learning Plans. 

11. Repeat steps 4-10 until all desired learning plans have been assigned to the demographic 
group. 

12. Click Done. 
 

Edit Learning Plan Assignments 

To view or edit learning plan assignments 

1. Click the Demographic Groups > Learning Plan Assignments on the navigation bar.  

2. To search for a demographic group, enter the search criteria in Filter Groups. You can enter 
either a full or partial group title. 

3. In the Demographic Group(s) list, click Assign next to the desired group.  

The Learning Plan Assignments page displays. The list of courses for the selected 
demographic group displays at the bottom of the page.  
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4. To change the training requirement information for a course: 

a. Click Edit next to the desired course.  

b. On the Edit Learning Plan Assignment page, edit the fields as needed.  

c. Click Done.  

 
 

Assign an Exemption or Equivalency to a Demographic Group 

You can assign exemptions and equivalencies to all users in a demographic group. The values you 
enter in the EX/EQ Date Granted, Exemption Expiration Date (for exemptions) and Justification 
fields apply to all users in the group.   

To assign an exemption or equivalency to a group 

1. Click Demographic Groups > Exemptions and Equivalencies on the navigation bar. 

2. Select the course from the Course drop-down list.  

3. To further filter the group, select the appropriate demographics from the drop-down lists. 

A list of only those users with an open (non-complete) assignment for the selected course and 
who meet the demographic criteria, if specified, displays. 

4. To assign an exemption (waive the course for users who are exempt from training):  

a. Select the EX check box. 

b. In Exemption Expiration Date, enter the date the course exemption expires.  

c. In EX/EQ Date Granted, enter the date the exemption was granted. 

d. In Justification, enter the reason for the exemption.  

5. To assign an equivalency (give users credit for a learning plan assignment):  

a. Select the EQ check box. 

b. In EX/EQ Date Granted, enter the date the equivalency was granted. 

c. In Justification, enter the reason for the equivalency.  

6. To grant the exemption or equivalency: 

 To all users in the list, select the Select/Unselect All check box. 

 To only certain users, click the check box beside each name.  

To clear all users, click the Select/Unselect All box again. You can clear certain users by 
clicking the check box beside each name. 

7. Click Submit. 
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Delete an Exemption or Equivalency from a Demographic Group 

When an equivalency or exemption is deleted, the learning plan assignment will be displayed on each 
user's learning plan under Current Training. 

To delete an exemption or equivalency from a group 

1. Click Demographic Groups > Exemptions and Equivalencies on the navigation bar. 

The Exemptions and Equivalencies by Demographic page displays. 

2. Select the course from the Course drop-down list.  

3. To further filter the group, select the desired demographics from the drop-down lists. 

A list of only those users with an open (non-complete) assignment for the selected course and 
who meet the demographic criteria, if specified, displays. 

4. Click Submit. 

5. To delete an exemption, clear the corresponding check box in the EX check box for the 
desired course. 

6. To delete an equivalency, clear the corresponding check box in the EQ check box for the 
desired course. 

7. Click Submit. 

 

 
 

Assign Group Completions 

If you have made a learning plan assignment with a non-web-based training (non-WBT) delivery 
method (such as video, classroom, or CD), you can record a training completion for a demographic 
group.  

Note: If an HTML link has been assigned and the Completion dialogue box is enabled, the 
demographic group will get a completion for that non-WBT assignment by accepting the confirmation 
upon closing the HTML link.  

To assign completions to a group 

1. Click Demographic Groups > Assign Completions on the navigation bar. 

2. In Course, select the desired assignment. 

3. If desired, select additional demographic filters for Department, JobRole, Region, and User 
Status.  

4. Click Submit to generate a list of learners with the course assigned. 

5. In Date Complete, enter the date for the completion.  

6. If desired, enter information in the Comment field.  

7. In the left column, select the checkbox corresponding to each learner who completed the 
assignment. To select/clear all learners in the list, select Select/Unselect All.  
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8. (Optional) In Score, enter the learner's test score for the assignment.  

9. Click Submit. 
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Learning Programs 

A learning program is a group of courses that you can assign to users or groups, and designate 
completion requirements for, such as complete all, complete in order, or minimum duration in hours. A 
learning program can have multiple folders assigned to it, each with its own completion requirements. 

Administrators can: 

 Create a learning program 

 Assign a group of courses to it 

 Designate completion requirements for the learning program 

The assignment of a learning program allows the Administrator to follow the current process of 
creating an assignment for a user or group, and at the time of assignment set the conditions in which 
the Learning Program is successfully completed, such as type, passing threshold, and number of days 
to complete the assignment.  

Note: The Passing Threshold value for a learning program is applied to each course within the 

learning program; it is not a cumulative passing threshold. 

The user’s learning plan displays a single title for each learning program, with (LP) displayed after the 
title. If you click the Learning Program name, the information about the Learning Program is displayed, 
including the Description. 

If a Learning Program assignment is edited after it has been assigned to users, the following rules 
apply: 

 If the Learning Program has been completed, the users will not have to complete based 

upon any updates to the Passing Threshold, and the Learning Program will stay marked 

as "completed". 

 If the Learning Program has been partially completed, any courses that had met the 

passing threshold prior to the change will not be subject to the new passing threshold. 

 Any courses in the Learning Program that have not been completed will now need to meet 

the updated passing threshold percentage. 

 If the Learning Program passing threshold is lowered and, based upon that lowered 

threshold a user would now be eligible to pass a course, the user must re-launch the 

course in order to receive an updated completion status. 

 Only custom Learning prerequisites may be edited. Certain Learning Programs such as 

"HAZWOPER Annual 8-hour Refresher" are defined and provided by Skillsoft and cannot 

be customized. To edit these Learning Programs, an administrator must first copy the 

Learning Program and then edit the contents.  

 A Learning Program cannot be edited after it is assigned to a user or demographic group. 
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Learning Plan Assignments 

Initial Training 
There are two ways a user can receive Initial Training. The most common way is when the user 
receives the course assignment for the first time. This can occur either when a user is added or when 
a user is placed into a Demographic Group having the course assignment. In either case, the user has 
never had this course assigned during his history. 

The second way a user can receive Initial Training is when the course is assigned to the user following 
a previous assignment of the same course, but the previous assignment has been removed or no 
longer exists. In this case, a user may have had a previous completion, but that completion is no 
longer valid. 

Examples 

1. New Assignment: John Doe is added on 1/1/2013 after being hired. All courses assigned to 
John Doe are Initial Training. 

2. Re-assignment: Jane Doe was a supervisor in 2010, and completed Behavior-based Safety 
for Supervisors. 

In 2011, Jane changed job functions, and Behavior-based Safety for Supervisors was no 
longer required for her. As a result, her previous course completion was classified as history. 

In 2013, Jane once again moved into a supervisory role, and Behavior-based Safety for 
Supervisors was again required for her job function. The new course assignment is required 
annually, so her 2010 completion is not valid. As a result, her 2013 assignment will be 
assigned as Initial Training. 

 

Stringency Rules 
Learners are often part of several different training groups and can have individual training 
requirements assigned as well. As a result, a learner may have the same course assigned multiple 
times. Overlapping training requirements may have different settings for initial training, recurrences, 
due dates, and retraining windows. 

Multiple listings in a user’s learning plan can be confusing, especially if due dates are not the same. 
Therefore, only one assignment of the course is displayed on the user’s learning plan from any 
overlapping Advanced Compliance assignments. Skillport determines which assignment to display by 
using a process called stringency. 

The application of stringency rules for a group or individual determines which one of multiple training 
assignments takes precedence over the others. Individual training assignments always take 
precedence over assignments made through a group. This gives an administrator the option to make 
exceptions at an individual level. 

Stringency rules apply in the following order of descending precedence: 

Training Requirement Property Precedence 

Individual or Group Requirement Individual Requirement is more stringent 

Required or Optional Required is more stringent 

Training Type  Recurring by Completion Date (RCD) is 

most stringent 

 Recurring by Due Date (RDD) 

 One Time Only (OTO) is least stringent 
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Validity in Days The shortest validity or recurring period is more 
stringent 

Due Date (for RDD requirements only) The earliest due date is more stringent 

Assessment minimum score The highest minimum score is more stringent 

Although the learner only sees one assignment, all the unseen assignments for the same course 
remain in the system as unique group or individual training requirements; training requirements are not 
combined to form a hybrid requirement. When a training requirement is determined more stringent, all 
parameters for that particular requirement are given to the learner.  

For instance, a Required assignment for Back Safety is more stringent than an Optional assignment 
for Back Safety. If the Required assignment has a passing threshold of 80%, the learner will be 
required to achieve at least 80% on the course exam, even if the Optional assignment has a 100% 
passing threshold. This same decision hierarchy applies when determining how an inherited 
assignment may be edited at the group level. For example, an administrator may edit an optional 
assignment to Required but cannot edit a required assignment to Optional. When the administrator 
changes the assignment to Required, he can also make other options less stringent (for example, 
change the Optional RCD to a Required RDD). 

Example: 

Jane Smith is a member of the following demographics:  

Location: Knoxville 

Job Role: Welder 

Division: East  

She has received several training requirements for Fire Safety: 

Assignment #1: Individual training requirement that is Optional 

Assignment #2: Group training assignment for the Welders Training Group that is Required 
by Due Date (RDD) in 90 days 

Assignment #3: Group training requirement for Knoxville/East Training Group that is Required 
by Completion Date (RCD) in 180 days  

When Jane opens her learning plan, she will see that she has Fire Safety as an Optional course with 
no due date. This was the individual training Assignment #1, which takes precedence over any Group 
requirements. 

If the Training Administrator decides that the course is required, he can either delete the individual 
training requirement or change its parameters. If Jane’s individual training assignment #1 were 
deleted, when she opens her learning plan, she will see that the two remaining Group requirements for 
Fire Safety are both Required. Assignment #3 is RCD, which takes precedence over RDD in 
assignment #2. Jane would now see that Fire Safety was a required course due in 180 days. 
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Inherited Learning Plan Assignments 
If a learning plan assignment has been established for a particular demographic category (for 
example, Site), all subsequent demographic groups associated with Site will inherit the learning plan 
assignment and the learning plan assignment information (such as passing threshold and due date). 
Learning plan assignments that are inherited from another demographic group are indicated in gray, 
and the source demographic group for the inherited requirement is indicated in parentheses after the 
course title. You can make an inherited learning plan assignment more stringent (for example, by 
entering a higher passing threshold or earlier completion date), but you will not be able to specify less 
stringent requirements. 

Note: Learning plan assignments made at the individual level take precedence over all group 
assignments made to a user for the same course. Therefore, it is possible to make a learning plan 
assignment less stringent for a user at the Individual learning plan assignment level. For more 
information, see Stringency Rules.  

Example: 

John Doe is an office administrator in a Houston manufacturing facility. All Houston employees must 
complete Electrical Safety annually, as assigned through the demographic group "Houston". However, 
office employees only need Electrical Safety every 2 years. By editing the inherited Electrical Safety 
assignment at the Individual level for John Doe and setting the validity period to 2 years, he will only 
be required to complete the course every 2 years regardless of the annual requirement at the 
"Houston" level. 

 
 

Removal of Prior Course Starts 
Each Advanced Compliance site has a setting that is used to identify and remove old course starts. 
The number of days is configurable. By default, all sites are set to 3 years, but you can contact your 
Skillsoft representative to request a different period of time. The purpose of this feature is to prevent 
the "linking" of old course starts to new, more stringent course requirements. A process runs nightly to 
check for any course start (never completed) older than the specified time period, and these starts are 
reset. 

Example:  
A user has Ergonomics Awareness assigned as "optional" in 2014 and starts the course at that time. 
In 2015, the course becomes required for that individual. It would not be wise for partial progress from 
over 3 years ago to be maintained. This course start would be removed by the nightly processor at the 
point of expiration determined by the setting in Advanced Compliance. 
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Editing Demographic Group Due Dates and Learning Assignments 

Editing Demographic Group Due Dates 

When editing a Recurring by Completion Date (RCD) requirement for a demographic group, due dates 
for users will be calculated from their previous completion date using the validity period specified by 
the administrator. If the validity or recurring period is modified, users' next due dates are recalculated 
accordingly. If the recurring period is increased, making a user’s previous completion valid for the new 
period, the previous completion will be removed from history and re-linked to the current open 
requirements.  

When editing a Recurring by Due Date (RDD) requirement for a demographic group, due dates for 
users are based on the specified calendar date. Users who have completed the learning plan 
assignment will retain their current completion and associated due date until the next assignment 
comes due. Based on the number of days specified for the course to be made available for retraining, 
the completed learning plan assignment will be moved to history and a new requirement added to the 
user’s learning plan with the due date specified. 

Note: All users in Initial Training are not affected by changes to the Assignment Type due dates 
unless the recurring period is modified in such a way that the user’s previous completion, if one exists, 
becomes valid. Otherwise, users in Initial Training maintain due dates set by the Initial Training 
parameters. Modifying the values for Initial Training will update the due dates for all users in Initial 
Training. 

Editing Demographic Group’s Learning Plan Assignment Info (due date doesn’t 

change) 

When an administrator edits any learning plan assignment field other than the due date, users who 
have not completed the learning plan assignment or who have not begun training will automatically 
receive the new learning plan assignment information. Those users who have completed the training 
will receive the newly established assignment information upon retraining. 

 
 

Create a Learning Program 

To create a learning program 

1. Click Content > Learning Programs on the navigation bar. 

2. On the Learning Programs page, click Add. 

3. On the Add/Edit Learning Program Info page, enter the learning program information in each 
field (if applicable): 

Field Description 

Course Title Enter the  learning program title as you want it to display in the 
learning plan. 

Course Number If you use a numbering system to catalog your  learning program, 
enter the  learning program number. 

Library Enter the  learning program category (for example, Human 
Resources, Ethics, or Environmental, Safety and Health). 
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Version Enter a version number to help you track the most recent version of 
the learning program. 

Delivery Method Indicates that this is a Learning Program (LP). You cannot edit this 
field. 

Date Added Displays the date the learning program was added. 

CEU Specify Continuing Education Units (CEUs) that may be earned for 
completion of this learning program. CEUs are included in .csv 
versions of the Training Status, Exemptions/Equivalencies, and 
Completions Only reports for Users and Groups. 

Cost If you track cost for learning program, enter the cost for the user to 
complete the learning program here. Cost is shown on the Training 
Status report.  

Estimated Duration Enter the estimated time to complete this learning program.  

Objectives Enter the learning objectives for the  learning program. 

Intended Audience Enter the target audience for this training. 

Description Enter a brief description of the learning program. 

Approved Date Enter the date the learning program was approved. This allows you to 
keep track of the most recent version of the learning program. 

Equivalency If you select No for equivalencies, equivalencies cannot be assigned 
for this  learning program for any reason. 

Exemption If you select No for exemptions, exemptions cannot be assigned for 
this learning program for any reason. 

Client Drivers Enter any procedures or policies that relate to this learning program. 

Related Drivers Enter all related procedures or policies related to this learning 
program. 

Primary Drivers Enter all regulatory drivers related to this learning program. 

Author Enter the name of the author or owner of the  learning program 
content. 

4. Click Save and Add Content. 

The Edit Learning Program Content page displays. 

5. In the left pane, in Course Catalog Types, select the course type you want to use, either All, 
WBT Courses, or Non-WBT Courses.  

6. To search for a course, enter a full or partial course title in Filter by Course Title. 

7. Select a course title, then click ADD. The course title displays under the title of the learning 
program.  

8. Continue adding courses as needed.   

9. Click Save.  
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10. In the right pane, in Completion Requirements: 

a. Select Complete All or Complete All in Order. 

b. If desired, enter a value (in hours) in Minimum Time Spent. 

NOTE: If a folder is selected, Complete All or Complete All in Order applies to the courses 

in the folder. 

11. (Optional) To create multiple folders for Learning Program contents: 

a. Click New Folder, then enter a folder name.  

b. Select Complete All, Complete All in Order, or Optional.  

c. Click Save. 

NOTE: Courses included in a Learning Program share the same training requirement 

information (such as Date Due, Passing Threshold, and Validity set at the time of assignment). 
 

Edit a Learning Program's Contents 

You cannot edit the completion requirements or content of a learning program that is currently 
assigned to a user or group.  

To edit contents of a learning program 

1. Click Content > Learning Programs on the navigation bar. 

2. In the Learning Program list, select the radio button next to the learning program you want to 
edit.   

3. Click Edit Contents. 

The Edit Learning Program Content page displays. The contents of the selected learning 
program display in the right pane. 
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4. In the right pane, in Completion Requirements: 

a. Select the completion criteria, either Complete All or Complete All in Order. 

b. If desired, enter a value (in hours) in Minimum Time Spent. This value is the minimum 
amount of time that must be spent in this learning program in order to meet the completion 
requirements. 

5. To create a new folder: 

a. Click New Folder. 

b. In Folder Name, enter a name for the folder. 

c. Select the folder completion criteria, either Complete all items, Complete all items in 
order, or Optional items. 

d. Click Save.   

6. To add a course to the learning program: 

a. In the right pane, click the folder to which you want to add a course.  

b. In the left pane, select the desired course, then click Add. 

7. To edit folder contents: 

a. Click the folder name, then click Edit Folder.  

b. Modify the folder name and completion options as desired, then click Save. 

8. To delete a course or folder, click the course or folder name, then click Remove.  

9. To change the order of a course or folder in the list of Learning Program Contents, click the 
course or folder name, then click Up or Down.   

10. Click Save. 
 

Copy a Learning Program 

If an existing learning program closely resembles the desired program, you can copy the existing 
program and modify its contents as needed. 

To copy a learning program 

1. Click Content > Learning Programs on the navigation bar. 

The Learning Programs page displays. 

2. In the Learning Programs list, select the radio button next to the learning program you want to 
copy. 

3. Click Copy. 

The Add/Edit Learning Program Info page displays. 

4. Modify the learning program properties as desired. Fields displayed in gray cannot be edited. 
For more information about the properties, refer to Create a Learning Program.  

5. Click Save & Add Content. 

The Edit Learning Program Content page displays.  
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6. Edit the learning program's contents, as desired. 

7. Click Save. 
 

Inactivate a Learning Program 

When a learning program is inactivated, it is removed from all learning plan assignments. 

To inactivate a learning program 

1. Click Content > Learning Programs on the navigation bar. 

The Learning Programs page displays.  

2. In the Learning Programs section, select the radio button in the left hand column next to 
learning program you want to inactivate. 

3. Click Inactivate. 

A message displays informing you that all assignments for the learning program will be 
removed and the learning program will no longer display in the list on the Learning Programs 
page. 

4. To inactivate the learning program, click OK. 
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Content 

You can view the Library listing of all courses available to your Advanced Compliance feature set, and 
also add non-Web-based (non-WBT) training course titles that can be assigned as learning plan 
assignments. For example, you can add a video title or classroom training as a learning plan 
assignment.   

You can also do the following:  

 Create a Learning Program, assign courses to it, and designate completion requirements, 

such as Complete All, Complete in Order, and Minimum Duration. A learning program can 

consist of multiple folders, each with its own completion requirements.  

 Create Prerequisites, which allow you to make assignments to be completed in a certain 

order. You can create a collection of learning assets with a defined structure and completion 

criteria.  

 Designate Equivalent Courses. Equivalent Courses are defined so that when one course is 

completed, the requirement for the equivalent course is marked with an EQ (equivalency) and 

removed from the user's Learning Plan. 
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Library 

The library contains a list of all training courses (Web-based training (WBT) and non-WBT) as well as 
information on each course in your Advanced Compliance site. This feature provides a convenient 
method to create additional courses, links to documents, or other assets that may be offered to your 
users through a delivery method other than the Web. For example, you can add a video title or 
classroom training to the library so you can assign it as a learning plan assignment. In addition, you 
can edit existing course information.  

To access the library, click Content > Library on the navigation bar. 

To search the library, enter the search criteria in the Filter Course Titles field, then click Filter. You 
can enter a full course title, a partial title, or partial words. 
 

View Course Information 

To view course information 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In either the Non-WBT Courses list or the WBT Courses list, select the radio button in the left 
hand column for the desired course. 

3. Click Course Info to display the course information. 
 

Edit Course Information 

To edit course information 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In either the Non-WBT Courses list or the WBT Courses list, select the radio button in the left 
hand column for the desired course. 

3. Click Edit Course. 

4. On the Add/Edit Course page, edit the course information. Refer to Add a New Course to the 
Library for a description of each field. 

Note: Depending on the course type, certain fields will be disabled and cannot be edited. 

5. Click Add.  
 

Add a New Course to the Library 
You can add a new course, with a non-WBT delivery method, to the library. For example, you can add 
company procedures, video titles, or classroom training, and then assign the content as part of your 
learning program.  

Note: Courses added to a non-WBT library will not utilize the SCORM or AICC standards. To 
communicate with the Advanced Compliance system, completions must be entered by the 
administrator or uploaded through an import process. For courses with an HTML link delivery method, 
users can confirm that the course was accessed to achieve a completion. 

To add a new course to the library 

1. Click Content > Library on the navigation bar. 



128 ©2015 Skillsoft Skillport 8 Administrator Guide 

 

 Users and Groups 
 
 

2. In the Non-WBT Courses section, click Add Course to Library. 

3. On the Add/Edit Course page, enter the course information in each field (if applicable): 

Field Description 

Course Title Enter the title as you want it to display in the learning plan. 

Course Number If you use a numbering system to catalog your courses, enter the 
course number. 

Library Enter the course category (for example, Human Resources, Ethics, 
or Environmental, Safety and Health). 

Version Enter a version number to help you track the most recent version of 
the course. 

Delivery Method Indicate the course training method, such as video, classroom, or 
CD. If you add a course with delivery method HTML Link, you can 
also specify a URL which the user can launch from his learning plan. 

Link to this URL  Displays for delivery method HTML Link only. If the course delivery 
method is HTML Link, enter the URL that users should be directed to 
from the learning plan.  

Completion Dialogue For HTML links, there are three options: 

 Manual Entry: Course completions may be entered by the 

administrator, just as other non-WBT completions are 

entered. 

 Completion Dialogue: The user is presented with a dialog 

box after the HTML content is displayed. The user can either 

Confirm that he has reviewed the material or Cancel to exit 

without generating a completion. If the user confirms review 

of the material, a completion is automatically created for that 

HTML link and the link is moved to the completed section of 

the user’s learning plan. 

 Do not show Completion Dialogue: The course is marked 

complete immediately after the user launches the link, and no 

confirmation dialog box is shown. 

Date Added Displays the date the course was added to the library. 

CEU Specify Continuing Education Units (CEUs) that may be earned for 
completion of this course. CEUs are included in .csv versions of the 
Training Status, Exemptions/Equivalencies, and Completions Only 
reports for Users and Groups. 

Cost If you track cost for courses, enter the cost for the user to complete 
the course here. Cost is shown on the Training Status report.  

Estimated Duration Enter the estimated time to complete this course.  

Objectives Enter the learning objectives for the course. 
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Intended Audience Enter the target audience for this training. 

Description Enter a brief description of the course. 

Approved Date Enter the date the course was approved. This allows you to keep 
track of the most recent version of the course. 

Equivalency If you select No for equivalencies, equivalencies cannot be assigned 
for this course for any reason. 

Exemption If you select No for exemptions, exemptions cannot be assigned for 
this course for any reason. 

Client Drivers Enter any procedures or policies that relate to this course. 

Related Drivers Enter all related procedures or policies related to this course. 

Primary Drivers Enter all regulatory drivers related to this course. 

Author Enter the name of the author or owner of the course content. 

1. Click Add. 
 

Inactivate a Course 
You can only inactivate non-WBT courses. When a course is inactivated, it is removed from all 
learning plan assignments, learning programs, and prerequisites. 

To inactivate a course 

1. Click Content > Library on the navigation bar. 

The Library page displays.  

2. In the Non-WBT Courses section, select the radio button in the left hand column next to the 
desired course. 

3. Click Inactivate Course. 

4. When the message displays asking if you want to continue, click OK. 
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Completion Criteria 

A course's completion status is checked when results are posted to the Skillport database. This 
typically occurs when a learner finishes a session and closes a course. The learner's results are 
compared to the course's completion criteria to determine the course's completion status. A course is 
either COMPLETE (the learner has met the criteria) or STARTED (the learner has started the course 
but not yet met the criteria). 

You can define global (company-wide) and course-specific completion criteria for Advanced 
Compliance courses. 
 

Set Global Completion Criteria 
You can set global (company-wide) completion criteria that learners must meet in order to complete 
any course in the Advanced Compliance Library. 

Note: If you have also set course-specific completion criteria for one or more courses, the course-

specific criteria supersede the global criteria. 

To set global completion criteria 

1. Click Content > Completion Criteria on the navigation bar. 

The Completion Criteria page displays. 

 

2. In the Global Criteria section, click Edit Contents. 
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The Completion Criteria dialog box displays. 

 

3. Change the completion criteria as needed. For help with this step, see Completion Criteria 
Settings. 

4. Click Save. 

5. Contact Skillsoft Technical Support and request that your company's database be re-
summarized. 

 
 

Set Course-Specific Completion Criteria 
You can set course-specific completion criteria that learners must meet in order to finish one or more 
specific Advanced Compliance courses. Course-specific criteria overrides global criteria. 

To set course-specific completion criteria 

1. Click Content > Completion Criteria on the navigation bar. 
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The Completion Criteria page displays. 

 

2. In the Override Global Criteria section, locate the desired course(s). 

You can use the sorting options in the Override Global Criteria section to locate the course. 
You can also use the search fields at the top of the page. Only search categories for asset 
types for which completion criteria can be set are shown. 

3. Select the check box next to each desired course.  

4. Click Override Global Criteria.  

The Override Global Criteria dialog box displays. 

 

5. Change the criteria as needed. For help with this step, see Completion Criteria Settings. 

6. Click Save. 



Skillport 8 Administrator Guide ©2015 Skillsoft  133 
 

Users and Groups   
 
 

7. If there are existing course completions that have not yet been preserved (frozen), you are 
prompted to confirm that you want to change the criteria. Click OK to confirm, or click Cancel 
to discard the changes. 

8. Contact Skillsoft Technical Support and request that your company's database be re-
summarized. 

To remove course-specific completion criteria 

1. Click Content > Completion Criteria on the navigation bar.  

The Completion Criteria page displays. 

2. In the Override Global Criteria section, select the check box next to each course for which you 
want to remove course-specific completion criteria.  

3. Click Remove Override, and then click OK. 

4. If there are existing course completions that have not yet been preserved (frozen), you are 
prompted to confirm that you want to change the criteria. Click OK to confirm, or click Cancel 
to discard the changes.  

The selected courses revert to using the defined global (company-wide) criteria. 

5. Contact Skillsoft Technical Support and request that your company's database be re-
summarized. 

 
 

Completion Criteria Settings 
You can configure the following completion criteria settings for Advanced Compliance courses. 

Completion Criteria: Specify one of the following visitation criteria and, if desired, the minimum time 
duration. 

 Visitation 

 Achieve minimum test score OR visit all content pages: Learners can satisfy the 

Minimum test score and scoring model criteria OR page through all topics, whichever 

comes first.  

 Achieve minimum test score AND visit all content pages: Learners must satisfy the 

Minimum test score and scoring model criteria AND must page through all topics.  

 Achieve minimum test score: Content visitation is ignored. Learners must satisfy the 

Minimum test score and scoring model criteria. 

 Visit all content pages: Learners must page through all topics. The Minimum test score 

and scoring model criteria is ignored. 

If the course cannot be completed because there are no assessments or because of passive 
content, do not specify Achieve minimum test score AND visit all content pages or 
Achieve minimum test score. 
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 Minimum total time in course: Specify the minimum time duration (in hours and/or minutes) 

the learner must spend in the course to achieve completion. The Hours value must be an 

integer between 0 and 99, and the Minutes value must be an integer between 0 and 59. The 

default value is blank (no minimum specified). 

Configuration: Specify one or more of the following configuration options. 

 Scoring Model: The scoring model is the logic to apply when determining completion. There 

are 2 scoring models: 

 Each Test (lesson scoring): In order for the learner to complete the course, each lesson 

test must have a high score that meets or exceeds the value specified for Minimum test 

score. 

 Average (course scoring): In order for the learner to complete the course, the average of 

all lesson test scores must meet or exceed the value specified for Minimum test score. 

Tests that have not been attempted are scored as 0. 

 Maximum course test attempts: Allows you to specify the maximum number of attempts 

allowed for a learner to take a course test; after the maximum attempts is reached, the learner 

can request a course retake. You can enter an integer value from 1 - 99, or leave the field 

blank (unlimited attempts).  

 Visit all content pages prior to test access: When selected, prohibits the learner from 

directly accessing the test without first completing all the pages in the course. 

 Require users to complete all questions in each test: If you select this option, all questions 

must be answered in all tests in order to complete a course.  

When this option is selected, either Average + or Each Test + displays in the Model column 
in the Override Global Criteria list. 

 Disable forward navigation based on audio duration: When selected, the forward 

navigation for course pages is not enabled until the audio portion of the current page has 

completed and prevents the audio portion from being muted.  

Note: After you make changes to completion criteria, you must call Skillsoft Technical Support and 
request that your Skillport database be re-summarized. This updates the completion criteria, updates 
the summary data for all applicable courses, and reevaluates learners' completion status on all 
applicable courses based on the new criteria. 
 
However, if you do not want the changes to the completion criteria to affect learners who have already 
completed affected courses (based on the old completion criteria), first you must 1) freeze existing 
completions of the courses, and then 2) request that Skillsoft Technical Support re-summarize your 
Skillport database. Once this is done, you can change the completion criteria.  

 

Reset Course Test Attempts 
You can reset a course when a user has reached the maximum number of test attempts specified in 
the course completion criteria. The user must have the course reset to take the test again. You can 
also reset a course that is assigned to a demographic group. 

To reset a course test attempt for a user 

1. Click Users > Test Attempt Reset on the navigation bar. 

The Test Attempt Reset page displays. 
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2. To search for the user by Last Name, enter the first letter(s) of the last name.  

Or, use the drop-down menu to select a different search criteria.  

3. Click Find. A list of users matching your search criteria displays.  

4. Click the desired user name from the list. A list of courses requiring a reset are displayed.  

5. Click the Action check box next to the course you want to reset. 

6. In the Test Attempt Reset dialog box:  

a. Review the course information.  

b. If desired, add a Note.  

c. Click Save.   

To reset a course test attempt for a demographic group 

1. Click Demographic Groups > Test Attempt Reset on the navigation bar. 

The Test Attempt Reset page displays. 

2. In Course, select the learning plan assignment you want to reset. 

3. If desired, select additional demographic criteria.  

4. Click Submit. 

5. Click the Action check box next to the course you want to reset. 

6. In the Test Attempt Reset dialog box:  

a. Review the course information.  

b. If desired, add a Note.  

c. Click Save.  
 

Set the Player Logo 

You can modify the appearance of the Skillsoft Course Player (SCP) by uploading a custom logo or 
image. 

Note: The custom logo image specified in the Advanced Compliance Admin applies only to Advanced 

Compliance-assigned courses.  

To set the player logo for Advanced Compliance-assigned courses 

1. Click Content > Player Logo on the navigation bar. 

2. In Skillsoft Course Player Logo, select either option: 

  Use standard image: Displays the Skillsoft logo in the upper left corner of the SCP. 

  Use custom image: Displays your custom logo image in the upper left corner of the 

SCP. 
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3. For Use custom image, click Choose File to browse for the desired file, then click Upload to 
upload the image. 

Note: Recommended image dimensions are 62 pixels wide and 23 pixels high. Files are 

limited to 1.5 MB and jpeg formats only. 

4. Click Save. 
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Prerequisite Courses 

Prerequisites allow you to specify assignments to be completed in a certain order. You can create a 
collection of learning assets with a defined structure and completion criteria.  
 

Create Prerequisites 

To create prerequisites 

1. Click Content > Prerequisites on the navigation bar. 

The Create Prerequisites page displays. 

 

2. In the Select from Course Catalog drop-down list, select the course that should be 
completed last. 

3. Click Add.  

4. In the Select a Course required prior to <selected course> drop-down list, select the 
course that should be completed prior to the previous course.  

5. Click Add.  

6. If the completion of the previous course is a prerequisite for the completion of the selected 
course, select the Due Date of <Course Name> Based on Completion Date of selected 
course option. 

7. To add additional courses as prerequisites, repeat steps 4 through 6. 

8. Click Done when you are finished adding courses. 
 

Edit Prerequisites 

To edit prerequisites 

1. Click Content > Prerequisites on the navigation bar. 

The Create Prerequisites page displays. 

2. In the Courses with Courses Required Prior list, click Edit next to the prerequisite you want 
to edit. 

3. To add additional courses, select the course from the Select a Course required prior to 
<course name> list, then click Add.  
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4. To delete a course, click Delete next to the course name in the Courses Required Prior to 
<course name> list.  

5. Click Done. 
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Equivalent Courses 

You can designate equivalent courses so that when one course is completed, learners receive credit 
for the requirement after completing a different course. When a learner completes a web-based 
training (WBT) course or is granted a completion for a non-WBT, any equivalent course is marked with 
a status of EQ (equivalency) and is removed from the learner's Learning Plan. 

Note: For equivalent courses to apply to a learner, the learner must have assignments for both 
courses. A learner will not receive an equivalency automatically for any course not assigned to him, 
even if an equivalency relationship exists between the courses. 

Equivalency Direction 

Uni-directional (-->): When the first course selected is completed, an equivalency is generated for the 
equivalent course(s). However, if the second course (or courses) is/are completed first, it will not 
generate an equivalency for the first course. 

Bi-directional (<-->): When either course is completed, an equivalency is generated for the other 
course(s). 

Courses may be equivalent to more than one course, and in those cases, a completion for any of the 
courses results in EQs for all others in the group. However, EQs assigned automatically by the system 
for a course which has other equivalent courses do not result in EQs for the additional courses. This 
prevents "cascading" equivalencies. 

Example 1 

Back Safety is equivalent to Ergonomics Awareness and Office Ergonomics. Ergonomics Awareness 
is equivalent to Back Safety and Computer Ergonomics. 

A learner completes Back Safety. This learner will receive an EQ for Ergonomics Awareness and 
Office Ergonomics, but not for Computer Ergonomics. 

An equivalency or exemption assigned manually by an administrator on the Assign Exemptions and 
Equivalencies page functions the same as a completion, and any course set as equivalent will also be 
marked with an EQ. 

Example 2 

Back Safety is equivalent to Ergonomics Awareness and Office Ergonomics. Ergonomics Awareness 
is equivalent to Back Safety and Computer Ergonomics. 

An administrator grants a learner an Exemption for Back Safety. This learner will receive an EQ for 
Ergonomics Awareness and Office Ergonomics. 

 
 

Create Equivalent Courses 

To create equivalent courses 

1. Click Content > Equivalent Courses on the navigation bar. 
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The Create Equivalent Courses page displays. 

 

2. In the Select from Course Catalog drop-down list, select the course title for which you want 
to create equivalent courses. 

3. Click Add. 

4. On the Equivalent Courses page: 

a. Select the equivalent course title from the drop-down list. 

b. Select the equivalency direction, either uni-directional or bi-directional. 

c. Click Add. 

5. Repeat step 4 to specify additional equivalent courses. 

6. Click Done to return to the Create Equivalent Courses page. 

Any course with an associated equivalent course displays in the Courses with Equivalent Courses list 
at the bottom of the page. 

Note: When a course is set as equivalent to another, any user with an existing completion for either 
course will immediately receive an equivalency (EQ) for the second course. 

 

Edit an Equivalent Course 

To edit an equivalent course 

1. Click Content > Equivalent Courses on the navigation bar.  

2. On the Equivalent Courses page, in the Courses with Equivalent Courses list, click Edit 
beside the desired course title. 

3. To add an associated equivalent course:  

a. Select the equivalent course title from the drop-down list. 

b. Select the equivalency direction, either uni-directional or bi-directional. 

c. Click Add. 
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4. To delete an equivalent courses, click Delete next to the desired course name in the Courses 
Equivalent to <Course Name> list. 

5. Click Done. 
 

Delete an Equivalent Course 
You can delete a course from its associated equivalent course.  

To delete an equivalency 

1. Click Content > Equivalent Courses on the navigation bar.  

2. On the Create Equivalent Courses page, in the Courses with Equivalent Courses list, click 
Edit next to the desired course title. 

The Edit <Course Name> Equivalent Courses page displays, with a list of equivalent courses 
for the selected course. 

3. Click Delete beside the equivalent course(s) you want to remove. 

4. Click Done. 

Note: If an equivalent course is deleted, any users who have been granted an EQ for that course as a 
result of completing the equivalent course will retain his equivalency.  

 

Exemption and Equivalency Expiration 

An equivalency (EQ) assigned to a learning plan assignment expire upon the learning plan 
assignment due date. 

Exemptions (EX) expire on the date specified by the administrator. Upon expiration, the learning plan 
assignment is displayed on the user’s Learning Plan under Current Training with a new due date equal 
to the previous due date + the "valid-for" period or the calendar-based (RDD) due date. 

If the learning plan assignment has been defined as one-time-only training, the EX/EQ never expires. 
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Questionnaires 

The Questionnaire tool is a powerful resource for creating compliance-related questionnaires, surveys, 
and policy certifications, all supported by the robust administrative functionality of Advanced 
Compliance. After a user submits the questionnaire, it is reviewed and optionally commented on. 
When creating a questionnaire, certain questions can be marked as variant. This enables the reviewer 
to receive a notification when a user submits a non-standard answer. 

Administrators can: 

 Create and edit a questionnaire 

 Assign a questionnaire to a user or demographic group 

 Review a user's answers to a questionnaire and make comments 

 Run a questionnaire report for a user or demographic group 

 

Create a New Questionnaire 

Note: While creating a questionnaire, click Save Draft periodically to save it as a draft without 

activating it. Questionnaires cannot be assigned unless they have been activated. 

To create a new questionnaire 

1. Click Content > Questionnaires. 

The Questionnaires page lists all the questionnaires you have created. 

2. On the Questionnaires page, click New Questionnaire. 

3. Specify information about the questionnaire. 

4. Click the Info tab. 

5. Enter information in the fields as described below: 

Field Description 

Name Enter a unique name for the questionnaire. This is a required field.  

ID Displays the questionnaire ID. This value cannot be modified. 

Title Enter the title you want to display in the learning plan. This is a 
required field.  

Questionnaire Number If you use a numbering system to catalog your questionnaires, 
enter the questionnaire number. 
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Version Displays the version number of the questionnaire.  

When you first create a questionnaire, it is automatically assigned 
version 1. Each time you edit and save the questionnaire, the 
version increments automatically (version 2, version 3, and so on).  

Versioning helps track the historical records of users who have 
taken this questionnaire. When you run a report, you can see which 
users took which version of the questionnaire.  

Author Enter the name of the author or owner of the questionnaire content. 

Reviewer Email Enter the email address of the person who will review user 
responses to the questionnaire.  

Created On Displays the date the questionnaire was created. This value cannot 
be modified. 

CEU Specify Continuing Education Units (CEUs) that may be earned for 
completion of this questionnaire.  

Cost If you track cost, enter the cost for the user to complete the 
questionnaire. Cost is shown on the Training Status report.  

Estimated Duration Enter the estimated time to complete this questionnaire. 

Library Select the questionnaire category from the drop-down list (for 
example, Human Resources or Food Safety). 

Delivery Method Displays how the questionnaire is delivered to the user. This value 
is Web-based Training and cannot be modified. 

Objectives Enter the objectives for the questionnaire. 

Description Enter a brief description of the questionnaire. 

Intended Audience Enter the target audience for the questionnaire. 

Primary Drivers Enter all regulatory drivers related to this questionnaire. 

Client Drivers Enter any procedures or policies that relate to this questionnaire. 

Related Drivers Enter all related procedures or policies related to this questionnaire. 

Exemption By default, exemptions are allowed. If you select Disallow 
Exemptions, exemptions cannot be assigned for this questionnaire 
for any reason. 

Equivalency By default, equivalencies are allowed. If you select Disallow 
Equivalencies, equivalencies cannot be assigned for this 
questionnaire for any reason. 

Policy Explanation Enter the text to display to the user before they begin taking the 
questionnaire. 

Policy Document Identifies the policy for the user to review that is associated with the 
questionnaire.  

Either enter the URL to the policy or click the link to upload  the 
document. You can only upload PDF files less than 10 MB. 
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Standard Completion Message Enter the text to display to the user after he has submitted his 
questionnaire responses.  

Variant Completion Message Enter the text to display to the user if he has submitted any variant 
responses. This completion message will display instead of the 
standard completion message. 

6. Click Save Draft. 

7. Add questions and answers to the questionnaire. 

8. Click the Questions tab. 

9. To add a question, click the  icon.  

10. Click the Click here to edit this question link. 

11. In the Question {N} Properties dialog box, specify the following information: 

 Number: If you have multiple questions, use this property to reorganize the order of the 

questions.  

 Response: Select whether or not the response is Required or Optional. By default, every 

question is required.  

 Response Type: Select the method for responding to the question, either Checkbox 

(user can select multiple choices from a list), Multiple Choice (user can select only one 

response from a list), or Text Response (user can write his own response). 

 Max Checks (Optional): If using the Checkbox response type, enter the maximum 

number of choices the user can select. 

 Question: Enter the question text.  

12. Click Apply. The question displays on the Questions tab.  

13. Click Add Answer.  

14. Click the Click here to edit this answer link.  

The Question {N}, Answer {N} Properties dialog box displays.  

 Number: Use this property to reorganize the display order of the answers. 

 Notify Reviewer: Enables you to determine if this response is a variant response. Select 

No if this response is standard (no email notification is sent). Select Yes if this response is 

non-standard (an email notification will be sent to the reviewer). 

 Answer Options: Specify further actions to take when the question is answered, either 

None (no further actions required), Create a series of follow-up questions (more 

questions will need to be answered), or Request further explanation ( 

 Answer: Enter the text for the answer to the question. 

15. Click Apply.  
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The answer displays below the question on the Questions tab.  

16. If applicable, click the  icon to add a follow-up question. 

17. To add more answers, click Add Answer and repeat steps 7 through 9. 

18. To add more questions, click the  icon either above or below the current question, 
depending on how you want to order the questions.  

19. Click Save Draft. 

20. Specify how the questionnaire will look when printed. 

21. Click the Print Options tab. 

 To add a page break before or after a question, click the corresponding Click to Force 

Page Break button. You may want to do this, for example, if a question prints on a 

separate page than the answers. 

 For questions with text responses, click the  icon to add an additional line for text or 

click the  icon to remove a line.   

22. Click Save Draft. 

23. Click Save & Activate. The questionnaire displays in the list on the Questionnaires page and 
is ready to be assigned.  

 

Edit an Existing Questionnaire 

To edit an existing questionnaire 

1. Click Content > Questionnaires. 

2. On the Questionnaires page, select the desired questionnaire from the list. 

3. Click Edit.  

4. Modify the information as desired.  

Note:  You cannot edit the ID, Version, and Delivery Method. You can edit the Name only if 

the questionnaire has not yet been activated.  

5. Click Save & Activate. 
 

Assign a Questionnaire 

You can assign a questionnaire to a user or a demographic group. Once assigned, the questionnaire 
displays in the user's Learning Plan and is launched in the same manner as a course. 

To assign a questionnaire to a user 

1. Click Users > Learning Plan Assignments.  

2. To search for the user by Last Name, enter the first letter(s) of the last name.  

Or, use the drop-down menu to select a different search criteria.  

3. Click Find. A list of users matching your search criteria displays.  
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4. Click the desired user name from the list.  

The Individual Learning Plan Assignments page displays. 

5. In Select from Library, click Questionnaire to filter the library to show only questionnaires. 

6. Select the questionnaire from the list.  

7. Click Add. The questionnaire assignment is added to the user’s learning plan.  

To assign a questionnaire to a demographic group 

1. Click Demographic Groups > Learning Plan Assignments.  

2. In the Demographic Group(s) list, click Assign for the desired group. 

The Learning Plan Assignments page displays. 

3. In Select from Library, click Questionnaire to filter the library to show only questionnaires. 

4. Select the questionnaire from the list.  

5. Click Add. The questionnaire assignment is added to the learning plan for all users in the 
demographic group.  

 

Review and Comment On a Questionnaire 

If you have been assigned as a reviewer, you can review and make comments on submitted 
questionnaires. You will also receive an email notification when a user's response to a particular 
question has been flagged as variant.  

To review a questionnaire for a user 

1. Click Users > Questionnaire Review. 

2. To search for the user by Last Name, enter the first letter(s) of the last name.  

Or, use the drop-down menu to select a different search criteria.  

3. Click Find. A list of users matching your search criteria displays.  

4. Click the desired user name from the list.  

5. On the Questionnaire Review page, select the desired questionnaire, then click View/Edit 
Comments.   

6. Review any variant responses, indicated by the  icon. 

7. To add a comment: 

a. Click the  icon next to the response. 

b. In the Add a Comment dialog box, enter the desired text, then click Add Comment. 

The  icon now displays next to the response.  

8. To view/edit a comment:  

a. Click the  icon next to the response.  

b. In the View/Edit Comment dialog box, edit the comment if desired, then click Update. 
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9. Click Save Comments.  
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Reports 

Use the Reports functionality to view and print training records for individual users and demographic 
groups. For most reports, you can sort by user, or filter by demographics, status, or group by dates.  

The Create a New Report page is organized by report types: 

 Group Reports 

 User Reports 

 E-mail Notification Reports 

 General Administrative Reports 

To access reports, click Reports on the navigation bar. 
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Report Types 

Group Reports 
You can generate and view the following types of group reports from the Reports page: 

Group Report, Completions Only 

Run this report to view all training completed by a group of users. This report also includes training 
that was granted an exemption or equivalency. The filters available for this report are course title, 
course status, delivery method, demographic labels, training type, user status, and date. The 
groupings available for this report are course (default) and user. Output types available are web 
browser, .PDF, and .CSV (optionally, demographic labels may be included).  

Note: If a date filter is specified for this report, the filter is applied to the users’ completion dates. 

Group Report, Exemptions/Equivalencies Only 

Run this report to view exemptions and equivalencies issued to users. This report also includes the 
justification text entered for the exemptions and equivalencies. The filters available for this report are 
course title, course status, delivery method, demographic labels, training type, user status, and date. 
The groupings available for this report are course (default) and user. Output types available are web 
browser, .PDF, and .CSV.  

Note: If a date filter is specified for this report, the filter is applied to the date the exemption or 

equivalency was granted. 

Group Report, Training Status 

Run this report to view the training status by a group of users. The report includes courses that are 
overdue, not started, in progress, and completed. This report also includes learning plan assignments 
that were granted an exemption or equivalency. The filters available for this report are course title, 
course status, delivery method, demographic labels, training type, training status, user status, and 
date. The groupings available for this report are course (default) and user. Output types available are 
web browser, .PDF, and .CSV (optionally demographic labels may be included).  

Note: If a date filter is specified for this report, the filter is applied to the users’ due dates. Not-started 
optional course assignments are not returned in this report. 

 

User Reports 
You can generate and view the following types of user reports from the Reports page: 

Note: You can also run user reports from the User Information page. 

User Report, Completions Only 

Run this report to view all training completed by an individual user. This report also includes training 
that was granted an exemption or equivalency. The filters available for this report are course title, 
course status, delivery method, demographic labels, training type, user status, and date. The 
groupings available for this report are alphabetical by course title or sorted by completion date. Output 
types available are web browser, .PDF, and .CSV.  

Note: If a date filter is specified for this report, the filter is applied to the user’s completion dates. 
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User Report, Exemptions/Equivalencies Only 

Run this report to view exemptions and equivalencies issued to users. This report also includes the 
justification text entered for the exemptions and equivalencies. The filters available for this report are 
course title, course status, delivery method, demographic labels, training type, user status, and date. 
The groupings available for this report are alphabetical by course title or sorted by completion date. 
Output types available are web browser, .PDF, and .CSV.  

Note: If a date filter is specified for this report, the filter is applied to the date the exemption or 

equivalency was granted. 

User Report, Training Status 

Run this report to view all training completed by an individual user. The report includes courses that 
are overdue, not started, in progress, and completed. This report also includes learning plan 
assignments that were granted an exemption or equivalency. The filters available for this report are 
course title, course status, delivery method, demographic labels, training type, training status, user 
status, and date. The groupings available for this report are alphabetical by course title or sorted by 
completion date. Output types available are web browser, .PDF, and .CSV. 

Note: If a date filter is specified for this report, the filter is applied to the user’s due dates. Not-started 

optional course assignments are not returned in this report. 

Learning Plan Assignments by User 

Run this report to view a list of learning plan assignments associated with user. The learning plan 
assignments are further identified by delivery method, valid period, passing threshold, test-out, test-out 
threshold, pretest, required/optional, original due date, assignment type (RCD/RDD), due date (for 
RDD requirements), retraining due date, and group where assignment was made. Output types 
available are web browser, .PDF, and .CSV.  

User Report, Learning Plan 

Run this report to view a list of learning plan assignments associated with user. The learning plan 
assignments are further identified by delivery method, valid period, passing threshold, test-out, test-out 
threshold, pretest, required/optional, original due date, and assignment type (RCD/RDD). 
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Email Notification Reports 
Data for email reports are maintained for 6 months. Reports may be filtered for a shorter time period 
(for example, those sent in the past 7 days), but data older than 6 months cannot be returned and 
viewed in reports. 

You can generate and view the following types of email notification reports from the Reports page: 

User Report, Email 

Run this report to view a list of all emails sent to a user. You can filter by email type and by period of 
time (for example, sent in last 7 days). This report includes email title, user name, user ID, user email 
address, date the email was sent, and if the email is recurring. Output types available are web 
browser, .PDF, and .CSV. 

Group Report, Email 

Run this report to view a list of emails sent to a group of users. You can filter the list by user status, 
email type, period of time and job function. This report includes email title, user name, user ID, user 
email address, date the email was sent and if the email is recurring. Output types available are web 
browser, .PDF, and .CSV. 

Supervisor Report, Email 

Run this report to view a list of emails sent to supervisors. You can filter this report by period of time. 
This report includes email title, email address of the supervisor, date the email was sent, and if the 
email is recurring. Output types available are web browser, .PDF, and .CSV. 

Administrator Report, Email 

Run this report to view a list of emails sent to administrators. You can filter this report by period of 
time. This report includes email title, email address of the administrator, date the email was sent, and if 
the email is recurring. Output types available are web browser, .PDF, and .CSV. 

Invalid Email Report 

Run this report to view all emails flagged as "failed" due to an invalid or malformed email address. You 
can correct email addresses for users, supervisors, or administrators identified here by clicking Email 
Notifications > Address Mgmt. Output types available are web browser, .PDF, and .CSV. 
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General Administrative Reports 
You can generate and view the following types of general administrative reports from the Reports 
page: 

Equivalent Courses (Web Only) 

Run this report to view a list of equivalent courses. 

Unused Demographics (Web Only) 

Run this report to view a list of demographics that have not been assigned to users or used to create 
demographic groups. 

Demographics Summary (Web Only) 

Run this report to view a list of demographic categories and demographic names. 

Users by Demographic 

Run this report to view a list of users associated with a demographic or several demographics. The 
users are identified by User ID, name, and user status. 

User Information Report 

Run this report to view all information associated with a user including User ID, security level, email 
address, supervisor’s email address, user status, and associated demographics. The filters for this 
report are demographics and user status. Output types available are web browser, .PDF, and .CSV. 

Learning Plan Assignments by Demographic 

Run this report to view a list of learning plan assignments associated with each demographic group at 
any given time. The learning plan assignments are further identified with delivery method, 
required/optional, initial training period, assignment type (RCD/RDD), due date (for RDD 
requirements), passing threshold, test out, test out threshold, pre-test, and group where assignment 
was made. The filters for this report are course title and demographic labels. Output types available 
are web browser, .PDF, and .CSV. 

Users with Individual Learning Plan Assignments (CSV only) 

Run this report to view the learning plan assignments that were made on an individual basis. This 
report is only available in a .CSV format. Each learning plan assignment is identified with UserID, user 
name, course ID, course name, delivery method, validity (in days), passing threshold, test-out, test-out 
passing threshold, pre-test, required/optional, original due date, assignment type (RCD/RDD), whether 
it was assigned as a group or individual requirement, group where it was assigned (if applicable), and 
whether the group or individual assignment is most stringent (if applicable). 

Learning Plan Assignments Summary (CSV only) 

Run this report to view a list of training assignments by demographic names. 

Completion Summary by Demographics for Required Courses (CSV Only) 

Run this report to view completion summary data for required courses associated with each defined 
demographic group. 

Prerequisites (Web Only) 

Run this report to view the prerequisites which include the selected courses. 
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Questionnaire Reports 
You can generate and view the following types of questionnaire reports from the Reports page: 

User Report, Questionnaire Results 

Run this report to view all questionnaire responses completed by an individual user. The filters 
available for this report are questionnaire title, response type (all responses or variant responses only), 
and due date. Output types available are web browser, .PDF, and .CSV.  

Group Report, Questionnaire Results 

Run this report to view all users who have completed the specified questionnaire(s). The filters 
available for this report are questionnaire title, response type (all responses or variant responses only), 
and due date. Output types available are web browser, .PDF, and .CSV.  
 

Create a Report 

Note: Reports for an individual user can also be run from the User Information page. 

To create a report 

1. Click Reports on the navigation bar. 

The Create a New Report page displays. 

 

2. Click the desired report category to display the list of available reports.  

3. Click the report you want to create. 

4. On the <Report Name> page, specify the desired filter criteria needed to run your report 
query. The fields vary depending on the selected report.  

5. In Output, select how you want the report displayed: 

 Web Browser: Displays the report in your web browser for immediate viewing. 

 PDF: Displays the report in PDF format that may be viewed in your browser using the 

Adobe Reader plug-in. 
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 CSV: Displays the report in a comma-delimited format that may be uploaded into data 

management applications, such as Microsoft Excel. If desired, select the With 

demographics option to include user demographics in the report output.  

6. (Optional) To save the report, enter a name in Report Title, then click Save Report. 

7. Click Run Report. 

8. If the selected output is Web Browser, the report displays immediately on the Reports page.  

9. If the selected output is PDF or CSV, the Report Generation page displays.  

a. Click Back to Reports to access the report. The report information displays in the Current 
Reports section.  

Note: Depending on the file size, PDF and CSV report outputs may take several minutes 
to download. All report queries requested in PDF or CSV format remain on the Reports 
page for 48 hours. 

b. To view a report, click the Download link in the Action column for the desired report. 

c. To delete a report, click Delete in the Action column for the desired report, then click OK 
in the message that displays. 

 
 

Saved Reports 

For many report types, you can save search criteria.  

 To save a report type, enter a title for your report in Report Title, then click Save Reports.  

 To view your saved reports, click Saved Reports on the Reports page.  

A list of saved reports displays, with options to run, edit, and delete them. 
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Report Types 

The Compliance Reporting Dashboards enable administrators to display, manage, and customize 
compliance training program details.  

The dashboards provide a customizable graphical display of training data, such as training program 
health, training assignments and asset assignments, allowing administrators to quickly analyze metrics 
and monitor the overall health of their compliance training program.  

Administrators can: 

 Customize data views with multiple chart options. 

 Print or export detailed data in a variety of report formats. 

 Filter on a variety of parameters allowing for user flexibility when creating, saving, and 

modifying custom graphics.  

 Quickly gain insight into the key performance indicators that support your organization's 

training initiatives.  

 Specify filters for summarized reports on a variety of fields to include your demographic 

categories and content types.  

 Assess training status by monitoring assigned training, completions, overdue courses, and 

equivalencies. 

 

Note: The Reporting Dashboards feature is only available if it has been enabled on your site. 
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Configuring the Dashboard 

The first time you launch the dashboard, it displays default charts in a default layout. You can 
subsequently customize it to meet your needs. Use the Dashboard Configuration page to create and 
edit charts, configure dashboard settings and layouts, and publish or unpublish charts. 

To access this page, click Reports > Dashboard Configuration on the navigation bar. 

 
 

Create a New Chart 

To create a new chart  

1. On the Dashboard Configuration page, click New Chart. 

2. In the Create New Chart dialog box:  

a. Enter a Name for the chart. This field is required and is the name that displays on the 
dashboard above the chart. 

b. (Optional) Enter a Description of the chart.  

c. In Report Type, select the report you want to create. 

A description of the selected report displays below the Report Type field. 

d. Select the Chart Type. 

e. Click Next.  

3. Click Save.  

The chart displays on the Dashboard Configuration page as an unpublished chart. To include 
the chart on your dashboard, publish the chart. 
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Edit a Chart 
You can edit an existing chart to modify the name, description, report type, and filter selections. The 
edited version of the chart is saved as a copy; however, the Published/Unpublished status of the 
edited chart remains unchanged. Charts can be edited from either the Dashboard Configuration page 
and the My Dashboard page. 

To edit a chart 

1. From the Dashboard Configuration page: 

a. Click Reports > Dashboard Configuration on the navigation bar.   

b. Select the desired chart in the list, then click Edit.  

2. From the My Dashboard page:   

a. Click Reports > My Dashboard on the navigation bar.  

b. Click  in the upper-right corner of the desired chart, then click Edit. 

3. In the Edit Chart dialog box, modify the desired chart details.  

4. Click Next.  

5. Modify the demographic filter selections as desired, then click Next.  

6. Modify the assignment filter selections as desired, then click Next.  

A preview of the modified chart displays.  

7. Click Save. 
 

Copy a Chart 
You can save a copy of an existing chart by renaming it with a new title. The copied chart will initially 
have a status of Unpublished, regardless of the status of the chart from which it was copied. 

To copy a chart  

1. Click Reports > Dashboard Configuration on the navigation bar. 

2. On the Dashboard Configuration page, select the desired chart from the list, then click Copy. 

3. In the Copying dialog box, specify a new Name for the chart copy. 

4. Click Copy.  

The chart copy displays in the list. 
 

Delete a Chart 
You can no longer edit or publish a chart to your dashboard once you have deleted it. You must 
recreate the chart if it is subsequently needed. 

To delete a chart  

1. Click Reports > Dashboard Configuration on the navigation bar.  

2. On the Dashboard Configuration page, select the desired chart from the list.  

3. Click Delete.  
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4. When the message displays asking if you are sure you want to delete the chart, click Yes.  
 

Publish or Unpublish a Chart 
In order for a chart to display on the dashboard, you must publish it. You can publish a maximum of six 
charts at one time. 

If you want to remove a chart from displaying on the dashboard, you can unpublish it. Unpublished 
charts remain in the list on the Dashboard Configuration page and can be re-published at any time. 

To publish a chart 

1. Click Reports > Dashboard Configuration on the navigation bar.  

The Dashboard Configuration page displays with a list of charts that have been created.  

2. Select the chart that you want to publish, and click Publish.  

The chart status in the Published column changes from Unpublished to Published.  

To unpublish a chart 

 From the Dashboard Configuration page: 

i. Click Reports > Dashboard Configuration on the navigation bar.  

ii. Select the chart you want to unpublish. 

iii. Click Unpublish.  

 From the My Dashboard page: 

i. Click Reports > My Dashboard on the navigation bar. 

ii. Click  in the upper-right corner of the desired chart. 

The chart status in the Published column changes from Published to Unpublished.  
 

Configure Dashboard Settings 
You can specify settings to display your dashboard as the default Administrator landing page and 
reset the dashboard to the default view. 

To configure the dashboard settings 

1. Click Reports > Dashboard Configuration on the navigation bar.  

2. On the Dashboard Configuration page, click Settings. 

The Dashboard Settings dialog box displays. 

3. Specify the settings as desired:  

 Login to My Dashboard: This option is selected by default. When selected, your 

customized dashboard displays as the landing page when you log in to the administrator 

tasks. 

 Reset Dashboard: Select this option to reset the dashboard to the default configuration. 

Any custom charts you have published to the dashboard will be unpublished, and the 

layout will be reset. 

4. Click Save.  
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Configure Dashboard Layout 
You can customize your dashboard by using one of several available layouts that are based on the 
number of currently published charts.  

To configure the dashboard layout 

1. Click Reports > Dashboard Configuration on the navigation bar. 

The Dashboard Configuration page displays. 

2. Click Layout.  

3. In the Dashboard Layout dialog box, click Edit.  

4. In the Select a layout section, click the desired layout. The available layouts depend on the 
number of published charts. 

A template of the layout displays.  

5. From the list of your published charts, drag and drop each chart to the desired position in the 
template.  

6. Click Save.  
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Working with the Dashboard 

Use the My Dashboard page to view compliance training program data, edit charts, export charts as 
image files, and print charts. 

To access this page, click Reports > My Dashboard on the navigation bar. 

 
 

View Chart Data 
You can view the data used to create an individual chart.  

To view chart data 

1. On the My Dashboard page, click  in the upper-right corner of the desired chart.  

2. Click View All Data.  

The chart data displays in a tabular format. You can view data such as user ID, name, course 
title, training status, due date and completed date. Each column in the spreadsheet can also 
be filtered using several different search criteria.  

3. To view additional pages of the chart data, use the navigation buttons (First Page, Previous 
Page, Next Page, and Last Page) below the table. 

4. Click  in the upper-right corner for options to edit the chart, view the chart, or export the data 
to a CSV file. 

5. To return to the dashboard view, click  in the upper-right corner. 
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Expand a Chart to Full Screen 

To expand a chart  

1. Click Reports > My Dashboard on the navigation bar.  

2. On the My Dashboard page, click  in the upper-right corner of the desired chart. 

The chart displays in full-screen mode. In this mode, you can click  in the upper-right corner 
to edit the chart, view the chart data, export it as an image, or print the chart. 

3. Click  to condense the chart and return to the dashboard view.  
 

Display Drill Down Chart Information 
Depending on the chart type, you can display the chart data for a selected section of the chart. 

To display drill down chart information  

1. Click Reports > My Dashboard on the navigation bar.  

2. On the desired chart, click on the desired section of the chart.  

The chart data displays in tabular format. 

3. Click  in the upper-right corner of the table to return to the dashboard view. 
 

Export a Chart as an Image 
You can save a chart that is displayed on the dashboard as a .png image file. 

To export a chart as an image 

1. Click Reports > My Dashboard on the navigation bar.  

2. On the My Dashboard page, click  in the upper-right corner of the desired chart, then click 
Export as Image. 

3. In the Save As dialog box, browse to the location where you want to save the file.  

4. In File name, specify a different file name if you do not want to use the default name. 

The default name is the chart title with the date appended to it. 

5. Click Save.  
 

Export Chart Data to a CSV File 
You can export detailed chart data to a file in .csv format. 

To export chart data 

1. Click Reports > Dashboard on the navigation bar.  

2. On the My Dashboard page, click  in the upper-right corner of the desired chart, then click 
View All Data.  

The chart data is displayed in tabular format. 

3. Click  in the upper-right corner of the table, then click Export CSV.  

You can either open the CSV file to view now or save the file to the desired location. The 
default file name is the chart name with the date and time appended to it. All chart data is 
included in the CSV file, not just the data that is currently displayed in the table. 
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Print a Chart 

To print a chart 

1. Click Reports > Dashboard on the navigation bar.  

2. On the My Dashboard page, click  in the upper-right corner of the chart you want to print. 

3. Click Print Chart.  

4. In the Print dialog box, select the desired options, then click Print. 
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Setup 

Use the Setup functionality to specify whether to use the automatic email notification system and to 
designate access levels for each of the administrative functions.  

 
 

Initial Setup 

The Initial Setup page allows you to specify whether or not you want to use the email notification 
system. If you activate the system, you can then configure it to send email notifications to learners, 
learners' supervisors, and the Administrator. If the system is not activated, no email notifications will 
be sent. 

To specify email notification system option 

1. Click Setup > Initial Setup on the navigation bar.  

The Initial Setup page displays. 

2. To activate the email notification system, select Yes in Do you want to use the email 
notification system?. 

3. If you do not want to activate the email notification system, click No. 

4. Click Submit. 

For information about creating custom emails, refer to Create and Edit a Custom Email. 
 

Security Setup 

The Security Setup option allows you to designate levels of access for each Advanced Compliance 
administrative page or function.  

There are four security access levels associated with Advanced Compliance: User, Manager, 
Administrator, and Company Administrator.  

Note: A security access level is based on the user’s role as defined in Skillport. To change a user’s 
security access level in Advanced Compliance, you must change that user’s role in User Management 
in the Skillport Administrator.  

For each administrative function, there are two levels of access: 

 Read Only: Allows the user to view a specific page or function, but the user is not permitted to 

make entries or edit existing information.  

 Read/Change: Allows the user to view the page and create or edit entries. 

A demographic delimiter enables you to limit what data is viewable by administrators. If you choose to 
use a demographic delimiter, administrators who have a security level at or below the selected level 
will only have access to users with the same demographic label as the administrator. 

To specify security access levels 

1. Click Setup > Security Setup on the navigation bar. 

The Security Setup page displays. 

2. To specify which security access levels can view the administrative functions menu, select the 
corresponding check box in the Admin Menu column in the Currently Defined Security 
Levels section. 
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3. To change the security access to a specific page or function, in the Assign Security Level to 
a Page or Function section: 

a. Select the lowest security access level of Read Only access for the desired page or 
function. 

b. Select the lowest security access level of Read/Change access for the desired page or 
function. 

Note: You cannot set the Read/Change access to a security access level lower than what 

is set for Read Access. 

4. To change the demographic delimiter:  

a. In Security level to which delimiting applies, select the desired security access level 
from the drop-down list. 

b. In Demographic to use as filter, select the desired demographic category from the drop-
down list.  

5. Click Submit. 
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Email Notifications 

Email Types 
The available email types are described below. Depending on the email type, certain fields can be 
customized. See Customizable Email Fields for more information.  

Initial Training Notice 

The initial training notice sends an email to users who have the Send Email to User option set to Yes 
and have an email address configured in their User Information profile. Initial Notices are sent each 
night to users who had new learning plan assignments added to their requirements on the previous 
day. The email includes the course(s) that have been assigned and when the courses are due. 

Overdue Training Notice 

The overdue training notice sends an email to users who have the Send Email to User option set to 
Yes and have an email address configured in their User Information profile. Overdue Training  Notices 
are sent each night to users who had learning plan assignments become overdue on the previous day. 
The email includes the overdue course(s) and the course due date(s). Click Edit to view the Overdue 
Training Notice configuration page. 

User Welcome Notice 

The User Welcome notice sends an email to users who have the Send Email to User option set to 
Yes and an email address configured in their User Information profile. User Welcome notices are sent 
to users on the night after they are added and also to users added in the past 60 days who have not 
already received a Welcome notice. The email includes the web address (URL), the User ID, and 
password. The notice also includes instructions for accessing the learning plan, launching a course, 
and Customer Service contact information. 

Custom User Email – Non-recurring/Recurring 

You can create custom emails for users, either recurring or non-recurring. Users who receive a custom 
email are determined by the distribution list criteria. For recurring and non-recurring emails, schedules 
are based on a calendar date and recurrence interval. All users who meet the distribution criteria 
within the period specified (for example, due within 90 days) will receive the email. 

Custom User Email – Training Status 

Training reminder emails for users are similar to recurring user emails. However, the frequency on 
which the email is sent is based on the user, not a calendar schedule. For example, a Training Status 
email set for "Due in 90 days" will email each user due in exactly 90 days. 

Example 

John Doe has Back Safety due 1/31/2014 and Asbestos Awareness due 2/15/2014. Jane 
Doe has Back Safety due 3/1/2014. For a Training Reminder email set to email any user 
with a course due in 90 days, emails will be sent to these users on the following dates: 

John Doe, Back Safety:  11/2/2013 
Jane Doe, Back Safety:  12/1/2013 
John Doe, Asbestos Awareness:  11/17/2013 
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Supervisor User Status Report 

This standard email will send notices to supervisors every 2 weeks, summarizing the training status for 
users reporting to them. The email text, sort order, schedule, and start date are configurable. The 
report includes users with courses due in 30 days, overdue, and completed in the past 30 days. 

Custom Supervisor Email – Non-recurring/Recurring 

You can create custom administrator emails, either recurring or non-recurring. The administrators who 
receive custom emails are determined by the list of administrators entered in the target recipients list 
on the distribution list page. You can enter up to 25 administrator addresses for each custom 
email. The users summarized in the email may be further filtered in the Distribution List settings. 

Custom Administrator Email – Training Reminder 

Training Reminders for Administrators are similar to custom recurring Administrator emails. However, 
the frequency that the email is sent is based on the due dates of the users in the distribution list 
settings, not a calendar schedule. For example, a Training Reminder email set for "Due in 90 days" 
will send an email to the administrators in the Target Recipient list summarizing each user who is due 
in exactly 90 days from the email send date. 

Custom Supervisor Email – Non-recurring/Recurring 

You can create custom supervisor emails, either recurring or non-recurring. The supervisors who 
receive custom emails are determined by the distribution list settings for the email. The supervisors of 
all users who meet the distribution criteria will receive the message. 

Training Administrator Report 

The standard Training Administrator Report sends summary reports in .csv format to all Advanced 
Compliance administrators. By default, any user with security level 10 is included in the distribution list. 
This list may be edited manually by clicking Edit beside the Training Administrator configuration in the 
Standard table on the main Email Configuration page. Summary reports include all Advanced 
Compliance users who have courses due in 30 days, are overdue, or have completed courses in the 
past 30 days. Because these reports have the potential to be quite large, they are included as .csv 
attachments to the emails. 
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Email Notifications 
You can configure the Email Notification System to send email notifications to the learner, the learner's 
supervisor, and the Administrator. 

To access the Email Notifications window, click Setup > Email Notifications on the navigation bar.  

 

The table below shows the standard emails and the associated distribution. 

Email Title Distribution Description 

Initial Training Notice User 

Overdue Training Note User 

User Welcome User 

Supervisor User Status Supervisor 

Training Administrator Report Administrator 

You can also create custom emails for users or supervisors. Available custom email types include: 

 User - Recurring  

 User -Training Reminder 

 User - Non-Recurring  

 Supervisor - Recurring  

 Supervisor - Non-Recurring 

 Administrator – Recurring 

 Administrator – Training Reminder 

Recurring emails are sent on a specified frequency (such as twice per month or weekly). Non-
recurring emails are a one-time email event sent to a group of users or supervisors. 
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Create a Custom Email 

To create a custom email 

1. Click Setup > Email Notifications on the navigation bar. 

2. On the Email Configurations page, click New Custom Emails Configuration. 

3. Select the custom email type. 

4. Click Next. 

5. Click Edit beside the email name. 

6. On the Content page, enter an email title for custom email types to help you identify the email 
configuration at a later time. This title displays in the email list on the Email Notifications page. 
You can also edit the From Name, Data Sort Order, and Email Text on this page. 

Email titles for the standard emails cannot be customized.  

7. Click Next to display the Distribution List page. 

8. For custom user and supervisor emails, enter a new Distribution List Title as a reminder of 
the group you are selecting. You can determine who receives the email by filtering on course 
title, course status, user status, training type, due date, assigned date, and demographic. The 
default distribution list is all required courses not started or incomplete, for active users due 
within 90 days. 

Available filters include: 

 Course Title: To filter the list by course assignment, click the desired course title in the 

left-hand column, and click the ">" arrow button to move the courses to the Selected 

column. You can select multiple courses at the same time by holding the Ctrl key and 

clicking each title. For emails filtered by course, only users who have those courses 

assigned will receive an email, and only the selected course titles will be summarized in 

the email report. For supervisor emails, only supervisors of the users meeting the 

distribution list criteria will receive the email. 

Note: Moving all courses using the double arrow ">>" button does not have the same 
effect as selecting the All courses check box. If new titles are added at a later time, the 
All courses option will include these new courses in the email distribution. When the ">>" 
button is used, only the titles in the list at that time will be used to determine the 
distribution. 

 Course Status: You can also filter the distribution list by course status: Not Started or 

Incomplete; Not Started, Incomplete, Complete, or Overdue. 

 User Status: You can elect to send the email to active users only, both active and 

inactive users, or inactive users only. 

 Training Type and Date: You can select the email to only be sent to users who have the 

course(s) specified as required, optional or both. Likewise, you can filter the list by due 

date or assignment date.  
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Note: If the emails are set for users with both optional and required courses, the due date 
filter is not applied to the optional course assignments. Therefore, any user with the 
specified course(s) assigned as optional will receive the email, even if a "Due Within" filter 
is applied. 

If you select "Due Within," the email will be sent to users who have the course due any 
time during the period specified here (for example, "Due within 30 days."). If Next is 
selected, the distribution list is filtered for users with courses due in the future. If Last is 
selected, the list is filtered for users who are overdue, or who had the course "Due within 
the past X days".  

Note: When "Due Within the past X days" is selected, only users with overdue training will 

be returned. 

If you select "Assigned Within", the distribution is filtered based on the date the course 
was assigned to the user. Here, only Last will return users, and Next is not applicable. 
For example, users who have had the course "Assigned Within the Last 30 days" will 
receive the email. 

To add all overdue training records to the distribution list, regardless of how the email has 
been configured, select the Include ALL overdue courses check box. 

 Demographics: You can further filter the distribution list by selecting certain 

demographics. Only users who meet all the demographics specified will receive the email. 

9. Click Next to display the Schedule page. 

10. Enter the date you want the emails to start, and for recurring emails, the frequency to send 
them.  

Note: The frequency for standard user emails is not editable. 

11. Click Next to display the Review Setup page to review the distribution list settings and 
schedule. 

12. Click Next to display the Preview page to review the format and custom text of the email 
message.  

13. Click Done to return to the Email Configuration page. 

14. To activate the email, click the Active checkbox beside the new email configuration.  

Note: Whenever you edit an email configuration, you must reactivate the email on the Email 

Configuration page.  
 

Customizable Email Fields 
Each email type has customizable fields and settings. 

 From Name: The name to display in the From field in the email. 

 Subject: The subject line of the email. 

 Data Sort Order: The order of data in the report included in the email. The default sort order 

for each email is as follows: 

 User emails: Due Date, Course Title, Course Type 

 Supervisor emails: User Name, Due Date Descending, Course Title 
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 Administrator emails: Supervisor Name, User Name, Due Date Descending, Course 

Title 

If desired, you can select an alternate sort order from the drop-down list: 

 User emails: Course Title, Due Date, Course Type 

 Supervisor emails: Course Title, Due Date Descending, User Name 

 Administrator emails: Supervisor Name, Course Title, Due Date Descending, User 

Name 

 Email Text: There are two blank fields that you can use to display custom text in each email. 

Each field is limited to 2000 characters. Click in the empty field to begin entering your custom 

text. Click in the blank field at the end of the email to enter additional custom text. 

 Distribution List: The audience who will receive the email. For Custom email types, this 

audience can be filtered by demographic, course title, user status, course due date, or course 

assigned date. If no users meet the criteria established in the distribution list settings, no 

emails will be sent. 

 Start Date: The date on which an email will first process. 

 Email Frequency: For recurring emails, the frequency at which the email will be sent. 

The following table shows which of these fields can be customized for each email type. 

Email Type From 
Name 

Subject Data Sort 
Order 

Email 
Text 

Distributio
n List 

Start 
Date 

Email 
Frequency 

Initial Training 
Notice 

X - X X - X - 

Overdue Training 
Notice 

X - X X - X - 

User Welcome X X - X - X - 

Supervisor User 
Status Report 

X - X X - X X 

Training 
Administrator Report 

X - X X X X X 

User - Recurring X X X X X X X 

User - Training 
Reminder 

X X X X X X - 

User - Non-recurring  X X X X X X X 

Supervisor - 
Recurring 

X X X X X X X 

Supervisor – 
Training Reminder 

X X X X X X - 

Supervisor - Non-
recurring 

X X X X X X X 

Administrator – 
Recurring 

X X X X X X X 
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Administrator - 
Training Reminder 

X X X X X X - 

Administrator - Non-
recurring 

X X X X X X X 

 
 

Edit Email Setup Options 

To edit email setup options 

1. On the main Email Configurations page, click Setup on the left-hand menu.  

2. In Number of Retry Attempts, enter the number of retry attempts for any message the 
system deemed undeliverable. By default, the system will try to resend any email for seven 
days. Emails are flagged for resend if the system cannot create or send the message or if the 
nightly system fails at any point during processing. 

3. In Default Access URL, specify the default URL you want included in emails. This is the URL 
to which the user is directed to log in. 

Note: If the default URL is changed, the URL in existing email configurations is not modified. 

4. To have users receive emails in HMTL format, select the Use HTML check box. 

5. To use the international date format in the emails, select the Use International Date check 
box. 

6. Click Submit. 
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Advanced Compliance Glossary 

A 

Administrative Functions: Primary navigation features that allow the Administrator to set up and 
monitor Advanced Compliance users. 

Assign Completions: A method to track learning plan assignments with a delivery method other than 
the Web (for example, video, classroom, CD, etc.). 

Associated Document: A document that is designated as required reading for completion of course 
requirements. Once the document has been assigned as a learning plan assignment, users will be 
able to click on a link in the Learning Plan to access the document file. 

C 

Client Drivers: Policies and procedures within an organization that mandate training for employees. 

Completion Record: A record of current completion or historical completion. The record is for one 
user, one course. When a user launches a course from the learning plan, a completion record is 
created. A current completion record may be either completed or started. A current completion record 
does not become "completed" until the user passes all exams or assessments. 

Course Category: A broad description used to categorize courses in the Library option such as HR, 
Health and Safety, and Environmental. 

Course Reset Date: Course reset date = date user completed course + valid-for period - 90 days. 

Current Completion: A completion record, which is linked to a current requirement and, if completed, 
appears as a completed course both in the user's learning plan and on reports. 

Current Requirement: A record signifying that this course is currently assigned to the user 
(regardless if the user has completed the course). A current requirement displays in both the user's 
Learning Plan and My Transcripts. 

D 

Delivery Method: The instructional method used to present course content (such as classroom, 
video, CBT, or CD). 

Demographic: Information related to the organizational structure associated with a user (such as Job 
Function, Site, or Division). All reports and curriculum assignments are based on demographic 
categories. 

Demographic Group: A category of users who share similar training needs. A demographic group 
must be defined prior to making a learning plan assignment. 

E 

Email Notification: A feature that allows automated email reminders and reports to be sent to users, 
their immediate supervisor, and the Administrator. 

Equivalency: A credit awarded to a user for previous training, education, and/or work experience. 

Exemption: The learning plan assignment is specifically removed (waived).  

H 

Historical completion: A completion record. An exemption/equivalency in history also qualifies as a 
historical completion. A completion is pushed into the historical table when 1) the completion expires 
and the course is ready for retraining, or 2) the learning plan assignment (and any path of inheritance 
for that course) is completely removed from the user or group. 
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Historical requirement: A record which may be a previous instance of a course for which the user 
still has a current requirement, meaning the user still has this course assigned to him but this instance 
was completed, expired and moved to history; or this may be a requirement previously assigned to the 
user and the learning plan assignment has been removed entirely from the user or the demographic 
group. For a requirement to be in history, there must be an associated completion or 
exemption/equivalency for that requirement. A historical requirement displays for a user only in My 
Transcript. 

I 

Inherited Learning plan assignments: If a learning plan assignment has been established for "All" 
members of a particular demographic category (for example, Site), all subsequent demographic 
groups associated with that particular site will inherit the learning plan assignment. 

Initial Setup: A feature that guides the Administrator through decisions regarding user access to 
Advanced Compliance and the Automatic Email Notification System. 

Initial Training: The first instance when a learning plan assignment is assigned, where the learning 
plan assignment’s "valid-for" date is established as anything other than "one-time training". When an 
administrator assigns a course to a demographic group or user for the first time, it is considered initial 
training. A user may also receive initial training when a new requirement is assigned and all previous 
completions for that course are invalid (see Valid Completion). 

Initial Training Decision: The option for assigning new or initial training. Options include calendar-
date or "due within X days" from receiving the requirement. 

L 

Learner transcript: A user's listing of the history and status of all assets. By default, the Core Data 
transcript displays, which contains the complete history of all launched and/or completed self-assigned 
and manager-assigned assets. 

Learning plan: A user’s listing of all assigned courses (required and optional learning plan 
assignments). 

Learning plan assignment (Individual): If a user has a unique learning plan assignment above and 
beyond or different from the requirements designated for a demographic group, training can be 
assigned to the user as required. 

Learning plan assignment (Group): A course that is required for a group of users by virtue of their 
job task duties. 

Learning Program: An administrative function that allows the administrator to assign a group of 
courses and designate completion requirements, such as complete all, complete in order, and 
minimum duration in hours. A Learning Program can have multiple folders assigned to it, each with its 
own completion requirements. 

Library: A comprehensive directory of all available training courses as well as information on each 
course. The function provides a method to add or delete course titles to your online library. 

N 

New User: Any user added after learning plan assignments have been assigned to the demographic 
groups. 

O 

One-Time Training: One-time training never expires, and therefore is not considered retraining. One-
time training will remain on the Learning Plan for one year following completion. 

"Open for retraining" window: This is the period of time before a course is due in which a user can 
launch the course and create a completion record. X-days will be a configurable number for each TR. 
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OrgGroup info: The parameters set for a particular learning plan assignment When a new 
assignment is set, a record is created. The parameters set for this assignment (such as Initial Training 
decision, training type, required/optional, due date, validity period, test out, and passing threshold) are 
referred to as OrgGroup info. 

P 

Passing Threshold: The minimum test score allowed for successful completion of the learning plan 
assignment. 

Pre-test: A comprehensive exam administered at the beginning of a course to establish a baseline 
score for post-test comparison to determine learning gains. 

Primary Drivers: The main regulatory drivers for a course that mandate the training be provided (for 
example, OSHA). 

Push completion to history: Move a current completion record to history. If the assignment is 
completed, the requirement and completion will be preserved in the historical tables and continue to 
show on the Training Status reports. If the completion is only a start (not completed), it and the 
requirement will be deleted in this process. 

R 

RCD: Recurring on Completion Date, equivalent to frequency-based training. Next due dates are 
calculated off last completion dates.  

RDD: Retraining on Due Date, equivalent to calendar-based training. Next due dates are calculated off 
previous due dates. (for example, due 12/31/14, next due is 12/31/15).  

Requirement: A training assignment; one course assigned to a user either through a demographic 
group or an individual Learning Plan assignment. A course assigned to a user results in a record. The 
term has no implication on required versus optional. An optional assignment is referred to as a 
requirement. 

Restricted Access: An Initial Setup feature that allows the Administrator to control access to 
Advanced Compliance features. With this option, a user must be pre-registered before they are able to 
log in and generate a record. Restricted access requires the use of a User ID and password, which 
must be distributed to the user. 

Resurrect completion: Extract a completed completion and its associated learning plan assignment 
record from the historical tables and make them current. 

Retraining: Retraining is defined as any subsequent completion of the learning plan assignment 
following initial training. Retraining occurs as often as specified in the Learning Plan assignment’s 
"valid-for" field and is dependent upon the user’s completion date of initial training. Retraining due date 
= date user completed course + valid-for period. 

S 

Security Setup: Designated levels of access for each of the Advanced Compliance administrative 
functions. 

T 

Test-Out: A comprehensive test at the beginning of the course. If the user’s score meets or exceeds 
the minimum passing threshold, they are not required to complete the course and will receive credit for 
the course. 

Training Administrator: A person or people who have full unrestricted access to all the Advanced 
Compliance administrative functions. 

U 

User Status: Users have a status of either 1) Active or 2) Inactive.  
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V 

Valid completion: A completion which, based on completion date, meets the criteria for a current 
requirement. This may be either a historical or current completion. A valid completion must be in the 
window between "today" (the day the user receives the learning plan assignment) and "today – valid 
for period."  

For example, a completion for Back Safety on or after 12/1/2014 would be valid for a requirement for 
Back Safety due every 1 year, assigned on 12/1/2014. A completion on or before 11/30/2014 would 
not be valid for this requirement. 

"Valid-for" Period: The period for which training is considered valid. Training expires after the "valid-
for" period has elapsed. 
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Enrollments and Waivers 

Learner Enrollment 

You can enroll a learner into a learning program or Live Learning Course (LLC) in one of two ways: 

1. Enroll the learner individually. 

2. Enroll the group in which the learner is a member. 

These enrollments are treated independently. If you enroll a group, and later withdraw a member of 
that group from the learning program or LLC, the rest of the group is unaffected. Also, if you enroll an 
individual learner, then enroll a group to which that learner is a member, the learner is not double-
assigned.  

Group Enrollment 

Note the following: 

 If you remove a learner from an enrolled group, he is automatically withdrawn from the 

learning program or LCC unless he has already completed it. No further steps need to be 

taken. 

 If you remove a learner from an enrolled group, his completion data for the learning program 

or LCC (In Progress or Completed) remains in the system, even if he has not made any 

progress within it. 

 If you add additional members to an enrolled group, those learners are automatically enrolled 

in the learning program or LCC.  

Exception: If you add a new subgroup directly under the ALL USERS group (visible only to 
Company Admins), those members are not automatically enrolled. You must enroll them 
individually, or add them to a different group. 

Completion Status 

Enrolling in a learning program or LLC is considered the first step of starting the program or course; as 
a result, the learning content is automatically displayed in the learner's learning transcript immediately 
upon enrollment. For more information about completion status, see Learning Program Completion 
Criteria. 

Learning Programs within a KnowledgeCenter 

If a learning program is used in a KnowledgeCenter roadmap, learners must be assigned and enrolled 
in the learning program before they can see it in the KnowledgeCenter. If they are not assigned, they 
will see an error message. If they are assigned but not enrolled, the learning program appears empty 
in the KnowledgeCenter roadmap details page. 
 

Enroll Users or Groups 

To enroll users or groups in a learning program or LLC 

1. Access the current enrollments for the given program or course. 

2. If you want to individually enroll users instead of enrolling an existing group (or groups), click 
the Users tab in the Current Enrollments pane on the right. Otherwise, leave the Groups tab 
active. 
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Note: The previous step is not strictly required. That is, if you drag and drop a set of users to 
the Groups tab (or a set of groups to the Users tab), the application detects this and 
automatically changes the tabs accordingly for you. However, it can be helpful to preview the 
existing list of enrolled groups or users before you enroll additional ones. 

3. In the Users and Groups pane on the left, locate the users or groups that you want to enroll. 
You can do this in one of two ways: 

 Browse the hierarchy of groups and users. 

 Search for the groups or users using the search controls at the top of the page. If you are 

searching for a group, you can enter a group name or org code. If you are searching for 

users, you can enter a login name, first name, last name, or email address. You can also 

use an asterisk (*) as a wildcard that represents one or more characters. 

4. Select the users or groups that you want to enroll, drag them to the Current Enrollments pane, 
and drop them on the pane. To select multiple users or groups, use Shift-click and Ctrl-click. 

Alternatively, you can select the users or groups, and then click  beneath the two panes. 

The users or groups are enrolled in the learning program or LLC. 

5. If prompted (because your site is configured to use enrollment-related notification emails), 
click Yes if you want to send a related email notification to the users or groups. If you do not, 
click No. 

6. If desired, create an entry in the learning plan for the users or groups that you enrolled: 

a. In the Current Enrollments pane, select the users or groups. (Use Shift-click or Ctrl-click 
to select multiple users or groups.) 

b. Click Configure Learning Plan at the top of the pane. 

c. In the Editing Learning Plan dialog box, enter the information as appropriate (see 
Managing Assets in Learning Plans). 

Note that if you specify a relative due date for a learning asset that you are assigning to a 
group, be aware that users who are added to the group at a later date will inherit the 
assignment when they are added to the group, but they will not have the same due date. 
Their due date will be relative to the date on which they were assigned the asset, which is 
the date on which they were added to the group. 

For example, assume you add a course entitled Leadership to the learning plans for all 
members of a group (Marketing Group) on January 1, 2014; you also specify members of 
the Marketing Group must complete the Leadership course 3 months after you assign it, 
which means it is due April 1, 2014. On February 1, 2014, you add John to the Marketing 
Group. Because John is assigned Leadership one month later (when he is added to the 
group), his due date for the Leadership course is also one month later (May 1, 2014). 

d. Click OK. 

Note: If a user has an existing administrator-assigned learning plan entry for the asset, this 
step updates the entry; it does not create a new one. In addition, be aware that you can 

modify thisentry later by returning to this page and repeating this step. 

An  icon displays in the Learning Plan column for the selected users or groups to indicate 
that they have a corresponding learning plan entry. 
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Approve Pending Enrollment Requests 

If you have been selected as an approval manager for learners, you must approve the enrollment of 
those learners in all learning programs that have been configured to require manager approval. 

To approve the enrollment of learners in a learning program 

1. In Skillport Administrator, click Content > Learning Programs.  

2. Click the Users tab in the Current Enrollments pane on the right. 

3. On the Users tab, select the users whose enrollments are in Pending Approval status. To 
select multiple users, use Shift-click or Ctrl-click. 

Note: You can also filter the list of users shown to include only those whose status is Pending 

Approval. For more information, see View Current Enrollments on page 36. 

4. Click Approve Pending. 
 

Withdraw a User or Group 

When you withdraw users or groups from a learning program or Live Learning course (LLC), keep in 
mind the following: 

 A user can be enrolled in a learning program or LLC both individually and due to membership 

in a group that is enrolled. These enrollments are treated independently; if you withdraw one, 

the other is unaffected. 

 You cannot withdraw users who have completed the program or course. The completion data 

for all users who have completed learning programs or LLCs always remains in the learner 

transcript for those users (unless you delete the learning program). 

 You cannot withdraw an individual user from a group enrollment. 

 If you remove a user from a group, the user is automatically withdrawn from a group 

enrollment as long as he or she has not completed the program or course. 

 If your site is configured to use enrollment-related notification emails: 

 When you individually withdraw users from a learning program, the users are 

automatically sent a notification email. 

 When you withdraw groups, you are prompted to specify whether to send a notification 

email. 

You can withdraw users or groups in two ways: 

To withdraw by selecting users or groups 

1. Click Users & Groups > User Management on the navigation bar. 

The User Management page displays. 

2. In Users and Groups, find the group or find the user that you want to withdraw from a learning 
program, and select that group or user. 

3. In the right pane, click the Enrollments and Waivers tab. 
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Both inherited enrollments and individual (if you have selected a user) or explicit (if you have 
selected a group) enrollments for the user or group are displayed. As an example, the 
following image shows the inherited and individual enrollments for a selected user. 

 

4. Do one of the following: 

 If you selected a user, click Edit Individual Enrollments. 

 If you selected a group, click Edit Group Enrollments. 

 

5. In the right pane, select the learning program, and click Withdraw. 

6. In the Confirm dialog box, click OK. 

7. In the Withdraw dialog box (if available), if you want to send a notification email to the group or 
user, click Yes. Otherwise, click No. 

8. Click Save, and then click OK. 

The learning program is removed from the learner transcripts for all affected users. 

Note: You may also want to remove any corresponding entries in the users' Learning Plan. 
You can remove Learning Plan entries using the Learning Plan Assignment tab on the User 
and Group Management page. For more information, see Add or Remove Assets from a 

User's Learning Plan on page 69. 

To withdraw by selecting the learning program or LLC 

1. Click Users & Groups > Enrollments and Waivers on the navigation bar. 

The Manage Enrollments and Waivers page displays. 

2. Select the learning program from the list, and click Manage Enrollments. 
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The Manage Enrollments page displays. 

 

3. If you want to withdraw individual users, click the Users tab in the Current Enrollments pane. 
Otherwise, leave the Groups tab active. 

4. In the Current Enrollments pane, select the users or groups that you want to withdraw. To 
select multiple users or groups, use Shift-click or Ctrl-click. 

5. Click Withdraw, and then click OK. 

6. If the users or groups have associated Learning Plan assignments, you are prompted to 
choose whether to remove them: 

 Click Yes to remove the assignment. 

 Click No to keep the assignment. 

7. Click Yes to confirm the withdrawal. 

8. If prompted, click Yes if you want to send an email notification to the users or groups. If you do 
not, click No. 

The learning program is removed from the learner transcripts for all applicable users. 

 
 

Grant Waivers to a User 

You can grant a waiver from one or more learning assets in a learning program to one or more users. 
A waiver from an asset applies to all of the user's enrollments in the learning program; even if the user 
withdraws and then enrolls again, the waiver remains. In addition, if the user is enrolled in the learning 
program both individually and due to membership in a group that is enrolled, the waiver applies to both 
enrollments. 

Note: You can grant waivers from assets on a per-learning program basis. If an asset is used in two 
learning programs, a waiver from the asset in one learning program does not automatically apply to 
the same asset in the other learning program. 

To grant a waiver by selecting a learning asset 

1. Click Users & Groups > Enrollments and Waivers on the navigation bar.  

The Manage Enrollments and Waivers page displays. 
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2. Click the asset for which you wish to grant waivers. 

3. Click Manage Waivers.  

The Manage Waivers page displays: 

 

Note: If the list of learners is long, it can be helpful to filter the display to include only those 
learners who meet specific criteria. For this reason, use the columns in the table to apply 
filters in the same way that you can on the Manage Enrollments page. For information on 
working with these filters, see Manage Information in Tables. 

4. Select the user for whom you want to grant the waiver, and click Grant Waiver. 

The Grant Waiver dialog box displays, which lists all the learning assets in the learning 
program or Live Learning course (LLC) for which completion can be determined. 

 

5. Select all the assets for which you want to grant a waiver.  
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6. Click Waive. The Waive Resource dialog box displays: 

 

7. Enter the reason for the waiver.  

8. Click OK. The Waive Resource dialog box closes, and the Grant Waivers to Multiple Users 
dialog box updates to reflect the granted waivers. 

Note: Waivers cannot be revoked once granted. Repeat these steps for each additional asset 

for which you want to grant a waiver. 

9. Click Exit. 

To grant a waiver by selecting a user 

1. Click Users & Groups > User Management on the navigation bar. 

2. Find the user for whom you want to grant a waiver, then select the user. 

3. In the right pane, click the Enrollments and Waivers tab. 

The enrollments for the selected user display: 

 

4. Select the check box beside the learning program for which you want to grant a waiver, and 
click Grant Waiver. 
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The Grant Waiver for User dialog box displays: 

 

5. Select all the assets for which you want to grant a waiver.  

6. Click Waive. The Waive Resource dialog box displays: 

 

7. Enter the reason for the waiver.  

8. Click OK. The Waive Resource dialog box closes, and the Grant Waiver for User dialog box 
updates to reflect the granted waivers. 

Note: Waivers cannot be revoked once granted. Repeat these steps for each additional asset 

for which you want to grant a waiver. 

9. Click Exit. 
 

Grant Waivers to Multiple Users 

If multiple users have requested a waiver for the same asset, you can grant waivers to them using the  

Grant waivers to multiple users 

1. In Skillport Admin, click Users & Groups > Enrollments and Waivers on the navigation bar.  

The Manage Enrollments and Waivers page displays. 

2. Click the asset for which you wish to grant waivers.  

3. Click Manage Waivers.  
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The Grant Waivers page displays. 

 

4. Select all users for whom you want to grant the waivers, and click  Grant Waiver.  

The Grant Waivers for Multiple Users dialog box displays. 

 

5. Select each asset you wish to waive for the selected users. 

6. Click Waive.  

The Waive Resource dialog box displays. 

 

7. Enter the reason for the waiver.  

8. Click OK. The Waive Resource dialog box closes, and the Grant Waivers to Multiple Users 
dialog box updates to reflect the granted waivers. 

Note: Waivers cannot be revoked once granted. 

9. Click Exit. 
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Batch Add/Update (Users & Groups) 

Add or Update Multiple Users (Batch Add) 

Using the Batch Add/Update page, you can use a single process to: 

 upload multiple users at once 

 upload changes to existing users at once 

 upload multiple new users and update multiple existing users at the same time 

Download the User template on the Batch Add/Update page to add multiple new users, or make 
changes to existing ones. To create a single user, see Create a User Manually on page 31. 

Note: You can also add or update multiple groups and grant multiple waivers to assets within a 

Learning Program.  

To add or update multiple users at once 

1. Properly complete the User template.  

Note: In the User template, ensure the second line containing the helpful hints is removed 

from the CSV file. 

2. Click Users & Groups > Batch Add/Update on the navigation bar. 

By default, the Users tab displays on the Batch Add/Update page:  

 

Note: If Approval Managers are enabled on your site, the Send approval manager email to 
updated user option displays.  

3. Click Browse. 
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4. Locate the User template .csv file and select it. 

Note to Safari users: When using Safari to download the template, it downloads in TXT 

format, not CSV format. You must use the CSV file format for the upload. 

5. If enabled on your site, select your notification preferences: 

 Select the Send Welcome email to new user option to send an automatically-generated 

email to all users with a valid email. 

 Select the Send approval manager email to updated user option to send an 

automatically-generated email about the changes to the users' approval managers to all 

users with a valid email. 

6. If you have selected to send emails, specify when to send them: 

 If you want to send the email immediately after the upload, click Send now. 

 If you want to send the email at a specific date and time, click Send later, and then 

specify the date and time. 

If you select to send the notification email at a specific date and time, you cannot change the 
date or time, or delete emails from the queue. 

7. Click Upload. 

The upload and verification process begins. If you have a valid email address associated with 
your Skillport credentials, an email is sent to you that contains the URL of a status report, and 
the date and time that the batch was submitted. 

Note: Once processed, view the Batch Uploads report (Users & Groups > Batch Uploads Report on 

the navigation bar) to see the upload records. 

 

User CSV Template 

**IMPORTANT: If using a CSV file downloaded prior to the Skillport 8.0.3285 release, it will not 
upload. You must either download a new CSV file, or modify your existing CSV file.** 

To modify an existing User CSV file (prior to May 2014) 

1. In your User CSV file, change _sys_userid to Username. 

2. Change _sys_password to Password. 

3. Ensure the column headers are in the following order: 

 Username 

 Password 

 _sys_firstname 

 _sys_lastname 

 _sys_emailaddress 
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 _sys_display_first_name 

 _sys_display_last_name 

 _sys_location 

 Force Password Change 

 Status 

 Role 

 Group Membership 

 Group Operation 

 Approval Manager 

 custom_privileges 

4. Save your file in the .csv file format. 

This template contains standard user profile fields. The fields included in the template may vary, based 
on the settings configured on the Manage User Profile Fields page. A standard field that displays as 
Enabled on the Manage User Profile Fields page is included in the user CSV template.  

Note to Safari users: When using Safari to download the template, it downloads in TXT format, not 

CSV format. You must use the CSV file format for the upload. 

File Type 

 Must be submitted in CSV format 

 Must be encoded in UTF-8 format.  

Ensure you specify the encoding format before you save the file. 

 If using a text editor, such as Notepad, click File > Save As, then select UTF-8 as the 

encoding format.  

 If using Microsoft Excel, click File > Save As > Web Options, then select Unicode (UTF-

8) as the document type. 
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Upload Guidelines 

 If you are uploading a batch of changes to existing users, you only need to complete the 

Username fields and the fields you wish to change. During an update operation, if a field is 

left empty, the existing value for a user is not changed. 

 You can add or update values in the custom user profile fields when you add or update 

multiple users. 

 Do not change the values in row 1 (column headers). 

 Enclose fields with embedded commas in quotes. Note that the quotes are not saved as part 

of the field value. If quotes are desired as the first and last characters of the field data, then 

you must enclose them with a second set of quotes. For example, to upload “myName”, you 

must enter ““myName””. 

 If the administrator submitting the upload file has a valid email address, an email is sent that 

includes the URL of the file, and the date and time that the upload was submitted. 

 When an upload is requested, an entry displays in the Reports section. The CSV-format report 

lists any records that were not successfully uploaded. 

 If an error occurs with the column names, the batch file is rejected at upload. 

 If there is an error with an individual user record in the template, only that record will fail, and 

correct records in the same batch file upload without issue.  

 You can view all batch file rejections, individual failures, and the reason for these errors in the 

Batch Upload report. 

User CSV Template Field Definitions 

The following table describes each standard user profile field in the user CSV template. Multiple 
custom user profile fields can be uploaded using a different CSV template. See Batch Add/Update 
Custom User Profile Fields for more information. 

Field Required? Max Text 
Size 

Description 

Username Yes 255 

acceptable 
characters 

abcdefghijklmnopqrstuvwxyz0123456789@$_.~'- 

A user ID (user name) cannot start with an 
apostrophe (') or a dash (-). 

Non-breaking white spaces (space, tab, and 
newline) and multi-byte characters (for example, 
Japanese or Chinese characters) are not 
allowed. 

All user IDs are converted to lower case, then 
validated, and finally saved in lower case if valid. 

The user's sign in name.  

Note: The user name cannot be changed when 
doing updates by upload. Certain reserved words 
produce an error. The most common are: add, 
all, block, count, down, force, link, mount, off, 
simple, tag, up. 
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Password No 255 

acceptable 
characters 

abcdefghijklmnopqrstuvwxyz0123456789@$_.~'- 

A user ID (user name) cannot start with an 
apostrophe (') or a dash (-). 

Non-breaking white spaces (space, tab, and 
newline) and multi-byte characters (for example, 
Japanese or Chinese characters) are not 
allowed. 

All user IDs are converted to lower case, then 
validated, and finally saved in lower case if valid. 

The user's password for Skillport sign on. If 
omitted, the value for Username is used. 
Passwords are case-sensitive. 

Note: This field is ignored during a batch update. 
Passwords can only be changed within Skillport 
Administrator. 

_sys_firstname No 255 

All Latin-1 
and double-
byte 
characters 
are accepted. 

The user's first name. If omitted, the value for 
Username is used.  

_sys_lastname No 255 

All Latin-1 
and double-
byte 
characters 
are accepted. 

The user's last name. If omitted, the value for 
Username is used. 

_sys_emailaddress No 255 

acceptable 
characters 

abcdefghijklmnopqrstuvwxyz0123456789@$_.~'- 

A user ID (user name) cannot start with an 
apostrophe (') or a dash (-). 

Non-breaking white spaces (space, tab, and 
newline) and multi-byte characters (for example, 
Japanese or Chinese characters) are not 
allowed. 

All user IDs are converted to lower case, then 
validated, and finally saved in lower case if valid. 

The user's email address. If omitted, this field is 
left blank. Non-breaking white spaces (space, 
tab, newline) are not allowed. 

_sys_display_first_na
me 

No 255 

All Latin-1 
and double-
byte 
characters 
are accepted. 

The user's first name to display in the Skillport 
interface, such as in the Community. (For 
example, a learner's nickname, or a name other 
than his legal first name). 
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_sys_display_last_na
me 

No 255 

All Latin-1 
and double-
byte 
characters 
are accepted. 

The user's last name to display in the Skillport 
interface, such as in the Community. (For 
example, a learner's maiden name, or a name 
other than her legal last name). 

_sys_location No 4000 The user's geographic location.  

Force Password 
Change 

No See 
Description 

You can force the user to change his password 
the first time he signs into Skillport. 

Acceptable values are 1 or 0. If omitted, the 
default is 0. 

 0: Allows the user to keep his assigned 

password. Determines whether the user 

will be forced to change his or her 

password immediately after the next (or 

first) login. 

 1: Forces the user to change his 

password when he first signs into 

Skillport.  

Status No See 
Description 

The active/inactive status of the user.  

Acceptable values are 1 and 0. If omitted during 
an add operation, the default is 1. If omitted 
during an update operation, the user's status is 
unchanged. 

 0: Marks the user as Deactive. 

 1: Marks the user as Active. 

Role No See 
Description 

 The user's role. The default value is END_USER. 

Values include: 

 END_USER 

 MANAGER 

 ADMIN 

 COMPANY_ADMIN 

Note: The value for Role determines the user's 
access privileges in the system and is not meant 
to identify his position within the organization. 
Super administrators cannot be created using 
Batch Add. 
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Group Membership  Yes 

for 

New 

User

s 

 No 

for 

Exist

ing 

User

s 

 

(See note in 
Description.) 

240 One or more org codes associated with the 
groups to which the given user should be added. 
A user can belong to multiple organizational 
groups, but only one advanced group. Each org 
code must be separated by a semicolon.  

Capital letters are accepted. Non-breaking white 
spaces (space, tab, newline) are not allowed. 

Note: This field is required for new users and 
optional for existing users. Groups associated 
with the specified org codes must exist prior to 
the upload; to determine a group's org code, click 
Users and Groups > User Management, and 
navigate to the group in the left pane. The org 
code displays in parentheses beside the group 
name. 

Group Operation No See 
Description 

Indicates how the groups specified in the Group 
Membership field are applied to the user.  If 
omitted, the default is 0. If a value for Group 
Membership is omitted, this field is ignored. 

Acceptable values are: 

 0: Replaces the user's current list of 

groups with the list specified in the Group 

Membership field. If you use this value, 

include in the Group Membership field 

the complete list of new groups that will 

replace the user's current groups. If you 

are uploading new users, this option 

adds them to the specified groups. 

 1: Adds the user to the groups specified 

in the Group Membership field. If you use 

this value, include in the Group 

Membership field only the groups that 

you are adding. If you are uploading 

updates to existing users, this option 

retains the users’ existing groups and 

adds the users to the specified groups. 

 2: Removes the user from the groups 

specified in the Group Membership field. 

This value is only valid if you are 

uploading updates to existing users. If 

you use this value, include in the Group 

Membership field only the groups that 

you are removing. 
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Approval Manager No 255 

All Latin-1 
and double-
byte 
characters 
are accepted. 

The user ID of an existing user who is the 
approval manager for this user. 

Note: This column only displays if Approval 

Managers are enabled on your site. 

custom_privileges No See 
Description 

If you want to assign custom privileges not 
already associated with the user's selected role, 
or if you wish to remove specific custom 
privileges that are already assigned to the user 
(or are included in the user's role by default), use 
this column to specify those. See Assign Custom 
Privileges in the User CSV Template before 
using this column. 

 
 

Assign Custom Privileges in the User CSV Template 

Important Information About Assigning Custom Privileges using Batch Add  

 Multiple values can be provided in this field using the pipe (|) to separate the values.  

 Each value must start with either + or - to indicate the inclusion or exclusion of the privilege.  

 When adding a custom privilege to a user, Skillport examines the user's assigned role and 

grants the custom privilege only if the assigned role allows it (for example, a user with an 

END_ROLE user cannot be granted course completion privileges, as that is only available to 

Admins). If a custom privilege in the custom_privilege column is not allowed within the 

specified role, the privilege is not assigned, and the user is processed without it. All valid 

privileges in this column will be assigned to the user, even if one or more in the list are 

skipped. 

Example of Removing Privileges from a User Role 

 Goal: Add a user specifically to run reports.  

 Choose the User Role: Reports can be run by managers and above; as you want this user to 

have only a single privilege, choose the lowest role possible, which is Manager. 

 Set the Privilege: You must remove all privileges except reporting, so you would enter the 

following in the custom_privileges column in the CSV template:  

-USER_MANAGER_PRIVS|-CURRICULUM_BUILDER_PRIVS|-

CURRICULUM_ASSIGNER_PRIVS|-LEARNER_RECORD_ASSIGNER_PRIVS|-

COURSE_EVAL_BUILDER_PRIVS|-ADMIN_MANAGEMENT_PRIVS|-

ADMIN_SYSTEM_PRIVS|-ADMIN_PRESENTATION_PRIVS|-

BOOKS24X7_ASSIGNER_PRIVS|-LEARNING_PROGRAMS_PRIVS|-ENROLLMENT_PRIVS|-

USERS_AND_GROUPS_PRIVS 
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Example of Adding Privileges to a User Role 

 Goal: You want a user to be able to delete other users and groups.  

 Choose the User Role: This privilege can only be granted to users with an Admin or 

Company Admin role. Select one of these. 

 Set the Privilege: Enter the following in the custom_privileges column in the CSV template:  

+DELETE_USER_PRIVS 

Valid values for the custom_privileges column in the User CSV Template: 

 ADMIN_MANAGEMENT_PRIVS  

Allows access and configuration privileges to the Content pages. 

 ADMIN_PRESENTATION_PRIVS  

Allows the user to configure the Skillport Learner interface. 

 ADMIN_REPORTS_PRIVS  

Provides access to Skillport Reports. 

 ADMIN_SYSTEM_PRIVS  

Allows access and configuration privileges to the Configuration pages. 

 ASSIGNMENT_GROUP_PRIVS  

Allows the user to create and manage assignment groups. 

 BOOKS24X7_ASSIGNER_PRIVS  

Allows the user to assign Books24x7 collections to users and groups. 

 COURSE_COMPLETION_PRIVS 

Allows access and configuration privileges to the Completion Criteria page. 

 COURSE_EVAL_BUILDER_PRIVS  

Allows the user to create and manage evaluations. 

 CURRICULUM_ASSIGNER_PRIVS  

Allows the user to assign or deassign content in the Library. 

 CURRICULUM_BUILDER_PRIVS  

Allows the user to make changes to the Skillport Library. 

 DELETE_DOMAIN_PRIVS  

Allows the user to delete domains. 

 DELETE_USER_PRIVS  

Allows the user to delete users and groups. 

 ENHANCED_COMPLIANCE_PRIV 



Skillport 8 Administrator Guide ©2015 Skillsoft  195 
 

Users and Groups   
 
 

Allows the user Advanced Compliance privileges. 

 ENROLLMENT_PRIVS  

Allows the user to enroll other users and groups in assets on page 176 such as 
learning programs or ILT sessions, and grant associated waivers for specific assets in 
those learning programs. 

 FEATURED_TOPIC_PRIV (available to the End User role) 

Grants the Curator role to the user. This allows him to add and remove assets within an 
active Featured Topics folder in the Library. Enabling this privilege displays the Add to 
Featured Topics option on an asset's Details page in Skillport Learner. 

 ILT_ADMIN_PRIV (available to the End User role) 

Allows the user access to all ILT pages within Skillport Administrator, including the Course 
and Session Manager, Resources Manager, and Batch Add functionality. 

 ILT_COURSE_ADMIN_PRIV (available to the End User role) 

Grants access to the ILT Course and Session Manager. 

 ILT_SESSION_ADMIN_PRIV (available to the End User role) 

Grants access to the ILT Session Manager. 

 ILT_SESSION_APPROVER_PRIV (available to the End User role) 

Allows the user to access the Approval Manager to approve session enrollment requests. 

 ILT_SESSION_INSTRUCTOR_PRIV (available to the End User role) 

Grants the Instructor role to the user. As an instructor, you can manage most of the ILT 
session details you deliver and also manage the session roster. 

 INGENIUS_PRIVS  

Allows the user to specify Community settings. 

 KEYWORD_PRIV 

Allows the user to create and manage keywords. This privilege is granted by default to 
company administrators, but it can be revoked. It is also available to administrators, but it 
is not granted to them by default. 

 LEARNING_PROGRAMS_PRIVS  

Allows the user to create and manage learning programs. 

 LEARNER_RECORD_ASSIGNER_PRIVS  

Allows the user to assign assets to the Learning Plan for individual learners and groups. 

 MULTIPLE_COMPLETION_ACCESS_PRIVS  

Allows the user to set specific courses to allow multiple completions. 

 PUBLISHER_PRIV 

Allows the user access to Skillsoft Publisher and the ability to upload custom content and 
publish passive content. 
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 USERS_AND_GROUPS_PRIVS  

Provides access to the Users & Groups pages. 

 USER_MANAGER_PRIVS  

Allows the user access to view and edit user and group information for those within the 
user's hierarchy. 

 

Add or Update Multiple Groups (Batch Add) 

You can create a batch of new groups or upload a batch of changes to existing groups. This is useful 
when creating an initial organizational group hierarchy for the users in your organization. A group 
hierarchy is needed in order to register learners into specific groups or subgroups. Once a group 
structure is in place, you and other administrators can better manage reporting and curriculum 
assignments. 

If you need to create just a few groups, see Create a Group Manually on page 33. 

Note: You can also add or update multiple users and grant multiple waivers to assets within a 
Learning Program. 

To add or update multiple groups at once 

1. Properly complete the Group CSV template. 

Note: In the User template, ensure the second line containing the helpful hints is removed 

from the CSV file. 

2. Click Users & Groups > Batch Add/Update on the navigation bar. 

By default, the Users tab displays on the Batch Add/Update page. 

3. Click the Groups tab.  
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4. Select the type of Batch Add you want to perform.  

 Add: The .csv file contains new groups. 

Note: Groups are added in a hierarchical and sequential manner. Be sure to place the 
highest level group first, followed by subgroups. Your main company group is typically 
created as part of your Skillsoft site build. See Completing the Group CSV Template. 

 Update: The .csv file contains updates to existing groups. 

Note: If you are updating changes to existing groups, changes to the Parent Group 
column in the Group CSV file are ignored because groups cannot be moved to new parent 
groups using the Batch Add/Upload feature.  

5. Click Browse.  

6. Locate the group template .csv file and select it. 

Note to Safari users: When using Safari to download the template, it downloads in TXT 

format, not CSV format. You must use the CSV file format for the upload. 

7. Click Upload. 

The upload and verification process begins. If you have a valid email address associated with 
your Skillport credentials, an email is sent to you that contains the URL of a status report, and 
the date and time that the batch was submitted. 

Note: Once processed, view the Batch Uploads report (Users & Groups > Batch Uploads Report on 

the navigation bar) to see the upload records. 
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Group CSV Template 

Use the group CSV template to define and upload the hierarchy of the user groups in your 
organization. A group hierarchy is needed to register learners into specific groups or organizations. 
Once your group structure is in place, administrators can better manage reporting and curricula 
assignments. 

File Type 

 Must be submitted in CSV format 

 Must be encoded in UTF-8 format 

File Names 

As a best practice (not required), use a convention such as 

<mycompany>_groupUPDATE_<date>.csv, for example, 

skillsoft_groupUPDATE_05312014.csv. 

Upload Guidelines 

 You must include all required fields. 

 You can view all batch file rejections and individual failures, and the reason for these 

errors, in the Batch Upload report. 

 During an update operation, if an optional field is left empty, the existing value for a group is 

not changed. 

 Specify parent groups before subgroups. See Define the Group Hierarchy using the Group 

CSV Template. 

 Do not change the values in row 1 (column headers) or the import will fail. 

 Do not exceed the maximum field sizes (see table below). 

 Enclose fields with embedded commas in quotes. 

 Quotation marks are not saved as part of the field value. If quotes are desired as the first 

and last characters of the field data, you must enclose them with a second set of quotes. 

For example, to upload "myName", you must enter ""myName"". 

Upload Format 

A group upload file contains several columns that organize the groups in an expandable tree structure. 
The column labels in the group CSV file are identical to the field labels that you see when you create a 
new group on the User Management page. The following table describes each field in the group CSV 
template: 

Field Required? Max Text Size Description 

Name Yes 240 The name for the group that is displayed on the User 
Management page. 

Org Code Yes, but only 
for an 
update 

240 The unique, alphanumeric identifier for the group. The 
purpose of the org code is to uniquely identify the 
group in the system, as the name of the group does 
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operation not have to be unique. 

If you do not specify an org code for a new group, the 
system assigns one to the group automatically during 
the import process using the format org_<number>, for 
example, org_18. However, you can change the org 
code for a group at any time. 

You can use the following characters: 

 a-z 

 A-Z 

 0-9 

 _ (underscore) 

 - (hyphen) 

 all Latin-1 characters that correspond to the 

following codes: #161 through #255, inclusive 

Spaces, tabs, and new lines are not accepted. 

Note: Do not change this value when performing a 

group update. 

To determine a group's org code, click Users & 
Groups > User Management, and navigate to the 
group in the hierarchy in the left pane. The org code 
for a group is displayed in parentheses beside the 
group name.  

Display on 
Registration 
Page 

No See Description Determines whether the group is displayed on the Self-
Registration page. Acceptable values are: 

 0 - Hides the group on the registration page 

 1 - Displays the group on the registration page 

The default value is 0. 

Note: All groups displayed on the Self-Registration 
page must also display the parent group under which 
they reside. In other words, to display a subgroup on 
the Self-Registration page, you must first display its 
parent group. 
 

Group Type No See Description Indicates the type of group. Acceptable values include: 

 NORMAL 

 ADVANCED 

 ASSIGNMENT_GROUP 

If this field is left blank the group data is treated as a 
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NORMAL group. 

Parent 
Group 

Yes 240 The org code of the parent group for this group. A 
group with this org code must already exist. Capital 
letters are accepted, and the value must not contain 
spaces, tabs or new lines. 

The value _*_ means this group is a root group (has 
no parent). The position of this field in the group 
upload file will determine its lineage. 

Note: Advanced groups may only be top-level groups. 
Assignment groups may only exist in the top-level 
group called Assignment Groups. The Parent Group 
field is ignored for both of these group types, and any 
changes to this column in the Group CSV template are 
ignored (groups cannot be moved to new parent 
groups using the Batch Add/Upload feature). 

 
 

Completing the Group CSV Template 

Important Information 

 The group CSV template adds groups in a hierarchical manner: 

 The top-level (root) group must be indicated first.  

 Subgroups are added sequentially as defined in the group CSV template.  

 To effectively show how to create a group CSV file, this procedure uses an example company, 

Akara.  

Example Group CSV Template 

Because groups are added to Skillport in a specific manner, to create an effective group hierarchy like 
this: 
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You must create a group CSV template like this: 

 

To successfully complete the group CSV template 

1. List your groups and associated Org Codes. You can use the default groups (Skillsoft and 
Assignment Groups), or create your own. 

a Enter the name of a parent group you wish to add in the Name column. 

b In the Org Code column, enter a unique code for the group.  

c Enter the name of the subgroups you wish to add in the Name column directly below their 
associated group. 

d In the Org Code column, enter a unique code for the subgroup.  

e Repeat these steps for all groups and subgroups you wish to add to Skillport. 

Note: To create a top-level group in the Group CSV file, enter its group name in both the Name and 
Org Code columns. Then, for each of its subgroups, enter the new top-level group's name. For 
example, to create the Akara top-level group, enter the following: 

 
 

Default Groups in Skillport 

Two top-level groups are available by default in Skillport - Assignment Groups and Skillsoft. By default, 
both of these groups are entitled to all content your Skillport site offers. 

In this example 

Akara wants to target their users based on their department and team. They have three departments: 
Human Resources, Marketing and Sales. The Human Resources department has two teams - Benefits 
and Compensations. They want each department to have its own group within Skillport, and they want 
the Human Resources department to have two subgroups for its teams.  

Akara creates their own top-level group and enters the group names and associated Org Codes into 
the group CSV template, listing first the parent group, then any subgroups: 
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Note: If the Benefits and Compensations groups are listed in the row before the Human Resources 
group, the upload would fail because both groups are subgroups of the Human Resources group. To 
add either group to the system, the Human Resources group must already exist - which means it must 
be created first during the upload. 

 

1. Mark groups for inclusion or exclusion on your Skillport registration page. 

You can specify that the groups defined in the group CSV file display on the registration page, to allow 
learners to join these groups (either a single group or multiple groups) when they register themselves.  

In the group CSV template, in the Display on Registration Page column: 

 Enter 0 to hide a group on the registration page. 

 Enter 1 to display the group on the registration page.*  

*You must enter 1 for the parent group of any sub-group you wish to display in the drop-down 

list. 

Note: Ensure you have your Skillport site configured to display groups. See Registration for more 

information. 

In this example 

Akara wants to display all of their company-specified groups and subgroups on the registration page. 

In the groups CSV file, they entered 1 for all groups: 
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Their registration page, once configured to display groups and the CSV template uploads to Skillport, 
looks like this: 

 

1. Determine each group's type. 

There are three different types of groups within Skillport: Normal groups, Advanced groups on page 
46, and Assignment groups on page 49. Enter one of the following values in the Group Type column 
in the groups CSV template: 

 NORMAL 

 ADVANCED 

 ASSIGNMENT_GROUP 

If this field is left blank, the group data is treated as a Normal group. 

In this example: 

Akara created only Normal groups by leaving those fields blank in the group CSV file: 

 

1. Define the parent groups. 



204 ©2015 Skillsoft Skillport 8 Administrator Guide 

 

 Users and Groups 
 
 

 If the parent group already exists in Skillport, enter the parent group name in the Parent Group 

column. 

 If the parent group is being created in the group CSV template, in the Parent Group column, 

enter the Org Code specified in the Org Code column of the group CSV template. 

In this example 

Akara had an existing group already existing in Skillport (Akara). Akara wants to target their users 
based on their department and team. They have three departments: Human Resources, Marketing 
and Sales. The Human Resources department has two teams - Benefits and Compensations. They 
want each department to have its own group within Skillport, and they want the Human Resources 
department to have two sub-groups for its teams.  Each department - Human Resources, Marketing, 
and Sales - has a parent group of Akara. 

They enter the Akara parent group name in the Parent Group column: 

 

The Human Resources group has its own subgroups. Those subgroups, Benefits and Compensations, 
are listed directly underneath the Human Resources group, and reference the Human Resources Org 
Code (org_2) as their parent group: 

 

Note: If the Benefits and Compensations groups are listed in the row before the Human Resources 
group, the upload would fail because both groups are subgroups of the Human Resources group. To 
add either group to the system, the Human Resources group must already exist - which means it must 
be created first during the upload. 

 

Grant  Multiple Waivers for a Learning Program (Batch Add) 

You can grant waivers to multiple assets for multiple users when you upload a completed waiver batch 
request. You must download and enter the information on the waiver template to grant these waivers 
at once. 

Note: You can also add or update multiple users and add or update multiple groups. 

To grant multiple Learning Program asset waivers at once 

1. Ensure you have properly completed the Waiver template. 

2. Click Users & Groups > Batch Add/Update on the navigation bar. 

By default, the Users tab displays on the Batch Add/Update page. 
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3. Click the Waivers tab.  

 

4. Click Browse.  

5. Locate the waiver template .csv file and select it. 

Note to Safari users: When using Safari to download the template, it downloads in TXT 

format, not CSV format. You must use the CSV file format for the upload. 

6. Click Upload. 

The upload and verification process begins. If you have a valid email address associated with 
your Skillport credentials, an email is sent to you that contains the URL of a status report, and 
the date and time that the batch was submitted. 

Note: Once processed, view the Batch Uploads report (Users & Groups > Batch Uploads Report on 
the navigation bar) to see the upload records. 
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Waiver CSV Template 

Use the waiver CSV template to approve multiple user waiver requests for one or more assets within a 
specified Learning Program. 

File Type 

 Must be submitted in CSV format 

 Must be encoded in UTF-8 format 

File Names 

As a best practice (not required), use a convention such as <mycompany>_waiver_<date>.csv, 

for example, skillsoft_waiver_05312014.csv. 

Upload Guidelines 

 Do not change the values in row 1 (column headers) or the import will fail. 

 Data for a column must fit in one cell. See the maximum field sizes that follow. 

 Enclose fields with embedded commas in quotes. Note that the quotes are not saved as part 

of the field value. If quotes are desired as the first and last characters of the field data, then 

you must enclose them with a second set of quotes. For example, to upload “myName”, you 

must enter ““myName””. 

Upload Format 

The following table describes each field in the waiver CSV template. All fields are required.  

Field Required? Maximum 
Text Size 

Description 

LP Asset ID Yes 240 The learning program asset identification number (for 
example, lp_leadership_001). 

Asset ID Yes 240 The asset identification number within the learning 
program (for example, lead_05_a06_bs_enus). 

User Login 
Name 

Yes 240 The Skillport user ID. 
 

Reason for 
Waiver 

Yes 240 Enter the reasons you are waiving the assets for the 
user. 
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Batch Upload Report 

When you click Users & Groups > Batch Upload Report, the View Reports page displays.  

 

The View Reports page is a list of currently-running reports, and generated reports that are ready for 
review. Select a report title to open and view the report in a new window. The report listing table shows 
the name of the user who ran the report, the date and time the report was submitted, when it was 
completed, and the format in which the report was generated. 

Reports currently generating have a - (Dash) under Date Completed and Format. The course title link 
is not available for these reports until the report generates.  

Click Refresh to see if the report is complete and ready for viewing. 

Important Note Regarding Times Displayed in CSV Reports 

You can select UTC (GMT) or Local Time for the display of certain time fields in CSV reports. Please 
refer to the Configuration | Report Configuration section for more details. 

HTML report times all appear in UTC (GMT) format. 
 

Viewing Batch Upload Reports 

Note: To enhance storage utilization and maximize report performance, saved reports are only 
available for a maximum of 30 days. Skillsoft makes every effort to ensure that saved reports are 
always available during this window; however, unforeseen maintenance may result in a loss of saved 
reports. As a result, Skillsoft strongly recommends that you save critical reports as soon as they are 
generated. 

To view and save a batch upload report 

1. Click Users & Groups > Batch Upload Report from the top navigation bar. 

The View Reports page displays. 

2. Click the name of the report you want to view. 

The report opens in a new window. 

3. Select File > Save As to save the report. 



208 ©2015 Skillsoft Skillport 8 Administrator Guide 

 

 Users and Groups 
 
 

When viewing reports, note that some reports include deactivated users, while other reports do not, as 
shown in the following table. 

Report Type Deactivated  
Users  
Included 

Deactivated  
Users Not  
Included 

Customize to 
Include/Exclude 
Deactivated Users 

Full Course Listing X   

Course Completion  X  

Custom   X 

User Activity  X  

Miscellaneous Activity X   

Course Activity Report  X  

Executive Overview X   

Course Utilization  X  

User Listing by Group X   

Evaluation   X 

Non-Participating Users X   

KnowledgeCenter Access   X 

Leadership Advantage   X 

Learning Program   X 

Credentialing  X  

 

To delete a batch upload report 

1. Click Users & Groups > Batch Upload Report from the top navigation bar. 

The View Reports page displays. 

2. To delete individual reports: 

a. Select the check box next to the name of the report(s) you wish to delete 

b. Click Delete. 

3. To delete all currently-displayed reports: 

a. Click Select All.  

b. Click Delete. 

Note: Reports marked for deletion are not retained when paging through available report pages. You 
must delete reports one page at a time. 
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Batch Upload Report Details 

To view the upload report details: 

 Click next to a report title. 

The report details display in a new window: 

 

 

Field Description 

Title The report title. 

User The user ID for the Admin who requested the report. 

Status The current status of a report request. The report status indicates if the Report 
request has been Submitted or if the request is Complete. 

Date Submitted The date and time the report request was submitted.  

Date Completed The date and time the report request was completed. 

Execution Time The amount of time taken to generate the report. 

File Name TThe location of the generated report on the site's server. 

 
 

Send Email 

If it is enabled on your site, you can use the Send Email page to send an email to a combination of 
individual users and group members. Emails sent through the Skillport system are not stored within 
Skillport for accessing at a later date; as an alternative, include yourself as one of the recipients so you 
receive and can retain a copy in your default email application. 

If you have an email address set in your profile, you are identified as the sender. If you do not, Skillport 
uses a generic and unmonitored "sender" email address (to which users cannot reply). 

Note: Do not use this feature for time-sensitive communications. For guidelines on how to test email 
delivery, contact your Learning Consultant or Application Engineer at Skillsoft. Skillsoft does not 
accept liability for non-delivery of emails due to circumstances beyond its control, such as a local 
network outage. 
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See an example email. 

 

To send an email 

1. Click Users & Groups > Send Email on the navigation bar. 

2. Specify the users to whom to send the email. 

a. Click To. 

The Email To dialog box displays; in the left pane, the users and groups to which you 
have access privileges display. 

 

b. To add users to the recipient list, select the users and/or groups in the left pane, and click 
Add. Alternatively, you can drag and drop the selection into the right pane. 

If desired, you can search for a group by group name or org code, or search for a user by 
login name, first name, last name, or email address. Use an asterisk (*) as a wild card that 
represents one or more characters. 
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You cannot enter email addresses manually; you must select the users and groups from 
the group hierarchy. You cannot add individual users who do not have a defined email 
address; these users are highlighted in red. 

If you add a group to the recipient list, both the members of the selected group and those 
in its subgroups will receive the email (if they have defined email addresses). 

c. To remove users or groups from the email, select the users or groups in the right pane, 
and click Remove. 

d. Click OK. 

Note: There is a supporting User Management system email template called Ad-hoc 
Email for this page. By default, the system template is empty. However, if your site uses a 
custom version of this template, you may see some default but editable text on the page. 
While the language-specific template that is shown to you depends on the default site 
language of your Skillport site, you can enter text in any desired language. 

3. In Subject, type the subject of the email. You can enter a maximum of 255 characters. 

4. In Body, type the email message. 

Note: The message can include a combination of plain text, symbols (accessible via the  

button), hyperlinks, and images. You cannot include fields; these controls are disabled.  

5. If desired, add a hyperlink. 

a. Select the text to convert to a hyperlink, and click . 

The Insert/edit link dialog box displays. 

b. In Link URL, enter the Uniform Resource Locator (URL).  

This value is required. The URL must be complete and begin with http://. 

c. In Target, specify whether the URL should be launched in a new browser window or the 
existing browser window.  

If you do not specify a value, the hyperlink is launched in a new window. This setting 
affects browser-based email clients only, and the recipient’s own browser settings 
determine whether or not it is respected. Non-browser-based email clients always use a 
new window. 

d. In Title, enter a short description. 

In browser-based email clients only, this appears as a tool tip when the user moves the 
cursor over the hyperlink. 

Note: The Class setting is not used. 

e. Click Insert. 

The Insert/Edit dialog box closes and the hyperlink displays in the body of the email. 

6. To remove a hyperlink, place the cursor on the link, and click . 

7. If desired, add an image. 

a. Put the cursor in the desired location, and click . 

The Insert/edit image dialog box appears. 
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b. In Image URL, enter the complete URL for the location of the image. The image must be 
a JPEG or GIF file that is hosted on a web site elsewhere. In the recipient's email, the 
URL will render as a link that, if clicked, will display the image itself. This value is required. 

c. In Image description, enter a description of the image. In text-only environments 
(browsers that cannot display inline images), this text is displayed instead of the image. 
This value is required. 

d. In Alignment, select how to align the image relative to the line of text in which it is 
inserted. For example, select Left to align the image with the left margin and have the text 
wrap around the image's right side. 

e. In Dimensions, enter in pixels the size (width x height) of the image if you want it to be 
resized before being inserted into the email. 

f. In Border, enter in pixels the width of the border to add around the image. 

g. In Vertical space, enter in pixels the width of the padding to add before and after the 
image. 

h. In Horizontal space, enter in pixels the width of the padding to add to the left and right of 
the image. 

i. Click Insert. 

 

1. If desired, format the text using the toolbar buttons in the Body. 

2. Click Send, and then click OK. 

The email is sent immediately. However, there may be a delay in when it is received, based 
on the number of recipients and other email being processed. You will receive a confirmation 
email when your email is sent. See Non-Customizable Emails on page 432 for an example 
of what this email contains. 
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Library 

The Library 

As a Skillport user with an admin or manager role, you can: 

 Manage the library by working with the assets in Skillsoft's two stock content catalogs 

(Skillsoft Library and Course Curricula catalogs) as well as all custom content. 

 Organize the content to create any number of custom libraries. Each root folder on page 228 

(top-level folder) in the Catalog is an independent library that can be created for different 

purposes, such as job roles or compentency skills to optimize content for learner browsing and 

for admin catalog assignment and entitlement purposes. For examples, see Examples of 

Library Organization. 

 

The Library page has three main areas: 

 Search panel: Use this panel at the top to specify the search criteria when you search for 

folders and assets. (For more information on this search tool, see Search for Assets and 

Folders on page 14.) 

 View Contents pane: Use this left pane to browse the Catalog in its current state or to 

browse the results of a search. For convenience, you can also use this pane to quickly 

rename or remove custom folders. 

 Edit Contents pane: Use this right pane to edit the contents of a folder, that is, to add or 

remove learning assets; to create, rename, remove, or reorganize the contents a folder; or to 

create, edit, or delete an external learning object (ELO). 

Note: A user cannot see any stock or custom content in the Library until you assign it to him or her 
directly or to a group of which he or she is a member. To access the interface with which to assign 
content to groups and individual users, click Users & Groups > User Management on the navigation 

bar. 

 

Library Workflow 

To set up the Library 

1. Customize the order and grouping of content from within the stock and custom content folders 
to best meet your organization's learning goals and objectives. 
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2. Create browse views for learners to group content according to your preferred browsing 
metaphors. 

3. Create Featured Topic folders on page 225.  

4. Assign the Curator role as a custom privilege to one or more learners. Curators can add and 
remove content from the Featured Topics area via the learner user interface (UI). 

5. Create a series to explicitly order content and convey (but not enforce) a preferred completion 
order.  

Note: If you want to enforce an order of completion for content, create a learning program. 

6.  Hide (or unhide) specific assets to display only relevant content for your organization. 

 

After you have organized your library content, you need to entitle and/or assign the content to 
learners.  

To make content available to learners 

1. Entitle content to learners. 

2. Assign content to your learners' Assigned Learning tab. 

3. Assign content to your learners' Development Plan set. 
 

Library Permissions 

Permissions by Admin Type 

 Company admins can view all content available for your site.  

 Admins and managers can view all content that they are entitled to view, i.e., all content that 

has been assigned to them. 

 Unscoped admins can create root folders (same as 7.x), and hide/unhide assets 

 Any admin can create new folders, series, and Featured Topic folders, as well as copy, move 

and remove assets and folders. 

Permissions for Folders 

Action Stock Folder Linked Folder 
(top folder) 

Linked Folder 
(subfolder) 

Custom Folder 

Copy x x x x 

Move  x  x 

Remove  x  x 

Unlink  x   

Hide x x x x 

Unhide x x x x 
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Add a custom folder  x x x 

Remove a custom 
folder 

 x x x 

Edit contents  x x x 

Edit properties  x x x 

Permissions for Assets 

Action Stock Asset 
in Stock 
Folder 

Stock Asset 
in Linked 
Folder 

Stock Asset 
in Custom 
Folder 

Linked Asset 
in Linked 
Folder 

Custo
m 
Asset 

External 
Learning 
Object (ELO) 

Copy x x x x x x 

Move     x x 

Remove  x x x x x 

Delete      x 

Hide   x  x x 

Unhide   x x x x 

Unlink       

Edit 
properties 

    x x 

 

 

 
 

Browse the Catalog 

To browse the Catalog 

1. Click Content > Library on the navigation bar. 

The Library page displays. 
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Use the left pane to browse the Catalog in its current state or to browse the results of a 
search.  

Use the right pane to edit the contents of a folder. You can add or remove learning assets; 
create, edit, remove, or reorganize the contents of a folder; or create, edit, or delete an 
external learning object (ELO). 

2. Browse the contents of the Catalog and examine its structure by expanding and collapsing the 
folders in the left pane. 

Note: Folders whose contents cannot be modified are shown with a locked icon ( ). 
 

Search the Catalog 

To search the Catalog 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In the search fields at the top of the page, enter your search criteria, and click Search. 

Note: For detailed information on the search tool, including tips on creating search 

expressions, see Search for Assets and Folders on page 14. 

Both the folders and assets that match your specified criteria are displayed on the Search 
Results tab in the left pane, as shown below in an example search for the term "java". 

 

3. To filter the search results to show only a certain type of asset, click the corresponding 
category link at the top of the results. 

4. To view more search results for a given category, click View More (shown above) for that 
category. Depending on the number of items returned and how the search settings (on page 
479) for your site are configured, there may be multiple pages of search results. 

5. To view more information about an asset, move your mouse over the asset title, and click 
Show Details. 
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If you want to identify the location of the asset in the Catalog, click View in Catalog (shown 
below). This returns you to the Browse Catalog tab with the Catalog opened to the location of 
the asset (and with the asset selected so you can easily add it to a folder in the Edit Contents 
pane using drag-and-drop). 

 

Note: Folders whose contents cannot be modified are shown with a locked icon ( ). 
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Working with Browse Views 

A browse view is a custom view folder created to: 

 Optimize content for learner browsing. 

 Optimize the content for administrator entitling and promotion. 

You can designate up to three browse views to display in the learner user interface in the Browse the 
Library link. The sub-folders in a browse view are presented to learners as topics and sub-topics in 
the Library. 

Browse views use an organizing principle that is useful for specific types of browsing, such as by job 
role, competency, or vendor. However, you might also create browse views that highlight specific 
types of learning content, align with training objectives, or other organizational objectives. See an 
example here. 

 
 

Browse View Workflow 

A browse view is an organization of content displayed to learners as a column in the Browse the 
Library menu in Skillport Learner. You can create a browse view to organize content specific to your 
organization. 

To create a browse view 

1. Create a custom view folder. 

a In Skillport Administrator, click Content > Library on the top navigation bar. 

The Library page displays. 

b In the Edit Contents pane, click New Folder. 

The New Root Folder dialog box displays. 

c Complete the required folder fields.  

For more information about these fields, see Create a Root Folder on page 228. Note that 
the Name displays as the title of the browse view, and is visible to learners in Skillport 
Learner. 

d Select the This is a Browse View check box. 
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Note: Selecting this flags the custom view to display as an available Browse View on the 

Designate Browse View page in Skillport Administrator. 

e Click Save. 

The New Root Folder dialog box closes, and the Library page refreshes, displaying the 
custom view (the new root folder) in the Browse Catalog pane. 

2. Add content to the custom view folder. 

f In the Browse Catalog pane, hover your mouse over the custom view folder.  

g Click the Edit Contents link that displays. 

The custom view folder displays in the Edit Contents pane. 

h In the Browse Catalog pane, locate the content folder(s) you wish to include in the custom view 
folder. 

i Click the folder to highlight it. 

j Click Copy. 

The content copies into the custom view folder and saves automatically. 

3. Ensure the users you wish to access this custom view folder are entitled to the content. 

k Click Users & Groups > User Management on the navigation bar. 

l In the left panel, select the user or group to which you want to entitle content.  

m In the right panel, click the Catalog Assignment tab. 

n Locate the content you added to the custom view folder in the Catalog Assignment tab. 

Note: If the content displays in the Catalog Assignment tab, the content is entitled and your 
user(s) can view the content when the Browse View is enabled. If the content does not 
display, it is not yet entitled to the user or group. 

o If necessary, entitle the content: 

a. Click Override Inherited Assignment (if a user) or Edit Group Assignments (if a 
group). 

The Catalog Assigner dialog box displays. 

b. In the Browse Catalog pane, click the custom view you created to highlight it. 

c. Click Add.  

Note: Ensure you add all the content to which you want the user entitled. Modifying a 
user's individual assignments removes the group entitlements, and only the content within 
the user's Catalog Assignment folder is available to him when he browses or searches the 
Library. 

4. Designate the custom view as a Browse View. 

p Click Content > Designate Browse View. 

q Select which view you want the custom view to display: 

 Primary View: This is the default view displayed to learners, and it displays as the first 

column in the browse view. 

 Alternate View 1: The view displays as the second column in the browse view. 
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 Alternate View 2: The view displays as the third column in the browse view. 

r In the drop-down menu, select the custom view folder you wish to display as a browse view to 
learners. 

s Click Save. 

The browse view displays the next time a learner signs into Skillport. 

 

 
 

Important Information About Browse Views 

A browse view is a top-level folder that can be created to: 

 Optimize content for learner browsing. 

 Optimize the content for admin entitling and assigning. 

You can designate up to three browse views to display in the Browse the Library link in Skillport 
Learner.  

 

Browse views are useful for browsing by organizational needs such as job roles, competencies, or 
vendors. However, you might also create browse views that highlight specific types of learning 
content, align with training objectives, or suit another purpose. 

It is important to understand the following regarding browse views: 

 All top-level folders in the Catalog—including those designated as browse views—are 

displayed in all of the areas of Skillport Administrator in which you assign content to users, for 

example, in the Learning Plan Assignment interface. 

 A learner cannot automatically view all of the assets in a browse view, only those she is 

assigned and entitled to see. 

 Because you can assign assets that are not included in a browse view, a browse view does 

not necessarily provide access to the learner's full entitlement. For example, the learner can 

also access and launch content in the following manners provided she is entitled to it: 

 She performs a search. 

 She receives an email containing the URL for accessing an asset. 
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 She is assigned an asset in her learning plan by her manager, and she receives a 

reminder email about the assignment that contains the URL for accessing the asset. 

 She clicks an asset that is shared by a community member via the Community activity 

stream. 

 In order to enforce proper display in the Library, a browse view cannot contain assets directly 

within it. All assets must be located in a folder within the Library. 

 You can designate an unlimited number of top-level folders as browse views. However, you 

can only have 3 active browse views at a time. For more information, see Designate the 

Library's Browse Views. 

Note: Browse views are available across the entire site for all users and groups, including Advanced 
Groups on page 46. 

 

Examples of Library Organization 
You can organize the catalog content in ways to create unique libraries that align content with your 
organization's training goals. You can create custom libraries that optimize learner search and browse, 
as well as separate libraries solely for the purpose of entitling and assigning content. Below are 
examples of ways to arrange assets by different subject or role metaphors.  

 

 

 Assets by Subject Matter: You can organize content 
based on pure subject areas. 
 
 

 Assets by Asset Type: Group together like assets, such 
as courses, books, videos, instructor led training, and live 
events.  
 
 

 Assets by Competency: Arrange content into 
competency categories. 
 
 

 Assets By Job/Role: Create libraries custom curated 
for specific job functions and roles within your 
organization. 
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Browse Views vs. Entitlement Views 

There are two distinct types of views of content that you can create when organizing your library: 
browse views and entitlement views. Browse views allow learners to browse for content, while 
entitlement views facilitate assigning and entitling content to learners. 

A browse view is a type of library view that: 

 Is specified as a browse view in the root folder properties. 

 Is eligible to be exposed to learners (up to a maximum of three browse views) when they 

select Browse the Library from the top of the Skillport home page. 

 May be created solely for the purpose of organizing and facilitating catalog and learning plan 

assignments. 

 Is visually indicated in the Library Manager by the  icon. 

Although you can create unlimited browse views, you can only designate up to three browse views at 
a time to be exposed in the Browse the Library area in Skillport. 

Note: Learners will only see content to which they are entitled in browse views. 

A learner's entitlement is content entitled to them via the catalog assigner or the learning plan 
assigner.  

An entitlement view is a type of library view that: 

 Groups content together for entitlement or assignment purposes. 

 Will not appear in Browse the Library in the Skillport learner user interface (UI). 

Assets can be catalog-assigned and entitled to a learner but not contained within any of the three 
exposed browse views. If this is the case, then: 

 A learner will not find the asset by browsing the library. 

 A learner can find the asset via Search. 

 A learner may see the asset in their learning plan (if assigned) and/or learning transcript (if 

previously launched). 
 

Create a Custom View Folder 

You can create a custom view folder, combining stock and custom content, for one of two purposes: 

 To designate as a custom browse view that can be exposed to learners from the Browse the 

Library link in Skillport. 

 To serve as a custom entitlement view for assignment purposes. 

To create a custom view folder 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. Create a root folder on page 228 and, if desired, specify it as a browse view in the folder 
properties. You can also edit an existing root folder's properties and set the folder as a browse 
view. 
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3. Copy folders of content and/or individual assets  on page 232from various folders into 
your custom view folder. To further customize your browse view, you can also hide/unhide 
content. Hiding/unhiding content is a site-wide action, and will affect all locations in the Library 
that contain this content.  

Note: Copying stock folders into a browse view creates linked folders that maintain a dynamic 

relationship with its parent folder, inheriting all updates to the parent folder. 

4. If your custom view folder is to be a Browse View, click Content > Designate Browse Views 
to designate the custom view as one of the browse views that you want to expose to learners 
in Browse the Library. 

5. If your custom view folder is for entitlement purposes, then you must entitle or assign the view 
to learners so that they can find the content in Skillport. 

 

Designate the Library's Browse Views 

The Library can have only 3 active browse views at any given time. These browse views designate the 
content that will appear in the Browse the Library area in the Skillport learner user interface (UI). 

Folders that you create as browse views are identified with a browse view folder icon (  ). 

To designate the Library's browse views 

1. Click Content > Designate Browse Views on the navigation bar. 

The Designate Browse View page displays. 

 

2. Select a view for each of the following settings. You can select from the stock view provided 
by Skillsoft and all of the custom views that you have created and specified as browse views. 

 Primary View: This is the default view shown to learners, and it appears as the first option 

in the browse menu. 

 Alternate View 1: (Optional) If you select a view for this setting, the view appears as the 

second option in the browse menu. 
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 Alternate View 2: (Optional) If you select a view for this setting, the view appears as the 

third option in the browse menu. 

 

3. Click Save. 

Note: Browse views are available across the entire site for all users and groups, including 

Advanced Groups. 
 

Designate the Library's Featured Topics 

You can designate a subfolder of a browse view as a Featured Topics folder. Featured topics display 
in the Featured Topics area on the What's New page in Skillport Learner. 

Note: Featured topics folders must be the lowest subfolder of the browse view folder structure. See 
the image below. 

To designate the Library's Featured Topics 

1. In a browse view folder, create a custom subfolder on page 229 and designate this folder as 
a Featured Topics folder. In the example below: 
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  Leadership is a browse view folder. 

  Manager of Leaders is a Featured Topics folder.  

For more information on folder icons, see Folder Icons. 

 

1. Copy assets into the Featured Topics folder.  

Note: Do not include child folders in a Featured Topics folder as assets contained within child 

folders will not display. 

2. Click Exit to exit the Library and save your changes. 

3. Click Content > Designate Browse View.  

The Designate Browse View page displays.  

4. Select the browse view folder as one of the three exposed browse views. 

 

5. Click Save. The browse view folder containing the featured topics folder is saved as one of the 
three exposed browse views. Learners can view these by clicking Browse the Library in 
Skillport. 

To view the changes, open Skillport Learner. The content within the featured topic folder displays in 
the Featured Topics dropdown menu on the What's New page in Skillport Learner. 
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Working with Folders 

Note: The Library contains all stock and custom content installed on your Skillport site. You can 
organize this content into one or more libraries to optimize learner browsing and searching, and to 
facilitate the entitling and assigning of content. 

 

Folder Overview 

As you customize the Catalog into libraries to meet your organization's needs, you work with several 
types of folders: 

 Stock folder: A folder of content created by Skillsoft. 

 Root folder: A folder in the top level of the Library under the Catalog folder. A root folder can 

be designated as a browse view. 

 Custom folder: This is a folder you create that is not linked to a stock folder. The contents of 

the folder are not affected by changes to the contents of any other folder.  

 Linked folder: A copy of a stock folder that maintains a dynamic relationship to the stock 

folder. If the contents of the stock folder are changed in any way (additions, changes, and 

deletions to the assets and child folders therein), the copies in the linked folder are 

automatically updated in the same manner. You cannot reorder the linked subfolders or linked 

assets within a linked folder; they remain at the top of the folder. However, you can add 

custom folders and custom assets to the bottom of the linked folder. 

If Skillsoft removes a stock folder in the Library for which you have a linked folder, the 
following occurs: 

 The linked folder becomes a custom folder (that is, the dynamic relationship is broken). If 

there are no custom assets in the folder, the folder is removed entirely. 

 All linked assets are removed. 

 All custom assets are preserved. 

For information about icons used to represent folders, see Folder Icons.  

Folder Behaviors 

 Normal: Any folder you create that is not a series folder or a featured topic folder. 

 Series: A series is a folder of assets whose order of completion is prescribed for learners. A 

series can contain assets of different types (courses and related resources). A series cannot 

contain subfolders.  

A series is often used to: 

 Group related assets together (for example, the assets required to obtain a certification). 

 Maintain a specific order when displayed in the Library. Unlike a learning program, a 

series cannot be completed, but the assets within a series may be completable. 

When a learner views the assets in a series in the Library, he views them in the fixed order 
determined by the creator of the series. In contrast, when he views other assets, he views 
them sorted and displayed by the first date they were published. Assets for which this 
publication information is not available are displayed last and in alphabetical order. 
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 Featured Topic folder: You can designate a subfolder of a browse view on page 221 as a 

featured topic folder. These folders display as featured topics on the What's New page in the 

Skillport Learner interface. Users with the role of End User or higher and the Curator custom 

user privilege can add assets to featured topics using the Skillport Learner interface. Folders 

of this type cannot contain any series folders or subfolders. 

For more information, see Designate the Library's Featured Topics on page 225. 

Support for Multiple Languages 

Every folder has the following: 

 A specified default language and a corresponding folder name in that language. 

 (Optional) One or more additional languages specified and corresponding folder names in 

those languages. 

Note: You must provide the additional language folder names. They are not auto-generated. 

In the learner interface, a learner views the folder name that matches the language in which he is 
currently browsing the Library. In the administrator interface, an administrator views the English-
language folder name if it is available. Otherwise, he views the folder name specified for the default 
language.  

For more information, see Create a Custom Folder on page 229 and Create a Root Folder on page 
228. 
 

Create a Root Folder 

You can create a new root folder to be a repository for a custom library. This allows you to structure 
the Library to optimize learner browsing, and to optimize administrator tasks, such as entitling content 
to users and groups, and assigning assets. 

To create a root folder 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In the Edit Contents pane, select the top-level Catalog folder, and then click New Folder. 

3. In the New Root Folder dialog box, specify the properties of the folder: 

 Default Language: The default language of the folder.   

 Name: (Required) The name of the folder in the selected default language. You can enter 

a maximum of 255 characters. All printable characters, including double-byte characters, 

are accepted. 

If a learner is entitled to content in the folder, he sees the folder represented as a category 
in the Library. If the learner's content language (specified in his profile) does not match 
any of the folder's alternate languages, this name is shown. 

 Alternate Languages: If your site is configured to support it, you can specify localized 

folder names. 

a. In the Alternate Languages section, click Add.  

The Add Languages dialog box displays. 
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b. In Language, select the desired language.  

c. In Name, enter the text (in the selected language) that you want to display in the user 
interface.  

d. Click OK and Add Another to specify another label, or click OK to save the label.  

4. If you want the folder to be a browse view on page 221, select This is a Browse View. 

Note: You cannot add assets directly to a browse view folder; you must add them to its 

subfolders. 

5. Click Save. 

The folder is created, and you can now populate it with subfolders and assets as needed. 
Empty folders do not display in the Library. For more information, see Copy Folders and 
Assets into Other Folders on page 232. 

6. Click Exit.  

Note: The Library is not updated with your changes until you exit the Library page.  
 

Create a Custom Folder 

You can create a custom folder in any folder whose contents can be modified. If a folder's contents 

cannot be modified, the folder is shown with a locked icon ( ). 

A custom folder can be:  

 A subfolder of a root folder, to contain assets for browse views 

 A subfolder of a linked folder 

 A subfolder of a normal folder (not a series or featured topic folder) 

To create a custom folder 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In the Browse Contents pane, browse to or search for the folder in which to create the custom 
folder. 

3. Move your mouse over the folder title, and click the Edit Contents link. 

The selected folder is displayed in the Edit Contents pane. 

4. In the Edit Contents pane, click New Folder. 

5. In the New Folder dialog box, specify properties of the folder: 

 Default Language: The default language of the folder.     

 Name: (Required) The name of the folder in the selected default language. You can enter 

a maximum of 255 characters. All printable characters including double-byte characters 

are accepted. 
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If a learner is entitled to content in the folder, the learner sees the folder represented as a 
category in the Library. If the learner's content language (specified in his profile) does not 
match any of the folder's alternate languages, this name is shown. 

 Description: A description of the folder's contents. You can enter a maximum of 4,000 

characters. All printable characters including double-byte characters are accepted. 

Learners can view the description using the View Description link at the top of the 

category. 

6. If your site is configured to support it, you can specify localized folder names: 

a. In the Alternate Languages section, click Add.  

The Add Language dialog box displays. 

b. In Language, select the desired language.  

c. In Name, enter the text (in the selected language) that you want to display in the user 
interface.  

d. In Description, enter a a description of the folder. 

e. Click OK and Add Another to specify another label, or click OK to save the label.  

7. Specify the folder type as a Normal Folder, Featured Topic Folder, or Series. 

See Folder Overview for more information. 

8. (For series folders only) To specify a custom image to use for the series folder, click Use 
custom image. Then, click Add, click Browse to navigate to the desired file, and click 
Upload.  

The image file must be a .gif, .png, or .jpg file, and can have a maximum size of 5 MB. 

9. Click Save. 

The folder is created, and you can now populate it with subfolders and assets as needed. 
Empty folders do not display in the Library. For more information, see Copy Folders and 
Assets into Other Folders on page 232. 

10. Click Exit.  

Note: The Library is not updated with your changes until you exit the Library page.  
 

Rename a Folder 

You can rename a root folder or a custom folder, but you cannot rename a folder provided with the 
stock Catalogs. 

To rename a folder 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In the Edit Contents pane, navigate to the folder that you want to rename. 

3. Move your mouse over the folder title, and click the Edit link. 

4. In Name, enter a new name for the folder. 
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The folder name can be a maximum of 255 characters, and all alphanumeric and special 
characters that you can enter using the keyboard are permitted except for double-quotes ("") 
and the backslash (\). In addition, the name must be unique with respect to all other folders in 
the same location in the Catalog. However, case-sensitivity is considered when determining 
uniqueness; for example, "Sample Curricula" and "Sample curricula" are considered two 
unique names. 

5. Click OK. 

6. Click Exit.  

Note: The Library is not updated with your changes until you exit the Library page. 
 

Unlink a Linked Folder 

Unlinking a linked folder permanently breaks the dynamic relationship that exists between it and the 
original, stock folder. The unlinked folder becomes a static "snapshot" of the stock folder at the time 
that you unlink it. If the linked folder has linked subfolders, they too are unlinked. 

You can only unlink a top-level linked folder. If you want to create a static copy of a subfolder, you 
must first copy that subfolder to a custom folder (so that it becomes a top-level folder), and then unlink 
that newly-created linked folder. 

Unlinking a linked folder is a permanent action; you cannot undo it. 

To unlink a linked folder 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In the Browse Catalog pane, browse to or search for the folder that you want to unlink. Note 
that a linked folder can only be unlinked at the folder level where the original link was created. 

3. Move your mouse over the folder title, and click the Unlink link. A Warning dialog displays 
asking you to confirm the unlink action. 

 

4. The folder, and any linked subfolders, are now unlinked. 

 

5. If desired, you can now edit, remove, or hide/unhide the folders. 

6. Click Exit.  

Note: The Library is not updated with your changes until you exit the Library page. 
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Edit a Folder's Properties 

When editing folder properties, be aware of the following: 

 You can change a normal folder to a featured topic folder if the normal folder contains no 

subfolders. You can also change a featured topic folder to a normal folder. 

 A series folder must always be created from scratch. You cannot change a normal folder or a 

featured topic folder to a series folder, nor can you change a series folder to a normal folder or 

a featured topic folder. 

 A root folder can be changed to a browse view only if it contains no assets directly within it. All 

assets must be located in subfolders. 

 You can remove a folder's designation as a browse view only if it is not currently an active 

browse view on page 221 in the Library. 

To edit a folder's properties 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In the Edit Contents pane, navigate to the folder you want to edit. 

3. Move your mouse over the folder name and click Edit. 

4. Edit the folder's properties as desired.  

Depending on the selected folder type, the folder properties will differ. For folder property 
descriptions, see Create a Custom Folder on page 229 and Create a Root Folder on page 
228. 

5. Click Save. 

6. Click Exit.  

Note: The Library is not updated with your changes until you exit the Library page.  
 

Copy Folders and Assets into Other Folders 

You can copy existing folders and assets into any other folder whose contents can be modified. If a 

folder's contents cannot be modified, the folder is shown with a locked icon ( ). Folders from the 
stock Catalogs are locked. 

 

Although you cannot modify the folders in the stock Catalog, you can copy their contents into custom 
folders, which you can then modify by removing and reorganizing the copies. 

You can copy a stock, linked, or custom folder to any of the following destinations: 

 A normal, custom folder.  

 A linked folder. 

Note: Series folders and Featured Topic folders cannot contain subfolders. 
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If you copy: 

 A stock folder, then the copy becomes a linked folder. 

 A custom folder, then the copy also becomes a custom folder. The new copy does not have 

a dynamic relationship with the custom folder that you copied. If the source folder contains any 

linked folders, the new copy also contains linked folders that are also linked to the original 

stock folders. 

 A linked folder, then the copy becomes a linked folder that is also linked to the original stock 

folder. The new copy does not have a dynamic relationship with the linked folder that you 

copied. 

Note: If the contents of the stock folder are changed in any way (additions, changes, and 
deletions to the assets and child folders therein), the copies in the linked folder are 
automatically updated in the same manner. 

To copy folders and assets into a folder 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In the Browse Catalog pane, browse to or search for the folder into which you want to copy 
one or more folders or assets. 

3. Move your mouse over the folder title, and click the Edit Contents link. 

The selected folder is displayed in the Edit Contents pane. 

4. In the Browse Catalog pane, browse to or search for the folders or assets that you want to 
copy, and then select them. 

Note: To select multiple folders or assets, use Shift-click or Ctrl-click. Also note that you can 

select a combination of folders and assets, not just one or the other. 

5. Drag and drop the selected folders and assets in the Browse Catalog pane to the desired 
folder in the Edit Contents pane. If you move your mouse over a collapsed subfolder, it 
automatically expands to allow you to drop the assets inside. 

Alternatively, you can select folders and assets in the Browse Catalog pane, select a 

destination folder in the Edit Contents pane, and then click . 

6. Click Exit. 

Note: The Library is not updated with your changes until you exit the Library page.  
 

Reorder Folders and Assets 

You can reorder the folders and assets in any folder whose contents can be modified. If a folder's 

contents cannot be modified, the folder is shown with a locked icon ( ). 

To reorder the folders and assets in a folder 

1. Click Content > Library on the navigation bar. 

The Library page displays. 
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2. In the Browse Catalog pane, browse to or search for the folder in which you want to reorder 
subfolders and assets. 

3. Move your mouse over the folder title, and click the Edit Contents link. 

The selected folder is displayed in the Edit Contents pane. 

4. In the Edit Contents pane, select the folder or asset that you want to move, then drag and 
drop it to the desired location inside of the folder. 

5. Click Exit. 

Note: The Catalog is not updated with your changes until you exit the Library page. 
 

Remove Content from a Folder 

You can remove content from any folder whose contents can be modified. If a folder's contents cannot 

be modified, the folder is shown with a locked icon ( ). Folders from the stock Skillsoft Library are 
locked. 

You can remove the following types of content: 

 An instance of an asset from the stock Library that you have copied into a custom folder. 

Removing the copy does not affect the original asset in the stock Library. 

 A custom asset in a custom folder. If this is the only instance of the asset in the Library, this 

removes the asset from both the Library and the Catalog view on the Library page in the 

Administrator UI. However, it does not permanently delete the asset from your site; the asset 

remains in an Active state in the Content Installer. This is the case regardless of how the 

custom content was initially installed (Content Installer or Skillsoft Publisher). To permanently 

remove custom content, contact your Skillsoft account team representative for assistance. 

To remove content from a folder 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In the Browse Catalog pane, browse to or search for the folder that contains the learning asset 
that you want to remove. 

3. Move your mouse over the folder title, and click the Edit Contents link. 

4. In the Edit Contents pane, move your mouse over the asset you want to remove, and click the 
Remove link. 

5. Click OK to confirm the removal. 

6. Click Exit. 

Note: The Library is not updated with your changes until you exit the Library page. 
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Remove a Folder 

You can permanently remove custom folders from the Catalog. However, you cannot remove any 
folders provided with the stock Catalog or linked contents in a linked folder. 

Removing a custom folder from the Catalog also permanently removes all child folders and learning 
assets in the folder. If the folder's contents include custom assets that are not located elsewhere in the 
Catalog, this permanently removes them from the site. Before removing a folder, carefully examine its 
contents and copy any custom assets to a different folder, if necessary. 

To remove a folder 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In the Edit Contents pane, navigate to the folder that you want to remove. 

3. Move your mouse over the folder title, and click the Remove link. 

4. In the Warning dialog box, click OK to confirm the removal. 

5. Click Exit.  

Note: The Library is not updated with your changes until you exit the Library page. 
 

Folder Icons 

The following table identifies the folder icons that you see on the Library page. 

Icon Description 

Catalog Folder 

 Top-level folder that represents the overall Catalog 

Browse Views (always root folders) 

 Stock "browse view" folder 

 Linked "browse view" folder (top-level folder) 

 Custom "browse view" folder 

Normal Folders 

 Stock folder 

 Linked folder (top-level folder) 

 Linked subfolder (subfolder) 

 Custom folder 

Series Folders 

 Stock series 

 Linked series (top-level folder) 

 Linked series (subfolder) 
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 Custom series 

Featured Topics 

 Stock "featured topic" folder 

 Linked "featured topic" folder (top-level folder) 

 Linked "featured topic" folder (subfolder) 

 Custom "featured topic" folder 
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Working with Series 

You can create a series to present assets in a fixed order and suggest an order of completion but, 
unlike a learning program, series do not enforce a completion order. 

Series are created in a custom folder that you designate a series folder. 
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Important Information about Series 

A series contains specifically-ordered assets whose order is important for learners. A series can 
contain assets of different types. It is often used to: 

 Group related assets together (for example, the assets required to obtain a certification). 

 Maintain a specific order when displayed in the Library. 

A series itself cannot be completed, but the assets within the series may be completable. 

As you work with series folders, note the following: 

A series can: 

 Provide a higher profile presentation of a content set. 

 Implicitly convey an order of completion. 

 Have its own image. 

 Only contain certain asset types. (See Types of assets you can add to a series, below.) 

A series cannot: 

 Force a learner to complete assets in a certain order. If you want to do this, create a learning 

program. 

 Contain other folders. 

 Be a Featured Topics folder. 

 Flip between series and non-series folder designation. 

Types of assets you can add to a series 

 Courses 

 Simulations 

 LLC 

 Assessments 

 Learning Programs 

 Business Impact & Challenges 

 Learning Sparks 

 Projects 

 Practice Labs 

 Mentoring 

 Express Guides 

Series subsets 
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A series subset is a grouping of specific items within a series.  

Note: A series subset is live - any asset added to the series displays to learners when they next sign 

in. 

 

Create a Series 

You can create a series, which is a folder of content that you explicitly order to suggest a specific order 
of completion. You can assign a custom image to the series that will display when learners view the 
folder when they browse the library. 

 

To create a series 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In the Browse Catalog pane, browse to or search for the folder where you want to create the 
series folder.  

3. Move your mouse over the folder title, and click the Edit Contents link. 

Note: The Edit Contents link only appears beside folders whose contents can be modified.  

4. In the Edit Contents pane, click New Folder. 

The New folder dialog box displays.  

5. Fill in the desired fields: 

 Default Language: The default language of the folder.   

 Name: (Required) The name of the folder in the selected default language. You can enter 

a maximum of 255 characters. All printable characters, including double-byte characters, 

are accepted. 

If a learner is entitled to content in the folder, the learner sees the folder represented as a 
category in the Library. If the learner's content language (specified in his profile) does not 
match any of the folder's alternate languages, this name is shown. 

 Alternate Languages: If your site is configured to support it, you can specify localized 

folder names. 

a. In the Alternate Languages section, click Add.  

The Add Languages dialog box displays. 

b. In Language, select the desired language.  

c. In Name, enter the text (in the selected language) that you want to display in the user 
interface.  

d. Click OK and Add Another to specify another label, or click OK to save the label.  

6. Select the Series radio button.  

7. Select one of the following: 
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 Use standard image: Uses a standard image provided by Skillsoft. 

 Use custom image: Click Add, click Browse to locate a custom image to display to your 

learners when viewing the custom series folder, and then click Upload. 

Note: Image file size is limited to 5 MB and must be .gif, .png., or .jpg formats. 

8. Click Save. The series folder is created and is marked with the  folder icon. You can now 
populate it with stock and/or custom assets as needed. For more information, see Copy 
Assets into Other Folders.  

9. Click Exit.  

Note: The Library is not updated with your changes until you exit the Library page. 
 

Edit a Series' Contents 

You can edit the content in a series by adding, rearranging, removing content from, or hiding/unhiding 
content in the series folder. 

To edit a series' content 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In the Browse Catalog pane, browse to or search for the series that you want to edit. 

3. At the top level Catalog folder, select Edit Contents. 

4. In the Edit Contents pane, select the series folder and click Edit. 

The series folder opens and the content displays.  

5. Do any of the following: 

 Reorder assets by by dragging and dropping into their desired location in the folder. 

 Remove assets by selecting the asset and clicking Remove. 

 Hide/Unhide assets by selecting the asset and clicking Hide/Unhide. 

6. Click OK.  

Note: The Library is not updated with your changes until you exit the Library page. 
 

Remove a Series 

You can remove a series, which deletes the folder and all of its contents, from the Library. The 
individual assets, if copied from a stock folder, still exist in the Library. 

To remove a custom series 

1. Click Content > Library. 

The Library Manager displays. 

2. In the Browse Catalog pane, browse to or search for the series that you want to remove. 
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3. At the top level Catalog folder, select Edit Contents. 

4. In the Edit Contents pane, select the series folder and click Remove. 

A warning messages displays that you are about to permanently remove the series folder and 
all of its contents.  

5. Click OK.  

6. The series folder is removed. 

Notes: Removing a series is an unrecoverable action; you cannot undo it. The content may still be 
discoverable via search or browse if the asset(s) were contained in a different folder or hierarchy in the 
Library. 
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Working with Assets in the Library 

What is a Stock Asset? 

Stock assets are content items created by Skillsoft. These are contained in the two main Skillsoft 
catalog folders: 

 Course Curricula (Skillsoft legacy content) 

 Skillsoft Library (Skillsoft content that is unified with books and video content, and arranged by 

subject matter) 

Actions you can take with stock content include: 

 Copy stock assets from one customized library to another 

 Hide or unhide stock assets within a library 

 Entitle stock assets to learners, so they can search and browse for them 

 Assign or deassign stock assets to learning plans, so learners have direct access in the 

Assigned Learning tab of their learning plans 

Default icons for Skillsoft's stock assets include the following: 

Icon in the 
Catalog 
(Skillport 
Administrator) 

Icon in the 
Learning Plan 
(Skillport 
Learner) 

Content Type 

  Courses 

A course is web-based instructional content delivered to you on your 
computer. During a course, you practice and are assessed on your 
mastery of the skills and knowledge learned in the course. 

The following types of courses are examples of what may be 
available in your Library: 

 Business Skills 

 Certifications 

 Compliance  

Note: Compliance courses assigned from the Advanced 
Compliance feature set display in the learning plan with a 

badge symbol  on the course icon. This is applicable only 
if Advanced Compliance is enabled for your site. 

 Desktop Skills 

 IT Skills 

 Instructor-Led Training (ILT) 
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Simulations 
A SkillSim (Skillsoft simulation) is a technology-enabled simulation 
that puts you in an authentic business or professional situation. 

You play a major role in a variety of simulated interactions where 
your decisions have a direct impact on the course of events and 
result in realistic consequences. The SkillSim is designed to help 
you practice or assess your mastery of skills and knowledge learned 
in a series of Skillsoft courses. As you progress through a series of 
scenes, you will receive feedback on your performance. To assist 
you, the simulation incorporates links to context-sensitive Skillsoft 
course material. 

 

  Live Learning Courses (LLC) 

Live Learning courses are a derivative of traditional, instructor-led 
technical training. Instead of gathering students in a physical 
location, lectures are delivered to participants with streaming audio, 
video presentations, and application sharing over the Internet. 
Lectures are also available as recordings for on-demand viewing. 
Live Learning courses are hosted and delivered as a collection of 
launchables; once you enroll in a Live Learning course, all of its 
assets become available to you on the course summary page. 

  
Live Learning: Expert  Live Sessions: Live Learning Expert Live 
sessions are live, webcast instructional sessions taught at specific, 
scheduled dates and times by a team of expert instructors. 

 

  
Live Learning: Expert Encore Sessions: Recorded sessions for on-
demand viewing or reviewing of Expert Live sessions. 

 

  Books: Analyst Perspectives 

Summaries of the views of many different analyst firms. Analyst 
Perspectives provide insight into their research and opinions on IT 
and telecommunications in a context that helps planners and 
decision makers at all levels make better informed decisions. With 
hundreds of research firms tracking the technology industry, Analyst 
Perspectives help you to select and apply the right reports to your 
business needs. 

 

 

 Books: Blueprints 

Authored by C-level business executives, Blueprints provide nuts 
and bolts information to help formulate planning and action of 
strategies. 

 

  Books: Summaries 

Summaries are summaries of leading business books from today's 
foremost business authors. Summaries expertly encapsulate the 
salient points and ideas of full-length books into digestible, 8-page 
summaries. Unlike excerpts or reviews, Summaries skillfully distill 
the essence of the author's work, conveying content, style and spirit. 
Designed for ease-of-use with short passages, bulleted lists, and 
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other useful elements, these thorough, yet concise high-level 
overviews represent cutting-edge ideas that are shaping today's 
business environment 

  Books: Journals 

Journals are issues of a given publication released on a periodic 
basis. 

  Books: Newsletters 

Newletters are short-form text documents containing news and other 
topical information. 

  Books: Recorded Sessions 

Recorded Sessions are recorded audio conversations with leading 
business book authors. (transcripts are included) 

  Books: Reports 

Reports are short-form text documents covering a specific business 
or technical topic. 

  Books: Audio books 

Certain collections of books have audio editions available for 
download in MP3 format. 

  Business Exploration Series: Courses  

Business Exploration Series courses (Business Impact Series and 
Challenges) provide learners with engaging, visually rich, scenario-
based learning that enables them to experience real world situations 
in safe, exploratory environments. These learning assets use video 
and Flash to make the learning experience engaging and authentic. 

  Business Exploration Series: Business Impact Series 

Media-rich dramatizations of frequently encountered business 
problems. Use these to pick up on best practices and things to avoid 
in various business scenarios. 

  Business Exploration Series: Challenges 

Media-rich case studies focused on content analysis, problem 
solving, and decision making. Each challenge presents learners with 
a specific objective or goal, along with related discovery material 
and multiple potential solutions. Learners are challenged to analyze 
a business problem and discovery material, select one of several 
potential solutions, and then defend or justify their selections by 
answering questions about the selected outcome. 



Skillport 8 Administrator Guide ©2015 Skillsoft  245 
 

Content   
 
 

  Express Guides™  
Express guides are electronically-delivered equivalents of the 
student guides that IT professionals receive when they attend 
instructor-led training classes. They consist primarily of text and 
graphics and do not contain interactive practice questions or 
assessments. 

  Job Aids 

Job aids are standalone documents that support the transfer of 
knowledge and skills from courses to the workplace. They are 
performance-support tools designed to be used on an ongoing 
basis, or around a specific work-focused events, such as 
performance reviews, interviewing, or strategic planning. Job aids 
are not dependent on course content. 

If a job aid is available for a particular course, you can launch it from 
the course summary page. 

  Learning Sparks 

Learning Sparks are interactive assets designed primarily for 
information technology subjects such as Cisco and IT Security. 

  Practice Labs 

Practice labs are designed to help you practice and assess your 
current skill levels and maintain ongoing expertise. An expert 
introduction provides you with insights and key pointers to the core 
skills practiced in the lab. After the introduction, you work in a 
learning environment that replicates a real-world job situation, and 
you complete hands-on exercises designed to build a rounded 
aggregation of competencies and skills. 

  Projects 

Projects give IT professionals the opportunity to test their skills in 
structured learning environments that reflect real-world situations. 
They consist of extensive programs of unified, integrated projects 
that challenge developers to solve practical business problems, and 
they foster the acquisition of core programming skills. 

Use a hosted IDE or Microsoft Visual Studio to build a robust 
business application by completing a series of coding projects. 
Skillsoft's innovative code judging application can evaluate your 
solutions, provide targeted feedback, and pinpoint helpful reference 
materials. 

  SkillBriefs 

SkillBriefs are single-page, condensed summaries of the 
instructional content of a course topic. Use SkillBriefs as an instant 
reference after you have completed a course. 

If a SkillBrief is available for a particular course, you can launch it 
from the course summary page. 
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  Mentoring 

Mentoring provides a convenient way of accessing the Ask My 
Mentor feature for a particular course or certification path. Mentoring 
assets map to specific certification exams, and, therefore, they 
appear in the Library beneath applicable exams in a certification-
related curricula folder. 

You can access mentoring support by clicking  in one of the 
following locations: 

 A course summary page that has a related mentoring 

offering. Browse the certification-related categories in the 

Library, or use search. 

 The objectives screen of a mentored exercise. 

The Ask My Mentor page allows you to take advantage of three 
types of mentoring: live chats, questions and answers by email, and 
daily messages. 

 Chat with a Mentor: If you have a quick question about a 

course or certification, your mentoring team can provide you 

with a quick answer. To enter a live chat with a mentor, click 

Chat with a Mentor. 

 Email My Mentor: If you have a detailed question about a 

course or certification, your Mentoring Team can provide 

you with a detailed answer via email. To email a mentor, 

click Email My Mentor. 

 Change Daily Email Options: You can receive daily email 

messages that contain questions and information relevant to 

the specific certification. To activate this feature and specify 

the frequency with which to receive messages, click 

Change Daily Email Options. 

 

  Videos 

Videos covers a variety of business- and leadership-related themes. 
Videos include: 

 Leadership QuickTalks 

 CEO QuickTalks 

 On-Demand versions of Live Events 

 Live Video Events 

  Live Events 

Live Events are scheduled live and interactive forums during which 
recognized thought leaders offer cutting edge thinking on a 
leadership topic. Live Events are recorded for viewing at a later 
date. 
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  Skillsoft Advantage 

Skillsoft Advantage (SA) is a series of targeted development 
programs comprised of a collection of learning assets that have 
been thoughtfully selected and organized by industry experts. 

Individual learning tracks offer a combination of new and existing 
assets that combine multiple modes of instruction, including text, 
video, and interactive practice activities that are intended to keep 
the learning quick and engaging. Each track is designed to take no 
more than two hours to complete, although you can complete as 
much or as little of any track at one time. 

  
KnowledgeCenters 
A KnowledgeCenter™ is a pre-packaged, user-friendly learning 
portal that allows learners instant access to trusted, targeted 
content. Each KnowledgeCenter includes material selected by 
subject matter experts to help learners build knowledge around a 
topic quickly and efficiently. KnowledgeCenter materials can include 
featured topics refreshed on a monthly basis, online books and 
reference materials, Skillsoft courses, Live Learning courses and 
their related assets, SkillSims, practice labs, projects, and more. 

  TestPrep Exam 

TestPrep Exams are practice tests that help you prepare for a 
certification exam by testing your knowledge in a simulated 
certification testing environment. You can take a TestPrep exam in 
Study Mode (where you receive feedback after each question) or in 
Certification Mode (designed to mimic a certification exam). 

  Final Exam 

These are final tests associated with a series of courses or learning 
path. Questions are drawn from all courses in the series to create an 
inclusive exam to test your knowledge of the subject matter. You 
demonstrate your competency with the associated courseware by 
successfully completing the final exam. In some cases, you must 
complete a final exam in order to earn college credits or to meet the 
requirements for professional-level certifications. 
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  Evaluations 

Some learning assets, such as courses and learning programs, can 
have associated evaluation forms that allow you to provide feedback 
about your experience. In some cases, courses that you take as part 
of a credential require that you complete an evaluation in order to 
receive credit for the course. 

If you complete an asset that has an associated evaluation, an 
evaluation is automatically added to the Assigned Learning tab of 
your learning plan. (Evaluations for learning programs and Live 
Learning courses are only added after the entire program or course 
is completed.) After you complete the evaluation, it is then 
automatically removed from your learning plan. 

If the evaluation is optional, you do not have to complete it, and you 
can remove it from your learning plan at any time. 

If the evaluation is required, you can only remove it from your 
learning plan by completing it. Each time you sign in to Skillport, you 
are reminded to complete the required evaluation. 

 
 

What is a Custom Asset? 

Custom assets are those created specifically for your organization, such as external learning objects 
(ELOs), Instructor-led training (ILT) courses and sessions, Dialogue Live sessions, and custom 
courses uploaded using Skillsoft Publisher. 

Actions you can take with custom assets include: 

 Copy custom assets from one customized library to another 

 Hide or unhide custom assets within a library 

 Entitle custom assets to learners, so they can search and browse for them 

 Assign or deassign custom assets to learning plans, so learners have direct access in the 

Assigned Learning tab of their learning plans 

Default icons for custom assets vary; you can upload your own image, or use the default icons: 

Icon in the 
Catalog 
(Skillport 
Administra
tor) 

Icon in the 
Learning 
Plan 
(Skillport 
Learner) 

Content Type 

  Custom Course 

A custom course is organization-specific web-based instructional content 
delivered to you on your computer. During a custom course, you practice and 
are assessed on your mastery of the skills and knowledge learned in the 
course. 
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  Instructor Led Training (ILT) Courses 

Instructor Led Training (ILT) courses are scheduled courses that you attend 
at a specific time. An ILT course can have one or more sessions, which are 
scheduled instances of the course. There are 2 types of ILT sessions: 

 ILT physical sessions: These sessions are held at physical 

locations, for example, a classroom or conference room. 

 ILT virtual sessions: These sessions are delivered online via web 

conferencing applications. 

You can enroll yourself in an ILT session, or your manager or training 
administrator can enroll you. Depending on the configuration of your site, 
your manager may need to approve the enrollment if you enroll yourself. If 
your manager enrolls you, you are notified by email of the location, duration, 
time, and date of the scheduled session. 

If sessions of a course are currently unavailable (that is, there are no 
scheduled sessions or all scheduled sessions are full), you can add an ILT 
course to your watchlist in order to be notified when a new session is 
scheduled. 

  Learning Programs 

A Learning Program is a collection of learning assets that are grouped 
together based on subject matter, target audience, learning goal, or another 
organizing principle. Learning programs can include required and elective 
assets, have a defined structure that requires completion in a prescribed 
order, and a learner's progress can be tracked. 

 

  
External Learning Objects (ELOs) 

An external learning object (ELO) is a reference to a learning activity or 
resource such as: 

 A membership in a professional association 

 A subscription to, or an article in, a journal or magazine 

 An on-the-job or off-the-job experience 

 A web site (for example, http://www.mywebsite.com/usefulinfo.html) 

 An Internet newsgroup 

 An in-house policy and procedure manual (for example, 

http://www.mywebsite.com/manuals/newemployeemanual.pdf) 

External learning objects can be displayed, and searched for, in the Library. 
However, Skillport cannot track their completion by learners. 

 



250 ©2015 Skillsoft Skillport 8 Administrator Guide 

 

 Content 
 
 

Custom Image Specifications 

Custom images must follow these guidelines: 

 Size: Up to 5 MB 

 Format: .jpg, .gif, .png  

 Dimensions: 125 pixels x 138 pixels 

Note: Skillport automatically resizes custom images depending on where they display (such as in the 
learning plan or in search results.) 
 

Copy an Asset 

You can include an asset in multiple libraries by copying it into different folders. Valid folder 
destinations are: 

 A custom folder or linked folder. 

 A custom series or linked series, if the selections in the Browse Catalog pane are resources 

and courses only (no books). 

Note: You cannot copy an asset into a root folder that is a browse view, nor into a stock folder (as 

these are locked and not disabled for editing). 

To copy an asset 

1. Click Content > Library on the navigation bar.  

The Library page displays. 

2. In the Browse Catalog pane, browse to or search for the folder into which you want to copy 
one or more assets. 

3. Move the mouse over the folder title, and click the Edit Contents link. 

The selected folder displays in the Edit Contents pane. 

4. In the Browse Catalog pane, browse to or search for the asset(s) that you want to copy, and 
then select them. To select multiple assets, use Shift-click or Ctrl-click. 

5. Drag and drop the selected assets in the Browse Catalog pane to the desired folder in the Edit 
Contents pane. If you hover your mouse over a collapsed subfolder, it automatically expands 
to allow you to drop the assets inside. 

6. Alternatively, you can select assets in the Browse Catalog pane, select a destination folder in 
the Edit Contents pane, and click the arrow icon displayed on Library page for copying assets 
into different folders. 

7. Click Exit. 

Note: The Library is not updated with your changes until you exit the Library page. 
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Hide or Unhide Assets 

You can hide assets to remove them from the view of other administrators and learners without having 
to reorganize the Catalog. You can hide all types of assets, except for Instructor Led Training (ILT) 
courses, books, videos, Live Events, SkillBriefs, job aids, and portals (such as KnowledgeCenters). 
You must be a company administrator to hide or unhide assets. 

Note: The Library contains all stock and custom content installed on your Skillport site. You can 
organize this content into one or more libraries to optimize learner browsing and searching, and to 
facilitate the entitling and assigning of content. 

When you hide an asset: 

 It is marked as hidden (grayed out) in the Catalog. If there are multiple instances in the 

Catalog, all of the instances are marked as hidden. 

 It is hidden from all learners in the Library, Community, and Search. 

 It cannot be launched (for example, via a link in an email). 

 It continues to display in a learner's Learning Plan and Learning Transcript, if he has already 

made progress on the asset.  

 It continues to be viewable in reports. Hidden assets can still be selected as filter criteria in the 

Reports user interface.  

If you hide all the assets in a particular folder, and then later add an asset to that folder, the new asset 
does not inherit the hidden state of the other assets in the folder. 

To hide one or more assets 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In the Edit Contents pane, navigate to the folder containing the asset(s) you want to hide. 

3. To hide a single asset: 

a. Expand the folder to display the assets in the folder. 

b. Move your mouse over the desired asset, then click the Hide link. 

4. To hide all the assets in a folder:  

Note: When you specify a folder of assets to hide, only the assets contained in the folder are 

hidden; the folder and any subfolders remain visible. 

a. Move your mouse over the desired folder, then click the Hide/Unhide link.  

b. In the confirmation dialog box, click Hide All Assets. 

5. Click Exit. 

Note: The Library is not updated with your changes until you exit the Library page. 

To unhide one or more assets 

1. Click Content > Library on the navigation bar. 
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The Library page displays. 

2. In the Edit Contents pane, navigate to the folder containing the asset(s) you want to unhide. 

3. To unhide a single asset: 

a. Expand the folder to display the assets in the folder. 

b. Move your mouse over the desired asset, then click the Unhide link. 

4. To unhide all the assets in a folder:  

a. Move your mouse over the desired folder, then click the Hide/Unhide link. 

b. In the confirmation dialog box, click Unhide All Assets. 

5. Click Exit. 

Note: The Library is not updated with your changes until you exit the Library page. 
 

Edit a Custom Asset's Image 

External learning objects (ELOs) created within Skillport, as well as custom assets created outside of 
Skillport and then uploaded to your site, can use either a standard image provided by Skillsoft (the 
default) or a custom one that you upload. 

To edit a custom asset's image 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In the Edit Contents pane, expand the Publisher Custom Content folder (with the lock icon) 
and locate the desired custom asset. 

3. Hover the cursor over the custom asset, and click the Edit link. 

The Edit Asset dialog box displays. 

4. Select Use custom image.  

5. Click Add. 

6. Click Browse to navigate to the desired image file. 

 Custom images must follow these guidelines: 

 Size: Up to 5 MB 

 Format: .jpg, .gif, .png  

 Dimensions: 125 pixels x 138 pixels 

Note: Skillport automatically resizes custom images depending on where they display (such 

as in the learning plan or in search results.) 

7. Click Upload. 

8. Click Save. 
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Content Types 

Skillsoft supports a wide variety of content types which can be divided into two basic categories: Active 
and Passive content. 
 

About Active Content 
Active Content (or trackable content) uses standardized commands to communicate student progress 
results to a standards-conformant learning management system (LMS) such as Skillport. Trackable 
content consists of the course content files and a file set (either third-party or Skillport-proprietary) 
designed to enable the LMS to understand the structure and communication protocol of the course.  

Skillport supports three basic types of active or trackable content:   

 Assets in the Skillsoft standard library that include an end user assessment or test are 

considered active.    

 Courses 

 Simulations (SkillSims): Note that learners must select the option to take the Simulation in 

Score mode upon launch or the asset will NOT track as complete. 

 TestPrep Exams 

 AICC third-party content hosted in Skillsoft environment 

 SCORM third-party content hosted in Skillsoft environment 
 

Active Content Types 
Below is a list of currently supported active content types. 

 Skillsoft Stock Library courses 

 Course Topics 

 Custom Courses 

 SkillStudio courses (both generated from or modified in SkillStudio) 

 Dialogue Design courses (provided they contain assessments) 

 Courses generated in third-party tools 

Note: Follow the authoring guidelines for AICC/SCORM content authoring to ensure that 

your content will be trackable and completable.  

 Final Exams* 

 Instructor Led Training (ILT) Course 

 Learning Events 

Note: By default, Learning Events are passive but can be configured to be completable. 

 Resources 

 Projects 

 Practice Labs 
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 Series 

Note: Content in a series may be completable (active), but the series itself is not completable. 

 Simulations 

 TestPrep Exams* 

* To complete this type of asset, you must obtain the minimum score. 
 

About Passive Content 
Passive Content (or non-trackable content) is typically used to supplement or enhance the learning 
experience as additional reference or resource material.  

 Passive content does not communicate with Skillport or third-party LMS systems in any way. 

 Skillport does record the date and number of times passive content is accessed and by whom. 

 Skillport does not track the duration, score, or completion status for this content. The status of 

any passive object will be indicated as In Progress after that content item has been launched. 

  

 Typical file formats that are considered passive include .pdf, .doc, .xls, .zip, .txt, and .htm.  

Examples of passive content include white papers, articles, Microsoft Office files, and media 

files. 

 Any External Learning Object (ELO) published in Skillport is considered passive. 

 All content (regardless of file format) hosted outside the Skillport hosting environment is 

considered passive.   

 
 

Passive Content Types 
While passive content can be launched and tracked, and reported on (first access and last access 
dates), it cannot be completed. 

Below is a list of currently supported passive content types. 

 Books: All books and book sections, including: 

 Newsletters 

 Recorded Sessions 

 Reports 

 Summaries 

 External Learning Objects (ELOs) 

 Learning Events 

Note: Learning Events by default are passive but can be configured to be completable. 

 Learning Portals 

 Business Exploration Series 
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 Knowledge Centers 

 Skillsoft Advantage Products 

 Resources 

 Business Impacts 

 Business Challenges 

 Job Aids 

 Learning Sparks 

 Live Learning Mentoring 

 SkillBriefs 

 Videocasts 

 Mentoring 

 Videos 
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Learning Programs 

A learning program consists of folders and learning content with specified orders and completion 
criteria.  

 

The root folder defines the basic attributes of the learning program and can have both learning assets 
and child folders. Each child folder can have its own completion criteria. These child folders can 
contain learning assets and child folders of their own. 
 

Important Information about Learning Programs 

Learner Enrollment 

You can enroll a learner into a learning program in one of two ways: 

1. Enroll the learner individually. 

2. Enroll the group in which the learner is a member. 

These enrollments are treated independently. If you enroll a group, and later withdraw a member of 
that group from the learning program, the rest of the group is unaffected. Also, if you enroll an 
individual learner, then enroll a group to which that learner is a member, the learner is not double-
assigned.  

Group Enrollment 

Note the following: 

 If you remove a learner from an enrolled group, he is automatically withdrawn from the 

learning program unless he has already completed it. No further steps need to be taken. 

 If you remove a learner from an enrolled group, his completion data for the learning program 

(In Progress or Completed) remains in the system, even if he has not made any progress 

within the learning program. 

 If you add additional members to an enrolled group, those learners are automatically enrolled 

in the learning program.  

Exception: If you add a new subgroup directly under the ALL USERS group (visible only to 
Company Admins), those members are not automatically enrolled. You must enroll them 
individually, or add them to a different group. 
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Completion Status 

Enrolling in a learning program is considered the first step of starting the program or course; as a 
result, the learning content is automatically displayed in the learner's learning transcript immediately 
upon enrollment. For more information about completion status, see Learning Program Completion 
Criteria. 

Learning Programs within a KnowledgeCenter 

If a learning program is used in a KnowledgeCenter roadmap, learners must be assigned and enrolled 
in the learning program before they can see it in the KnowledgeCenter. If they are not assigned, they 
will see an error message. If they are assigned but not enrolled, the learning program appears empty 
in the KnowledgeCenter roadmap details page. 

Content Types 

You can add the following content types to learning programs: 

 Books 

 Courses  

 Express Guides 

 Instructor-led Training Courses 

 Folders 

 Job Aids 

 Learning Sparks 

 Mentoring 

 Practice Labs 

 Projects 

 Simulations 

 SkillBriefs 

 TestPrep Exams 

 Videocasts 

 Videos 
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Learning Program Completion Criteria 

Learning programs are presented in a hierarchical (tree view) form, and completion of a learning 
program is determined by the completion criteria specified for it. A folder's rules are imposed on its 
immediate children unless a child is a folder with its own rules, in which case the child folder's rules 
apply. 

The completion criteria for a folder can be one of the following: 

 Complete All: Complete all courses in the folder in any order. 

 Complete In Order: Complete all courses in the folder in a specific, forced order. A learner 

must complete the first course before the link for the second course becomes active, and so 

on. 

 Complete Any {N}: Complete a specified number of the courses in the folder, for example, 

"Complete Any 3." You must specify the number of courses that must be completed. 

 Optional: No courses in the folder need to be completed. 

Note: If all the assets in a learning program are optional, a learner's status in the learning 
program is automatically changed to Completed when he enrolls. This is because there are 
no requirements for completion. Furthermore, if you subsequently change the learning 
program's completion criteria, the learner's status of Completed remains unaffected. 

As a learner completes a learning program, he receives a % Completed score. This value is 
determined by dividing the number of completed courses by the total number of courses in the 
learning program. Learning assets for which progress cannot be tracked (for example, a document or 
a hyperlink) are not included in this calculation. 
 

Create a Learning Program 

You can create a new learning program from scratch. However, if an existing learning program closely 
resembles the desired program, you can copy the existing learning program instead and then modify 
its contents as needed. For more information, see Copy a Learning Program on page 261.  

To create a learning program 

1. Click Content > Learning Programs on the navigation bar. 

The Manage Learning Programs page displays, which lists the learning programs created on 
your site. 

2. Click New Learning Program. 
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The New Learning Program dialog box displays: 

 

3. Enter the information. An asterisk (*) indicates a required field.  

Property Description 

Name* The name of the learning program. 

ID* Uniquely identifies the learning program in the system. This value 
can be a maximum of 250 alphanumeric characters, and cannot 
begin with an underscore. If you do not enter an ID, one is 
automatically generated. 

Requires Approval to Enroll Select this option if learners must request approval from their 
designated approval managers to enroll in the learning program. 

If you select this option, learners who are not enrolled cannot access 
the learning assets in the learning program. 

Content Language* This setting determines where the learning program displays when a 
user searches or browses within a selected language. Select Not 
Specified to ensure it displays in all searches regardless of a 
learner's selected content language, or select a language to include 
it only when a learner searches within that language. 

Completion The completion criteria for the root folder in the learning program: 

 Complete all items: Learners must complete all of the 

items in the folder, but they can do so in any order. 

 Complete all items in order: Learners must complete all of 

the items in the folder in a specific, forced order. In other 

words, a learner must complete the first item before the link 

for the second item becomes active, and so on. 

 Complete any <N> items: Learners must complete a 

specified number (N) of items in the folder, but they can do 
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so in any order. You must specify the number of items that 

must be completed. 

 Learning Program is optional and does not have to be 

completed: Learners do not have to complete any of the 

items in the root folder, nor do they have to complete any of 

the items in any child folders. If you select this option, a 

learner is considered to have completed the learning 

program as soon as he or she has enrolled. 

Image Specify the image to display for the learning program:   

 Use standard image: This is the default setting.  

 Use custom image: Click Add, click Browse to browse for 

the desired file, then click Upload to upload the image. The 

image must be either a .png, .gif, or .jpg file, and can have a 

maximum size of 5MB. 

Description A description of the contents of the learning program. This value 
must be 4,000 characters or less. 

Objectives The objectives (goals) of the learning program. This value must be 
4,000 characters or less. 

Internal Notes Any information you want to note for administrators about the 
learning program. These notes do not display on the learning 
program summary page that learners can view. This value must be 
4,000 characters or less. 

1. Click Save. 

2. Click OK. 

Note: The learning program is added to the Manage Learning Programs page, and added as 
the last asset in the Learning Programs folder in the Catalog. Therefore, if you have assigned 
the Learning Programs folder to any groups or individual users, the learning program is now 
accessible to them by browsing the Library and by using Search (once the next run of Search 
indexing has occurred for your site). 

The Edit Learning Program page displays, showing the Catalog in the left pane and the 
learning program root folder in the right pane. 
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3. Add learning assets to the root folder, and add child folders (to contain related learning assets) 
to the root folder, as appropriate.  

For help with this step, see Edit a Learning Program on page 263. 

Note: Assigning a Learning Program with an empty folder can cause incorrect values in report 
data for the Status and Percent Started fields.  

4. Click Save, then click Exit. 

5. If desired, relocate the learning program or copy it into additional catalog folders.  

To get started with this, select Admin Home in the upper-right corner, then click Organize the 
catalog on the Admin Home tab. For more information, see Library on page 214. 

6. If desired, assign the learning program to one or more groups or individual users.  

To get started with this, select the learning program, and click Manage Enrollments. For 
more information, see Enroll Users or Groups on page 176. 

 

Copy a Learning Program 

If an existing learning program closely resembles the desired program, you can copy the existing 
program and modify its contents as needed. 

To copy a learning program 

1. Click Content > Learning Programs on the navigation bar. 

The Manage Learning Programs page displays, which lists the learning programs created on 
your site. 

2. Select the learning program that you want to copy, and click Copy at the top of the page. 

3. In the Copy Learning Program dialog box, modify the learning program properties as desired. 
For more information about the properties, see Create a Learning Program on page 258. 

4. Click Save, then click OK. 

The Edit Learning Program page displays. The new learning program (shown in the right 
pane) contains all the assets in the original learning program. 

Note: The learning program is added to the Manage Learning Programs page, and added as 
the last asset in the Learning Programs folder in the Catalog. Therefore, if you have assigned 
the Learning Programs folder to any groups or individual users, the learning program is now 
accessible to them by browsing the Library and by using Search (once the next run of Search 
indexing has occurred for your site). 

5. If desired, edit the learning assets and folders in the learning program. For help with this step, 
see Edit a Learning Program on page 263. 

6. Click Save, then click Exit. 

7. If desired, relocate the learning program or copy it into additional catalog folders. To get 
started with this, select Admin Home in the upper-right corner, then click Organize the 
catalog on the Admin Home tab. For more information, see Library on page 214. 

8. If desired, assign the learning program to one or more groups or individual users. To get 
started with this, select the learning program, and click Manage Enrollments. For more 
information, see Enroll Users or Groups on page 176. 
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Edit a Learning Program 

You can modify a learning program in several ways. Prior to editing a learning program, you must 
open it for editing (that is, display the Edit Learning Program page). 

To open a learning program for editing 

1. Click Content > Learning Programs on the navigation bar. 

The Manage Learning Programs page displays, which lists the learning programs created on 
your site. 

2. Select the learning program that you want to edit, and click Edit. 

The Edit Learning Program page displays, with the contents of the learning program displayed 
in the right pane. Note that both the left pane and the right pane are resizable. 

 

Add or Remove Assets from Folders 

To add a learning asset to a learning program 

1. Open the learning program for editing. 

2. In the Browse Catalog pane, locate the asset that you want to add to the learning program. 
You can do this in one of two ways: 

 Browse the Catalog by navigating through its structure. 

 Search for the asset using the search fields at the top of the page. For detailed 

information on the search tool, including tips on creating search expressions, see Search 

for Assets and Folders on page 14. 

3. To add the asset: 

a. Select the title of the asset in the Browse Catalog pane, and drag it to the Edit Contents 
pane on top of the desired folder or asset.  

b. When the cursor changes from a red circle with a line through it, to a green circle with a 
plus sign, drop the asset in the desired location. 

Alternatively, you can select the title of the asset, select the destination folder in the Edit 

Contents pane, and click  between the two panes. If you want to select the root folder of 
the learning program, select the title of the learning program as the destination. 

Note: You can use Shift-click and Ctrl-click to select multiple assets. 

4. Click Save, then click OK. 

To remove a learning asset from a learning program 

1. Open the learning program for editing. 

2. In the Edit Contents pane, move your mouse over the title of the asset, and click the Remove 
link. 

3. Click OK. 
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Add or Remove Child Folders 

You can add and remove child folders from a learning program as needed. Note that removing a child 
folder also removes all of the assets in the folder from the learning program. 

To add a child folder to a learning program 

1. Open the learning program for editing. 

2. In the Edit Contents pane, select the folder in which to create the child folder: 

 To add the folder as a top-level folder in the root folder, select the title of the learning 

program. 

 To add the folder as a child folder within another folder, select the parent folder. 

3. Click New Folder. 

The New Folder dialog box displays. 

4. In Name, type a name for the folder. 

5. In Completion, select the completion criteria for the items that the folder will contain. 

6. Click OK. 

To remove a child folder in a learning program 

1. Open the learning program for editing. 

2. In the Edit Contents pane, move your mouse over the title of the folder, and click the Delete 
link. 

3. Click OK. 
 

Reorder Assets and Folders in a Learning Plan 

You can reorder the assets or folders in any folder in a custom learning program. This changes the 
order in which they are displayed to learners. Be aware that if the parent folder's completion criteria is 
Complete All In Order, reordering the items in a folder also affects the order in which learners must 
complete the items. For more information, see Learning Programs on page 258. 

To reorder the assets or folders in a learning program 

1. Open the learning program for editing. 

2. In the Edit Contents pane on the right, select the asset or folder that you want to move, drag it 
to the desired location, and drop it. 

 

Edit the Properties of a Folder 

You can edit the name and completion criteria for any folder in a learning program. 

The root folder of a learning program has several additional properties that apply to the learning 
program as a whole, such as the objectives of the learning program and whether the learning program 
requires approval in order for learners to enroll. You can edit these properties as well. 

To edit the properties of the root folder or a child folder 

1. Open the learning program for editing. 
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2. In the Edit Contents pane on the right, do one of the following: 

 If you want to edit the properties of the root folder, move your mouse over the title of the 

learning program, and click the Edit link that displays. 

 

 If you want to edit the properties of a child folder, move your mouse over the title of the 

folder, and click the Edit link that displays. 

 

3. In the Edit Learning Program box (if you are editing the root folder) or Edit Folder dialog box (if 
you are editing a child folder), edit the properties of the folder as needed. For more information 
on these properties, see Create a Learning Program on page 258. 

Note: The Content Language setting determines if the folder displays when a user searches 
or browses within a selected language. Select Not Specified to ensure it displays in all 
searches regardless of a learner's selected content language, or select a language to include 
it only when a learner searches within that language. 

4. Click OK, and then click Save to save your changes. 

 
 

View Existing Learning Programs 

To view existing learning programs 

1. Click Content > Learning Programs on the navigation bar. 

The Manage Learning Programs page displays, which lists all the learning programs created 
on your site. By default, the learning programs are sorted by title. 

 



266 ©2015 Skillsoft Skillport 8 Administrator Guide 

 

 Content 
 
 

2. To view the details of a learning program, click the plus sign ( ) to expand it. 

 
 

Delete a Learning Program 

If you delete a learning program that one or more users have already completed, the completion data 
for the learning program as a whole is also deleted for those users.  

However, the completion data against the individual assets of the learning program is retained and 
remains in each user's Learner Transcript, and is represented in any reports that you run. 

Note: If you no longer want to use a learning program, but want to keep the existing results, do not 
delete the learning program. Instead, create a new folder (for example, Retired LPs) in the Catalog, 
and move the learning program into that folder. To ensure its contents are hidden from users, do not 
give anyone any entitlement to the folder. 

To delete a learning program 

1. Click Content > Learning Programs on the navigation bar. 

The Manage Learning Programs page displays, which lists the learning programs created on 
your site. 

2. Select the learning program that you want to delete, and click Delete. 

3. Click OK to confirm the deletion. 

4. Click Yes to delete the learning program.  

5. Click OK to acknowledge the deletion. 
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External Learning Objects (ELOs) 

An external learning object (ELO) is a reference to a learning activity or resource such as: 

 A membership in a professional association 

 A subscription to, or an article in, a journal or magazine 

 An on-the-job or off-the-job experience 

 A web site (for example, http://www.mywebsite.com/usefulinfo.html) 

 An Internet newsgroup 

 An in-house policy and procedure manual (for example, 

http://www.mywebsite.com/manuals/newemployeemanual.pdf) 

External learning objects can be displayed, and searched for, in the Library. However, Skillport cannot 
track their completion by learners. 
 

Create an ELO 

You can add an external learning object (ELO) to any folder that can be modified except for the top-
level Catalog folder. 

To create an ELO 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In the Browse Catalog pane, browse to or search for the folder in which to create the ELO. 

3. Move your mouse over the folder title, and click the Edit Contents link. 

4. In the Edit Contents pane, select the folder, and click New ELO. 

5. In the Create New External Learning Object (ELO) dialog box, enter the information for the 
new ELO. Required fields are indicated with an asterisk (*): 

 Title: Enter up to 54 characters. All Latin1 and double-byte characters are accepted. 

 Valid URL: The URL to access the ELO. 

 URL Restrictions: The URL must be static (no passing of parameters or variables is 

permitted), and it must begin with http:// or https://. Also, if the resource to which the URL 

points is hosted by Skillsoft, the URL must point to either a PDF file or an HTML page that 

does not include scripting. Microsoft Office documents, including those converted to 

HTML, are not permitted. If you want to point to a resource whose file type is not 

permitted, you must host it on an external server (that is, specify an external URL). 

 ID: The unique identifier for the ELO within Skillport. The identifier is automatically 

assigned a prefix of "elo_". 

 Content Language: This setting determines where the ELO displays when a user 

searches or browses within a selected language. Select Not Specified to ensure it 

displays in all searches regardless of a learner's selected content language, or select a 

language to include it only when a learner searches within that language. 



268 ©2015 Skillsoft Skillport 8 Administrator Guide 

 

 Content 
 
 

For example:  
An admin, Joe, creates an ELO for an upcoming seminar for leadership and sets the 
content language to Spanish. A learner, Kim, searches for leadership, but her content 
language in Skillport Learner is set to English (United States). Kim won't see the ELO 
because it isn't marked as English (United States). If Joe sets the content language to Not 
Specified, Kim would be able to see the ELO regardless of her set content language.  

Note: To include the external learning object in browse and search results regardless of 
language, select Not Specified. 

 Description: Enter descriptive text about the ELO. All Latin1 and double-byte characters 

are accepted. 

 Objectives: The learning objectives that the ELO satisfies. 

 Common Attributes: Select whether the ELO is Tablet Accessible, Smartphone 

Accessible, or both. 

Note: If the ELO's URL is supported by mobile browsers, you can select this option to 
enable launch of the ELO from a tablet or smartphone. If you do not select this option, the 
user is able to search for and save the ELO to their learning plan, but cannot launch it, 
from their mobile device. 

 Image: To specify a different image to display for this ELO in Skillport Learner, click Use 

custom image. Then, click Add, click Browse to navigate to the desired file, then click 

Upload.  

The image file must be a .gif, .png, or .jpg file, and can have a maximum image size of 5 
MB. 

6. Click Save. 

7. Click Exit. 

Note: The Library is not updated with your changes until you exit the Library page. Once the 
ELO displays in the Library, any learners who have been assigned the ELO's parent folder 
(directly or indirectly) can access the ELO. 

8. If necessary, assign the ELO to users and groups as needed. For more information, see 
Assign and Deassign Assets in the Library on page 66. 

 

Edit an ELO 

To edit an ELO 

1. Click Content > Library on the navigation bar. 

The Library page displays. 

2. In the Browse Catalog pane, browse to or search for the folder that contains the ELO you want 
to edit. 

3. Move your mouse over the folder title, and click the Edit Contents link. 

4. In the Edit Contents pane, move your mouse over the title of the ELO, and click the Edit link. 

5. In the Edit External Learning Object (ELO) dialog box, edit the properties as desired. For 
descriptions of each property, see Create an ELO . 
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6. Click Save. 

7. Click Exit.  

Note: The Library is not updated with your changes until you exit the Library page. 
 

Remove an ELO 

Note: Removing an external learning object (ELO) from one folder automatically removes all instances 

of that ELO from all other folders. The ELO is permanently removed from the site. 

To remove an ELO 

1. Click Content > Catalog on the navigation bar. 

The Library page displays. 

2. In the Browse Catalog pane, browse to or search for the folder that contains the ELO that you 
want to remove. 

3. Move your mouse over the folder title, and click the Edit Contents link. 

4. In the Edit Contents pane, move your mouse over the title of the ELO, and click the Remove 
link. 

5. Click OK to confirm the removal. 

6. Click Exit. 

Note: The Library is not updated with your changes until you exit the Library page. 
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Dialogue Live 

You can list Dialogue Live sessions directly in the Skillport Library to make them easier for learners to 
locate and attend. 
 

About Dialogue Live Sessions 

If your Skillport site is configured to support it, Dialogue Live sessions can be listed in the Skillport 
Catalog when they are created.  

Be aware that, while adding a Dialogue Live session to your Skillport Catalog automatically adds the 
session to a custom folder (Live Dialogue Sessions), it will not make these sessions visible to learners. 
To make the sessions visible to learners, you must do the following: 

1. Entitle the sessions to learners so that they can search for sessions. 

2. Add the Dialogue Live session(s) to one of the three designated browse views on page 221 
so that learners can browse for sessions via the Browse the Library link in Skillport. 

3. Create a copy of the folder and designate this copy a browse view. Note that copies of custom 
folders do not inherit any updates to the parent folder. For more information on custom folders, 
see Create a Custom Folder on page 229. 
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Instructor Led Training (ILT) 

 

Getting Started with ILT 

Overview 

Instructor Led Training (ILT) enriches and optimizes the learning experience of your students. By 
extending the Skillport platform with a wide range of ILT functionality, Skillsoft offers you a way to 
manage instructor-led training sessions. 

With ILT, you can manage all the requirements for: 

 In-house or third-party training sessions delivered in a classroom environment by an instructor 

to students (for example new employee orientation) 

 Online training sessions delivered by an instructor using Skillsoft Dialogue Virtual Classroom 

or other online collaboration software. 

ILT also provides tools for tracking facilities and classrooms, and for scheduling instructor-led training 
sessions. ILT does not track classroom or facility attributes such as projectors, printers, network 
connections, or other infrastructure such as availability. 

Note: You cannot add ILT courses or sessions to a series. For information about which asset types 

can be added to a series, see Important Information about Series. 

A series is a container of specifically-ordered assets used to group related assets together (for 
example, to obtain a certification). Series cannot have subsets. 

 

ILT and Advanced Groups  

You can create and use advanced groups on your Skillport site when you are also using ILT. This 
works as follows:  

 ILT administration:  While your ability to access non-ILT pages in Skillport Administrator 

depends entirely on your Skillport role, your ability to access ILT pages depends entirely on 

your ILT role. On the ILT pages that you can access, neither the tasks that you can perform 

nor the users on which you can perform them are affected by your or their existence in an 

advanced group. If you can perform an ILT-related task for users and groups, you can do so 

for all users and groups on your site, including all advanced groups. 

 Reports 

 ILT Event Journals: Like for other ILT-related pages, your ability to access this page 

depends entirely on your ILT role, and you can view event journals for all users and 

groups, including all advanced groups. 
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 Skillport Reporting: Skillport’s Reporting feature includes a large number of templates 

that you can use to run reports, including several ILT course and session reports and ILT 

student roster reports. If you do not have Admin privileges with Reporting capabilities in 

Skillport, you will not be able to run these reports. In addition, you will only be able to run 

reports on groups to which you are a member. Your ILT role has no effect on your 

privileges in this area. Rather, your Skillport role and how your site’s User/Group Filter 

Scoping setting is configured determine the specific users and groups—including 

advanced groups—that you can select to include in reports. For more information, see 

User and Admin Privileges. 
 

ILT Terms 

Skillport 

Skillport is a Learning Management System (LMS) where you can personalize your elearning 
environment and monitor your progress toward your own learning goals. Reminders can also be e-
mailed in order to complete courses and simulations. 

You can also link the areas of Skillport which you use most often to the Quick Links area. These links 
can be Skillsoft features and any custom pages. 

Course 

A course is a training activity which addresses a specific topic. A course can consist of: traditional 
materials presented in a PowerPoint format, a recorded live session delivered by a presenter, 
simulations which replicate a program or environment so you can practice completing tasks, other 
multimedia clips that support leaning, test and assessments that verify retention of knowledge, as well 
as job aids, skill briefs, or other materials to support the learning activities. 

ILT Course 

Instructor Led Training courses are placeholders to which an ILT Administrator attaches scheduled 
sessions that a learner can attend at a specific time and place. A learner can select an ILT course 
from the Skillport Library and add it to his watch list for sessions that meets his schedule, or it can be 
assigned by a training administrator. 

Session 

A session is an instance of a course that has been scheduled for a specific date and time and will be 
held in a facility/classroom or virtually, with an instructor and students. 

Learning Plan 

Learning Plan contains items that are part of your formal learning program. You, your training 
administrator, or your manager can add ILT courses to your Learning Plan. 
 

ILT Roles 

The table below shows the ILT features available for the different user roles. 

 Learner Admin Course 
Admin 

Session 
Admin 

Session 
Approver 

Mgr Instructor 

View ILT courses and 
sessions through Skillport 
catalog  

X X X X X X X 

Enroll in ILT sessions X X X X X X X 



Skillport 8 Administrator Guide ©2015 Skillsoft  273 
 

Content   
 
 

Watch ILT courses X X X X X X X 

Assign user roles in ILT 
Admin interface 

 X      

Create a course  X X     

Edit a course  X X     

Delete a course  X X     

Create a session  X X X    

Edit a session  X X X    

Delete a session  X X X    

Approve session 
registration requests 

 X   X X X - Applies only 
when Instructor 
Can Manage 
Roster is set to 
Yes for the 
session. 

Reject session registration 
requests 

 X   X X X - Applies only 
when Instructor 
Can Manage 
Roster is set to 
Yes for the 
session. 

E-mail all learners enrolled 
in a session  

 X X X   X 

Close a session  X X X    

Force enroll learners into a 
session 

 X X X   X - Applies only 
when Instructor 
Can Manage 
Roster is set to 
Yes for the 
session. 

Enter test 
scores/attendance for a 
session 

 X X X   X 

Edit/preview an e-mail 
template  

 X      

 
 

Assign an ILT Role to a User 

To assign an ILT role to a user 

1. In Skillport Administrator, click Users & Groups > ILT Roles > User Role Management. 

The list of users and their associated roles displays. 

2. Find the user you wish to assign a role to by: 

 manually searching through the list of usernames for the user 
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 using the Search feature at the top of the page. 

Note: The grid refreshes to show the search results, and a Clear Search button displays on 
the page. Clear Search clears the top bar search, but not the column filters or the "Group By" 

function.  

3. Select the role's check box. See ILT Roles for more information. 

4. Click Submit to save your changes and assign the selected role to the user. 

 
 

Generate and Export a Learner Report 
To manage the users and their roles with ease, you can also generate a Learner Report.  

Note: The Learner Report button on the top of the ILT User Role Management screen is enabled only 

if one of the records in the grid are selected. 

To generate and export a Learner Report 

1. In Skillport Administrator, click Users & Groups > ILT Roles > User Role Management. 

The list of users and their roles displays. 

2. Click the username of the learner of whom you want to run the report. 

3. Click Learner Report on the top of the screen. 

The Learner Report can be viewed in the resulting page. 

Note: This report is generated only for the selected user. 

4. To export the Learner Report, click Export Report. 

5. The following information can be obtained from the resulting .csv document that you 
download: 

 Session ID 

 Status 

 Course ID 

 Course Title 

 User Name 

 Last Name 

 First Name 

 Email 

 Zip 

 Pass 
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 Attd (attendance) 

 Score 

 Instructor User Name 

 Instructor Last Name 

 Instructor First Name 

 Facility ID 

 Facility Name 

 Classroom ID 

 Classroom Name 

 Start 

 End 

 Notes 

 
 

Upload User Roles 
You can use the Batch Add function to upload multiple ILT user roles from another system, 
spreadsheet, or data from a third party (such as an external session vendor). 

To upload ILT roles 

1. Click Users & Groups > ILT Roles > User Role Batch Update. 

The ILT User Roles screen displays: 

 

2. Next to the file type that you want to upload, click Browse. 

The Choose File window displays. 

3. Navigate to the .csv file you want to upload. 

4. Click the .csv file to select it. 

5. Click Open. 

The path to your .csv file displays in the field. 

6. Click Validate to validate the .csv file. 
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7. Click Upload. 

The upload process begins. If you have a valid email address, an email is sent containing the 
URL of a status report and the date and time of the batch submission. 

 

User Roles Template 
Use the User Roles Template to upload roles for a user quickly and easily. The table below shows 
the correct data format for each field in the template. 

Field Name Format 

Login Required. This must be a Skillport login ID. 

Administrator Optional.  

 1: enables the role for the user 

 0 or leave blank: disables the privilege. 

Instructor Optional.  

 1: enables the role for the user 

 0 or leave blank: disables the privilege. 

Session Administrator Optional.  

 1: enables the role for the user 

 0 or leave blank: disables the privilege. 

Course Administrator Optional.  

 1: enables the role for the user 

 0 or leave blank: disables the privilege. 

Session Approver Optional.  

 1: enables the role for the user 

 0 or leave blank: disables the privilege. 
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ILT Course and Session Manager 

Dashboard 

The dashboard provides you with a summary of details related to courses and sessions.  

To view the dashboard 

1. Click Content > ILT > Course and Session Manager on the navigation bar. 

The dashboard displays under the ILT Dashboard tab. 

 

The following are the items that can be found in the dashboard. 

 Sessions At or Above Capacity: Sessions that are full with 100% or more participants as 

determined by the Session Capacity and the site-wide default setting “Full Session Threshold”.  

Note: Site Settings are controlled by the Skillport Company Admin. 

 Low Enrollment Sessions: This includes the sessions that do not meet the session low 

enrollment criteria. The criteria is determined by the entry in the Minimum Enrollment and 

Low Enrollment Alert fields.  

 Pending ILT Approvals: This includes the list of ILT approvals that are pending. 

 Unconfirmed Sessions: This displays all sessions that have a status of Unconfirmed. From 

the View more in print friendly window, the Admin can select one or more sessions and 

click Confirm the selected sessions to mark sessions as Confirmed.  

Note: If the Skillport Company Admin disables Unconfirmed in the site-wide ILT Site Settings, 

then no sessions will appear in this section. 

 Total Courses: Displays the total number of ILT courses. 

 Activated: Displays the total number of activated ILT courses. 

 Deactivated: Displays the total number of deactivated ILT courses. 

 Total Watchers: Total number of Watch List entries made to courses by Learners. 
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 Total Sessions - Displays the total number of Unconfirmed and Confirmed ILT sessions. 

 Total Enrollments: Displays the total number of Pending Sessions and Confirmed 

enrollments. 

 Total Waitlist: Displays the total number of Learners on all Waiting Lists. 

 Upcoming Sessions: Lists all future sessions including sessions for the day. Clicking the 

value of the link Next 7 days, Next 30 days or Next 90 days on the dashboard tab brings you 

to the Session Manager. 

 Total Facilities: Displays the total number of ILT Facilities. 

 Total classrooms: Displays the total number of ILT Facilities. 
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Courses 

View Courses 
The Course Manager displays the available course list (by course ID and course title) and the 
sessions. 

To view courses 

1. Click Content > ILT > Course and Session Manager on the navigation bar. 

2. Click Course Manager.  

The ILT courses display. 

 

3. Sort the courses: 

 Click a column header to sort in ascending or descending order. 

 Use the Group by field to sort by group by Title, Spoken Language, or Cost. 

4. Optionally, you can select the Show deactivated check box to include deactivated courses in 
the Course Manager. 

 

View ILT Course Details 
The Course Details page provides additional information related to a specific course, such as the 
course ID, title, mastery level, cost, and duration. Use this view to change and modify the details. 

To view course details 

1. Click Content > ILT > Course and Session Manager on the navigation bar. 

2. Click Course Manager.  

The ILT courses display. 

3. To view course details without navigating away from the Course Manager, click  next to the 
course you want to view.  

4. Click  next to Course Information, or click  next to Course Administration.  
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The course details display below the course listing: 

 

5. To open the course details on the View Course Details page (to allow edits), click the course 
ID you wish to view. 

The View Course Details page opens, and you can review your ILT course: 

 

 



Skillport 8 Administrator Guide ©2015 Skillsoft  281 
 

Content   
 
 

Create a New ILT Course 
Use this process to create and enter details of a new ILT course. 

To create a new course 

1. Click Content > ILT > Course and Session Manager on the navigation bar. 

2. Click Course Manager.  

3. Click New Course.  

The New Course window displays: 

 

4. Enter the Course Information. Items with an asterisk (*) are required: 

 Title*: The title of the course as presented to learners. This does not need to be unique. 

 Course ID*: All course IDs begin with ilt_ and are always unique. Once the course ID is 

saved, it cannot be changed. 

 Status: This option activates or deactivates the course; by default the status is active. 

Active courses display on the View Courses page. The deactivated courses display on the 

View Courses page if the Show Deactivated check box on the View Courses page is 

selected. 

 Spoken Language*: The spoken language of the course (for example, the language 

spoken by the instructor or the learners). 

 Content Language:* This setting determines where the ILT course displays when a user 

searches or browses within a selected language. Select Not Specified to ensure it 

displays in all searches regardless of a learner's selected content language, or select a 

language to include it only when a learner searches within that language. 
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For example:  
An admin, Joe, creates an ILT course about leadership and sets the content language to 
Spanish. A learner, Kim, searches for an ILT course about leadership, but her content 
language in Skillport Learner is set to English (United States). Kim won't see the ILT 
course because it isn't marked as English (United States). If Joe sets the content 
language to Not Specified, Kim would be able to see the ILT course regardless of her set 

content language. 

 Duration: Enter the duration of the course. This is the length of time required to complete 

a course. This field has a default value. 

Note: There is no correlation or checking of this value with the actual schedule information 

applied to a session. 

 Mastery Level (0-100%): The percentage score a learner must obtain to complete the 

course. The Mastery Level default value is 100. If you submit the course with a blank 

value, it is considered zero (0).  

 Cost: The cost and currency of the course.  

Note: Skillport does not bill learners. This is a notification to the learner that the course 

costs money. 

 Location: The location of a course, whether it is to be held in a physical classroom or 

online. 

Note: Extended Attributes display if enabled. Classrooms can be added only after a 
facility is added. For information on adding a facility, refer to Add a Facility to a Course. 
For information on adding a classroom, refer to Create a New Classroom. 

 Description: The description of the course. 

5. Add the administration details. 

6. Click Save & Add Sessions to save the course and navigate to the New Sessions window. 
Alternatively, click Save & Exit to save the course and return to the Course Manager screen. 
Cancel dismisses the window without any changes saved and gets back to the main screen in 
the previous state. 

 
 

Add Administration Details to a Course 
Additional details regarding administration can be added to a course while creating a new course. 
These details can also be set at the session level or overwritten at the session level. If they are set at 
the course level the session will automatically default to the settings. 

To add administration details to a course 

1. View Courses. 

2. Click New Course or select the course from the list of courses and click Edit Course if you 
are editing the administration details. 
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3. Click the Administration tab. 

 

4. Fill in the Administration, Approval Settings and Enrollment Settings. 

 Course Administrators: Select up to three course administrators. 

 Contact: You can edit or remove a contact. 

 Session Approval/Manager Approval: Select whether Session Approval or Manager 

Approval is required for this course. 

 Instructor Can Manage Roster :Select this checkbox to allow an Instructor to manage 

the course roster. 

 Close Session: Select when you wish to close the session to new enrollment by selecting 

the relevant entries from the drop-down. 

 Prohibit Self-Withdrawal: Select if and when to prohibit self-withdrawal from a session 

from the options in the drop-down. 

 Late Withdrawal: Select if and when a late withdrawal is possible from the options in the 

drop-down. 

 Minimum Enrollment: Enter the minimum number of enrollments possible. 

 Low Enrollment Alert: Select when you want to get an alert if there is low enrollment by 

selecting an option from the drop-down. This field does not display if Minimum Enrollment 

is zero. 

5. Click Save & Add Sessions to save the course and navigate to the Add Sessions page. 
Alternatively, click Save & Exit to save the course and return to the Course Manager screen. 

Note: Cancel will enable you to exit the New Course window without saving. 
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Select a Facility for a Course 
You can associate a facility to a course or replace the association. 

To add/edit a facility to a course 

1. View Courses. 

2. Click New Course. 

3. Click Edit next to Facility. The Select 1 Facility window displays. 

 

4. Select a facility from the list or use the search to list the required facilities. 

Note: You may search for the facility using the Facility Name, Facility ID, City, 
State/Province or Country. 

5. Click OK. 

 
 

Select a Classroom for a Course 
Once you have added a facility to a course, you can add a classroom. You can also edit an existing 
classroom. 

Note: You can search for a classroom only if it exists within the selected facility. 

To add/edit a classroom to a course 

1. View Courses. 

2. Click New Course. 
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3. Click Edit next to Classroom. The Select 1 Classroom window displays. 

 

4. Select a classroom from the list or use the search to list the required classrooms. 

Note: You may search for the facility using the Classroom Name, Classroom ID, Facility 
Name, Facility ID or Maximum Capacity. 

5. Click OK. 

 

 
 

Edit a Course 
You can edit the details of a course if any changes are required.  

Note: The option to edit a course on the Course Manager tab is enabled only if there is a course 

selected in the list of courses found in the Course Manager screen. 

To edit a course 

1. View Courses. 

2. Click the course ID you wish to view. 

The View Course window displays. 

3. Click Edit. 

4. Edit the course details. For more information on course details, refer to Create a New ILT 
Course. 



286 ©2015 Skillsoft Skillport 8 Administrator Guide 

 

 Content 
 
 

Note: Course ID cannot be edited. Course Title can have HTML tags, but those tags will 

remain as text. In Description field, the HTML tags can be applied. 

5. Click Save. The Course Summary displays the updated details for the course, and it is 
automatically republished to the Skillport Library. 

 
 

Copy an ILT Course 
If you want to create multiple courses with similar attributes, you can copy an existing course. This is a 
quick and efficient method for creating a series of related courses. All the details and field settings will 
be copied to the new course and you can edit fields as needed. While copying the course the course 
ID changes automatically. 

Note: To enable the copy button, you must select a course on the Course Manager grid. Only course 
details can be copied, not the sessions associated with the course. 

To copy a course 

1. Click Content > ILT > Course and Session Manager on the navigation bar. 

2. Click Course Manager.  

The ILT courses display. 

3. Click a course name to select it. 

4. Click Copy.  

Note: You can also copy a course by viewing the ILT course details and clicking Copy. 

The Copy Course dialog box displays: 

 

5. Edit the information: 

 Title*: The title of the course as presented to learners. This does not need to be unique. 
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 Course ID*: All course IDs begin with ilt_ and are always unique. Once the course ID is 

saved, it cannot be changed. 

 Status: This option activates or deactivates the course; by default the status is active. 

Active courses display on the View Courses page. The deactivated courses display on the 

View Courses page if the Show Deactivated check box on the View Courses page is 

selected. 

 Spoken Language*: The spoken language of the course (for example, the language 

spoken by the instructor or the learners). 

 Content Language:* This setting determines where the ILT course displays when a user 

searches or browses within a selected language. Select Not Specified to ensure it 

displays in all searches regardless of a learner's selected content language, or select a 

language to include it only when a learner searches within that language. 

For example:  
An admin, Joe, creates an ILT course about leadership and sets the content language to 
Spanish. A learner, Kim, searches for an ILT course about leadership, but her content 
language in Skillport Learner is set to English (United States). Kim won't see the ILT 
course because it isn't marked as English (United States). If Joe sets the content 
language to Not Specified, Kim would be able to see the ILT course regardless of her set 
content language. 

 Duration: Enter the duration of the course. This is the length of time required to complete 

a course. This field has a default value. 

Note: There is no correlation or checking of this value with the actual schedule information 

applied to a session. 

 Mastery Level (0-100%): The percentage score a learner must obtain to complete the 

course. The Mastery Level default value is 100. If you submit the course with a blank 

value, it is considered zero (0).  

 Cost: The cost and currency of the course.  

Note: Skillport does not bill learners. This is a notification to the learner that the course 

costs money. 

 Location: The location of a course, whether it is to be held in a physical classroom or 

online. 

Note: Extended Attributes display if enabled. Classrooms can be added only after a 
facility is added. For information on adding a facility, refer to Add a Facility to a Course. 
For information on adding a classroom, refer to Create a New Classroom. 

 Description: The description of the course. 

6. Add the administration details. 

7. Click Save & Exit.  

8. Optionally, using the email template that displays, send an email to the enrolled learners to 
inform them of the change. 
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Activate or Deactivate a Course 
You can activate or deactivate a course if required. You can deactivate the course when the course 
has no sessions or the course has canceled and completed sessions. If the course has 
unconfirmed/confirmed sessions, it cannot be deactivated. 

Note: Sessions cannot be created under the deactivated course. 

To deactivate a course 

1. View Courses. 

2. Click on a course to select it. 

3. Click Deactivate. This deactivates the course. 

Note: The deactivate button is enabled only when the selected course has no sessions or 

canceled/completed sessions. 

 

To activate a course 

1. View Courses. 

 

2. Select the Show Deactivated check box. 

3. Click on the deactivated course to select it. 

4. Click Activate. This activates the course. 
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Delete a Course 
Deleting a course removes all history and any results that have been posted in association with this 
course. By following this procedure, all course results can be deleted and the course is removed from 
the courses list. A course cannot be deleted if there are sessions associated with it. 

Note: The option to delete a course on the Course Manager tab is only enabled if a course is selected 

in the list. 

To delete a course 

1. View Courses. 

2. Click on a course to select it. 

3. Click Delete. 

4. Click OK. 

Note: You can also delete a course by opening the course details and clicking the Delete button. For 
more information on viewing the course details refer to View Course Details. 

 

 

Session Manager 

View Sessions 
A session is a specific instance of a course, held in a facility, classroom, or virtually with an instructor 
and students. 

The Session view displays the available sessions for all available courses. 

To view sessions 

1. Log in to Skillport and navigate to the Admin area. 

2. Click Content > ILT > Course and Session Manager on the navigation bar. 

3. Click Session Manager. The available sessions display. 

 

4. Sort the session list by clicking the column headers to sort in ascending or descending order. 
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5. Use the Group by field to group sessions. The sessions can be grouped by: 

 Course ID 

 Course Title 

 Status 

 Open 

 Start Date 

 Instructor 

 Facility 

 City 

 Country 

6. Select the Date Range by selecting the start and end date. 
 

View Session Details 
The session details view displays the details of a selected session for an available course. 

To view sessions 

1. View Sessions. 

2. Click the Session ID you wish to view. 

The View Session window displays. 
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Create a New Session 
Use this process to create and enter details of a new Instructor Led Training (ILT) session for a 
specific course. 

Note: ILT Course records contain many attributes that are attributes of a course's sessions (such as 
cost, facility, classroom, and enrollment rules). These are set at the course level as defaults for 
convenience, representing the most common values that are set in sessions. When a new ILT session 
is created, those values from the parent course record are auto-populated into the new session record. 
All inherited values can be overridden at the session level. 

To create a new session 

1. View Sessions. 

2. Click the course for which you wish to create a session. 

3. Click New Session.  

The New Session window displays: 

 

4. Enter the following information: 

 Session ID: This is auto generated from the course ID and the session sequence. You 

can modify the session ID. 

 Language: Select the session language using the options in the drop-down. 

 Location: Select a session location: 

Physical Classroom: A physical facility, or a classroom within a selected facility, where 
the session is held. 

Online Classroom: A virtual classroom where learners use a website to attend the 
session. 
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Dialogue Live: A virtual classroom where learners access Dialogue Live to attend the 
session. 

 Session Notes: Notes to learners that display wherever the session is viewed. 

 Schedule Details: Select a time zone from the drop-down. 

Note: Facilities and classrooms are inherited from the course. Different locations can result in 
different facilities and classrooms. For information on editing a facility or classroom, see Add a 
Facility for a Course and Add a Classroom to a Course. 

5. Add Administration Details to a Session. 

6. Do one of the following: 

 Click Save & Add Another to save the session and open another New Session window.   

 Click Save & Exit to save the course and return to the Session Manager screen. 

 Click Cancel to exit the window without saving your changes. 
 

Add Administration Details to a Session 
Additional details regarding administration can be added to a session while creating a new session. 
This is part of the process of creating a new session. They can also be added later if need be. 

To add administration details to a session 

1. View Sessions. 

2. Click the course for which you wish to create a session. 

3. Click New Session. 

The New Session page displays. 

4. Click the Administration tab. 

 



Skillport 8 Administrator Guide ©2015 Skillsoft  293 
 

Content   
 
 

5. Enter the Administration, Approval Settings and Enrollment Settings information. 

 Session Administrators: Select up to three session administrators. 

 Contact: Edit or remove an existing contact. 

 Session Approval/Manager Approval: Enable or disable Session Approval or Manager 

Approval for the session. 

 Session Approver: Select a contact to approve session enrollment requests. Enabled 

when Session Approval is selected. 

 Instructor Can Manage Roster: When selected, the session Instructor can determine 

enrollments and withdrawals.  

 Close Session: Determine the time frame when you wish to close the session using the 

options in the drop-down. 

 Prohibit Self-Withdrawal: Allow or prohibit self-withdrawal from a session using the 

options in the drop-down. 

 Late Withdrawal: Allow or prohibit late withdrawal using the options in the drop-down. 

 Capacity*: (Required field) Enter the required capacity (number of students) in the 

session.  

Note: The session capacity value determines when the session is full. Skillsoft recommends 

changing this value to your specific capacity. 

 Minimum Enrollment: Enter a minimum number of enrollments. 

 Low Enrollment Alert (not shown): If a session has low enrollment, select this to enable 

email alerts. Choose notification options using the drop-down. 

6. Click Save & Add Another to save the session and navigate to the New Session window. 
Click Save & Manage Roster to save the session and manage the roster. Alternatively, click 
Save & Exit to save the course and return to the Session Manager screen. 

 



294 ©2015 Skillsoft Skillport 8 Administrator Guide 

 

 Content 
 
 

Confirm a Session 
You can confirm a session as soon as you create it or when you have enough people enrolled in this 
session. 

The confirmation process varies based on the policies and procedures of your company. The following 
are the ways the confirmation works: 

 If you confirm as soon as you create a session, when an end user enrolls they only get one 

email with an Outlook calendar invite confirming their registration. 

 If you confirm as soon as you create a session, and you do not get the minimum required, the 

course may be canceled and a notification sent. 

 If you do not confirm the session until later, the end user will get one email indicating that they 

enrolled, and a second email with an Outlook calendar invite saying the session is confirmed 

after the session actually gets confirmed. 

To confirm a session 

1. View Sessions. 

2. Click the Session ID you wish to confirm. 

3. Click Confirm.  

 
 

Open/Close a Session to Enrollment 
 

To open a session to enrollment 

1. View Sessions. 

2. Click the Session ID you wish to open for enrollment. 

3. Click Open.  

 

To close a session to enrollment 

1. View Sessions. 

2. Click the Session ID you wish to close for enrollment. 

3. Click Close.  
 

Edit a Session 
You can edit the details of a session if any changes are required.  

To edit a session 

1. View Sessions. 

2. Select the session you wish to edit. 

3. Click Edit. The Edit Session dialog box displays. 
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4. Edit the session details. For more information on session details, refer to View Session 
Details. 

Note: Enrollment Status and Session Status cannot be modified in the Edit Session window. 

5. Click Save. 

 

 
 

Copy a Session 
If you want to create multiple sessions with similar attributes, you can copy an existing session. This is 
a quick and efficient method for creating sessions. All the details and field settings are copied to the 
new session and you can edit fields as needed. The Session ID is auto generated with the sequence 
for the last session in the selected course. The Enrollment Status and Session Status are not inherited 
from the original session. 

Note: To enable the copy button, you must select a session on the Session Manager grid.  

To copy a session 

1. View Sessions. 

2. Click on a session to select it. 

3. Click Copy. The Copy Session dialog box displays. 

Note: You can also copy a session by opening the session details and clicking Copy. For 
more information on viewing the session details refer to View Course Details. The Copy 
Session window replicates all the information found in the session. However, the button Save 
& Add Another Copy should display in place of Save & Add Another. 

 

 

 
 

Cancel an ILT Session 
When you cancel an ILT session, the following occurs: 

 All enrolled learners with a valid email address receive an email notifying them that the 

session is cancelled.  

 The cancellation email includes an iCalendar attachment to remove the session from the 

learner's calendar.  

 The status of all enrolled learners changes from Enrolled to Withdrawn. 

 The ILT course the session is associated with is placed in all enrolled students' ILT Watchlist 

to ensure they are notified of newly-scheduled sessions of the course. 

 Record of the cancelled session remains in the ILT Event Journal. 

Note: Session cancellations must be performed individually. Batch cancellations are not allowed.   
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To cancel an ILT session 

1. In Skillport Administrator, click Content > ILT > Course and Session Manager. 

The Course and Session Manager displays.  

2. Click the Course Manager tab.  

The Course Manager page displays.  

3. Click the name of the course containing the session you wish to cancel. 

4. Click the Sessions tab. 

5. Click the name of the session you wish to cancel. 

The following message displays: 

Cancelling the session will un-enroll all students, including those 

on the waiting list. You may later confirm this session will take 

place, but all students must re-enroll at that time. 
Do you really want to cancel this session? 

6. Click OK to confirm the cancellation. 
 

Delete a Session 
You can delete a session if required. To be deleted, the session must have a status of Unconfirmed, 
Canceled, or Completed. The delete option is not available if the session has a status of Confirmed. 
To delete a confirmed session, you must cancel the session or mark the session as complete. 
Canceling the session will remove all learners from the roster, wait list and pending approval list and 
send a session cancelation notification to the learners.  

Note: To enable the Delete button, you must select a session on the Session Manager grid.  
 
Important: If you delete a session with a status of Unconfirmed before canceling the session, all 
learners will be removed from the roster, wait list and pending approval list, but they will not receive a 
notification that the session has been deleted. Therefore, it is strongly recommended that you first 
cancel the session before deleting it. All learners will then receive a session cancellation notification. 

To delete a session 

1. View Sessions. 

2. Click the session you wish to delete. 

The Delete button enables. 

3. Click Delete. 

4. When the confirmation message displays, click Yes. 
 

Print a Session 
This enables you to print the session details. This option creates a printable version of session 
information. An HTML version of the report opens in a new browser window and displays all the 
information on the session details page. You can print the report or save it to your computer. 

To print a session 

1. View Sessions. 
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2. Click on the session you require. 

3. Click Print. The print dialog box displays. 

 

4. Click Print to open your printer settings and print the session details. 

 
 

Email Learners Enrolled in a Session 
This enables you to email all enrolled and wait-listed learners. This option emails updates to learners 
whenever there is a change in the session status or to the schedule. Administrators can manually 
send messages to enrolled learners and instructors. Instructors can also manually send messages to 
learners on the roster, including wait-listed learners. 

To email a learner 

1. View Sessions. 

2. Click on the session you require. 

3. Click Email. The email dialog box displays. 

4. Click the To and/or the Cc button to select specific users or groups from a list. Also you can 
add users to the Bcc list. 

Note: To add a Bcc, you can select users from the Session Enrolled List, Session Wait List, 
Course Wait List and Course Watch List. Do this by selecting the checkbox next to their 
names and click Submit. 
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5. Click Send to send the mail. 

 

 
 

Export a Learner Report 
You can generate a report that contains the student results for a selected course. You can then save a 
Comma Separated Value (CSV) version of the report and open it in other programs such as a 
spreadsheet or database application. 

Note: The Learner Report includes data for both active and deactivated users. There may be a 
difference in the number of users displayed in this report and on the Roster tab, which only displays 
active users. 

 

Note: The Learner Report option on the Course Manager tab is only enabled if a course is selected in 

the grid. 

To export a learner report 

1. View Courses. 

2. Click the Course ID you wish to use to generate the Learner report. 

3. Click Learner Report. 

4. In the File Download prompt, Open or Save the report.  

5. The following information can be obtained from the resulting .csv document that you 
download: 

 Session ID 

 Course ID 

 Course Name 

 Student Login 

 Last Name 

 First Name 

 Learner Status* 

 Email 

 Enrollment Date 

 Passed 

 Attended 

 Mastered 
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 Instructor Login 

 Instructor Last Name 

 Instructor First Name 

 Facility ID 

 Facility Name 

 Classroom ID 

 Classroom Name 

 Phone 

 Alternate Phone 

 Passcode 

 URL 

 Start 

 Finish 

 Notes 

*Note: Learner Status does not always indicate whether or not the learner has completed the session. 
This value is related to the status of the ILT session.  For instance, if an administrator marks a session 
as completed, the Learner Status for any users enrolled in the session will be marked as Completed, 
even if the user did not complete the session.  If the session is unconfirmed, the enrolled learner's 
status will be marked as Pending Session.  
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ILT Email Notifications 

The table below shows the events, triggers, and email recipients for the various ILT email notifications. 

Note that the following notifications are sent with an iCal calendar update: 

 Enrollment Withdrawal Notification 

 Enrollment Request Approved by Administrator/Approver 

 Instructor Change Notification 

 Enrollment Status Change Notification 

 Session Cancelled 

 Session Updated 

 

Event  Trigger Notifications 

Course Created Any of the course attributes are 
updated: 

 Title 

 Language 

 Active Status 

 Description 

To: 

 Course Administrator(s) 

Bcc: 

 Watch List Learner 

Optional: 

 Course Interest List 

Course Copied Any of the course attributes are 
updated: 

 Title 

 Language 

 Active Status 

 Description 

To: 

 Course Administrator(s) 

Bcc: 

 Watch List Learner 

Optional: 

 Course Interest List 

Course 
Deactivated/Remov
al 

A course is deactivated or 
deleted. 

To: 

 Course Administrator(s) 

Bcc: 

 Watch List Learner 

Optional: 

 Course Interest List 
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Approval for 
Enrollment Request 
by Learner 

Learner registers for a course 
which requires approval 

To: 

 Approval Manager 

 Session Approver 

Enrollment Request 
Approved by 
Administrator/Appro
ver 

Administrator or Approver 
approves a learner’s request for 
enrollment. 

To: 

 Approved Students 

Enrollment Request 
Denied by 
Administrator/Appro
ver 

Administrator or Approver denies 
a learner’s request for 
enrollment. 

To: 

 Declined Learners 

Enrollment Request 
Awaiting Approval 

A specified number of days have 
passed after an enrollment 
request has been sent to the 
approver, but the approval has 
not been granted. 

To: 

 Approval Manager 

 Session Approver Email 

 Awaiting Approval Learner 

Request for 
Enrollment Expired 

An enrollment request has 
expired without approval, based 
on a pre-defined number of days. 

To: 

 Awaiting Approval Learner 

Enrollment Request 
Approved by 
Administrator 

Administrator, instead of the 
Approver, approves a learner’s 
enrollment request. 

To: 

 Approval Manager 

 Session Approver 

Enrollment Request 
Denied by 
Administrator 

Administrator, instead of the 
Approver, denies a learner’s 
enrollment request. 

To: 

 Approval Manager 

 Session Approver 

Enrollment Status 
Change Notification 

Enrollment status changes for a 
learner. 

To: 

 Learner 

Enrollment 
Withdrawal 
Notification 

Approver withdraws a learner 
from a session of a course. 

To: 

 Instructor Email 

 Learner Email 

Cc: 

 Session Admin 

Bcc: 

 Approval Manager 

 Session Approver Email 

Ad Hoc Email to a An Administrator with rights to To: 
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Course Watch List the course’s Watch List members 
sends an ad hoc message to the 
group. 

 Course Owned By Email 

Bcc: 

 Watch List Learners 

Course Activated Course is activated. To: 

 Course Administrator(s) 

Bcc: 

 Watch List Learner 

Course Updated Any of the course attributes are 
updated: 

 Title 

 Language 

 Active Status 

 Description 

To: 

 Course Administrator(s) 

Bcc: 

 Watch List Learner 

Optional: 

 Course Interest List 

Course Removal A course is deactivated or 
deleted. 

To: 

 Course Administrator(s) 

Bcc: 

 Watch List Learners 

Instructor Change 
Notification 

An instructor for a session has 
changed. 

To: 

 Instructor(New) 

 Instructor (Old) 

Cc: 

 Session Administrator(s) 

Notify All Enrolled 
and Waitlisted 
Learners in a 
Session 

The "Mail Learners" function is 
triggered in session view. 

To:  

 Instructor 

 Session Administrator(s) 

Session Created A new session of a course is 
created. 

To:  

 Instructor; 

 Session Administrator(s) 

Bcc: 

 Course Watch List Learners 
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Session Updated Any of the following session 
details are updated: 

 Facility  

 Classroom 

 Schedule 

 Session Type 

To:  

 Instructor 

 Session Administrator(s) 

Bcc: 

 Enrolled Learner 

Session Deleted A session of a course is deleted. To:  

 Instructor 

 Session Administrator(s) 

Session Cancelled A session of a course is 
cancelled. 

To: 

 Instructor 

 Session Administrator(s) 

Bcc: 

 Session Approver 

 Approval Manager 

 Learners 

Session Closed A session of a course is closed 
to additional enrollments. 

To: 

 Instructor; 

 Session Administrator(s) 

Bcc: 

 Approvers/Managers for Pending 

Approval Learner 

 Pending Approval Learner 

 Waiting List Learner 

Session Closed – 
Roster Listing 

A session of a course is closed 
to additional enrollments. 

To:  

 Instructor 

 Session Administrator(s) 
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Session Confirmed A session of a course is 
confirmed. 

To:  

 Instructor 

 Session Administrator(s) 

Bcc:  

 Pending Session Learner 

 Approval Manager 

 Session Approver 

Session Enrollment 
Limit 

Either: 

1. Enrollments for a 
session reach or cross a 
session’s maximum limit, 
or 

2. Enrollments for a 
session reach or cross a 
session’s threshold 
minimum limit. 

To:  

 Session Administrator(s) 

Enrollment Request 
by Learner 

In the case where both the 
Approval Manager and Session 
Approver must act, this email is 
sent when one approver has 
approved the request as a 
reminder to the remaining 
approver to act, too. 

To: 

 Approval Manager 

 Session Approver 

Session Seats 
Become Available – 
Watch List 

1. A session is at or over 
capacity, and 

2. One or more withdrawals 
occurs to take enrollment 
below capacity, and 

3. A session is closed to 
enrollments (also 
meaning there is no Wait 
List), and 

4. The Parent Course does 
have a Watch List 

To:  

 Watch List Learners 

Session Re-opened 
for Enrollment 

A course session which was 
previously closed has been re-
opened for additional 
enrollments. 

To:  

 Session Admin(s) 

 (parent) Course Admin(s) 

 Session Instructor 
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Resources 

ILT Resources include Facilities, Classrooms and Contacts. Resources can be added to your ILT site 
individually or by using the batch upload feature.  Administrators can then assign a facility, classroom 
and contact to courses and sessions.  
 

View Resources 

You can create, modify, deactivate or delete a resource using the Resource Management page. The 
three resources available in ILT are: 

 Facilities: Available training locations, such as conference centers or corporate buildings. 

 Classrooms: Training rooms available within each facility. 

 Contacts: External companies or individuals that an Administrator may want to associate with 

a facility, course or session.  For example, a session is having lunch catered and the 

Administrator wants to include the catering company contact on the session. The administrator 

would add the catering contact information to ILT and then assign that contact to the session.  

To view resources 

1. Log in to Skillport as an Administrator and navigate to the Admin area. 

2. Click Content > ILT > Resource Manager. The Resource Management page displays. 

 

 Resources pane: Displays the list of available resources. Click the expand icon to display 

the required resource. 

Note: You must expand a facility in order to view the list of classrooms available within 

that facility. 

 Info pane: Displays information on the selected resource. 
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Search Resources 

There are two methods of searching for resources i.e. basic search and advanced search. 

To do a basic search for a resource 

1. Log in to Skillport as Administrator and navigate to the Admin area. 

2. Navigate to the Resource Management page. 

3. Select the resource type you want to search for by using the drop-down list provided. 

 Facility 

 Classroom 

 Contact 

4. Enter the name of the resource you are searching for in the text field provided. 

5. Click Search. The results display in the Resource pane. 

 

To do an advanced search for a resource 

1. Navigate to the Resource Management page 

2. Click Advanced Search on the top right hand corner of the page. 

3. Select the resource type you want to search for by using the drop-down list provided. 

 Facility 

 Classroom 

 Contact 

4. You can enter details in the following fields for more specific results. 

 Facility Name 

 Facility ID 

 City 

 State/Province 

 Country 

Note: You can choose to include deactivated extended attributes in your results by selecting 

the Include Deactivated checkbox. 

5. Enter the name of the resource you are searching for in the text field provided. 

6. Click Search. The results display in the Resource pane. 
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Facilities 

View Facility Information 

To view facility information 

1. Log in to Skillport as Administrator and navigate to the Admin area. 

2. Click Content > ILT > Resource Manager. The Resource Management page displays. 

3. Browse or search for the required facility.  

The details of the selected facility display in the Info pane. 

 
 

Create a New Facility 

To create a new facility 

1. Log in to Skillport and navigate to the Admin area. 

2. Navigate to the Resource Management page. 

3. Click New Facility in the Resources pane. The New Facility page appears. 

 

4. Enter the required details. 

5. Click Save. If you want to create another facility, click Save & Add Another. 
 

Edit a Facility 

To edit a facility 

1. Log in to Skillport as Administrator and navigate to the Admin area. 
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2. Navigate to the Resource Management page. 

3. Display the details of a required facility. 

4. Click Edit in the Info pane.  

The Edit Facility page appears. 

5. Make the required changes and click Save. 
 

Activate or Deactivate a Facility 
You can activate or deactivate a facility by following the steps given below. Alternatively you can also 
switch to the 'Activated' or 'Deactivated' radio button while in the Edit Facility window and save your 
changes. 

Note: Activating a facility does not activate classrooms attached to that facility. Classrooms have to be 
activated explicitly. Deactivating a facility results in deactivating all the classrooms. 

To activate or deactivate a facility 

1. Log in to Skillport as Administrator and navigate to the Admin area. 

2. Navigate to the Resource Management page. 

3. Display the details of a required facility. 

4. Click Deactivate in the Info pane. The Resource pane will refresh and the deactivated facility 
does not display in the Resource pane. 

Note: The deactivated facilities will only appear in the Resource pane, if the Show 
Deactivated check box is selected. 

5. Make the required changes and click Save. 
 

Delete a Facility 
This procedure will enable you to delete the facility permanently and remove it from the Resource 
pane.  

Note: A facility can be deleted only if it is not associated to any course/sessions. 

To delete a facility 

1. Log in to Skillport as Administrator and navigate to the Admin area. 

2. Navigate to the Resource Management page. 

3. Display the details of a required facility. 

4. Click the Delete button in the Info pane. 

5. Click OK to confirm the action. 

The facility is deleted and does not display in the Resource pane.  
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Classrooms 

View Classroom Information 
Using the Info pane, you can modify the details of a classroom. 

To view classroom information 

1. Log in to Skillport as Administrator and navigate to the Admin area. 

2. Navigate to the Resource Management page. 

3. Browse for the required classroom by expanding the facility to which the classroom is 
attached. 

Note: You can alternatively use the Search utility to find the classroom directly. 

4. Expand the list of classrooms below the specific facility. 

5. Select the required classroom.  

The details of the classrooms appear in the Info pane. 

 

 
 

Create a New Classroom 

To create a new classroom 

1. Log in to Skillport as Administrator and navigate to the Admin area. 

2. Navigate to the Resource Management page. 

3. Click New Classroom in the Resources pane. The New Classroom screen appears. 

 

4. Enter the required details. 

Note: The Classroom ID is unique across Skillport. The Classroom Name must be unique 

within the facility. 
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5. Click Save. If you want to create another classroom, click Save & Add Another. 

 
 

Edit a Classroom 

To edit a classroom 

1. Log in to Skillport as Administrator and navigate to the Admin area. 

2. Navigate to the Resource Management page. 

3. Display the details of a required classroom. 

4. Click Edit in the Info pane. The Edit Classroom page appears. 

5. Make the required changes and click Save. 

 
 

Activate or Deactivate a Classroom 
You can activate or deactivate a classroom by following the steps given below. 

Note: Classrooms have to be activated explicitly. Activating a facility does not activate classrooms 
attached to that facility. Deactivating a facility results in deactivating all the classrooms. 

To activate or deactivate a classroom 

1. Log in to Skillport as Administrator and navigate to the Admin area. 

2. Navigate to the Resource Management page. 

3. Display the details of a required classroom. 

4. Click Deactivate in the Info pane. The Resource pane will refresh and the deactivated 
classroom does not display in the Resource pane. 

Note: The deactivated classrooms will only appear in the Resource pane, if the Show 
Deactivated check box is selected. 

5. Make the required changes and click Save. 

 
 

Delete a Classroom 
This procedure will enable you to delete the classroom permanently and remove it from the Resource 
pane.  

Note: A classroom can be deleted only if it is not associated to any course/sessions. 

To delete a classroom 

1. Log in to Skillport as Administrator and navigate to the Admin area. 

2. Navigate to the Resource Management page. 

3. Display the details of a required classroom. 
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4. Click Delete button in the Info pane. 

5. Click OK for the confirmation message that appears. 
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Contacts 

The contacts in the Resources section display external contact information (such as vendors or 
building owners). Within this view, you can create a hierarchy of contacts (for example, you can create 
a contact entry for a training vendor and then note all instructors associated with that vendor). You can 
sort contacts by Code, Name or Status. You can use the ILT Search bar to enter key words to narrow 
the results on the page. 

Note: For your convenience, the ILT system maintains your contacts, but they are not used by 
Skillport in any way.  

 

View Contact Information 
Using the Info pane, you can modify the contact details of a particular owner of a facility. You can also 
use the Search bar to narrow the results on the page. 

To view contact information 

1. Log in to Skillport as Administrator and navigate to the Admin area. 

2. Navigate to the Resource Management page. 

3. Browse or search for the required contact. The details of the selected contact appear in the 
Info pane. 

 

Create a New Contact 

To create a new contact 

1. Log in to Skillport as Administrator and navigate to the Admin area. 

2. Navigate to the Resource Management page. 

3. Click New Contact in the Resources pane. The New Contact page appears. 
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4. Enter the required details. 

Note: The Contact Name and Contact ID must be unique. If the contact person cannot be 
reached, the contact entered in the Related Contact field is the next point of contact to get 

the details about the courses, sessions, facilities and classrooms. 

5. Click Save. If you want to create another contact, click Save & Add Another. 

 
 

Edit a Contact 

To edit a contact 

1. Log in to Skillport as Administrator and navigate to the Admin area. 

2. Navigate to the Resource Management page. 

3. Display the details of a required contact. 

4. Click Edit in the Info pane. The Edit Contact page appears. 

5. Make the required changes and click Save. 

 
 

Activate or Deactivate a Contact 
You can activate or deactivate a contact by following the steps given below. 

To activate or deactivate a contact 

1. Log in to Skillport as Administrator and navigate to the Admin area. 

2. Navigate to the Resource Management page. 

3. Display the details of a required contact. 

4. Click Deactivate in the Info pane. The Resource pane will refresh and the deactivated contact 
does not display in the Resource pane. 

Note: The deactivated contacts will only appear in the Resource pane, if the Show 
Deactivated check box is selected. 

5. Make the required changes and click Save. 

 
 

Delete a Contact 
This procedure will enable you to delete the classroom permanently and remove it from the Resource 
pane.  

Note: A contact can be deleted only if it is not associated to any course, session, facility, classroom or 
contact. 

To delete a contact 

1. Log in to Skillport as Administrator and navigate to the Admin area. 
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2. Navigate to the Resource Management page. 

3. Display the details of a required contact. 

4. Click Delete in the Info pane. 

5. Click OK for the confirmation message that appears. 

The contact is deleted and does not display in the Resource pane.  
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Upload ILT Content 

You can use the Batch Add view to bulk-upload contacts, facilities, classrooms, courses, sessions and 
enrollments. Use it to upload data from another system, spreadsheet, or data from a third party (such 
as an external session vendor). 
 

Upload a Batch of ILT Content 

To upload ILT content 

1. Click Content > ILT > Batch Add.  

The upload screen displays. 

 

Note: If there is more than 1 file to be uploaded at the same time, the order the uploads are 

processed follows how they are ordered on the screen. 

2. Download the correct .csv file for the type of data you wish to upload. For details about each 
template, see: 

 Contacts Template 

 Facilities Template 

 Classrooms Template 

 Courses Template 

 Sessions Template 

 Enrollments Template 

3. Once you've completed the .csv file, click Browse next to the file type that you want to upload. 

The Choose File window displays. 

4. Navigate to the .csv file you want to upload. 

5. Click the .csv file to select it. 
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6. Click Open. 

The path to your .csv file displays in the field.  

7. Repeat these steps for each file type you want to upload. 

8. Click Validate to validate the .csv file(s). 

9. Click Upload. 

The upload process begins. If you have a valid email address, an email is sent containing the 
URL of a status report and the date and time of the batch submission. 

 

Contacts Template 

Use the Contacts Template to upload contact records quickly and easily. The table below shows the 
correct data format for each field in the template. 

Field Name Format 

Name Field is required. Field value must be unique. Field must be less than or equal 
to 80 characters. 

Status The field is required. The field must be one of 0 or 1 where 0 is Deactivated 
and 1 is Activated. 

Contact ID Field is required. Field value must be unique. Field must not contain any 
leading or trailing spaces. Field must be less than or equal to 25 characters. 

Contact Function/Title Field is optional. Field must be less than or equal to 80 characters. 

Related Contact ID Field is optional. Field must match an existing contact or one in the contact 
upload file. 

Company Name Field is optional. Field must be less than or equal to 80 characters. 

Primary E-mail Field is optional. Field must be a valid email address. Field must be less than 
or equal to 80 characters. 

Alternate E-mail Field is optional. Field must be a valid email address. Field must be less than 
or equal to 80 characters. 

Primary URL Field is optional. Field must be a legal URL. Field must be less than or equal 
to 80 characters. 

Alternate URL Field is optional. Field must be a legal URL. Field must be less than or equal 
to 80 characters. 

Phone Number Field is optional. Field must be a legal phone number. Field must be less than 
or equal to 50 characters. 

Alternate/Mobile Field is optional. Field must be a legal phone number. Field must be less than 
or equal to 50 characters. 

Fax Field is optional. Field must be a legal fax number. Field must be less than or 
equal to 50 characters. 

Address 1 Field is optional. Field must be less than or equal to 80 characters. 

Address 2 Field is optional. Field must be less than or equal to 80 characters. 

City Field is optional. Field must be less than or equal to 50 characters. 
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State/Province Field is optional. Field must be less than or equal to 25 characters. 

ZIP/Postal Field is optional. Field must be a valid zip code. Field must be less than or 
equal to 25 characters. 

Country Field is optional. Field must be less than or equal to 50 characters. 

Notes Field is optional. Field must be less than or equal to 2500 characters. 

 
 

Facilities Template 

Use the Facilities Template to upload facility records quickly and easily. The table below shows the 
correct data format for each field in the template. 

Field Name Format 

Facility Name Field is required. Field value must be unique. Field must be less than or 
equal to 80 characters. 

Status Field is required. Field must be one of 0 or 1. 

Facility ID Field is required. Field value must be unique. Field must be less than or 
equal to 20 characters. 

Address 1 Field is optional. Field must be less than or equal to 80 characters. 

Address 2 Field is optional. Field must be less than or equal to 80 characters. 

City Field is optional. Field must be less than or equal to 50 characters. 

State/Province Field is optional. Field must be less than or equal to 50 characters. 

ZIP/Postal Field is optional. Field must be less than or equal to 25 characters. 

Country Field is optional. Field must be less than or equal to 50 characters. 

Contact Name Field is optional. Field must match an existing contact. 

Description Field is optional. Field must be less than or equal to 2500 characters. 

Directions Field is optional. Field must be less than or equal to 2500 characters. 

 
 

Classrooms Template 

Use the Classrooms Template to upload classroom records quickly and easily. The table below 
shows the correct data format for each field in the template. 

Field Name Format 

Facility ID Field is required. Field must match an existing facility. 

Classroom Name Field is required. Field value must be unique. Field must be less than or equal 
to 80 characters. 

Status Field is required. Field must be one of 0 or 1. 

Classroom ID Field is required. Field value must be unique. Field must not contain leading or 
trailing spaces. Field must be less than or equal to 20 characters. 

Capacity Field is required. Field must be in the range 0-99999. 
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Contact Name Field is optional. Field must match an existing contact. 

Description Field is optional. Field must be less than or equal to 2500 characters. 

Directions Field is optional. Field must be less than or equal to 1000 characters. 

 
 

Courses Template 

Use the Courses Template to upload course records quickly and easily. The table below shows the 
correct data format for each field in the template. 

Field Name Format 

Course Title Field is required. Field must be less than or equal to 255 characters. 

Course ID Field is required. Field must contain only alphanumeric characters or the '_' 

character and begin with ilt_.  

Field must be less than or equal to 40 characters, and spaces are not 
allowed. 

Status Field is required. Field must be one of 0 or 1. 

0 - deactivated 

1 - activated 

Language Field is required. Field must be a valid Locale (for example, en-us). 

Duration Field is optional. Field must be positive integer in the range 0-99999. 

Mastery Level Field is required. Field must be in the range 0-100. 

Cost Field is optional. Field must be a valid amount format according to currency 
specified and server locale. 

Currency Field is required. Field must be a valid code. 

Manager Approval 
Required 

Field is required. Field must be one of 0 or 1. 

 0 - no 

 1 - yes 

Session Approval Required Field is required. Field must be one of 0 or 1. 

 0 - no 

 1 - yes 

Course Description Field is optional. Field must be less than or equal to 3500 characters. 

Course Administrator 1 
User Name 

Field is optional. Field must match an existing course administrator. 

Course Administrator 2 
User Name 

Field is optional. Field must match an existing course administrator. 
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Course Administrator 3 
User Name 

Field is optional. Field must match an existing course administrator. 

Session Approver User 
Name 

Field is required if Session Approval Required has value 1. Field must 

match an existing session approver. 

Contact Name Field is optional. Field must match an existing contact or one in the contact 
upload file. 

Instructor Can Manage 
Roster 

Field is required. Field must be one of 0 or 1. 

 0 - no 

 1 - yes 

Facility ID Field is optional. Field must match an existing facility or one in the facility 
upload file. 

Classroom ID Field is optional. Field must match an existing classroom or one in the 
classroom upload file. 

Close Session (days 
before/after session start) 

Field is optional. Field must be in range {-90 -60 -45 (-30.0 to 

30.0) 45 60 90}. 

Prohibit Self-Withdrawal 
(days before session start) 

Field is optional and can be one of the following: 

 leave blank (renders a value of Never) 

 always 

 a number from 1 to 31 

Late Withdrawal (days 
before session start) 

Field is optional and can be one of the following: 

 leave blank (renders a value of Never) 

 a number from 1 to 31 

Minimum Enrollment Field is optional. Field must be in range 0-99999. 

Low Enrollment Alert (days 
before session start) 

Field is optional. Field must be (never) or from 0 to 31. 

san1 Field is required. Field must match an existing item in the extended 
attribute list. 

san2 Field is required. Field must be less than or equal to 250 characters. 

san3 Field is required. Field must match an existing item in the extended 
attribute list. 

2 Field is optional. Field must match an existing item in the extended attribute 
list. 
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Currency Codes for the ILT Course Batch Add CSV File 
Use the table below to determine the correct currency abbreviation that corresponds to your country. 

Currency Code Country Currency Type 

AED United Arab Emirates Dirhams 

ALL Albania Leke 

ARM Armenia Dram 

ARS Argentina Pesos 

AUD Australia Dollars 

BAM Bosnia, Herzegovina Convertible Marka 

BGN Bulgaria Leva 

BHD Bahrain Dinars 

BOB Bolivia Bolivianos 

BRL Brazil Brazil Real 

BYR Belarus Rubles 

CAD Canada Dollars 

CHF Switzerland Francs 

CLP Chile Pesos 

CNY China Yuan Renminbi 

COP Colombia Pesos 

CRC Costa Rica Colones 

CSD Serbia Dinars 

CZK Czech Republic Koruny 

DKK Denmark Kroner 

DOP Dominican Republic Pesos 

DZD Algeria Algeria Dinars 

EEK Estonia Krooni 

EGP Egypt Pounds 

EUR Euro Member Countries Euro 

GBP United Kingdom Pounds 

GTQ Guatemala Quetzales 

HKD Hong Kong Dollars 

HNL Honduras Lempiras 

HRK Croatia Kuna 

HUF Hungary Forint 

ILS Israel New Shekels 
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INR India Rupees 

IQD Iraq Dinars 

ISK Iceland Kronur 

JOD Jordan Dinars 

JPY Japan Yen 

KES Kenya Shilling 

KRW Korea (South) Won 

KWD Kuwait Dinars 

LBP Lebanon Pounds 

LTL Lithuania Litai 

LVL Latvia Lati 

LYD Libya Dinars 

MAD Morocco Dirhams 

MDL Moldova Leu 

MGA Madagascar Ariary 

MGF Madagascar Franc 

MKD Macedonia Denars 

MUR Mauritius  Rupee 

MXN Mexico Pesos 

MYR Malaysia  Ringgit 

NGN Nigeria Naira 

NIO Nicaragua Cordobas 

NOK Norway Krone 

NZD New Zealand Dollars 

OMR Oman Rials 

PAB Panama Balboa 

PEN Peru Nuevos Soles 

PHP Philippines  Pesos 

PLN Poland Zlotych 

PYG Paraguay Guarani 

QAR Qatar Rials 

RON Romania New Lei 

RSD Serbia  Dinars 

RUB Russia Rubles 

SAR Saudi Arabia Riyals 

SDG Sudan Pounds 
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SEK Sweden Kronor 

SGD Singapore  Dollars 

SKK Slovakia Koruna 

SVC El Salvador Colones 

SYP Siyria Pounds 

THB Thailand Baht 

TND Tunisia Dinars 

TRY Turkey New Lira 

TWD Taiwan New Dollars 

UAH Ukraine Hryvnia 

UGX Uganda  Shilling 

USD United States of America Dollars 

UYU Uruguay Pesos 

VEF Venezuela Bolivares Fuertes 

VND Viet Nam Dong 

XAF Communauté Financière Africaine 
(BEAC) CFA  

Francs 

XOF Communauté Financière Africaine 
(BCEAO) 

Francs 

XPF Comptoirs Français du Pacifique 
(CFP) 

Francs 

YER Yemen Rials 

ZAR South Africa Rand 

 
 

Sessions Template 

Use the Sessions Template to upload session records quickly and easily. The table below shows the 
correct data format for each field in the template. 

Field Name Format 

Session ID Field is required. Field must be less than or equal to 50 characters. 

Status Field is required. Field must be one of the following: 

 Unconfirmed 

 Confirmed 

 Completed 

 Canceled 
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Facility ID Field is optional. Field must match an existing facility. 

Classroom ID Field is optional. Field must match an existing classroom or one in the 
classroom upload file. 

Course ID Field is required. Field must match an existing course or one in the 
course upload file. 

Language Field is required. Field must be a valid locale (for example, en-us). 

Capacity Field is required. Field must be in the range 0-99999. 

Instructor User Name Field is optional. Field must match an existing instructor. 

Time Zone Field is required. Field must be a legal time zone (for example, 

America/New_York). 

Contact ID Field is optional. Field must match an existing contact. 

Notes Field is optional. Field must be less than or equal to 2500 characters. 

Schedule Time Field is required if Status is Confirmed. Field must be of the format 

mm/dd/yyyy hh:mm (for example, 10/12/1972 13:54). 

Duration Field is required if Status is Confirmed. Field must be a valid float in 

range 0.0-24.0. 

Session Administrator 1 User 
Name 

Field is optional. Field must match an existing session administrator. 

Session Administrator 2 User 
Name 

Field is optional. Field must match an existing session administrator. 

Session Administrator 3 User 
Name 

Field is optional. Field must match an existing session administrator. 

Manager Approval Required Field is required. Field must be either 0 or 1. 

 0 - Not required 

 1 - Required 

Session Approval Required Field is required. Field must be either 0 or 1. 

 0 - Not required 

 1 - Required 

Session Approver User Name Field is required if Session Approval Required has value 1. Field must 

match an existing session approver. 

Instructor Can Manage Roster Field is required. Field must be either 0 or 1. 

 0 - Not required 

 1 - Required 

Type Field is optional. Field must be : 

 0 for Physical Classroom, or  
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 1 for Dialogue Live, or  

 2 for Other 

Phone Field is optional. Field must be less than or equal to 50 characters. 

Alt Phone Field is optional. Field must be less than or equal to 50 characters. 

Passcode Field is optional. Field must be less than or equal to 20 characters. 

URL Field is optional. Field must be less than or equal to 255 characters. 

Open to Enrollment Field is required. Field must be either 0 or 1. 

 0 - closed to enrollment 

 1 - open to enrollment 

Close Session (days 
before/after session start) 

Field is optional. Field must be in range {-90 -60 -45 (-30.0 to 

30.0) 45 60 90}. 

Prohibit Self-Withdrawal (days 
before session start) 

Field is optional and can be one of the following: 

 leave blank (renders a value of Never) 

 always 

 a number from 1 to 31 

Late Withdrawal (days before 
session start) 

Field is optional and can be one of the following: 

 leave blank (renders a value of Never) 

 a number from 1 to 31 

Minimum Enrollment Field is optional. Field must be in range 0-99999. 

Low Enrollment Alert (days 
before session start) 

Field is optional. Field must be (never) or from 0 to 31. 

san1 Field is required. Field must match an existing item in the extended 
attribute list. 

san2 Field is required. Field must be less than or equal to 250 characters. 

san3 Field is required. Field must match an existing item in the extended 
attribute list. 

2 Field is optional. Field must match an existing item in the extended 
attribute list. 
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Enrollments Template 

Use the Enrollments Template to upload registrations quickly and easily. The table below shows the 
correct data format for each field in the template. 

Field Name Format 

Session ID Field is required. Field must match an existing session ID. 

Student Login Field is required. Field must be a Skillport login id. 

Send Notification Field is required. Field must be one of 0 or 1 where 0 is not send and 1 is 
send. 

 
 

ILT Event Journals 

Use the Event Journals view to run journals (reports) on various ILT functions, such as enrollments, 
approval decisions, sessions, and courses. 

Note: When an ILT Administrator changes a session schedule after the session has been set to 
Completed, Skillport reporting and ILT Event Journals do not reflect this change. Only the data as 
recorded in the database at the time the session is marked as complete is reflected; additional 
changes do not render. 

To view and generate event journals 

1. Click Reports > ILT Event Journals. 

The ILT Event Journal page displays: 

 

2. Select the journals you wish to view using the checkboxes available. 
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 Withdrawals: A log of learners withdrawn from an ILT session, by whom, the course and 

session and when the withdrawal was performed. Withdrawal data includes Withdrawn 

For, Withdrawn By, Title, Session ID, Withdrawal Date and Withdrawal Time. 

 Enrollments: A log of learners enrolled into an ILT session, by whom, the course and 

session and when the enrollment was performed. Enrollment data includes Learner 

Name, Enrolled By, Title, Session ID, Enrollment Date and Enrollment Time 

 Approvals: A log of ILT enrollment approval (and denial) actions listing learner, approver, 

approval results and notes and date performed. This report lists the Learner, Approver, 

Approval Results, Notes, Date and Time. 

 Course Create: A log of new ILT Courses created, by whom and when. Course Create 

data includes Course Created By, Course ID, Title, Date and Time. 

 Session Create: A log of new ILT Sessions created showing parent course, created by 

whom and when. Session Create data includes Session Created By, Session ID, Title, 

Date and Time. 

 Course Change: A log of ILT Courses whose attributes were changed, by whom and 

when. Course Change data includes Course Changed By, Course ID, Title, Attribute 

Changed, Date and Time. 

 Session Change: A log of ILT Sessions whose attributes were changed showing parent 

course, changed by whom and when. Session Change data includes Session Changed 

By, Session ID, Title, Attribute Changed, Date and Time. 

 Session-Close-Waitlist: A list of Waitlisted Learners moved to the parent course's Watch 

List when a session is closed and its Waitlist is purged. It lists Title, Session ID, Session 

Start Date, Session Start Time, Wait List Learner, Session Close Date and Session Close 

Time. 

3. Click Generate Journal to download the specified journals. A .zip file downloads. 

4. Extract the contents of the .zip file. 

5. Open the .csv file(s) to view the contents of each journal. 

Note: The .csv file(s) can be opened in spreadsheet programs (such as Microsoft Excel). 
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Instructor Features 

As an instructor, you can manage most of the ILT sessions details you deliver and also manage the 
session roster. 

 
 

Sessions I am Teaching 

As an instructor, you can manage many of the details related to the ILT sessions you deliver. You can 
view a list of sessions you are teaching, including session number, status, type, catalog number and 
title, and also manage the session roster. 

To view the session information 

1. Log in to Skillport as an Instructor and navigate to the Admin area.  

2. Click Content > ILT > Sessions I Am Teaching. The Sessions I Am Teaching page 
displays: 

 

3. Select the session you want to view. The session details display. 

4. Click Cancel to return to Skillport. 

You can click a session ID to view session details on your upcoming sessions, edit session 
information, and, once completed, input student progress results. 

When you are assigned a session to teach, you will receive an email notification with the session 
details, or if a session you are teaching is canceled, you will receive an email notification of the 
cancelation. 
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Manage Enrollments 

Enroll Learners in a Session 
An Instructor has to be assigned to the specific session in order to enroll learners into a session. 

To enroll learners manually in a session 

1. Click Content > ILT > Course and Session Manager. 

2. Click the Session Manager tab. 

3. Click the Session ID you wish to view. 

The View Session window displays. 

4. Click Manage Enrollments. 

The following screen displays: 

 

5. Find the user or group you wish to assign to the session by using the search or find the user 
name or group name on the list. 

The Search Bar is available on top of the screen, allowing you to search for a user or group in 
basic and advanced modes. The Search fields in Advanced mode for users are:  

 Group 

 Email 

 User Name 

 Last Name 

 First Name 
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 City 

 State 

 Include Ineligible to Enroll 

The Search fields in Advanced mode for groups are:  

 Group Name 

 Org Code 

The Users and Groups pane refreshes to show the search results. 

6. Once you have found the user or group that you require, select it and click Add to add to the 
current enrollments. 

The user or group will be added to the Roster of that session. 

 
 

Withdraw Learners from a Session 
The following are the procedures followed to withdraw a learner from a session. 

To withdraw learners manually when managing enrollments 

1. Click Content > ILT > Course and Session Manager. 

2. Click the Session Manager tab. 

3. Click the Session ID you wish to view. 

The View Session window displays. 

4. Click Manage Enrollments. 

5. Click the name of the learner in the roster found in the right hand window pane that you want 
to withdraw. 

6. Click Withdraw. 

7. The learner is withdrawn from the session. 

To withdraw learners directly from the roster 

1. Click Content > ILT > Course and Session Manager. 

2. Click the Session Manager tab. 

3. Click the Session ID you want to view. 

The View Session window displays. 

4. Click the Roster tab. 

The list of learners enrolled in the session displays. 

5. Click the Withdraw learner button next to the learner you want to withdraw. 

6. Click Yes in the confirmation message that displays. 
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7. The learner is removed from the roster of the session. 

 

 
 

Moving Learners to the Waitlist 
The following is the procedure followed to move a learner to the waitlist. 

To move a learner to the waitlist 

1. Click Content > ILT > Course and Session Manager. 

2. Click the Session Manager tab. 

3. Click the Session ID you wish to view. 

The View Session window displays. 

4. Click Manage Enrollments. 

The following screen displays: 

 

5. Click the name of the learner in the roster and click Move to Waitlist. 

 

 
 

View Attendance 

To view attendance of Learners in a session 

1. Click Content > ILT > Course and Session Manager. 

2. Click the Session Manager tab. 
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3. Click the Session ID you wish to view. 

The View Session window displays. 

4. Click the Roster tab. 

The list of learners enrolled in the session appears. 

5. Click Attendance Sheet.  

The attendance sheet opens in a new window. This sheet contains the following details: 

 Instructor: Name of the Instructor. 

 Session ID: ID of the session that the Learner has enrolled for. 

 Course ID: ID of the course which contains the session. 

 Title: Title of the session. 

 Facility: Facility which the session is conducted in. 

 Classroom: Classroom which the session is conducted in. 

 Start: Date and time that the session starts. 

 End: Date and time that the session ends. 

 Name: Name of the Learner. 

 User Name: User name of the Learner 

 Email: Email address of the Learner 

 Student Signature: Space for signature of the student. 

6. Click Print to print out the attendance sheet, or click Close to close the window. 
 

Entering Results 

When the scheduled session is complete, you can enter results for enrolled learners. 

An ILT Course is considered a Completion for a learner when both of the following conditions are met:  

 the learner's session record has a Passed value of Yes, AND 

 the session has been marked as Completed 

A learner’s Actual Duration gets its value from the parent ILT Course record’s Duration value. The 
Actual Duration value is populated when the learner has completed an ILT Session for that ILT 
Course.  

Note: The results can only be modified after the session is marked complete. A Learner's results 

appear in a Learner's My Report. 

To enter results for a Learner in a session 

1. Click Content > ILT > Sessions I am Teaching. 
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2. Click the Session ID you wish to view.  

The View Session window displays. 

3. Click the Roster tab.  

The list of learners enrolled in the session displays. 

4. Click the Enter Results button.  

The following screen displays. 

 

5. Click the relevant check boxes and enter details for the following fields: 

 Attd (Attended) 

 Pass 

 Score 

 Notes 

6. Click Submit All to save the changes and enter the results. Reset clears all changes made. 
 

Quiz Results 

The quiz results can be viewed in this section. The average score can be imported and the quiz results 
can be exported from this page. 

To view quiz results for a Learner in a session 

1. Click Content > ILT > Course and Session Manager. 

2. Click the Session Manager tab. 

3. Click the Session ID you wish to view. 

The View Session window displays. 

4. Click the Roster tab. 

The list of Learners enrolled in the session displays. 
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5. Click the Quiz Results button. The following screen displays. 
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Skillsoft Advantage 

About Skillsoft Advantage Content 

In order for your learners to access Skillsoft Advantage content from Skillport, you must entitle it to 
them in Skillport Administrator.  Entitling content allows learners to access content items, as well as 
view them in Skillport. A content item that is not entitled to a user either explicitly or through 
inheritance, will not appear in Skillport Learner.  

You can entitle Skillsoft Advantage content to your learners at the track level, at the content item level, 
or both. 

Note: All book and video content must be entitled to the learner through the appropriate Books24x7 
Collection. Once a collection is entitled, the book and video content items will be available from within 
the learning track, and from outside the learning track.  

Entitling at the Track Level 

Entitling Skillsoft Advantage content at the track level allows learners to access the track and all 
content items within the track. With this option, only the learning tracks will appear in Skillport Learner. 
Individual content items will only be available from within the track and will not appear in Skillport 
Learner.  

If you want your learners to access the learning tracks from the Skillsoft Advantage Home page, you 
must entitle them to the Home page in addition to the tracks. 

This option is useful if you want your learners to access all tracks from the home page of a Skillsoft 
Advantage product.   

The following image depicts the appearance of a Home page and it's associated learning tracks within 
the Catalog Assigner. 

 

1. Skillsoft Leadership Advantage 2.0 Home page. 

2. Leadership Advantage 2.0 learning tracks. 

Entitling at the Track and Content Item Level 

Entitling content at the track level, and at the content item level, allows learners to access the item 
from within the track or from outside the track.  With this option, the learning tracks and the individual 
items will appear in Skillport Learner. 

This option is useful if you want your learners to access a few tracks in their entirety, and specific 
content items from other tracks in Skillport. 

For more information about entitling content, see Working with Entitlements. 
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Entitling Skillsoft Advantage Content 

Skillsoft Advantage content is entitled to learners through the Catalog Assignment tab within the User 
Management Administrator page.  

There are three ways to locate and entitle Skillsoft Advantage content in the Catalog Assigner window. 

 From the Course Curricula folder. (Recommended) 

 Groups content by content type 

 Provides easy access to all related tracks and associated content items 

 From the Skillsoft Library folder. 

 Groups content by subject matter 

 With the Search feature.  

 Allows you to search for specific tracks or content items by content type and subject 

matter 
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Entitling Content from the Course Curricula Folder 

The Course Curricula folder groups content together according to content type. For instance, all 
Skillsoft Leadership Advantage 2.0 tracks and associated content items are listed under the Skillsoft 
Leadership Advantage 2.0 folder.  

 

Expanding the Skillsoft Leadership Advantage 2.0 folder displays: 

1. All folders that contain content items for individual tracks. 

2. The Leadership Advantage 2.0 Home page and the Leadership Advantage 2.0 learning tracks. 
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From this view, you can select one or more tracks, and you can select the folders which contain the 
learning track content items.  

 

To provide learners access to the learning tracks form the Leadership 

Advantage 2.0 Home page 

1. On the navigation bar, click Users & Groups > User Management.  

2. In the left panel, select the group or user to which you want to entitle content.  

3. In the right panel, click the Catalog Assignment tab. 

4. Click Edit Group or Individual Assignments. 

5. Under the Course Curricula folder, select Skillsoft Leadership Advantage 2.0. 

6. Select the desired tracks. 

7. Click Add, or drag the content to the right pane and drop it into the Catalog Assignment folder. 
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Important Notes: 

 Entitling the Home page does not entitle the learning tracks. Each learning track must also be 

entitled to the learner. 

 Entitling the learning track does not provide the learner with access to content from outside 

the learning track. You must entitle the learner to the individual content items. 

To provide learners access to Skillsoft Leadership Advantage 2.0 content items 

from outside the learning tracks 

1. After step 5 above, select the folder that contains the content items associated with the 
specific learning track.  

2. Click Add, or drag the content to the right pane and drop it into the Catalog Assignment folder. 

Note: Selecting an entire folder makes all content items within the folder accessible from Skillsoft 

Advantage and Skillport Learner. 

Optionally, you can expand the folder containing the content items and select individual items.  

 

 

Entitling Content from the Skillsoft Library 

You can entitle Skillsoft Advantage content from the Skillsoft Library by locating and selecting the 
entire library, individual library folders, individual tracks, or individual content items and then adding 
them to the Catalog Assignment folder.   

If you would like to entitle the Skillsoft Library to all or many learners, but entitle Skillsoft Advantage 
only to a few learners, you can create a custom library by copying the Skillsoft Library and removing 
the Skillsoft Advantage content. You can then entitle the custom library by following the steps below, 
and entitle the Skillsoft Advantage content from the Course Curricula folder.  

 

Note: When you create a custom library, you must designate the library's browse view in order for 

your learners to view it from their Browse view. 
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To entitle content from the Skillsoft Library 

1. On the navigation bar, click Users & Groups > User Management.  

2. In the left panel, select the group or user to which you want to entitle content.  

3. In the right panel, click the Catalog Assignment tab. 

4. Click Edit Group or Individual Assignments. 

5. In the Browse Catalog tab, select the Skillsoft Library folder. 

6. Click Add, or drag the folder to the right pane and drop it into the Catalog Assignment folder. 

Optionally, you can expand the Skillsoft Library folder and select individual folders. 

 

 

Entitling Content with the Search Feature 

The Search feature allows you to search for Skillsoft Advantage tracks using the keyword "leadership", 
"sales", or "professional", with the Category filter set to Skillsoft Advantage. This option is convenient 
when you want to entitle your learners to a Skillsoft Advantage Home page and any related learning 
tracks. To locate individual content items, use the Course Curricula folder. 

To entitle content with the Search feature 

1. On the navigation bar, click Users & Groups > User Management.  

2. In the left panel, select the group or user to which you want to entitle content.  

3. In the right panel, click the Catalog Assignment tab. 
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4. Click Edit Group or Individual Assignments. 

5. In the Search for field, enter the subject matter for the desired Skillsoft Advantage product, 
such as "Leadership." 

6. With the Category drop down, select Skillsoft Advantage in order to refine the search 
results. 

7. In the search results, select the desired content.  

8. Click Add, or drag the content to the right pane and drop it into the Catalog Assignment folder. 

 

For more information about entitling content, see Working with Entitlements. 
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Keywords 

Understanding Keywords 

A keyword is a word or phrase that you can link to an asset, for example, a course or a book. If the 
search phrase that you enter includes that word or phrase, the linked asset is returned in the search 
results. 

Keywords allow you to associate assets with specific identifiers, such as corporate buzzwords, job 
titles, skill classification descriptors, and common misspellings. This makes it easier for learners and 
administrators to search for and find relevant instructional material. 

A keyword can be associated with one or more assets, and an asset can have one or more associated 
keywords. 

Asset Searches Using Keywords 

Users can use keyword searches to search for associated assets anywhere that asset searches are 
possible, for example, using SEARCH&LEARN in Skillport or using the search fields in the Catalog 
Assigner in the Skillport Administrator. 

When you use a wild card in a search expression, the assets associated with all applicable keywords 

are returned. For example, if you enter program*, then the assets linked to all keywords beginning 

with "program," such as "programming" and "programmer," are returned. 

Note: You can only use a wild card at the end of a search term. 

Support for Multiple Languages 

You can define keywords in any language that is supported by the Unicode character set. For 
example, you can create an English keyword for a Chinese asset, and vice versa. 

Invisible Keywords 

Keywords can be visible or invisible to learners. If they are visible, learners can see them on the 
summary pages of assets. If they are invisible, learners cannot see them. Invisible keywords can be 
useful in cases such as common misspellings. 

Company Administrators can still see any keywords in the Learner UI that are invisible. However, 
these keywords are not visible to learners, managers, or administrators.  
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View Existing Keywords 

To view existing keywords 

 Click Content > Keywords on the navigation bar. 

 

By default, keywords are sorted numerically, then alphabetically by capitalized keyword, and 
finally alphabetically by lowercase keyword. 

To change the sort order of a column, click the column header. To view the details of a 
keyword and its linked assets, expand the + (plus) sign beside that keyword. 

 

To display assets for a keyword that has 10 or more assets linked to it, click View More. 
 

Create a Keyword 

A keyword is a word or phrase that you can link to an asset, for example, a course or a book. If the 
search phrase that you enter includes that word or phrase, the linked asset is returned in the search 
results. 

Keywords allow you to associate assets with specific identifiers, such as corporate buzzwords, job 
titles, skill classification descriptors, and common misspellings. This makes it easier for learners and 
administrators to search for and find relevant instructional material. 

Note: You can create a maximum of 150 keywords. 
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To create a keyword 

1. Click Content > Keywords on the navigation bar. 

 

2. On the Keyword Management page, click New. 

3. Enter the desired keyword information: 

 Keyword: (Required) The word or phrase. You can enter a maximum of 64 characters. All 

keywords must be unique, and the following characters are supported: 

- The space character (used to separate words in a phrase) 

- Any letter in any language 

- Any number in any language 

- Any currency character 

- Any of the following ASCII graphical characters (which are used like a letter or number in 
a tag): #  % + - . / : @ ^ _ $,  

(number sign, percent sign, plus sign, hyphen (minus), full stop (period, dot, decimal 
point), solidus (slash), colon, at sign, circumflex accent, underscore, dollar sign) 

 Visible:  

If you select this option, the keyword is visible to all users, and displays in search results 
and on the summary pages of the assets to which it is linked.  

If you clear this option, the keyword is visible only to company administrators in search 
results and on the Details page, and is displayed in italics to indicate that it is not visible to 
other users. The keyword will not be visible to learners, managers, or administrators. 

Note: If entering a keyword as a corrective measure (for example, using a commonly 
misspelled word, such as "customre" instead of "customer", to display intended results), 
you can leave this option cleared so the misspelled word does not display for learners, 
managers, or administrators in the user interface. 

 Description: A phrase describing the keyword or the reason for its use. You can enter a 

maximum of 256 characters. 

4. Click Save. 

You can now link the keyword to assets so that they can be used in searches for assets. 
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Link a Keyword to Assets 

You can link a keyword to any asset for which you can browse or search, for example, courses, books, 
and SkillBriefs. 

To link a keyword to assets 

1. Click Content > Keywords on the navigation bar. 

 

2. Select the keyword, and click Links. 

 

3. In the Browse Catalog pane, locate the asset to which you want to link the keyword. You can 
do this in 2 ways: 

 Browse the Catalog by navigating through its structure. 

 Search for the asset using the search fields at the top of the page. For detailed 

information on the search tool, including tips on creating search expressions, see Search 

for Assets and Folders on page 14. 

4. In the left pane, select the asset. 
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Note: You can also select a folder in the Catalog. If you do this, all assets currently in the 
folder and its subfolders will be linked to the keyword. Since linking a large number of assets 
can be time-consuming, if you select a folder that contains more than 25 assets, you will be 
prompted to confirm the action. 
 
In addition, be aware that if the contents of a folder subsequently change, there is no effect on 
any asset's keywords. You must manually link or unlink assets as needed. 

5. Click Link. Or, you can drag and drop the asset into the right pane. 

6. Repeat steps 3 through 5 as needed. 

7. Click Save & Exit. 

Note: There may be a short delay before your changes affect Catalog searches while the database is 
updated accordingly. Links to books can require the most time (typically, a maximum of 5 minutes) to 
be applied and begin working in searches. 

 

Unlink Assets from a Keyword 

To unlink assets from a keyword 

1. Click Content > Keywords on the navigation bar. 
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2. Select the keyword, and click Links. 

 

3. In the Linked Assets pane: 

a. Select the asset to remove. To select multiple assets, use Shift+click or Ctrl+click. 

b. Click Delete Link(s). 

4. Click Save & Exit. 

Note that there may be a short delay before your changes affect Catalog searches while the database 
is updated accordingly. 
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Copy a Keyword's Linked Assets 

As a convenience feature, you can copy one keyword's linked assets to another keyword. This allows 
you to quickly link a large number of assets to a keyword by 1) performing the copy and then 2) adding 
or removing individual assets as appropriate. 

To copy a keyword's linked assets 

1. Click Content > Keywords on the navigation bar. 

 

2. Select the asset that has the linked assets that you want to copy, and click Copy Links. 

 

3. In Destination Keyword, select the keyword to which you want to copy the linked assets. 

4. Click Copy, and then click OK. 

The linked assets are copied to the destination keyword. Note that there may be a short delay 
before your changes affect Catalog searches while the database is updated accordingly. 

5. If desired, add or remove individual linked assets as appropriate. 
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Edit a Keyword 

You can edit all aspects of a keyword. However, be aware that changing the name can be a process-
intensive operation because it requires all linked assets to be updated accordingly. 

To edit a keyword 

1. Click Content > Keywords on the navigation bar. 

 

2. Select the keyword that you want to edit, and click Edit. 

3. In the Edit Keyword dialog box, change the keyword's information as needed: 

 Keyword: (Required) The word or phrase. You can enter a maximum of 64 characters. All 

keywords must be unique, and the following characters are supported: 

- The space character (used to separate words in a phrase) 

- Any letter in any language 

- Any number in any language 

- Any currency character 

- Any of the following ASCII graphical characters (which are used like a letter or number in 
a tag): #  % + - . / : @ ^ _ $,  

(number sign, percent sign, plus sign, hyphen (minus), full stop (period, dot, decimal 
point), solidus (slash), colon, at sign, circumflex accent, underscore, dollar sign) 

 Visible:  

If you select this option, the keyword is visible to all users, and displays in search results 
and on the summary pages of the assets to which it is linked.  

If you clear this option, the keyword is visible only to company administrators in search 
results and on the Details page, and is displayed in italics to indicate that it is not visible to 
other users. The keyword will not be visible to learners, managers, or administrators. 

Note: If entering a keyword as a corrective measure (for example, using a commonly 
misspelled word, such as "customre" instead of "customer", to display intended results), 
you can leave this option cleared so the misspelled word does not display for learners, 
managers, or administrators in the user interface. 

 Description: A phrase describing the keyword or the reason for its use. You can enter a 

maximum of 256 characters. 

4. Click Save. 
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Note that there may be a short delay before your changes affect Catalog searches while the database 
is updated accordingly. 
 

Delete a Keyword 

You can delete a keyword at any time, which also removes it from all linked assets. Deleting a 
keyword has no impact on an asset itself. 

To delete a keyword 

1. Click Content > Keywords on the navigation bar. 

 

2. Select the keyword you want to delete. 

3. Click Delete, and then click OK. 
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Evaluations 

You can create evaluations to gather information about completable learning assets and to allow users 
to provide feedback on their learning experiences. The evaluations can be linked to any asset with 
completion criteria. Skillport includes a standard default evaluation containing 23 questions to get you 
started. You can use some or all of these questions, or create your own custom evaluation. 

To access the Evaluation Manager, click Content > Evaluations on the navigation bar. The 
Evaluation Manager shows the existing evaluations listed in alphabetical order. 

 

Company administrators, administrators, and managers can run Evaluation reports. 
 

Skillsoft Default Evaluation 

To aid you in creating your own evaluations, Skillport includes a sample evaluation named "Skillsoft 
Default Evaluation." This evaluation comes with 23 standard questions. You can quickly copy this 
evaluation and then customize the copy as needed. 

Before you begin creating custom evaluations, Skillsoft recommends that you preview the Skillsoft 
Default Evaluation in order to view its contents. For step-by-step information on how to preview an 
evaluation, see Preview an Evaluation on page 352. 

 

 
 

Create an Evaluation 

You can create an evaluation from scratch. However, if an existing evaluation closely resembles the 
desired new result, you can copy the existing evaluation instead and then modify its contents as 
needed. For more information, see Copy an Evaluation on page 354. 

To create an evaluation 

1. Click Content > Evaluations on the navigation bar. 

The Evaluation Manager appears. 

2. Click New Evaluation. 
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The New Evaluation page appears.  

 

3. Enter the information for the evaluation: 

Field Description 

Title (Required) Enter a title for the evaluation. The maximum length is 255 
characters. 

Internal Notes Enter any internal information for the administrator. This text is not visible to the 
user. The maximum length is 4,000 characters. 

Language Select the language to display the evaluation in to users. 

4. Click New Question.  

The New Question dialog box appears.  

 

5. In Type, select the question type from the drop-down list.  

Valid options are Yes/No, Likert Scale, Drop Down, and Text Entry. The fields in which you 
enter question information vary depending on which type of question you select from the drop-
down list.  

 Maximum question length is 500 characters. 

 Maximum response to a text-type question is 4000 characters. 

6. Select Required to specify that the question is mandatory. 

7. Enter the question text into the form, and then click the appropriate next step: 

 OK: Enters the question and returns you to the New Evaluation screen. 
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 OK and Add Another: Enters the question and displays the new question form for your 

next entry. 

 Cancel: Closes the new question form and returns you to the New Evaluation screen. 

Note: While creating your evaluation, you can click Preview to preview exactly how it will 
appear to users.  After previewing, you can use the menu options to edit, remove, or 
rearrange questions by moving them up or down in the list. 

8. Click Save to save the evaluation. 

9. Click Exit to return to the Evaluation Manager. 

The new evaluation now appears in the list in the Evaluation Manager. 

10. Link the evaluation to one or more learning assets. 

 
 

Preview an Evaluation 

You can preview evaluations while you are creating them or after they have been saved. Previewing 
an evaluation allows you to ensure the content is arranged in a logical order, to experience the user 
perspective, and to test for accuracy. 

To preview an evaluation during creation 

1. Begin to create, copy, or edit an evaluation so that it is open for changes. 

At any point after questions have been entered, click Preview to display the evaluation.  

2. After previewing the evaluation, do one of the following: 

 Click Print to print the evaluation. 

 Click Close Preview to return to the Evaluation Manager page. 

If desired, you can edit, delete, or reorder questions, then preview the evaluation again. 

3. Do one of the following:  

 Click Save to save any changes. 

 Click Exit to return to the Evaluation Manager page. 

To preview an evaluation after it has been saved 

i. Click Content > Evaluations on the navigation bar. 

The Evaluation Manager page appears. 

ii. Select an evaluation from the list, and click Preview. 



Skillport 8 Administrator Guide ©2015 Skillsoft  353 
 

Content   
 
 

The evaluation opens, showing all questions in the order they will appear in the evaluation. 
The example below shows the four possible question types: Yes/No, Likert Scale, Text 
Entry, and Drop Down. 

 

iii. After previewing the evaluation, do one of the following: 

 Click Print to print the evaluation. 

 Click Close Preview to return to the Evaluation Manager page. 
 

Edit an Evaluation 

You can edit an evaluation while creating it or after it has been saved. You can reword questions, add 
or delete questions, or change the order that the questions display. 

If an evaluation has already been submitted by at least one user, you can only edit certain items: 

Allowed Not Allowed 

 Changing the title, internal notes, or 

language 

 Reordering questions 

 Changing a question's text 

 Adding or removing questions 

 Changing a question's type 

 Changing the values in a drop-down 

question 

To edit an evaluation 

1. Click Content > Evaluations on the navigation bar. 

The Evaluation Manager page appears. 

2. Select an evaluation from the list. 

3. Click Edit.   

The selected evaluation opens. 
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4. Select a question from the list. 

5. Click Edit.  

The Edit Question window appears. 

6. Edit the desired sections. 

7. Click OK to save the edits. 

8. On the Edit Evaluation page, click Save, then click OK. 

9. Click Exit. 
 

Copy an Evaluation 

Many evaluations will reuse questions from other evaluations. Rather than creating each evaluation 
from scratch, you can customize existing evaluations by copying, modifying, and renaming them, 
saving time and retaining consistency throughout your evaluations.  

To copy an evaluation 

1. Click Content > Evaluations on the navigation bar.  

The Evaluation Manager page appears. 

2. Select an evaluation from the list. 

3. Click Copy.  

The Copy Evaluation window appears. By default, the Title displays as Copy of <selected 
evaluation name>. 

4. Enter the following information: 

Field Description 

Title (Required) Enter a title for the evaluation. The maximum length is 255 
characters. 

Internal Notes Enter any internal information for the administrator. This text is not visible to the 
user. The maximum length is 4,000 characters. 

Language Select the language to display the evaluation in to users. 

5. If desired, edit or reorder the questions in the evaluation: 

 Edit the individual questions in the evaluation. 

 Reorder the questions by dragging them into the desired order.  

6. Click Save. 

A message appears stating the evaluation has been successfully saved.  

7. Click Exit. 

The new evaluation displays in the list on the Evaluation Manager page. 

8. Link the evaluation to one or more learning assets. 
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Link an Evaluation to Learning Assets 

You must link an evaluation to learning content so that it is available to users. You can link an 
evaluation to the following types of content: 

 Courses 

 Live Learning courses (LLCs) 

 Instructor Led Training (ILT) courses 

 Learning programs 

 KnowledgeCenters 

 Business Exploration Series assets 

 Skillsoft Advantage assets 

 External learning objects (ELOs) 

To link an evaluation to learning assets 

1. Click Content > Evaluations on the navigation bar. 

The Evaluation Manager page displays. 

2. Select the evaluation you want to link, and click Link. 

The Link Items page displays, showing the assets in the left pane and the linked items in the 
right pane. You can resize the panes on this page to adjust the viewing window. 

 

 

The Link Items page has three main areas: 

 Search panel: Use this panel at the top to specify the evaluation to link to from those 

available in the drop-down menu, as well as to choose search criteria when you search for 

folders and assets. For more information on this search tool, see Search for Assets and 

Folders on page 14. 
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 All Items pane: Use this pane to browse the assets in their current state (linked or 

unlinked), or to browse the results of a search. 

 Items Linked to pane: Use this pane to view the assets that are linked to the selected 

evaluation. In this pane, you can also specify whether evaluations are required or optional, 

as well as unlink assets from an evaluation. 

If desired, you can modify the presentation of the data on the page. To sort the assets, click 
the desired column header. To change the sort order, click the column header again. Or, click 
the down arrow next to the column header, and click Sort Ascending or Sort Descending on 
the menu. 

3. In Link Items to, select the desired evaluation. 

For more information on the menu options on this page, see Options When Linking 
Evaluations on page 357. 

Note: An evaluation will no longer appear if an asset that it was linked to was uninstalled from 
the Content Installer tab. 

4. In the All Items pane, select an asset or group of assets. 

 To select a range of assets, press and hold the Shift key, then click the first and last items 

in the range. 

 To select multiple assets, press and hold the Ctrl key, then click the desired items in the 

list. 

5. Click Link. The selected assets display in the Items Linked to pane. 

You can also drag and drop selected assets into the right hand pane to link them to the 
selected evaluation. 

To require users to complete an evaluation after completing a linked asset, select Required. 
Otherwise, an evaluation remains optional for the user to complete.  

Note: For required evaluations, the user is prompted to complete the evaluation after 
completing the linked asset. If the user does not complete the evaluation at that time, a 
reminder message displays whenever the user subsequently logs in to Skillport. Required 
evaluations cannot be deleted from a user's Assigned Learning tab of his learning plan. If the 
evaluation is optional, a user is not required to complete the evaluation, and he can delete the 
evaluation.  

6. When you are finished linking assets to evaluations, click Exit. 

7. Assign the content with a linked evaluation to a user's learning plan using the Learning Plan 
Assignment tab. 

The specified evaluation displays in the asset Details page for the linked asset and in the 
user's learning plan upon their completion of the asset. 

Note: Content that cannot be completed (for example, Job Aids, SkillBriefs, and Express Guides) does 
not place an evaluation in a user's learning plan. 
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Menu Options When Linking Evaluations 

The following table describes the various controls and settings you can use when linking learning 
assets to an evaluation. 

Option Description 

Search for Allows you to enter a specific title or keyword to narrow your search results.  

 The Search Results tab displays the returned results. 

 Click Show Details to learn more about a specific asset before 

deciding to link it to an evaluation. 

Category Select one of 12 asset types from the drop-down list to narrow your search 
results. 

Language Select one of 18 languages from the drop-down list to narrow your search 
results. 

Show Unlinked When selected, displays all unlinked assets that can be linked to an 
evaluation. This is selected by default. 

Show All Displays all linked and unlinked assets that can be linked to an evaluation. 

Unlink Select to unlink an asset from an evaluation. 

Required Select this option to make completing an evaluation required after 
completing the linked asset.  

 An evaluation automatically opens after an asset has been 

completed. 

 If the user does not complete the evaluation, a reminder message 

displays whenever the user subsequently logs in to Skillport.  

Optional Select this option to make completing an evaluation for a specific asset 
optional. 

 
 

Delete an Evaluation 

Note: If you delete an evaluation, all the results associated with it will be deleted. If you unlink an 
evaluation from assets instead of deleting the evaluation, the data associated with that evaluation is 
retained, and you can report on it.  

To delete an evaluation 

1. Click Content > Evaluations on the navigation bar. 

The Evaluation Manager page appears. 

2. Select an evaluation from the list. 

3. Click Delete. 

The evaluation no longer displays in the list, and any linked assets are unlinked from the 
evaluation. 
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Credentials 

Credentials are credits or certifications that users earn from professional certification organizations or 
from institutions of higher learning. Additionally, many companies develop their own internal (custom) 
credentialing programs, to ensure that workers are equipped with the job-specific skills necessary to 
support the company direction. 
 

Create a Custom Credential 

Custom credentials can be created with assets you select that align well with a defined skill set or 
business initiative. By developing these internal ("custom") credentials, organizations can ensure that 
workers are equipped with the job-specific skills necessary to support the company direction within 
their department. 

Note: You can only create credentials at the company level. Advanced groups are not supported for 
Credentialing. 

To create a custom credential 

1. Click Content > Credentials on the navigation bar. 

The Credential Manager page appears. 

 

2. In Custom Credentials, click New Credential. 
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The New Credential dialog box appears. 

 

3. Enter the information for the credential using the fields provided: 

Field Description 

Credential Name The name of the credential. This name will appear in the SkillPort UI. This is 
a mandatory field. The credential name must be less than or equal to 60 
characters and cannot include the plus (+) sign. 

Credential Board The group of professionals in a professional association that establish the 
subject standards, policy, and Credential requirements. This is a mandatory 
field. The board name must be less than or equal to 60 characters and 
cannot include the plus (+) sign. 

Credential Sponsor The organization approved by a Credentialing board to carry out the 
Credential requirements. This is a mandatory field. The sponsor name must 
be less than or equal to 60 characters and cannot include the plus (+) sign. 

Description A description of the Credential. This description displays for the Credential on 
the main Credentialing page. The description must be less than or equal to 
1,000 characters and cannot include the plus (+) sign. 

Credit Type A unit of credit that varies depending on the type of Credential. The credit 
type must be less than or equal to 50 characters and cannot include the plus 
(+) sign. 

Examples of credit type are: 

 NASBA: CPE 

 PMI: PDU 

 ISM: Contact Hour 

 CFP: CE 

Instructional Delivery 
Method 

The method of instruction. This value must be less than or equal to 150 
characters and cannot include the plus (+) sign. 

For NASBA, the default value of this field is "Self Study". Other values 
include group-live, group-internet based, lectures, teleconferencing, and so 
on. 
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Field Description 

Course Completion 
Criteria (Minimum 
Passing Score) 

Course completion criteria is a combination of the minimum passing score 
set and, if selected, viewing all content pages. The minimum score that a 
learner must earn to receive credit for a course must be an integer value 
between 0 and 100, inclusive. 

Note: The rule for assessing course completion is as follows: If View All 
Content Pages (described immediately below) check box is selected, then 
course completion is contingent upon meeting the following criteria: 

 The learner's score is equal to or greater than the score you set in 

this Passmark field AND 

 The learner has viewed all of the pages in the course 

If View All Content Pages check box is not selected, then course completion 
is contingent upon only the learner's score being equal to or greater than the 
score you set in this Minimum Passing Score field. 

View all Content Pages Whether or not a learner must page through every page of a course to get 
credit for that course. Possible values are True or False; the default value is 
False. 

Note: Minimum Passing Score (above). 

Sponsor Address 1 The first line of the address that appears on the Credential certificate. The 
address must be less than or equal to 199 characters and cannot include the 
plus (+) sign. 

Sponsor Address 2 The second line of the address that appears on the Credential certificate. The 
address must be less than or equal to 199 characters and cannot include the 
plus (+) sign. 

Logo Image URL The simple file name of the certificate logo that you are using for the 
credentialing certificate. The file name must be less than or equal to 49 
characters, and it cannot include the plus (+) sign or the double quote ( " ) 
character. For example, to use the image in a graphics file named 
CompanyX_Logo.gif, specify CompanyX_Logo.gif as the value of this field. 

This graphics file must be either .jpg or .gif file, and it must be 240 pixels long 
X 86 pixels high.  

Note: You must copy this graphics file into the SkillPortFE\custom\<SName> 
directory, where <SName> is the value of "Short Company Name" for 
SkillPort Company as exhibited inside the Master Admin. 

Signature Image URL The file name of the signature that you are using for the credentialing 
certificate. This file should contain the image of the customized signature for 
the certificate. The file name must be less than or equal to 149 characters, 
and it cannot include the plus (+) sign or the double quote ( " ) character. For 
example, to use the image in a graphics file named CompanyX_Signature.gif, 
specify CompanyX_Signature.gif as the value of this field. 

This graphics file must be either .jpg or .gif file, and it must be 240 pixels long 
X 86 pixels high.  

Note: You must copy this graphics file into the SkillPortFE\custom\<SName> 
directory, where <SName> is the value of "Short Company Name" for 
SkillPort Company as exhibited inside the Master Admin. 

Activate Credential Selecting this check box activates the credential and makes it available to 
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Field Description 

users.  

1. Click Save and Add Items to create the credential. 

The Edit Credential page appears, allowing you to add assets to the credential. 

Note: After the credential is created, you must add courses to it and then activate the 

credential in order to make it available to users. (The credential is deactivated by default). 

2. Add assets to the credential. 
 

Add or Remove Assets from a Custom Credential 

Custom credentials are composed of assets that can be completed. Only these types of assets can be 
added to a Credential. They are: 

 Course 

 Custom Content 

 Final Exam 

 Practice lab 

 Project 

 SkillSim 

 Test Prep 

Types of non-completable assets, such as Knowledge Centers, Learning Programs, and Job Aids, 
cannot be included in a custom Credential. 

To add assets to a custom credential 

1. Click Content | Credentials on the navigation bar. 

The Credential Manager appears. Select a custom credential from the list. 

2. Click Edit.  

The Edit Credential screen appears.  
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The Edit Credential screen is divided into two resizable panes. You use the left pane to 
browse the Catalog in its current state or to browse the results of a search.  The right pane will 
display assets that are linked to the custom credential. 

Note: For detailed information on the search tool, including tips on creating search 

expressions, see Search for Assets and Folders on page 14. 

3. Select the asset or assets that you want to add to the Credential from the list displayed in the 
left pane. 

 To select a range: press and hold down the SHIFT key, and then click the first and last 

item in the list. 

 To select multiple items: press and hold down the CTRL key, and then click individual 

items in the list. 

4. Click Add  between the two panes. The Add Item menu appears.  

 

5. Fill in the following fields for each course in the link: 

 Credit - The number of credits that this asset is worth. This field cannot be empty and 

should include a numeric value. 

 Field of Study - The subject of the credential. This value must be less than or equal to 50 

characters. For NASBA CPE credit, the currently valid options for this field are Accounting 

and Auditing, Consulting Services, Ethics, Management, Personal Development, 

Specialized Knowledge and Applications, and Taxation. 

Note: The Field of Study field is not required for non-NASBA Credentials. 

 Valid From - The date that this credit is available for this asset. For NASBA and PMI 

credentials, this value is specified in an XML file. For custom credentials, this value is the 

current date. 

6. Click OK. The asset will now appear in the right hand pane as linked to the custom credential. 

7. When done adding assets to the credential, click Exit to return to the Credential Manager. 

To remove courses from a custom credential 

1. Click Content | Credentials on the navigation bar. 

The Credential Manager appears. 

2. Select a custom credential from the list and click Edit.  
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The Edit Credential screen appears. Select the course or courses that you want to remove 
from the Credential from the list displayed in the right pane. 

 To select a range: press and hold down the SHIFT key, and then click the first and last 

item in the list. 

 To select multiple items: press and hold down the CTRL key, and then click individual 

items in the list. 

3. Click Remove Item. A warning message is displayed confirming your selection.  

4. Click OK to remove the item from the credential. 

Note: A learning program cannot be part of a Credential. 

 
 

Edit an Asset in a Custom Credential 

To edit an asset in a Custom Credential 

1. Click Content > Credentials on the navigation bar. 

The Credential Manager page appears. 

2. Select the desired credential in the Custom Credentials list, and click Edit.  

The Edit Credential page appears. The right pane displays the assets that are currently linked 
to that credential. You can resize the panes to better view the asset details or the course 
catalog.  

3. In the Linked Items pane, select one or more assets to edit. 

 To select a range of assets, press and hold the Shift key, then click the first and last items 

in the range. 

 To select multiple assets, press and hold the Ctrl key, then click the desired items in the 

list. 

4. Click Edit Item. 

A list of the selected assets displays. 

 

5. Edit the Credit, Field of Study, and Valid From fields as desired.  
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6. Click OK.  

The changes display in the right pane of the Edit Credentials page.  

7. Click Exit to return to the Credential Manager page. 
 

Edit Information about a Custom Credential 

You cannot edit a core credential, but you can edit a custom credential. 

To edit information about a custom credential 

1. Click Content > Credentials on the navigation bar. 

The Credential Manager page appears. 

2. Select the desired credential in the Custom Credentials list, and click Edit. 

3. On the Edit Credential page, click Edit Credential in the Linked Items pane. 

The Edit Credential page appears. 

 

4. Edit the information for the credential using the fields provided: 

Field Description 

Credential Name The name of the credential. This name will appear in the SkillPort UI. This is 
a mandatory field. The credential name must be less than or equal to 60 
characters and cannot include the plus (+) sign. 

Credential Board The group of professionals in a professional association that establish the 
subject standards, policy, and Credential requirements. This is a mandatory 
field. The board name must be less than or equal to 60 characters and 
cannot include the plus (+) sign. 

Credential Sponsor The organization approved by a Credentialing board to carry out the 
Credential requirements. This is a mandatory field. The sponsor name must 
be less than or equal to 60 characters and cannot include the plus (+) sign. 

Description A description of the Credential. This description displays for the Credential on 
the main Credentialing page. The description must be less than or equal to 
1,000 characters and cannot include the plus (+) sign. 
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Field Description 

Credit Type A unit of credit that varies depending on the type of Credential. The credit 
type must be less than or equal to 50 characters and cannot include the plus 
(+) sign. 

Examples of credit type are: 

 NASBA: CPE 

 PMI: PDU 

 ISM: Contact Hour 

 CFP: CE 

Instructional Delivery 
Method 

The method of instruction. This value must be less than or equal to 150 
characters and cannot include the plus (+) sign. 

For NASBA, the default value of this field is "Self Study". Other values 
include group-live, group-internet based, lectures, teleconferencing, and so 
on. 

Course Completion 
Criteria (Minimum 
Passing Score) 

Course completion criteria is a combination of the minimum passing score 
set and, if selected, viewing all content pages. The minimum score that a 
learner must earn to receive credit for a course must be an integer value 
between 0 and 100, inclusive. 

Note: The rule for assessing course completion is as follows: If View All 
Content Pages (described immediately below) check box is selected, then 
course completion is contingent upon meeting the following criteria: 

 The learner's score is equal to or greater than the score you set in 

this Passmark field AND 

 The learner has viewed all of the pages in the course 

If View All Content Pages check box is not selected, then course completion 
is contingent upon only the learner's score being equal to or greater than the 
score you set in this Minimum Passing Score field. 

View all Content Pages Whether or not a learner must page through every page of a course to get 
credit for that course. Possible values are True or False; the default value is 
False. 

Note: Minimum Passing Score (above). 

Sponsor Address 1 The first line of the address that appears on the Credential certificate. The 
address must be less than or equal to 199 characters and cannot include the 
plus (+) sign. 

Sponsor Address 2 The second line of the address that appears on the Credential certificate. The 
address must be less than or equal to 199 characters and cannot include the 
plus (+) sign. 

Logo Image URL The simple file name of the certificate logo that you are using for the 
credentialing certificate. The file name must be less than or equal to 49 
characters, and it cannot include the plus (+) sign or the double quote ( " ) 
character. For example, to use the image in a graphics file named 
CompanyX_Logo.gif, specify CompanyX_Logo.gif as the value of this field. 

This graphics file must be either .jpg or .gif file, and it must be 240 pixels long 
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Field Description 

X 86 pixels high.  

Note: You must copy this graphics file into the SkillPortFE\custom\<SName> 
directory, where <SName> is the value of "Short Company Name" for 
SkillPort Company as exhibited inside the Master Admin. 

Signature Image URL The file name of the signature that you are using for the credentialing 
certificate. This file should contain the image of the customized signature for 
the certificate. The file name must be less than or equal to 149 characters, 
and it cannot include the plus (+) sign or the double quote ( " ) character. For 
example, to use the image in a graphics file named CompanyX_Signature.gif, 
specify CompanyX_Signature.gif as the value of this field. 

This graphics file must be either .jpg or .gif file, and it must be 240 pixels long 
X 86 pixels high.  

Note: You must copy this graphics file into the SkillPortFE\custom\<SName> 
directory, where <SName> is the value of "Short Company Name" for 
SkillPort Company as exhibited inside the Master Admin. 

Activate Credential Selecting this check box activates the credential and makes it available to 
users.  

1.  Click Save to update the changes to the credential. 
 

Activate or Deactivate a Custom Credential 

To activate or deactivate a custom credential 

1. Click Content > Credentials on the navigation bar. 

The Credential Manager page appears. 

 

2. To activate a credential, select the corresponding check box in the Active column. 

The credential is activated and is available to users. Once a credential is active, users can 
earn credits for courses associated with the credential. 

3. To deactivate a credential, clear the corresponding check box in the Active column. 

Note: Make the Credentialing shortcut available by enabling it on the Navigation Shortcuts 

page. 
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Delete a Custom Credential 

To delete a custom credential 

1. Click Content > Credentials on the navigation bar. 

The Credential Manager page appears. 

2. Select a custom credential from the list. 

3. Click Delete. 

The following warning message displays: 

 

Note: If you delete a credential, it cannot be undone. To deactivate it instead, click Cancel 
and follow the steps in Activate or Deactivate a Custom Credential. Deactivating a credential 
retains the completion history and removes the credential from the learner view. 

4. Click OK to delete the credential. 
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Skillsoft Publisher 

The Skillsoft Publisher is an easy-to-use web application included with Custom Content hosting 
agreements. It allows you to upload, preview, test, and publish your proprietary e-learning content 
directly to Skillport.  

To access Skillsoft Publisher to upload courses, click Content > Skillsoft Publisher on the navigation 
bar. 

With the Skillsoft Publisher, you can: 

 Upload content from your computer to Skillport upload servers through a virus check scan.   

 Verify that content has been properly converted. 

 Move the content to your specific Skillsoft content server. 

 Preview and test the content on a separate Preview Site. 

 Publish content to the live production site. 

View the online Skillsoft Publisher documentation to learn more about this application. 

 
 

Skillsoft Publisher 

You can access Skillsoft Publisher from Skillport to upload the courses mentioned above, by clicking 
Content > Skillsoft Publisher on the navigation panel of the Administrator menu. 

You can upload a range of course content in Skillsoft Publisher, including: AICC, Dialogue, Passive, 
SCORM 1.2 RTE, SCORM 2004, SkillStudio, SCORM, mSpark and Packaged Content. 

You can also publish Passive content directly from Skillport. For more information, refer to the section 
on Uploading Passive Content. 

For information on Passive and Active content types, see Content Types. 

 
 

Upload Passive Content 

You can publish passive content directly from Skillsoft Publisher to Skillport. 

To upload passive content 

1. Click Content > Upload Passive Content on the navigation bar. 

Skillsoft Publisher opens in a new window. 
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The Publish tab displays the Upload Content page, where you can browse to your content, 
upload the passive course content, and execute the publishing process.  

 

In Skillsoft Publisher, the actual display for the Publish tab allows you choose the type of content you 
wish to upload, view notifications pertaining to content deployment status, and view the most recently 
uploaded courses and their status. 

To view this page, click the Publish tab. You can also view this page when you click Publish other 
content on the result pages of the publishing process.  
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Configuring the Skillport User Interface 

The topics in this section provide an overview of the various areas of Skillport that you can configure. 
Refer to the rest of the topics in the Display section of the help for information on how to make the 
associated changes. 
 

Sign In Page 

You can customize the login page of Skillport so that it best suits your organizational needs. View the 
following image and descriptions to learn about areas that you can customize on the Skillport login 
page. 
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1. Banner Logo 

The banner graphic can be replaced with a custom graphic. 

2. Welcome to Skillport Splash Logo 

The splash logo can be replaced with a custom graphic. 

3. Welcome Message 

The welcome message can be modified or removed completely. 

4. Assistive Technology Link 

Web Accessibility is Skillsoft's implementation of Section 508 compliance standard, which allows 
learners with disabilities to utilize information on a computer.   If enabled on your site, the Assistive 
Technology link is right justified at the top of the login page. To enable this feature, consult your 
Skillsoft representative. 

5. Labels for Login Fields 

The login and password labels can be modified.   

6.  Forgot Your User ID / Forgot Your Password 

Links to enable users to retrieve their user IDs and/or passwords can be added to the login page.  
Depending on how Skillport is configured, one or more of the following options may apply:  

 The system can automatically email the learner’s user ID. 

 The system can prompt the learner to answer a security question. 

 The system can automatically change the password and email it to the learner. 

To enable these features, consult your Skillsoft representative. 

7. Disclaimer Text 

A disclaimer text message can be enabled on the login and/or registration page.   To successfully 
login, a learner must click the disclaimer check box. 

The text for this message is configurable. 

8. Copyright Notice 

The text color of the copyright notice can be changed. The copyright notice always appears centered 
at the bottom of the Skillport login page. The text is not configurable and cannot be removed. 

9. Self-registration Fields / Group List 

A link to enable users to register themselves can be added. The fields and labels on the registration 
form can be modified. Drop-down lists on the form can display groups in your organization's group 
hierarchy. 

Pop-Up Messages (Not Shown) 

A custom pop-up message can be added, such that the learner must acknowledge it before logging in. 
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Logout Page 

When learners log out of Skillport, they can be sent to the default “good-bye” page, to a specified URL 
or to a custom URL. For information on setting and customizing the Logout page, see Login/Logout 
Options on page 381. 

 

 
 

What's New Page 
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1. Image 

The image can be replaced with a custom graphic or removed entirely using the What's New Page 
options. 

2. Welcome Message 

The welcome message (HTML content) can be replaced or removed. 

3. Promoted Assets 

Up to three assets can be highlighted in the Promoted Assets area. These can be replaced or 
removed. 

Note: Featured Topics and Browse the Library are additional, configurable content areas contained 
on the What's New page. They are accessed from the Library page under the Content tab. See 
designating the Library's Featured Topics on page 225 and creating and designating browse views 
in Browse the Library for more details. 

 

What's New Page Workflow 

You can configure the Skillport Learner user interface (UI) in a number of ways to optimize the UI look 
and feel, as well as the display of content, to best meet your organization's learning goals. 

To configure the What's New page 

1. Configure the navigation options by customizing: 

 the top navigation options, 

 the toolbar, and 

 the Quick Links menu. 

2. Update messaging, images, and promoted content on the What's New page to keep current 
information in front of your learners. 

3. Customize the colors of your site to align with your organizational color scheme. 

4. Set banner images for desktop and mobile environments, as well as other web site settings 
such as a logo image and browser title bar text. 
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What's New Page Options 

You can customize messaging, images, and featured content on the Skillport home page to best suit 
your organizational needs and goals.  

 

Note the following: 

 Welcome messaging and a default image auto-populate the What's New page and remain if 

you choose not to customize the page. 

 If you delete the default welcome message and do not enter a custom message, this area will 

be left blank. 

 If you delete the default image and do not upload a new image, the welcome message area 

expands to fill up the space where the image would have displayed. 

 If you hide the promoted asset's visibility or choose to remove your promoted assets, this area 

will be left blank.  

 You cannot customize the Upcoming Events or Featured Topics labels. 

Note: The Upcoming Events and Featured Topics sections only appear if there is companion 

content to display. 

To customize the What's New page image 

1. Click Display > See What's New. 

The See What's New page displays, showing the image editing options as well as the image 
page placement. 

 

2. Select the Visibility: Display On Page check box to ensure the image is visible on the What's 
New page. 

3. Select Use custom image. 

4. Click Add.  

5. Click Browse to browse to the image on your computer. 

Note: Image files are limited to 5 MB and must be .jpg, .gif., or .png format. If an image is 

more than 690 pixels wide, it displays at 690 pixels (width).  

6. Click Upload to upload the image. 
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7. Click Save to save your changes. 

To customize the What's New page welcome message 

1. Click Display > See What's New on the navigation bar.  

The See What's New page displays, showing a message customization area and the 
message page placement in Skillport. 

 

2. Select the Display on Page check box to ensure the message is visible on the What's New 
page. 

3. From the Language drop-down list, select the language in which you want the message to 
display. 

4. In the text entry box, enter the welcome message. You can use the available formatting 
options (bold, italic, underline, bulleted and numbered lists, as well as the hyperlink options).  

Important Considerations about What's New Message Text 

 Copying and pasting pre-formatted text from third-party applications (such as Microsoft Word) 

is not supported; doing so can result in hidden characters being pasted into the text field, 

resulting in inconsistent and improper text formatting on the What's New page. 

 You can create different welcome messages for different advanced user groups and domains. 

If you delete the default welcome message and do not enter a custom message, no message 

displays and the area is blank. 

 In the What's New message text, using hashtags within a link from your Skillport site is not 

supported. Skillsoft suggests using the Share feature to generate a link for the What's New 

message text.  

To customize the What's New page promoted assets 

1. Click Display > See What's New. 
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The See What's New page displays, showing the asset selection options and page placement. 

 

2. Select the Visibility:Display On Page check box. 

3. Click Select Assets.  

The Asset Selection dialog box displays the Catalog for you to browse and make your 
selections.  

4. Locate the asset(s) in the left Catalog pane and click Add to add it to the Displayed Assets 
list in the right pane. You can select up to three assets to display in the promoted assets area. 
These can be either stock assets from the Skillsoft library catalogs or content that you have 
created and uploaded. Order these assets by using the up and down arrows. To remove an 
asset from the list, highlight it and click Remove. 

Note: Job Aids and Skillbriefs cannot be selected as promoted assets. 

5. Click Save. 

Note: If you either do not select any assets for the What's New area or de-select the Display 
on Page check box, the promoted assets space will be left blank in the learner user interface. 
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Certificate of Completion Graphics 

Learners can print a certificate of completion when they complete a course, and administrators can 
print a learner’s certificate of completion once she completes a learning program.  

The top and bottom graphics of the certificate can be replaced, but the wording cannot be changed. A 
cascading style sheet (CSS) is used to modify the text color and font. 

 
 

Web Site Colors 

You can customize the colors for many different areas of your Skillport site. 

The Skillport color scheme is divided into six groups based on various functionality: 

 Group 1: The content text and inactive (not current page) header link text (including the My 

Profile, Log Out and Support links) 

 Group 2: Top right header background color, Search dropdown background, Search button 

background, background color of bars for sets and subsets, inactive (not current page) tab 

text, Bottom and right borders  

 Group 3: Main header background and divider line 

 Group 4: Active (current page) tab text and active (current page) header link text 

 Group 5: The body background 

 Group 6: Some page headings and selected navigation elements 
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Default View 

The What's New page is the default landing page for Skillport, but you can select a different menu 
option to designate as your Default View. You can also show, hide, reorder, and rename the default 
view as well as the other three main Skillport menu options on the Navigation page. 

To set the default page for Skillport Learner 

1. Click Display > Navigation > Navigation. 

The Navigation page displays: 

 

2. Click the name of the page you wish to set as the default page you want your Skillport 
Learners to see upon sign in. 

3. Click Edit.  

The Edit Button dialog box displays: 

 

4. Check the Make this the Default View (Always arrive at this page upon log in) option. 

5. Click OK. 

The Edit Button dialog box closes. 

6. Click Save.  

Effective immediately, the newly-selected default page displays upon learner sign-in. 
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Sign In/Log Out Page Options  

Login/Logout settings allow you to modify the appearance of Skillport's login page, goodbye page, and 
self-registration page. 

To configure Login/Logout settings 

1. Click Display > Login/Logout Options on the navigation bar. 

2. Under Log In Options, configure the settings as needed: 

Field Description 

Default Document URL This is the absolute or relative URL a user accesses when attempting 
to sign into Skillport. The default is the main Skillport sign in page. 

Welcome to Skillport Splash 
Logo URL 

Enter the absolute or relative URL to the image to display on the sign 
in page. 

Restrictions: 

 The image must be 300 x 200 pixels in size. 

 The image must be saved in JPEG format with a .jpg 

extension. 

 The image cannot be replaced with text, but you can use a 

screen shot of text, and use that as the image. 

Enable Welcome Message Text If checked, the text entered in the Welcome Message Text box is 
displayed on the login page. If unchecked, the text is not displayed. 

Display Text Language Select the language that you want the UI text to display in from the 
language drop-down menu. 

Welcome Message Text If the Enable Welcome Message Text check box is checked, this 
message displays on the Skillport login page. 

You can enter plain text or use the controls provided to enter HTML-
formatted text (bold, italic, underline, ordered and unordered lists, 
and hyperlinks). 

Note: See the image at the bottom of this page for an example. 

Login Fields Layout Specifies the arrangement of the following controls on the login page: 

 Label and text box for "Username" 

 Label and text box for "Password" 

 Disclaimer check box and text 

You can select to arrange the controls horizontally or vertically. The 
controls are ordered as above, and they are right-aligned. 

Enable Pop-up in Login Page Specifies whether to display a pop-up message to users when they 
log in to Skillport. 

Pop-up Text If the Enable Pop-up in Login Page check box is checked, this text 
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is displayed in the pop-up message shown to users when they log in 
to Skillport. 

You can enter a maximum of 500 characters. 

1. Under Log Out Options, for Goodbye Page URL, enter the The absolute or relative URL to 
the goodbye page that appears when a user logs out of Skillport. 

2. Under Disclaimer Text, configure the settings as needed: 

Field Description 

Enable Login Page disclaimer If checked, the text entered in the Disclaimer Text box is displayed 
on the Skillport login page, and a user must accept the disclaimer (by 
checking the corresponding check box) before logging in to Skillport. 

Enable Registration Page 
disclaimer 

If checked, the text entered in the Disclaimer Text box is displayed 
on the Skillport self-registration page, and a user must accept the 
disclaimer (by checking the corresponding check box) before 
registering himself or herself. 

Disclaimer Text The disclaimer text that is displayed on the login page or the self-
registration page (or both) when the corresponding disclaimer check 
boxes described above are checked. 

You can enter a maximum of 100 characters. You can enter plain text 
or use the controls provided to enter HTML-formatted text (bold, italic, 
underline, ordered and unordered lists, and hyperlinks). 

3. Click Submit Form. 
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Navigation 

Modify the Navigation options to alter the Skillport interface to match your organizational needs. 
 

Navigation 

You can use the Navigation page to show, hide, reorder, and rename these options. For information 
on how to specify the default page (view) a user sees immediately after logging in, see Default View 
on page 380. 

There are four stock navigation options that display in Skillport Learner: 

 See What's New 

 View Learning Plan 

 Browse The Library 

 Visit Community 

To set the default page for Skillport Learner 

1. Click Display > Navigation > Navigation. 

The Navigation page displays: 

 

2. Click the name of the page you wish to set as the default page you want your Skillport 
Learners to see upon sign in. 

3. Click Edit.  

The Edit Button dialog box displays: 
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4. Check the Make this the Default View (Always arrive at this page upon log in) option. 

5. Click OK. 

The Edit Button dialog box closes. 

6. Click Save.  

Effective immediately, the newly-selected default page displays upon learner sign-in. 

To show or hide pages in the Skillport header 

1. Click Display > Navigation > Navigation. 

The Navigation page displays: 

 

2. To hide a page in Skillport Learner, you can do one of the following: 

 Clear the corresponding check box in the Visible row 

 Use the Edit dialog box: 

a. Click the name of the page you wish to hide. 

b. Click Edit.  

The Edit Button dialog box displays: 

 

c. Clear the Visible option. 

d. Click OK. 

The Edit Button dialog box closes. 
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Note: The following happens in Skillport Learner when you hide the page: 
- See What's New: The What's New page and contents are removed from Skillport Learner. 
- View Learning Plan: The Learning Plan page are removed from Skillport Learner. Learners 
cannot access their learning plans from the header. 
- Browse the Library: Learners cannot browse the Library, and the Search bar is removed 
from all Skillport Learner pages. 
- Visit Community: Learners cannot access the Community feature of Skillport, and cannot 
see recommendations, their followers, or whom they are following. Learners cannot follow 
other members of the community. 
 

3. To show a page in Skillport Learner, you can do one of the following: 

 Check the corresponding check box in the Visible row, or 

 Use the Edit dialog box: 

a. Click the name of the page you wish to show. 

b. Click Edit.  

The Edit Button dialog box displays. 

c. Select the Visible option. 

d. Click OK. 

The Edit Button dialog box closes. 

4. Click Save. 

Effective immediately, the page is hidden or shown in Skillport Learner, depending on your 
configurations. 

To reorder the pages in the Skillport header 

1. Click Display > Navigation > Navigation. 

The Navigation page displays: 

 

2. Click the name of the page you wish to move. 
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3. Click the Left or Right buttons, as appropriate.  

4. Click Save.  

Effective immediately, the changes display upon learner sign-in.  
 

Quick Links 

Quick Links provide access to specific sites (URLs) that are available from the main toolbar in the 
Skillport interface. Any company administrator or administrator can enable or disable Quick Links.  

The following image compares an end user's view of a customized set of Quick Links with your view of 
the same Quick Links as you configure them in Skillport Administrator. 

 

To configure Quick Links 

1. Click Display > Navigation > Quick Links on the navigation bar. 

The Quick Links page displays. 

 

2. To create a Quick Link: 

a. Select the Quick Link beneath which to create the new Quick Link. Alternatively, select the 
folder in which to create the Quick Link, and the system will create it at the bottom. (You 
can reorder the Quick Links at any time.) 

b. Click New Quick Link. 

The New Quick Link page displays. 

c. Enter the information for the shortcut. 
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Field Description 

Title Specifies the text name of the link that appears in the Quick Links Menu. If 
the value is too long, the title will be shown with an ellipsis (…), but the 
tooltip will display the full Quick Link name. 

The titles of company-wide navigation Quick Links must be unique. The 
titles of normal/parent Quick Links must be unique within an advanced 
group. The titles of child Quick Links must be unique with respect to all 
other Quick Links with the same parent Quick Links. 

URL Specifies a relative or an absolute URL path to the Quick Link's target page. 
For more information on the valid format for absolute and relative paths, see 
Working with Hyperlinks. 

You can add a Quick Link to any type of text file, including HTML (.HTM, 
.HTML), Microsoft Word (.DOC), Acrobat PDF (.PDF), plain text (.TXT), etc. 

Display Indicates how to display the target page. 

 New Window: The shortcut is launched in a new browser window. 

(This is the default option.) 

 Replace current window: The shortcut is launched and takes over 

the browser window, replacing Skillport. The user may be able to 

click the Back button to return to Skillport. 

 Within Skillport frame: The shortcut is launched as a pane inside 

the Skillport frame. This choice is recommended for web sites using 

simple HTML and no stylesheets. Many web sites do not display 

properly within the Skillport frame. 

Visible Indicates whether the Quick Link appears in Skillport. Select this check box 
to make the Quick Link available in the Skillport interface. Clear this check 
box to hide the Quick Link. 

Manager and Admin Controls the availability of the Quick Link based on a user's role. Select this 
check box to make the Quick Link appear only for users with roles other 
than End User. 

508 accessible  Select (check) this check box if the target page supports Section 508 (also 
known as Web Accessibility) for users with disabilities. 

 If the external target page supports Section 508, no warning is 

displayed when the user accesses the page from Skillport. 

 If the external target page does not support Section 508, a warning 

dialogue appears to the user prior to the page loading in their 

browser. 

a. Click OK. 

1. To create a folder: 

a. Select the folder or Quick Link beneath which to create the folder, and then click New 
Folder. 

The New Folder dialog box displays. 

b. (Required) For Title, enter the folder's title. 
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c. Select the Visible check box if the folder should be visible. Alternatively, clear the check 
box if it should be hidden. 

d. Click OK. 

2. To reorder the folders and Quick Links, drag the item to its new location, and then drop it. 

3. To edit a folder or Quick Link, select the item, and then click Edit. 

Note: Skillport adds Quick Links if optional Skillport add-on modules are installed, for 
example, Community or KnowledgeCenters. You cannot change the value for the URL setting 
or the Display setting for these Quick Links. 

4. To delete a folder or Quick Links, select the item, and then click Delete. 

5. Click Save. 

 
 

Toolbar 

The toolbar in the upper-right of Skillport Learner allows the learner to change their profile information, 
access the Skillport documentation, change their content language, and log out. 

 

To configure the toolbar 

1. Click Display > Navigation > Toolbar on the navigation bar. 

The Toolbar page displays. 

 

2. Select the options you want visible on your site. 

3. To reorder the options, select an option and click Up or Down. 
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The order of the items in the list in Skillport Administrator determines their order from left to 
right in Skillport Learner. 

4. Click Save. 
 

Skins Options 

Skins are alternative color schemes and graphics that modify the appearance of the Skillsoft Course 
Player (SCP). You can modify the look of the SCP in two ways: 

 By creating a customized player skin, or 

 By uploading a custom logo or image 

For information on how to create a customized player skin, contact your Account Representative. 

To set the skins directory for the Skillsoft Course Player 

1. Click Display > Player Skins on the navigation bar. 

The Skin Options page display. 

2. In Skins Directory, enter the URL of the directory where user skins are installed. The skins 
directory must be located on the same server as the Skillsoft Course Player and content. 

3. Click Save. 

Note: Setting a custom logo image overrides the custom skins directory. You can revert to the custom 
skins at any time by selecting Reset and reentering the URL for the skins directory. 

To set a custom logo image for the Skillsoft Course Player 

1. Click Display > Player Skins on the navigation bar. 

2. In Skillsoft Course Player Logo, select either option: 

  Use standard image: Displays the Skillsoft logo in the upper left corner of the SCP. 

  Use custom image: Displays your custom logo image in the upper left corner of the 

SCP. 

3. For Use custom image: 

a. Click Add. 

b. Click Browse to browse for the desired file, then click Upload to upload the image. 

Note: Recommended image dimensions are 62 pixels wide and 23 pixels high. Files are 

limited to 5 MB and jpeg, gif and png formats only. 

4. Click Save. 

Note: A custom skin or logo image applies to all content for the organization that displays in the 

Skillsoft Course Player. Player skin options are not available for the Skillsoft Mobile Player. 
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Registration 

You can configure registration options that determine the layout and appearance of the New User 
Registration page that users use to create their own accounts. If you have made this page available to 
users (see Configure Self-Registration (on page 480)), it is available via a link on the Sign In page. 

 

For information on specifying what fields (for example, First Name and Last Name) display on the 
New User Registration page, see Configure User Profile Information (on page 491). 

To configure registration options 

1. Click Display > Registration on the navigation bar. 

2. Configure the registration options as needed. For help with this step, see the information that 
follows. 

Field Description 

Group title / Orgcode 
Display at Self- 
Registration Page 

Specify whether users can enter or select a user group on page 31 on the 
New User Registration page. The options are: 

 Default (Orgcode only): A single text field is displayed on the page. 

A user can enter an org code. You can change the label in Web Site 

Settings. 

 Single Select Box: A single-select Select Group drop-down list is 

displayed on the page. Subgroups appear indented under their 

respective parent groups. You specify the label for this drop-down 

list using the Orgcode Group Label setting. For more information, 

see the Single Select Box section that follows. 

 Multiple Select Box: Separate Select Group and Select Sub-

Group drop-down lists display on the page. You specify the labels 

for these controls using the Orgcode Group Label setting and the 

Orgcode Sub-Group Label setting. For more information, see the 
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Multiple Select Box section that follows. 

 Disabled: No org code or group fields display on the page. 

Note: You must have a group hierarchy set up in order to register users into 
specific groups and organizations. If you want to make a group available on 
the New User Registration page, you must set the group's Display on 
Registration Page setting to Yes (via the Users & Groups interface). 

If you select Multiple Select Box, values for the following settings are *required*. 

Orgcode Group Label The field label for the parent group drop-down list.  

If you choose a Single Select Box display, this is the label for the drop-down 
list. If you choose a Multiple Select Box display, this is the label for the 
parent (first) drop-down list. 

Orgcode Sub-Group 
Label 

The field label for the subgroup (child) drop-down list (or lists, if there is more 
than one subgroup).  

Orgcode group default 
selection text 

The default text in the parent group drop-down list (which is selected). 

Orgcode sub-group 
default selection text 

The default text in the subgroup drop-down list (which is selected). 

If you select Single Select Box, values for the following settings are *required*. 

Maximum allowed group 
count 

The total number of groups on page 33 in your company must be less than 
the value specified here. Otherwise, the single Select Group drop-down list 
will not function. 

Indentation character The character used to indent subgroups under their respective parent 
groups. 

Maximum group Level in 
Self Reg screen 

The number of subgroups to display on the New User Registration page. 
Consult you system administrator before changing this value.  

1. Click Submit Changes. 
 

Colors 

Use the Colors form to alter the appearance of the Skillport interface to match your organizational 
needs. 

Note: You cannot customize the colors of the Skillport Mobile interface. 
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Colors and Browsers 

A browser-safe table of 252 colors is available in Skillport. These colors include 216 browser-safe 
color values and 36 grayscale colors common among supported browsers when running in 256-color 
mode. 

Color Schemes 

The Skillport color scheme is divided into groups based on functionality. See the images below for 
relative placement of the groupings and their affected areas. The groups are: 

 Group 1: The content text and inactive (not current page) header link text (including the My 

Profile, Log Out and Support links) 

 Group 2: Top right header background color, Search dropdown background, Search button 

background, background color of bars for sets and subsets, inactive (not current page) tab 

text, Bottom and right borders  

 Group 3: Main header background and divider line 

 Group 4: Active (current page) tab text and active (current page) header link text 

 Group 5: The body background 

 Group 6: Some page headings and selected navigation elements 
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To change a color scheme 

1. Click Display > Colors on the navigation bar. 

2. (Optional) Click in the rainbow panel next to the group(s) to show the Color Pick Table from 
which you can easily select browser-safe colors. 

 

3. In the field for the group color scheme element that you want to change, specify a new color 
by doing one of the following: 

 Enter the hexadecimal value for the color. The hexadecimal value must include the # 

symbol, for example, #9999CC. 

 Click in the field, and then click a color in the Color Pick Table. This inserts the 

hexadecimal value for the selected color. 

4. Repeat the previous step as needed to change other group color scheme elements. 
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5. Click Submit. 

Note: To restore Skillport to its default color scheme, click Restore Default Colors at the 

bottom of the page. 

 
 

Login Text Customizations 

You can customize the default field labels that appear on the Skillport login page. 

To configure the login text 

1. Click Display > Text > Login Text Customizations on the navigation bar. 

2. Configure the settings as needed: 

Field Description 

Alternative "login" text  The text label for the login name field (default is "User ID"). The following 
are possible alternatives:  

 User name 

 Email address 

 Login ID 

 Network login 

 Employee number 

Alternative "password" text The text label for the password field (default is "Password"). The following 
are possible alternatives: 

 Code 

 Security code 

1. Click Submit Changes. 
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Web Site Settings 

Web site settings allow you to modify site settings such as banner images and alternative text for 
images. 

 

To configure web site settings 

1. Click Display > Web Site Settings on the navigation bar. 

2. Configure the settings as needed: 

Field Description 

Application Name Customize the label for your Skillport site (use your company 
name, for example). This label displays in the browser's title 
bar. 

Desktop Header Image The banner logo that displays at the top of Skillport 
Administrator. 

 Supported formats include .jpg, .gif and .png. 

 The image must be 24-bit true color and a maximum 

size of 180 pixels wide by 68 pixels high. 

 The image must be located in the \images directory of 

the Skillport installation (for sites hosted on Skillsoft 

servers, contact your Skillsoft representative to 

change this logo). 

Mobile Header Image The banner logo that displays at the top of Skillport Mobile. 

 Supported formats include .jpg, .gif and .png. 

 The image must be 24-bit true color and a maximum 

size of 64 pixels wide by 32 pixels high. 
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 The image must be located in the \images directory of 

the Skillport installation (for sites hosted on Skillsoft 

servers, contact your Skillsoft representative to 

change this logo). 

Organization Code Label Label for the Organization Code field on the self-registration 
page. If you are building a self-registration page with a single 
or multiple select box, that label is modified in the Registration 
Options. 

Display "Powered by" logo Determines whether or not the "Powered by" logo will appear 
at the bottom of every Skillport page.   

Select the Display "Powered by" logo check box to make 
the logo display in the Skillport interface. Clear the check box 
to remove the logo. 

Logo Image URL Specifies a relative or an absolute URL path to the image.  
For more information on the valid format for absolute and 
relative paths see Hyperlinks. 

3. Click Submit Form. 

 



Skillport 8 Administrator Guide ©2015 Skillsoft  397 
 

 

C H A P T E R  5  

C o n f i g u r a t i o n  

In This Chapter 

Features.............................................................................. 398 

Completion Criteria ............................................................. 418 

Notification Management .................................................... 430 

Notification Settings ............................................................ 478 

Learning Plan Settings ....................................................... 478 

Search ................................................................................ 479 

Self-Registration ................................................................. 480 

User Profile Fields .............................................................. 483 

Language ............................................................................ 492 

Report Configuration .......................................................... 493 

Web Site Switches .............................................................. 494 

Additional Deployment Options .......................................... 495 
 
 



Skillport 8 Administrator Guide ©2015 Skillsoft  398 
 

Configuration   
 
 

Features 

Books24x7 

The Books24x7 settings control access to the Books24x7 content. Use this page to manage 
subscription information. 

Note: The Books24x7 link only appears in the navigation menu if you have installed the Books24x7 

add-on module. 

Subscription Capacity 

This section of the page provides details on the status your organization's Books24x7 subscription. 
The table shows the number of seats per collection reported by the Books24x7 site to the Skillport 
LMS: 

 Total: The number of seats available for each collection. 

 Taken: The number of seats already assigned for each collection. 

 Free: The number of open seats for each collection. 

Subscription Structure 

This section of the page provides details on the status of a company's Books24x7 subscription. The 
table shows data reported by both Books24x7 and Skillport: 

 Collections: The names of the collections included in the subscription. 

 Total: The number seats allocated to the collection. 

 Taken: The number of seats occupied by learners. 

 Free: The numbers of seats available in the collection. 

Subscription Updates 

At the bottom of the page, you can update your subscriptions. 

 Import Subscription Changes: Click to import information from Books24x7: 

 Subscription Capacity: The total number of seats for the Books24x7 subscription. 

 Subscription Structure: The total number of seats, organized by Collection name. 
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 Import Users: Click to synchronize user registration information between Books24x7 and 

Skillport. The user registration data stored in the Skillport database is replaced with the new 

data imported from Books24x7. 

 Release Seats: Some administrative actions (for example, deleting users, deactivating users, 

moving users and groups, or editing Books24x7 collection assignments) can change the list of 

collections visible to users. However, some of the users may still be registered on the 

Books24x7 service. Click this button to un-register users from the Books24x7 service and 

release the taken seats. 

Note: Removing, deleting, or reassigning Books24x7 collection assignments is prohibited 
under terms of your corporate license agreements except under specific conditions. Contact 
your Skillsoft representative to verify license terms before making any changes. 
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inGenius 

Prior to using the Community feature of inGenius, you must enable it, set up a community, and assign 
a moderator to that community. Once complete, the Visit Community tab displays on your learners' 
Skillport home page. 
 

Assign or Remove a Social Community Administrator 

A social community administrator moderates comments reported as abuse on the Moderate 
Community page in Skillport Administrator (Content > Moderate Community).  

Note: To access this page, you must log in with Company Admin privileges, or as an admin with 
inGenius Settings custom privileges. To set up a community, contact your Skillsoft representative. For 

more information about user roles, see User Privileges by Role. 

To assign a social community administrator 

1. Click Configuration > Features > inGenius on the navigation bar.  

The Social Community Settings page displays. 

 

2. Configure the following settings: 

Field Description 

Setup Social Community This feature is configurable by Super Administrators only. 

Enable Social Community Select yes from the drop-down menu to enable the 
Community features in Skillport. 

Note: This is only available if there is a community set up 
and configured. If a community is not yet configured, 
contact your Skillsoft representative for setup. 

Enable Social Community for 
Skillsoft Advantage 

Select yes from the drop-down menu to enable the 
Community features for Skillsoft Advantage users. 

Enable inGenius Score Select yes from the drop-down list to enable the 
Community Score feature. 

3. Choose a user for Social Community Administration by: 
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 Using search 

a. Enter the name of the user you want to act as a community administrator. Click Search.  

The search results display in the Search Results tab. 

b. Click the user's name to select it. 

c. Click . The user name displays in the User as inGenius Community Administrator 
section. 

d. Click Submit. A confirmation message displays at the top of the page. 

 Using the list of users 

a. In the Users and Groups list, click the Group to which the user belongs. 

b. Locate the name of the user you want to act as a community administrator. 

c. Click the user's name to select it. 

d. Click . The user name displays in the User as inGenius Community Administrator 
section.  

e. Click Submit. A confirmation message displays at the top of the page. 

Note: In order to be a social community administrator, the user must have Manager or above 

privileges in Skillport. 

4. Click Submit. The user is now assigned as a social community administrator. 

To remove a social community administrator 

1. Click Configuration > Features > inGenius on the navigation bar. 

The Social Community Settings page displays. 

2. In the User as Social Community Administrator section, click a user name to select it. 

3. Click Remove. 

4. Click Submit. The user is no longer assigned as a social community administrator and cannot 
access any of the community administrator features.  

 
 

Monitor Community Abuse 

Note: To access this page, you must log in as a Manager or above who has been designated as a 

social community administrator. For more information about user roles, see User Privileges by Role. 

Community comments reported as abuse display on the Moderate Community Comments page. 
The social community administrator can edit the comment, delete the comment, or remove the abuse 
flag without action. 

To review a comment marked as abuse 

1. Click the Admin link at the top right of the page. 
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2. Click the Content tab. 

3. Click Moderate Communities.  

The reported incidents of abuse display. 

4. Click the comment you wish to review.  

The comment is highlighted. 

5. To modify the comment: 

a. Click Edit. 

b. Modify the text. 

c. Click OK. 

d. Click the comment again to highlight it. 

e. Click Remove Abuse Flag.  

The comment is updated and the flag is removed from the comment. 

6. To delete the comment, click Delete.  

The comment is deleted from the thread. 

7. To leave the comment as is, click Remove Abuse Flag.  

The comment remains as it was written by the community member. 
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ILT 

ILT Workflow 

Workflow for ILT Admin 

1. Configure ILT Site Settings. This enables you to customize ILT default values and actions to 
meet your organization's needs. 

2. Configure Email Templates. You can determine whether each template is used or not, and 
whether to customize the text in any/all of the templates. 

3. Configure Extended Attributes. This enables you to set up extended fields or attributes for 
sessions.  

4. Assign roles to the Skillport users who function as administrators or instructors. If necessary, 
create these users. 

5. Set up the Resources as follows: 

a. Manually create contacts or batch upload contacts; This is not just for facilities but can be 
"stand alone" contacts. Examples of contacts are vendors or facility managers who are 
used in putting on an ILT session. 

b. Manually create facilities or batch upload facilities; Facilities are physical structures where 
an ILT session can be held, like a conference center or onsite building.  

c. Manually create classrooms or batch upload classrooms; These classrooms are attached 
to the facility in which they reside. 

6. Create ILT courses. You can create new courses by using the form available. Once the course 
has been created it is displayed in the grid. 

7. Create ILT sessions for the courses created. 

8. Manage Sessions. 

a. Confirm an ILT Session; By confirming a session, you are saying that the session will take 
place. There is an option in ILT system settings that allows any new session you create to 
automatically be marked as confirmed. By keeping this setting off, confirming a session is 
a manual process. 

b. Enrollments/Roster on page 328; This section is inclusive of enrolling and withdrawing 
learners to the roster for a session. 

c. Close to new enrollment; You can close a session to new enrollment if it is open. 

d. Complete a session; After a session has been held, an administrator or instructor must 
mark it as complete in order for students to receive credit. 

e. Archive old sessions. 

9. View the ILT Event Journal. Event Journals are ILT-specific reports you can use to see all ILT 
activity. 

 

Workflow for ILT Instructor 

1. View Sessions I am Teaching. 
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2. Choose a specific session with which to work: 

a. Mail All Enrolled and Wait-listed Users (if desired – what to bring to class, location, etc.). 

b. Create Session Sign-in Sheet (if desired). 

c. Enter the Session Results (needed, but can also be done by an admin). 

d. Mark Session as Complete (finalize results - needed, but can also be done by an admin). 

e. Create Session Learner Report (if desired). 

3. Managing Virtual Sessions - If you are conducting an online/virtual classroom session, chose 
that option, and then specify the criteria such as phone number, passcode, and URL to join 
the virtual session. 
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Extended Attributes 

Understanding Extended Attributes 
ILT courses and sessions have a default set of fields or “attributes”. ILT Extended Attributes allow you 
to customize courses and sessions to better fit the requirements of your organization. By going 
through this section, you can set up additional attributes for courses and sessions to include properties 
of your choosing, appropriate for your training program. 

For example, if your organization assigns continuing education credits to ILT courses, you can add a 
single-select extended attribute called “CE Credits” that contains the credit choices available. When an 
ILT Admin creates a course, they will select the correct number of credits from the multi-select 
extended attribute field.  

Note: Extended Attributes is an optional feature and may not be enabled on your system; to enable it, 

contact your Skillsoft representative. 

Attributes can be of three types: 

 Enter a simple text value - presented as a text field in the edit form 

 Select a single value from a list of values - presented as a single select list (drop-down menu) 

in the edit form 

 Select multiple values from a list of values - presented as a list box in the edit form 

Any number of attributes can be created and they will be available on all courses and sessions. 
Attribute fields can be designated as required or optional. New attributes are not applied to existing 
sessions until an existing session is edited, but they are applied to subsequently created sessions. 

 
 

View Extended Attributes 
The extended attributes are displayed in a list. 

To view extended attributes 

1. Log in to Skillport. 

2. Click Configuration > Features > ILT > Extended Attributes on the navigation bar. The 
extended attributes display. 

 

The created attributes are displayed in the grid. If the attributes are activated, then those attributes can 
be viewed/used in New/Edit/Copy Course/Session window. You can Activate or Deactivate an 
Extended Attribute. 
 



406 ©2015 Skillsoft Skillport 8 Administrator Guide 

 

 Configuration 
 
 

Create a New Extended Attribute 
Use this process to create and enter details of a new extended attribute. 

To create an extended attribute 

1. View Extended Attributes 

2. Click the New Extended Attribute button. The New Extended Attribute dialog box displays. 

 

3. Enter the extended attribute details. 

 Label: You can enter the label of the new attribute. The label must be unique. 

 Field Type: You can select either Text Field, Single Select or Multi Select. For Single 

Select or Multi Select, the Default can be set by selecting the checkbox next to the 

relevant List Item. There can be more than one default if the Field Type is Multi Select. If 

you switch the field type from single/multi select to text field, the item list specified is 

removed permanently if you submit that change. 

 Activated: Select the checkbox to mark the extended attribute as activated. 

 Required: Select the checkbox to mark the extended attribute as required. 

4. Click Save. 

 
 

Edit an Extended Attribute 
You can edit the details of an extended attribute if any changes are required.  

To edit an extended attribute 

1. View Extended Attributes list and select the attribute you want to edit. 

2. Click the Edit button. The Edit Extended Attribute window displays. This has all the details 
from the New Extended Attribute window. 

3. Edit the extended attribute details. 

4. Click Save. 
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Reorder an Extended Attribute 
You can modify the order in which an extended attribute appears in the list of extended attributes. 

To reorder an extended attribute 

1. View Extended Attributes. 

2. Click on the extended attribute to select it. 

3. Click the Up or Down button. The extended attribute moves up or down in the list. 

Note: This order is reflected in the course/session window. 

 
 

Activate or Deactivate an Extended Attribute 
You can activate or deactivate an extended attribute if required. 

To deactivate an extended attribute 

1. View Extended Attributes. 

2. Click on an extended attribute to select it. 

3. Click the Deactivate button. This deactivates the extended attribute. 

Note: When an extended attribute is deactivated, you cannot use this attribute for any future 

course/sessions. However, this attribute remains the same for already associated courses/sessions. 

To activate an extended attribute 

1. View Extended Attributes. 

2. Click on the deactivated extended attribute to select it. 

3. Click the Activate button. This activates the extended attribute. 

Note: Reactivating the extended attribute will bring the attribute to the course/session window. 

 

Delete an Extended Attribute 
You can delete an extended attribute if required. When you confirm the deletion, the system removes 
the extended attribute, as well as all of its instances throughout the system. 

Note: An extended attribute cannot be deleted if the attribute is associated with a course/session until 

the respective course/session is deleted. 

To delete an extended attribute 

1. View Extended Attributes. 

2. Click on the extended attribute you want to delete. 

3. Click the Delete button. A confirmation box displays. 
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4. Click Yes to confirm. 

 

 
 

ILT Site Settings 

If you have Company Admin privileges, you can access the Site Settings view, where you can 
configure some ILT site-specific settings for your company. 

Note: This menu option is only available if ILT is enabled on the site.  

To view the site settings 

1. Log in to Skillport as an admin. 

2. Click Configuration > Features > ILT > Site Settings. The Site Settings page displays. 

 

3. Set the desired site settings: 

Site Settings Required 
Field? 

Description Value 

Full Session Threshold; 
ILT Dashboard: A session 
appears in the Full 
Sessions section of the ILT 
Dashboard when 
enrollment reaches this 
percentage of capacity 

yes This controls when a 
session is listed in the 
"Sessions at or above 
Capacity" section of 
the Dashboard. 

An integer between 0 
and 100 (inclusive) 
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Maximum Session 
Threshold; Email Notice: 
An email is triggered when 
a session has enrollments 
above this percentage of 
capacity, then a withdrawal 
causes enrollment to go 
below this percentage of 
capacity 

yes  The value selected is 
based on the value of 
the 'Full Session 
Threshold' field. When 
the session capacity 
reaches this specified 
percentage, an email 
is automatically sent 
to the Session 
Administrator detailing 
that the session is full. 

Note: This email is 
only sent to the 
Session Administrator, 
not the ILT 
Administrator. If no 
Session Administrator 
is assigned, then the 
email is not sent. 

An integer between 101 
and 300 (inclusive) 

Minimum Session 
Threshold; Email Notice: A 
session triggers an email 
to Administrators when 
enrollment crosses this 
minimum percentage of 
capacity 

yes When a withdrawal 
from a full session 
results in the roster 
going below the 
minimum capacity, an 
email is sent to the 
Session Administrator.  

This email is sent 
based on very specific 
criteria:  

 - The session 

is full. 

 - The session 

is closed to 

enrollment. 

 - A withdrawal 

results in a 

roster that is 

less than or 

equal to the 

percentage 

full designated 

by this field.  

Note: This email is 
only sent to the 
Session Administrator, 
not the ILT 
Administrator. If no 
Session Administrator 
is assigned, then the 

An integer between 0 
and 99 (inclusive) 



410 ©2015 Skillsoft Skillport 8 Administrator Guide 

 

 Configuration 
 
 

email is not sent. 

 

Session Auto-Close 
Relative Date: That number 
of calendar days before 
(plus-value) or after 
(minus-value) session 
start-date when it 
automatically closes to 
enrollments 

no This setting 
determines the 
number of days to 
automatically close a 
session before 
(positive number) or 
after (negative 
number) it is 
scheduled to begin. 
The value entered in 
this field controls the 
default value for the 
“Close session” field in 
a new course. The 
value can be changed 
at either the course or 
session level when 
creating them. Course 
level changes will not 
affect existing 
sessions, only new 
sessions. 

For example, if you 
want to close a 
session to further 
enrollments 2 days 
prior to the start of the 
session, select 2 from 
the drop-down list. If 
you want to close the 
session 2 days after 
the start of the 
session, select -2 from 
the drop-down list. 

 

Never, 90, 60, 45, 30 
through -30, -45, -60, -
90 and is chosen from a 
drop-down box. 
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Global Enrollment 
Minimum: The number of 
enrollments deemed 
minimally-acceptable in all 
sessions; defines when a 
session appears in the 
Dashboard's Low 
Enrollment section   

yes When a session is at 
or below this value by 
the day specified in 
the "Display low-
enrollment alert X 
days before session 
start" setting, the 
session is displayed in 
the Low Enrollment 
Sessions section of 
the Dashboard.  

The value entered in 
this field controls the 
default value for the 
“Minimum 
Enrollments” setting in 
a new course. The 
value can be changed 
at either the course or 
session level. 

An integer between 0 - 
99999 (inclusive) 

Minimum Enrollment 
Relative Date: The number 
of calendar days before 
Session Start Date when 
the low-enrollment test is 
applied to determine if the 
session appears in the 
Dashboard's Low 
Enrollment section 

no This value determines 
how many days in 
advance of a session 
start date that a 
session must meet the 
minimum enrollment. 
If the session is at or 
below the minimum 
enrollment criteria on 
that day, then that 
session is in "low 
enrollment". The 
default minimum 
enrollment is defined 
in the Global default 
applied to all sessions 
defining the minimum 
number of enrollments 
desired. 

The value entered in 
this field controls the 
default value for the 
“Low Enrollment Alert” 
field in a new course. 
The value can be 
changed at either the 
course or session 
level. 

Never or an integer 
between 0 and 31. The 
selection is chosen from 
a drop-down box. 

 Never: There is 

no minimum 

enrollment 

requirement, 

and the session 

will never be 

listed in the Low 

Enrollment 

Sessions 

section of the 

Dashboard. 

 0 to 31: Number 

of days prior to 

session start 

when low 

enrollment 

sessions are 

listed in the Low 

Enrollment 

Sessions 

section of the 

Dashboard. 
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Unconfirmed Session 
Relative Date: The number 
of calendar days before 
Session Start Date when 
an Unconfirmed session 
will appear in the 
Dashboard's Unconfirmed 
Sessions section 

yes This setting determines 
how many days in 
advance of the session 
start date to list an 
unconfirmed session in 
the Unconfirmed 
Sessions section of the 
Dashboard. 

When a learner enrolls in 
a session with an 
"Unconfirmed" status, 
they receive a 
confirmation email, but it 
does not include a 
calendar attachment. 
The learner’s enrollment 
status is “Pending 
Session”. After an 
administrator marks the 
session "Confirmed", all 
enrolled learners will 
receive another email 
noting that the status is 
now Confirmed, and that 
email will have the 
calendar attachment. 
Any learners who enroll 
after the session has 
been confirmed will 
receive an email with a 
calendar attachment.  

For more information on 
"Unconfirmed" and 
"Confirmed" see the 
"The default status for all 
newly created sessions". 

The setting provides a 
quick and easy method 
for an ILT Administrator 
to see which sessions 
are still “pending” 
(meaning they have a 
status of "Unconfirmed") 
and then take action to 
confirm the sessions. 

Note: If the Default 

status for all newly 
created sessions is 
changed to "Confirmed" 
and existing sessions 
have an "Unconfirmed" 
status, those sessions 
will appear in the 
Unconfirmed Sessions 
section until their status 
is changed to 
"Confirmed".  

An integer between 0 
and 99 (inclusive) 
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Approval Expires Relative 
Date: The number of 
calendar days after an 
Approval Request is 
initiated when it expires 
(as Denied) if still not 
acted-upon 

yes If a session requires 
approval (either 
Session Approval or 
Manager Approval), 
this setting determines 
the number of days 
that the approval 
request remains open. 
If the request is not 
acted upon during this 
period, it is 
automatically deleted 
and the learner is not 
enrolled.  

If an enrollment is not 
approved by this date, 
the approval request 
is deleted, an 
expiration notification 
is sent to the learner, 
and the learner is not 
enrolled in the 
session. If the learner 
still wishes to enroll, 
he or she must open 
the session and click 
"Enroll" again to 
initiate a new approval 
request. 

An integer between 2 
and 99 (inclusive) 

Approval Reminder relative 
Date: The number of 
calendar days after an 
Approval Request is 
initiated when the Learner 
and Approver will receive 
an email reminder if the 
request is still not acted-
upon. This value must be 
less than Approval Expires 
Relative Date 

 

no If a session requires 
approval (either by a 
Session Approver or 
Manager), this setting 
determines the 
number of days after 
an approval request is 
initiated to send a 
reminder email to the 
Approver or 
Approvers. This is 
only sent if the 
Approver has not 
taken action on the 
request. 

n integer between 1 and 
7, inclusive (and should 
be less than the 
Approval Expires 
Relative Date setting) 

New Session Default 
Status: The status (New or 
Confirmed) assigned all 
Newly-created Sessions. 
Assigning Confirmed 
essentially eliminates the 
"New" status, and its 
associated "Pending 
Session" learner 
enrollment status  

no  An organization can 
use the Unconfirmed 
status for sessions 
that may run, and the 
Confirmed status for 
sessions that will run. 

Confirmed or 
Unconfirmed 
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Self-Withdrawal 
Prohibition Relative Days: 
The number of calendar 
days before session start-
date when a learner is 
prohibited from self-
withdrawing from a 
session  

no The value entered in 
this field controls the 
default value for the 
"Prohibit Self-
Withdrawal" field in a 
new course. The value 
can be changed at 
either the course or 
session level. 

 

Never, Always or a 
number between 1 and 
31 (inclusive)  

 Never: A learner 

can self-

withdraw from 

the session at 

any time, even 

on the day that 

the session 

takes place. 

 Always: A 

learner can 

never self-

withdraw from a 

session. The 

withdraw button 

is removed from 

the session, and 

is replaced with 

the following text 

"You are 

enrolled in this 

session. To 

withdraw from 

this session, 

please contact 

your Training 

Manager." 

 1 to 31: Number 

of days before 

the session start 

date that a 

learner can self-

withdraw. When 

the prohibit self-

withdrawal date 

is reached, the 

withdraw button 

is removed from 

the session and 

replaced with 

the following 

text: "You are 

enrolled in this 

session. To 

withdraw from 

this session, 

please contact 

your Training 

Manager." 
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Late Withdrawal Relative 
Days: The number of 
calendar days before 
session start-date when a 
learner withdrawal 
(performed by anyone) is 
flagged as a "Late 
Withdrawal" 

no The learner is still 
withdrawn, but his 
enrollment status is 
"late withdrawal". The 
value entered in this 
field controls the 
default value for the 
“Late Withdrawal” field 
in a new course. The 
value can be changed 
at either the course or 
session level. 

Never or an integer from 
1 to 31 (inclusive), 
chosen from a drop-
down box 

 Never: No 

withdrawals are 

ever flagged as 

a "late 

withdrawal". 

 1 to 31: Number 

of days prior to 

session start 

date when a 

withdrawal is 

flagged as a 

"late 

withdrawal". 

Default value of Attended 
in Roster (true to attend, 
false to not attend) -  

no Learners’ Attended 
value is Null until the 
first time an 
authorized user enters 
Session Results.  

When entering 
Session Results for 
the first time, all 
enrolled Learners get 
their Attended values 
populated in the Site 
Settings. You can then 
edit changes if 
desired.  

When you mark the 
session as complete, 
if any Learners record 
still contains NULL 
values for Attended, a 
warning message 
appears. 

If any Learners are 
added to a session 
after it is marked 
complete, their 
Attended values are 
auto-populated with 
the defaults.  

True or false 
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Default value of Passed in 
Roster (true to attend, false 
to not attend) 

no Learners’ Passed 
value is Null until the 
first time an 
authorized user enters 
Session Results.  

When entering 
Session Results for 
the first time, all 
enrolled Learners get 
their Passed values 
populated in the Site 
Settings. You can then 
edit changes if 
desired.  

When you mark the 
session as complete, 
if any Learners record 
still contains NULL 
values for Passed, a 
warning message 
appears. 

If any Learners are 
added to a session 
after it is marked 
complete, their 
Passed values are 
auto-populated with 
the defaults. 

True or false 
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Default value of Score in 
Roster (0-100) -  

no Learners’ Score value 
is Null until the first 
time an authorized 
user enters Session 
Results.  

When entering 
Session Results for 
the first time, all 
enrolled Learners get 
their Score values 
populated in the Site 
Settings. You can then 
edit changes if 
desired.  

Scores are final when 
an authorized user 
marks the session as 
complete.  

When you mark the 
session as complete, 
if any Learner's record 
still contains NULL 
values for Score, a 
warning message 
appears. 

If any Learners are 
added to a session 
after it is marked 
complete, their Score 
values are auto-
populated with the 
defaults. 

An integer between 0 - 
100 (inclusive) 

1. Click Submit to save your ILT Site Settings. 

2. Click Reset to revert to the previously saved settings. 

 
 

Publisher 

You can publish courses as well as passive content directly to your Skillport site by enabling the 
Skillsoft Publisher from within the Admin menu.  

To configure Publisher 

1. Click Configuration > Features > Publisher on the top navigation bar. 

2. Configure the settings as needed: 

 Enable Publisher - Select yes to enable the Publisher option in the Admin menu. The 

default setting is no. 

 Publisher URL - The url of the Publisher site that is provided by Skillsoft. 

 Allow seamless login for: 
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Publisher - This check box is enabled by default. Clearing this option will hide the 
Publisher link on the Content tab. 

Upload Passive Content - This check box is enabled by default. Clearing this option 
hides the Upload Passive Content link on the Content tab. 

 Publisher Company ID - The company ID provided to you by Skillsoft. Maximum 

character limit is 50 characters. 

 Publisher URL Timeout - The number of minutes that pass before Publisher times out 

due to inactivity. Characters are limited to  numbers 0-9 and can be a maximum of three 

characters long. 

 Publisher Error Text - The error message that appears when the Publisher application is 

not available. You can modify this text message to fit your company's needs. There is a 

255 character limit for error message text. 

3. Click Submit to save your changes, or click Cancel to return to the main Admin menu. 

4. A message appears stating that your Publisher Settings have been updated. You can now 
view the Publisher options that you have enabled from the Content tab: 

 Skillsoft Publisher 

 Upload Passive Content 
 

Completion Criteria 

A course's completion status is checked when results are posted to the Skillport database. This 
typically occurs when a learner finishes a session and closes a course. The learner's results are 
compared to the course's completion criteria to determine the course's completion status. A course is 
either COMPLETE (the learner has met the criteria) or STARTED (the learner has started the course 
but not yet met the criteria). 

You can define company-wide and course-specific completion criteria. 

Completion Criteria Settings 

You can configure the following completion criteria settings:  

Existing Completions: When Preserve existing completions is selected, any existing course 
completions are frozen (marked to permanently maintain their status of COMPLETE) once your 
Skillport database is re-summarized. For more information, see Existing Completions on page 425.  

Completion Criteria: Specify one of the following visitation criteria and, if desired, the minimum time 
duration. 

 Visitation 

 Achieve minimum test score OR visit all content pages: Learners can satisfy the 

Minimum test score and scoring model criteria OR page through all topics, whichever 

comes first. This is the default setting for Standard courses. 

 Achieve minimum test score AND visit all content pages: Learners must satisfy the 

Minimum test score and scoring model criteria AND must page through all topics. This is 

the default setting for Compliance courses. 
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 Achieve minimum test score: Content visitation is ignored. Learners must satisfy the 

Minimum test score and scoring model criteria. 

 Visit all content pages: Learners must page through all topics. The Minimum test score 

and scoring model criteria is ignored. 

 If the course cannot be completed because there are no assessments or because of 

passive content, do not specify Achieve minimum test score AND visit all content 

pages or Achieve minimum test score. 

 Minimum total time in course: Specify the minimum time duration (in hours and/or minutes) 

the learner must spend in the course to achieve completion. The Hours value must be an 

integer between 0 and 99, and the Minutes value must be an interger between 0 and 59. The 

default value is blank (no minimum specified).  

Configuration: Specify one or more of the following configuration options. 

 Minimum test score: Specify the numeric score the learner must meet or exceed to complete 

a course, then select the scoring model from the drop-down list. The scoring model is the logic 

to apply when determining completion. There are 2 scoring models: 

 Each Test (lesson scoring): In order for the learner to complete the course, each lesson 

test must have a high score that meets or exceeds the value specified for Minimum test 

score. 

 Average (course scoring): In order for the learner to complete the course, the average of 

all lesson test scores must meet or exceed the value specified for Minimum test score. 

Tests that have not been attempted are scored as 0. 

As an example, assume you set Minimum test score to 80. A learner takes a course with 5 
lessons and scores 100% on the first 4 lessons, but she doesn't attempt the last lesson test. If 
Each Test (lesson scoring) is being used, the course is considered incomplete because the 
learner did not get at least 80% on all lesson tests. However, if Average (course scoring) is 
being used, the course is marked as complete because the average of all lesson tests 
(100+100+100+100+0)/5 = 80, which meets the value specified for Minimum test score. 

Note: SkillSims ignore all completion criteria except Minimum test score. Even if you set the 
visitation completion criteria to Visit all content pages, SkillSims can only be completed by 

meeting the specified minimum score. 
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 Maximum course test attempts: Allows you to specify the maximum number of attempts 

allowed for a learner to take a course test; after the maximum attempts is reached, the learner 

can request a course retake. You can enter an integer value from 1 - 99, or leave the field 

blank (unlimited attempts).    

 Visit all content pages prior to test access: When selected, prohibits the learner from 

directly accessing the test without first completing all the pages in the course. 

 Require users to complete all questions in each test: If you select this option, all questions 

must be answered in all tests in order to complete a course. For Legacy courses, this option 

only applies when using Average (course scoring). This is because all tests are required by 

default for Legacy courses using lesson scoring. For CCA courses, this option applies when 

using either Each Test (lesson scoring) or Average (course scoring).  

 Disable forward navigation based on audio duration: When selected, the forward 

navigation for course pages is not enabled until the audio portion of the current page has 

completed and prevents the audio portion from being muted.  

 Allow multiple completions: Select this option to allow learners to restart a course that has 

already been started. This option will not be available if it has not been enabled on your site. 

Note: After you make changes to completion criteria, you must call Skillsoft Technical Support and 
request that your Skillport database be re-summarized. This updates the completion criteria, updates 
the summary data for all applicable courses, and reevaluates learners' completion status on all 
applicable courses based on the new criteria. 
 
However, if you do not want the changes to the completion criteria to affect learners who have already 
completed affected courses (based on the old completion criteria), first you must 1) freeze existing 
completions of the courses, and then 2) request that Skillsoft Technical Support re-summarize your 
Skillport database. Once this is done, you can change the completion criteria.  

 

Set Global Completion Criteria 

You can set global (company-wide) completion criteria that learners must meet in order to complete 
any course in the Skillport Library. You can specify separate completion criteria for Standard courses 
and for Compliance courses.  

 A Standard course is any CCA course, excluding Business Impacts, Business Challenges, 

Test Preps, Assessment Only content, or compliance courses.  

 A Compliance course is a CCA course that is marked as "compliance". 

Note: If you have also set course-specific completion criteria for one or more courses, the course-
specific criteria supersede the global criteria. 

To set global completion criteria 

1. Click Configuration > Completion Criteria on the navigation bar. 
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The Completion Criteria page displays. 

 

2. In the Global Criteria section, click either the Standard or Compliance course type. 

3. Click Edit Criteria. 

The Edit Standard Criteria or the Edit Compliance Criteria dialog box displays, depending on 
the selected course type. 

Note: The available criteria options are the same for both Standard and Compliance courses. 

However, the default completion criteria is different. 

 

4. Change the completion criteria as needed. For help with this step, see Completion Criteria 
Settings on page 425. 
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5. Click OK. 

6. Contact Skillsoft Technical Support and request that your company's database be re-
summarized. 

 
 

Set Course-Specific Completion Criteria 

You can set course-specific completion criteria that learners must meet in order to finish one or more 
specific courses. Course-specific criteria overrides global criteria. 

To set course-specific completion criteria 

1. Click Configuration > Completion Criteria on the navigation bar. 

The Completion Criteria page displays. 

 

Note: In the Override Global Criteria section, a  (check mark) displays next to the ID for 

those courses that have course-specific completion criteria applied. 

2. Locate the course (or courses) for which you want to specify course-specific completion 
criteria. 

You can use the sorting options in the Override Global Criteria section to locate the course. 
You can also use the search fields at the top of the page. Only search categories for asset 
types for which completion criteria can be set are shown. 

3. Select the course or courses. To select multiple course, use Ctrl+click or Shift+click. 

4. Click Override Global Criteria.  
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  The Override Global Criteria dialog box displays. 

 

5. Change the criteria as needed. For help with this step, see Completion Criteria Settings on 
page 425. 

6. Click Save. 

7. If there are existing course completions that have not yet been preserved (frozen), you are 
prompted to confirm that you want to change the criteria. Click OK to confirm, or click Cancel 
to discard the changes. 

8. Contact Skillsoft Technical Support and request that your company's database be re-
summarized. 

To remove course-specific completion criteria 

1. Click Configuration > Completion Criteria on the navigation bar. 

The Completion Criteria page displays. 

2. Select the course or courses for which you want to remove course-specific completion criteria. 
To select multiple courses, use Ctrl+click or Shift+click. 

3. Click Remove Override, and then click OK. 

4. If there are existing course completions that have not yet been preserved (frozen), you are 
prompted to confirm that you want to change the criteria. Click OK to confirm, or click Cancel 
to discard the changes. 

The selected courses revert to using the defined global (company-wide) criteria. 

5. Contact Skillsoft Technical Support and request that your company's database be re-
summarized. 
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Completion Criteria Settings 

 

Note: After you make changes to completion criteria, you must call Skillsoft Technical Support and 
request that your Skillport database be re-summarized. This updates the completion criteria, updates 
the summary data for all applicable courses, and reevaluates learners' completion status on all 
applicable courses based on the new criteria. 
 
However, if you do not want to affect learners who have already completed affected courses (based 
on the old completion criteria), prior to changing the completion criteria you must 1) preserve existing 
completions of the courses, and 2) request that Skillsoft Technical Support re-summarize your Skillport 
database. Once this is done, you can change the completion criteria. You cannot preserve existing 
completions and change completion criteria at the same time. 
 
The exception to the above is when you make a change to only the Allow Multiple Completions 

option. In this case, you do not need to have Skillsoft Technical Support re-summarize your database. 

 

Existing Completions 

When you select the Preserve existing completions option, any existing course completions are 
marked to permanently maintain their status of COMPLETE once your Skillport database is re-
summarized.  

You should select this option: 

 if you intend to change the completion criteria of courses (for example, by raising or lowering 

the minimum test score), but you do not want the changes to impact users who have already 

completed affected courses based on the old criteria.  

 when you are replacing one course with another from the catalog, but want to give credit to 

the users who have completed the original course.  

Preserving existing completions is a permanent action; if you later disable the option (by clearing the 
check box), all completions that have been frozen are still marked as COMPLETE. 

If you do not freeze existing completions, when Skillsoft Technical Support re-summarizes your 
database, all existing completions are reevaluated based on the new criteria. This can result in the 
completion status changing from COMPLETE to STARTED for some learners. 

Example 

Consider the following scenario: 

1. You set the company-wide completion criteria as follows: 

 Minimum test score = 75 

 Scoring Model = Average (course scoring) 

 Content visitation = Achieve minimum test score 

 Preserve existing completions = disabled (not checked) 

2. Learner A ends a course session for Course X, and a score of 80 is reported to Skillport. The 
course is marked as COMPLETE based on the defined criteria. 
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3. You change the value for Minimum test score to 85 and have Skillsoft Technical Support re-
summarize your database. 

4. When the database is re-summarized, the completion status for Course X is reevaluated 
based on the new criteria. Learner A's score does not meet the minimum test score, so her 
course completion status is changed to STARTED. 

5. You change the value for Minimum test score back to 75 and have Skillsoft Technical 
Support re-summarize your database. 

6. When the database is re-summarized, the completion status for Course X is reevaluated 
based on the new criteria. Learner A's score exceeds the minimum test score, so her course 
completion status is changed to COMPLETE. 

7. You select Preserve existing completions, click Save, and have Skillsoft Technical Support 
re-summarize your database. 

8. When the database is re-summarized, Learner A's completion of the course is frozen, that is, 
it is permanently marked as COMPLETE. 

9. You change the value for Minimum test score to 90 and have Skillsoft Technical Support re-
summarize your database. 

When the database is re-summarized, even though Learner A's score does not meet the new 
completion criteria, her completion status remains unchanged because her completion for Course X 
has been frozen. 
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Existing Completions for Compliance Content 

For detailed information about Compliance, see Recurring Assets (Compliance). 

If a learner has already completed an asset that is now marked as a compliance asset, that learner 
can get compliance credit for the asset if both the First Accessed and Completed dates are within 
the asset's designated previous recurrence period (the effective assignment date to the recurrence 
period).  

Example for Existing Completions for Compliance 

The Leadership Basics course is a mandatory course for a certain group of learners (Leadership 
Candidates). You assign the Leadership Basics course on June 15, 2013 with a recurrence period of 
one year. 

On August 1, 2013, you add two new learners to the Leadership Candidates group: 

 Joe has already taken the Leadership Basics course, and he accessed and completed it on 

June 25, 2013. Because he started and completed it within the last year (August 1, 2012 - 

August 1, 2013), he is not required to complete this asset in the initial period. Joe receives 

compliance credit.    

 Mike has also taken the Leadership Basics course, and he first accessed it on June 25, 2012. 

Mike completed the course on July 1, and because he did not complete it within the last year 

(August 1, 2012 - August 1, 2013), he is required to complete this asset in the initial period. 

Mike does not receive compliance credit until he has completed the asset within the initial 

period. 

Recurring Compliance Courses 

Credit is given for the initial assignment only. Compliance credit is not granted with prior completions 
for the next recurrence. 

Example of Recurring Compliance Courses 

All employees must successfully pass the Sexual Harassment Awareness course once per fiscal year 
to remain in compliance with an organization's internal goals. The Sexual Harassment Awareness 
course is open yearly from February 1 - January 31 of the following year (for example, Feb 1, 2013 - 
Jan 31, 2014).  

A new hire, Paul, begins work on January 25. He takes the Sexual Harassment Awareness course on 
January 30. When the assignment reappears in his learning plan on February 1, he wants credit for 
already taking the course. He is not granted compliance credit, as it is a recurring course for company-
wide yearly compliance.  
 

Completion Criteria 

The Completion Criteria settings in the Edit Standard Criteria and Edit Compliance Criteria dialog 
boxes include the following: 

 Visitation 

 Achieve minimum test score OR visit all content pages: Learners can satisfy the 

Minimum test score and scoring model criteria OR page through all topics, whichever 

comes first. This is the default setting for Standard courses. 

 Achieve minimum test score AND visit all content pages: Learners must satisfy the 

Minimum test score and scoring model criteria AND must page through all topics. This is 

the default setting for Compliance courses. 
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 Achieve minimum test score: Content visitation is ignored. Learners must satisfy the 

Minimum test score and scoring model criteria. 

 Visit all content pages: Learners must page through all topics. The Minimum test score 

and scoring model criteria is ignored. 

 If the course cannot be completed because there are no assessments or because of 

passive content, do not specify Achieve minimum test score AND visit all content 

pages or Achieve minimum test score. 

 Minimum total time in course: Specify the minimum time duration (in hours and/or minutes) 

the learner must spend in the course to achieve completion. The Hours value must be an 

integer between 0 and 99, and the Minutes value must be an interger between 0 and 59. The 

default value is blank (no minimum specified). 
 

Configuration  

The Configuration settings in the Edit Standard Criteria and Edit Compliance Criteria dialog boxes 
include the following: 

 Minimum test score: Specify the numeric score the learner must meet or exceed to complete 

a course, then select the scoring model from the drop-down list. The scoring model is the logic 

to apply when determining completion. There are 2 scoring models: 

 Each Test (lesson scoring): In order for the learner to complete the course, each lesson 

test must have a high score that meets or exceeds the value specified for Minimum test 

score. 

 Average (course scoring): In order for the learner to complete the course, the average of 

all lesson test scores must meet or exceed the value specified for Minimum test score. 

Tests that have not been attempted are scored as 0. 

As an example, assume you set Minimum test score to 80. A learner takes a course with 5 
lessons and scores 100% on the first 4 lessons, but she doesn't attempt the last lesson test. If 
Each Test (lesson scoring) is being used, the course is considered incomplete because the 
learner did not get at least 80% on all lesson tests. However, if Average (course scoring) is 
being used, the course is marked as complete because the average of all lesson tests 
(100+100+100+100+0)/5 = 80, which meets the value specified for Minimum test score. 

Note: SkillSims ignore all completion criteria except Minimum test score. Even if you set the 
visitation completion criteria to Visit all content pages, SkillSims can only be completed by 

meeting the specified minimum score. 
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 Maximum course test attempts: Allows you to specify the maximum number of attempts 

allowed for a learner to take a course test; after the maximum attempts is reached, the learner 

can request a course retake. You can enter an integer value from 1 - 99, or leave the field 

blank (unlimited attempts).  

 Visit all content pages prior to test access: When selected, prohibits the learner from 

directly accessing the test without first completing all the pages in the course. 

 Require users to complete all questions in each test: If you select this option, all questions 

must be answered in all tests in order to complete a course. For Legacy courses, this option 

only applies when using Average (course scoring). This is because all tests are required by 

default for Legacy courses using lesson scoring. For CCA courses, this option applies when 

using either Each Test (lesson scoring) or Average (course scoring).  

When this option is selected, either Average + or Each Test + displays in the Model column 
in the Override Global Criteria list. 

 Disable forward navigation based on audio duration: When selected, the forward 

navigation for course pages is not enabled until the audio portion of the current page has 

completed and prevents the audio portion from being muted.  

 Allow multiple completions: Select the option to allow learners to restart a course that has 

already been started.  

 
 

Course Restart (Course-Specific Only) 

If you have courses that learners need to complete on a recurring basis, you can select the Allow 
Multiple Completion option to partially automate the creation of new progress records for learners: 

 If you select this option, a learner can launch his most recent completion of the course for the 

purpose of restarting or continuing the course. Restarting the course creates a new record in 

the Learner Transcript that counts toward the next completion. Continuing the course allows 

the learner to re-enter the last completion with the goal of changing and improving its score. 

Immediately after the learner launches the last completion, he is prompted to choose whether 

to restart or continue the course. 

Be aware that if the Enable Forced Restart web site switch is set to Yes, and you set this 
setting for a course, learners can still launch the most recent completion. However, this 
automatically creates a new record in the Learner Transcript that counts toward the next 
completion. In other words, learners must restart the course; they are not given the option to 
continue (re-enter) the last completion. 

 If you do not select this option, a learner can still launch his initial completion of the course. 

However, doing so only allows the learner to re-enter the initial completion for the purpose of 

improving its score. The learner cannot create another completion record. 

Note: Unlike when you change a course's completion criteria, when you make a change to only the 
Allow Multiple Completion option, you do not need to have Skillsoft Technical Support re-summarize 
your database. 

For more information on assets that can be restarted, see Assets That Learners Can Restart. 
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Notification Management 
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Getting Started with Notification Management 

Emails and Email Templates 

Many events that occur as learners and managers use Skillport to manage online learning result in 
email notifications being sent by the system. For example, a learner can configure a Learning Plan 
assignment so that she is emailed a reminder notice before its due date. As another example, if a 
learning program is configured to require approval to enroll, the learner's manager can receive a 
reminder notice to approve or deny the request. 

By default, most of the events that trigger email notifications are set up to use a system email 
template. The system email templates are provided with your Skillport site. You can view them on the 
Notification Management page, but you cannot edit them. However, if desired, you can create custom 
templates and assign your custom templates to the events instead. 

There are a handful of events that trigger emails that are not available on the Notification Management 
page. You cannot customize these emails, but in some cases you can configure the system not to 
send them. For more information, see Non-Customizable Emails on page 432. 
 

Email Recipients 

 A recipient in the To, CC, or BCC field receives one copy of an email. 

 A recipient in the To and CC fields can see all other recipients in only those 2 fields. 

 A recipient in the BCC field can also see all recipients in the To and CC fields. In addition, she 

can see herself—and only herself—in the BCC field. 
 

Advanced Group Support 

If your site is set up to support advanced groups, you can customize the notification management 
system both at the site level and at the advanced group level. 

To make customizations that are applied to the overall site, before making any changes, make sure 
that no advanced group is set current in Skillport Administrator. To make customizations that are 
unique to a specific advanced group, before making any changes, set current that advanced group. 

Note: When you create an advanced group, by default its Skillport events are assigned the system 
email templates. Any custom templates that you create and apply at the site level are not inherited by 
the advanced group. You must make the same customizations to the advanced group, or you can 
make different ones if desired. 
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Non-Customizable Emails 

The following emails sent by Skillport are not available on the Notification Management page because 
you cannot customize their contents. These emails are always sent in U.S. English to recipients. 

Login 

A user forgets her user ID and requests for it to be sent via email. 

Recipient 

The user who made the request. 

Can the email be turned off? 

No. The user receives her user ID through this email. You can disable this feature; contact your 
Skillsoft representative for more information. 

Email text 

Subject: 

User Id Request 

Body: 

User Ids for address <user's email address> 

LastName   FirstName   UserId 

<user's last name> <user's first name> <user's user ID> 

 

 

A user forgets her password and requests that a new one be sent via email. 

Recipient 

The user who made the request. 

Can the email be turned off? 

No. The  user receives her password through this email. You can disable this feature; contact your 
Skillsoft representative for more information. 

Email text 

Subject: 

Password Request 

Body: 

Your new password is : <password> 

Reporting 

A scheduled report is run automatically by the system. 

Recipient 
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The administrator who created the schedule. 

Can the email be turned off? 

Yes. Open the report's schedule for editing, and clear the Email Notification check box. 

Email text 

Subject: 

Your scheduled SkillPort report is complete 

Body: 

The following SkillPort report has been completed. 

Schedule Name:  <name of schedule> 

Schedule Description: <description of schedule> 

Time Completed:  <YYYY-MM-DD HH:MM:SS> 

Please log into your SkillPort site to retrieve the report. It is in the 

Results tab in the Reports section. 

An administrator manually runs (previews) a report, and when saving the result, she selects to be 
notified via email when the report is completed. 

Recipient 

The administrator who ran the report. 

Can the email be turned off? 

Yes. When you save the report, do not select the Email Notification check box on the Email tab in the 
Save Result dialog box. (It is cleared by default.) 

Email text 

Subject: 

Your SkillPort report is complete 

Body: 

The following SkillPort report has been completed. 

Name:        <name of schedule> 

Description: <description of schedule> 

Time Completed: <YYYY-MM-DD HH:MM:SS> 

Please log into your SkillPort site to retrieve the report. It is in the 

Results tab in the Reports section. 

Send Email 

An administrator sends an email using the Send Email page that is accessed by clicking Users & 
Groups > Send an Email on the navigation bar. 

Recipient 

The administrator who sent the email. 
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Can the email be turned off? 

No. 

Email text 

Subject: 

Email Sent 

Body: 

Your email "<the subject you specified in your email>" has been sent. 

The following users do not have email addresses configured and did not 

receive your email: 

<user A's last name>,<user A's first name> 

<user B's last name>,<user B's first name> 

 
 

Notification Management Workflow 

To customize the notification system to meet your organization's needs, follow this recommended 
workflow: 

1. View the events that trigger emails. 

2. Deactivate the emails that you do not want to be sent, and activate the emails  that you do 
want to be sent. Most emails are activated by default, but a few are not. 

3. View the system templates on page 449 that are assigned to the emails that you do want to 
be sent. 

4. If you require any changes, create custom templates to use instead of the system templates. 

5. Assign the custom templates to the appropriate emails. 
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Instructor Led Training (ILT) Emails 

This section provides information on the Instructor Led Training (ILT) emails that are sent by Skillport 
to learners and administrators. For in-depth information on ILT in general, see Instructor Led Training. 
 

Types of ILT Emails 
If your site supports Instructor Led Training (ILT), then your ILT administrators, approvers, managers, 
and instructors work with 3 types of emails: 

 User-initiated emails 

 Optional, event-driven emails 

 Automatic, event-driven emails 

Tip: To view these events easily, change the filtering on the Feature column on the Manage Emails 
page, so that only the ILT events are displayed. 

User-Initiated Emails 

There are 2 places in Skillport in which you can send an ILT email on demand for any reason: 

 When you view a course's information, you can click the Email button to email 

 The course administrators assigned to the course 

 The learners on the course's watch list 

 When you view a session's information, you can click the Email button to email 

 The session administrators assigned to the session 

 The instructor assigned to the session 

 The learners enrolled in the session 

In user-initiated emails, you cannot change the body of the email, but you can change its subject line. 
You can also specify additional recipients in the CC and BCC fields. These recipients do not need to 
have Skillport accounts; in other words, you can specify them by their external email addresses. 

Note: You cannot disable the ILT events that support these user-initiated emails. 
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Optional, Event-Driven Emails 

When one of the following events occurs, you are prompted by the system to send an email if desired: 

 Course Activated 

 Course Updated 

 Course Removal 

 Session Created 

 Session Updated (You are prompted to optionally send this email if 1) the session status is not 

"Confirmed," and 2) the calendar object-related information hasn't changed.) 

 Session Deleted 

 Session Confirmed (This email does not include an iCalendar object.) 

 Enrollment Withdrawal Notification 

In optional, event-driven emails, you cannot change the subject or the body. However, like for user-
initiated emails, you can specify additional recipients in the CC and BCC fields. These recipients do 
not need to have Skillport accounts; in other words, you can specify them by their external email 
addresses. 

Automatic, Event-Driven Emails 

All of the other ILT-related events that trigger emails to be sent by Skillport do so automatically. You 
cannot disable these emails on a per email basis. However, you can deactivate the event so that it 
never triggers any emails to be sent. 
 

Calendar Objects 
When calendar-related information regarding a session changes (for example, the date, time or 
location), an iCalendar attachment (.ics file) is sent with the ILT email. This allows the learner to easily 
update his or her Microsoft Outlook calendar accordingly. 

 
 

Deactivating Emails 
You can deactivate all ILT emails except for the following user-initiated emails: 

 Ad Hoc Email to a Course Watch List 

 Notify All Enrolled and Waitlisted Learners in a Session 

These emails always remain active because they support the Email buttons on the pages that display 
course and session information. 
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Support for Multiple Languages 

Multiple Language Support - ILT Emails 
Multiple language support for Instructor Led Training (ILT) emails works as follows: 

 A course-related or session-related email is sent to all recipients in the language specified in 

the course's information if that language is one of the languages supported by the Skillport 

application. (All sessions inherit the language of the parent course.) For the list of languages 

supported by Skillport, see Language Support in the System Requirements. 

 If a course specifies a language that is not supported by Skillport, the email is sent to all 

recipients in the default language used by your Skillport site. 

 Users can override Skillport's default language by specifying a different language in the 

Default Site Language setting in his or her profile. However, unlike for non-ILT emails, this 

profile setting does not play a role in determining the language in which ILT emails are sent. 

 User-Initiated and Optional, Event-Driven Emails: Because these 2 types of emails are not 

sent automatically by the system, you have the option of adding a personal message in any 

language to the body of the email before you send it. For an introduction to these emails, see 

Types of ILT Emails. 
 

Multiple Language Support - All Other Skillport Emails 
Multiple language support for Skillport emails except ILT emails works as follows: 

 If an email recipient has not overridden Skillport's default site language, the recipient receives 

emails in that site language. 

 If the recipient has overridden Skillport's default site language by specifying a different 

language in the Default Site Language setting in his or her profile, the recipient receives 

emails in the language specified in his or her profile. 

 The exceptions to the above are: 

 Non-customizable emails 

These are sent in U.S. English. 

 Emails to new users created manually on page 31, via batch upload, and via self-

registration 

The default site language of your Skillport site determines which language-specific 
template is used to send emails. 

 Emails to existing users for whom approval managers are changed (manually or via batch 

upload) or deleted (manually) 

The default site language of your Skillport site determines which language-specific 
template is used to send emails. 

 Emails sent via the Send Email page 

The default site language of your Skillport site determines which language-specific 
template is displayed on the Send Email page. However, you can change both the subject 
and body, entering text in any desired language. 

 Emails containing previewed templates 
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The default site language of your Skillport site determines which language-specific 
"Preview Template" is displayed and is used to send the email. However, you can enter 
the subject and an optional, personal message in any desired language before sending 
the email. The language of the read-only, example email depends on which language-
specific template you selected to preview. 

 Optional emails regarding learning Plan assignments 

If your Skillport site is configured to do so, you are prompted to choose whether to send 
an email to learners when you make a change (addition, update, or removal) to their 
assignments in their learning plan. As is the case with most Skillport emails, if an email 
recipient has not overridden Skillport's default site language, the recipient receives the 
email in that site language. Alternatively, if the recipient has overridden Skillport's default 
site language by specifying a different one in the Default Site Language setting in her 
profile, the recipient receives the email in the language specified in her profile. However, 
when you send the email, you can also enter an optional, personal message in any 
desired language. 

 

Working with Email Templates 
When you initially view the email templates on the Manage Templates tab, by default you only see 
the system templates in the default site language specified for your Skillport site. A system template is 
provided in each language supported by Skillport. You can view the templates in additional languages 
by changing the filter on the Language column on page 15.  

Note: The filters you apply are not preserved once you log out of Skillport. 

As an example, in the following image, the filter on the Language column is configured to display the 
templates in three languages: German, Italian, and English. 

 
If you intend to support email notifications in multiple languages, before you begin working on the 
Manage Templates tab, change the filter on the Language column so that the templates for all 
applicable languages are displayed and accessible to you. This allows you to make the same 
customizations in all languages. 

Language-specific filtering is not available on the Manage Emails tab. On that tab, the templates in all 
languages that are assigned to a given event are always shown. 
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Managing Emails 

Skillport Events 

This topic provides information on most of the Skillport events that can trigger notification emails. All of 
the events discussed here are shown on the Notification Management page. 

The recipients of an email are determined by the variables specified in the recipient fields (the To, Cc, 
and Bcc fields) in the assigned template. For information on the available variables for each template, 
see Variables on page 461. 

Note: There are also a few emails that are not available on the Notification Management page 
because you cannot customize their contents; for information on these, see Non-Customizable 
Emails on page 432. 
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Development Plan 

Development plans: 

 Development Plan Approval Request by Learner: A learner requests approval for a change 

to his or her development plan. 

 Development Plan Request Approved by Manager: A manager approves a learner's 

request for a change to his or her development plan. 

 Development Plan Request Denied by Manager: A manager denies a learner's request for 

a change to his or her development plan. 

Learning events: 

 Learning Event Approval Request by Learner: A learner requests approval for a learning 

event. 

 Learning Event Approval Request Approved by Manager: A manager approves a learner's 

request for a learning event. 

 Learning Event Approval Revoked by Manager: A manager revokes approval of a learning 

event. 

 Learning Event Request Denied by Manager: A manager denies a learner's request for a 

learning event. 

Instructor Led Training 

Ad Hoc Email to a Course Watch List: An administrator with rights to a course's watch list manually 
sends an email to the members via the View Course page. 

Approval for Enrollment Request by Learner: A learner requests approval to enroll in an ILT 
course. 

Course Activated: An ILT course is activated. 

Course Removal: An ILT course is deactivated or deleted. 

Course Updated: Any attribute of an ILT course is updated. 

Enrollment Request Approved by Administrator: An ILT administrator who has administrator rights 
to the session—instead of an approval manager or the session's session approver—approves a 
learner's request for enrollment. A template assigned to this event can be sent to the learner's 
approval manager and the session's session approver. 

Enrollment Request Approved by Administrator/Approver: An ILT administrator who has 
administrator rights to the session, an approval manager, or the session's session approver approves 
a learner's request for enrollment. A template assigned to this event can be sent to the learner whose 
request was approved. 

Enrollment Request Awaiting Approval: A number of days pass since an approver (the learner's 
approval manager and/or the session's session approver) was notified of the learner's request to 
enroll, but the request has not yet been granted or denied. This event triggers an email after the 
number of days specified in the Approval Reminder Relative Date setting on the Site Settings ILT 
page. 

Enrollment Request by Learner: Both the approval manager and a session approver must approve a 
learner's enrollment in an ILT course, and only one has done so. This event triggers an email after the 
number of days specified in the Approval Reminder Relative Date setting on the Site Settings ILT 
page. 
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Enrollment Request Denied by Administrator: An ILT administrator who has administrator rights to 
the session—instead of an approval manager or the session's session approver—denies the learner's 
request to enroll. A template assigned to this event can be sent to the learner's approval manager and 
the session's session approver. 

Enrollment Request Denied by Administrator/Approver: An ILT administrator who has 
administrator rights to the session or an approver (the learner's approval manager and/or the session's 
session approver) denies the learner's request to enroll. A template assigned to this event can be sent 
to the learner whose request was denied. 

Enrollment Status Change Notification: A learner's enrollment status in a session is changed. 

Enrollment Withdrawal Notification: An ILT administrator who has administrator rights to the 
session or the session's instructor withdraws a learner from a session. 

Instructor Change Notification: An instructor for a session is changed. 

Notify All Enrolled and Waitlisted Learners in a Session: An administrator who has administrator 
rights to a session's enrolled and waitlisted learners manually emails those learners via the View 
Session page. 

Request for Enrollment Expired: A learner's request to enroll in a session expires because it was 
not granted or denied in a specified number of days. This event triggers an email after the number of 
days specified in the Approval Expires Relative Date setting on the Site Settings ILT page. 

Session Cancelled: A session is cancelled. 

Session Closed: A session is closed to additional enrollments. A template assigned to this event can 
be sent to the learners for whom enrollment requests are still pending approval, the approval 
managers for those learners, the learners on the session's wait list, and the session's session 
approver. 

Session Closed - Roster Listing: A session is closed to additional enrollments. A template assigned 
to this event can be sent to the session's instructor and session administrators. 

Session Confirmed: A session is confirmed. 

Session Created: A session is created. 

Session Deleted: A session is deleted. 

Session Enrollment Limit: The session's enrollment has 1) reached minimum capacity, or 2) reached 
maximum capacity. Note that the first condition (the session's enrollment has reached minimum 
capacity) is determined by the session's enrollment and the value specified in the Minimum Session 
Threshold setting setting on the Site Settings ILT page. 

Session Re-opened for Enrollment: The session is reopened for enrollments. 

Session Seats Become Available - Watch List: The following criteria has been met: Session is at or 
over maximum capacity, one or more withdrawals has occurred (taking it below capacity), and its 
parent course has a watch list. 

Session Updated: Any attribute of a session is updated. 

Learning Program 

Enrollment Approval by Manager: An approval manager or administrator approves a learner's 
request to enroll in a learning program. 

Enrollment Approval Request: A learner requests approval to enroll in a learning program. 

Enrollment Denial - Automated to Learner: A learner's request to enroll in a learning program is 
automatically denied because it was not handled by an approver within a specified number of days (by 
default, 8). 
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Enrollment Denial - Automated to Manager: A learner's request to enroll in a learning program is 
automatically denied because it was not handled by an approver within a specified number of days (by 
default, 8). 

Enrollment Request Denied by Manager: An approval manager or administrator denies a learner's 
request to enroll in a learning program. 

Learner Withdrawal: An administrator withdraws a learner or a group in which the learner is a 
member from a learning program. 

If you activate emails for this event, after you withdraw a user or group from a learning program (using 
either the User Management page or the Enrollments and Waivers page), you are prompted to choose 
whether to send a notification email. 

Learner Enrollment Request Withdrawal: A learner withdraws his or her request to enroll in a 
learning program. 

Learning Program Enrollment: An administrator enrolls a learner or a group in a learning program, 
or an administrator approves a learner's request to enroll in a learning program. 

If you activate emails for this event, after you enroll a user or group on page 176 in a learning 
program (using either the User Management page or the Enrollments and Waivers page), you are 
prompted to choose whether to send a notification email. 

Learning Program Status Change: An administrator withdraws a group from a learning program, and 
a learner in that group previously requested approval to enroll as an individual in that learning 
program. This event also triggers the Pending Approval - Learner Reminder event. 

Pending Approval - Learner Reminder: A specified number of days (by default, 5) pass since a 
learner's approval manager was notified to approve or deny the learner's request to enroll in a learning 
program. 

Pending Approval - Manager Reminder: A specified number of days (by default, 5) pass since an 
approval manager was notified to approve or deny a learner's request to enroll in a learning program. 

Learning Plan 

Completion of Course: A learner completes a course in Learning Plan. 

Learner Personal Reminder: A learner's personal reminder for taking a Learning Plan course is 
triggered. 

Learner's Learning Plan Assignment Updated by Administrator: An administrator adds, updates, 
or removes a Learning Plan assignment. 

If you activate emails for this event, the Preview Email Template dialog box appears after you save a 
change to a user's or group's Learning Plan assignments. This allows you to choose whether to send 
a notification email regarding the change. 

Overdue Notice to Administrator: The due date of an asset assigned to a learner's Learning Plan by 
an administrator has passed. By default, this event triggers an email when the asset becomes overdue 
and, thereafter, every 7 days. 

Overdue Notice to User: The due date of an asset assigned to a learner's Learning Plan by an 
administrator passes. By default, this event triggers an email when the asset becomes overdue and, 
thereafter, every 7 days. 

Pending Due Notice: The due date of an asset assigned to a learner's Learning Plan by an 
administrator is approaching. By default, this event triggers an email when the due date is less than 14 
days (2 weeks) away and, thereafter, weekly. 

User Reminder for Administrator-assigned Courses: A learner's reminder for taking a Learning 
Plan course—which was set by the administrator who assigned the asset—is triggered. 

Waiver Approval Request by Learner: A learner requests a waiver for a course in Learning Plan. 
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Waiver Request Approved by Manager: An approval manager or administrator approves a learner's 
waiver request for a Learning Plan assignment. 

Waiver Request Denied by Manager: An approval manager or administrator denies a learner's 
waiver request for a Learning Plan assignment. 

Waiver Revoked by Manager: An approval manager or administrator revokes a waiver for a learner's 
Learning Plan assignment. 

Note: If you activate the emails sent due to Learning Plan-related events, be sure to set the Allow 
Learning Plan Reminders setting to Yes. That setting exposes the reminder-related settings in the 
Learning Plan dialog boxes. 
 
Also be aware that neither changes to learner's Development Plan folders nor changes to learning 
events in Learning Plan trigger any of the Learning Plan emails described above. 

Notifications 

Preview Template: An administrator previews an email template (by clicking the Preview button) and 
sends the example email to herself and/or other recipients. 

User Management 

Ad-hoc Email: An administrator sends an email to a selection of users and/or groups via the Send 
Email page. If you deactivate emails for this event, the controls on that page are disabled to prevent 
users from sending emails using it. 

Approval Manager Deletion: The approval manager assigned to a learner is deleted. 

If you activate emails for this event, the "Approval Manager Change" check box is enabled on the Edit 
User dialog box when you delete the approval manager, which means you can choose at that time 
whether to send the notification email (by selecting or clearing the check box). 

Approval Manager Updated: A learner's assigned approval manager is changed. 

If you activate emails for this event, the "Send approval manager email to updated user" check box is 
enabled on the Batch Add/Update page and the "Approval Manager Change" check box is enabled on 
the Edit User dialog box when you change the approval manager, which means you can choose at 
that time whether to send the notification email (by selecting or clearing the check box). 

New User Notification: An administrator creates a new user manually or via the Batch Add/Update 
page; or a learner self-registers, and approval by an administrator is not required because the user 
has an allowed email suffix (specified on the Self-Registration page). 

If you activate emails for this event, the "Send Welcome email" check box is enabled in the New User 
dialog box on page 31 and on the Batch Add/Update page, which means you can choose at that time 
whether to send the notification email (by selecting or clearing the check box). 

Self-registration Approved by Administrator: An administrator approves a learner's request to self-
register as a Skillport user. 

Self-registration Confirmation: A learner self-registers as a Skillport user, but it must be approved by 
an administrator. 

Self-registration Denied by Administrator: An administrator denies a learner's request to self-
register as a Skillport user. 
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View the Events That Trigger Emails 

Most of the events that trigger emails to be sent by Skillport to learners, administrators, and approval 
managers are exposed in the Administrator UI. This allows you to disable the emails that you do not 
want to be sent and, if required, to customize those that you do. 

To view the events that trigger emails 

1. Click Configuration > Notification Management on the navigation bar. 

The Manage Templates page displays, with the Manage Emails tab shown by default. This 
tab groups the events by major feature area and indicates if the email triggered by the event is 
activated. 

 

2. Use the Manage Emails tab to: 

 Filter and sort the columns to change the information that is displayed. As an example, 

you can apply a filter to the Feature column to display just Learning Plan events so you 

can work easily with them. For help with filtering and sorting, see Manage Information in 

Tables on page 15. Note that filtering by language is not supported; the templates in all 

languages that are assigned to an event are always shown. 

 Identify which emails are activated (that is, are sent when the corresponding event occurs) 

and activate or deactivate an email if desired. 

 Identify which email template is used for an email and, if desired, change the email 

template. 
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Activate or Deactivate an Email 

When you activate an email, it is sent by Skillport to the specified recipients whenever the associated 
event occurs. 

When you deactivate an email, it is never sent by Skillport when the associated event occurs. 
However, be aware that instances of the email that have already been queued by the system for 
delivery to recipients are still sent. 

To activate or deactivate an email 

1. Click Configuration > Notification Management on the navigation bar. 

 

2. Select the event for which you want to activate or deactivate emails. 

3. Do one of the following: 

 To activate the email, click Activate Email at the top of the tab. Activated emails have a  

in the Email Activated column. 

 To deactivate the email, click Deactivate Email at the top of the tab. 

4. Click Yes to confirm the action. 
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Change the Email Template Used for an Email 

At any time, you can change the email template that is used for sending emails when a specific event 
occurs. However, be aware that instances of the email based on the old template that have already 
been queued by the system for delivery to recipients are still sent. 

To change the email template used for an email 

1. Click Configuration > Notification Management on the navigation bar. 

 

2. Find the event for which you want to specify a different template. 

The description of the template currently assigned to an event often can provide additional, 
useful information that can help you understand the event. If necessary, to verify you have 
identified the desired event, you can click expand ( ) beside the event to view the name and 
description of the currently-assigned template. 
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3. Select the event (not the template). 

 

4. Click Edit at the top of the tab. 

The Manage Emails page displays. 

 

5. In the Associated Template Name column, double-click the template name to activate the 
drop-down list. 
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6. In the drop-down list, select the template to assign to the event. 

 

7. Click Save. 

 



Skillport 8 Administrator Guide ©2015 Skillsoft  449 
 

Configuration   
 
 

Managing Templates 

View Existing Templates 

With the exception of a limited number of non-customizable emails, all of the email templates that 
support the emails sent by Skillport are shown in Skillport Administrator. This allows you to examine 
the system templates provided with Skillport, and to create and use custom templates to further meet 
the needs of your organization. 

There are two ways to access the email templates that support Skillport emails: 

 The Manage Emails tab: Use this procedure when you do not know the name of the specific 

template that you want to view, but you do know the email that utilizes it. 

 The Manage Templates tab: Use this procedure when you know the name of the specific 

template. 

View existing templates using the Manage Emails tab 

To view the existing templates 

1. Click Configuration | Notification Management on the navigation bar. 

The Manage Templates page appears, which displays the Manage Emails tab by default. This 
tab groups the events by major feature area. 

 

2. If desired, filter and sort the columns to change the information that is displayed. As an 
example, you can apply a filter to the Feature column to display just Learning Plan events so 
you can work easily with them. For help with filtering and sorting, see Manage Information in 
Tables on page 15. 

3. Identify the event for which you want to view an assigned template. 

4. Click the + sign to the left of that event. 
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The email templates (in all languages) that are assigned to the event are shown. 

 

5. From this point, you can 

 Move the cursor over a template's Description icon to view a description of the template 

(shown above). 

 Select any template, and click the corresponding button to copy, preview (view an 

example based on the template), or edit it.  

You cannot delete or deactivate a template that is currently assigned to an event. You must 
first assign a different template to the event. 

View existing templates using the Manage Templates tab 

To view the existing templates 

1. Click Configuration | Notification Management on the navigation bar. 

2. Click the Manage Templates tab. 

3. Click the + sign beside a feature area to display the templates available for use with that 
feature. 
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Both the system templates (the templates provided for your use) and the custom templates 
created by you (if any) are displayed. 

 

As shown in the preceding image, the templates are grouped first by feature (for example, 
Learning Plan) and grouped second by more granular aspects (for example, Pending Due 
Notice). 

4. From this point, you can 

 Filter, sort, and hide columns to change the information that is displayed. As an example, 

you can apply a filter to the Feature column to display just Learning Plan templates so you 

can work easily with them. For help with filtering, sorting, and hiding columns, see 

Manage Information in Tables on page 15. 

 Move the cursor over a template's Description icon to view a description of the template. 

 

 Select any template, and click the corresponding button to copy, preview (view an 

example email based on the template), edit, delete, activate, deactivate, or delete it. 
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Preview a Template 

When you preview a template, you view an example email based on the template as it appears to a 
recipient. This allows you to examine the email's subject and body, so you can determine if they meet 
your requirements. 

You can also email the example email to one or more recipients if you choose. 

To preview a template 

1. Find the template on page 449 that you want to preview. 

2. Select the template, and click Preview just above it. 

In the Preview Email Template window, an example of an email based on the template 
displays. 
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3. If you do not want to send the email to yourself and others, click Close. Alternatively, if you do 
want to email it, click Send Preview, and continue with this procedure. 

 

4. Specify the email recipients: 

a. Click To . 

b. In the Email To dialog box, use the search controls or browse the Users and Groups 
hierarchy in the left pane to find the user or group to whom to send the email. Then, select 
the user or group, and click the Add button between the two panes. Alternatively, you can 
drag the user or group to the right pane, and drop it. Moreover, you can do this with any 
tab active in the right pane, as the system automatically adds the user or group to the 
appropriate tab. 

c. To specify recipients with external email addresses, click the External Emails tab in the 
right pane. To add a recipient, click Add, enter the email address, and press Enter. To 
remove a recipient, select the recipient, and click Remove. 

d. Click OK. 

e. If desired, click Cc to add additional recipients, and repeat steps 4b through 4c. 
Optionally, click Bcc , and follow the same procedure. 

5. If desired, modify the contents of the email: 

 Modify the Subject line.  

 Enter a personal message (maximum of 1,024 characters) in any language in the text box 

provided in the body. 
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Note: You can also change the read-only, introductory text that appears in all preview emails 
just above the example email. To do so, create a custom version of the Preview Template 
email template and then assign it to the Preview Template event. The language-specific email 
template that 1) is assigned to the event on the Notification Management page and 2) 
corresponds to the default site language of your Skillport site is used to send this email. You 
can enter the subject and an optional, personal message in any desired language. 

6. Click Send. 
 

Activate a Template 

Once a templated is activated, you can assign it to a Skillport event that triggers the delivery of 
notification emails to users.  

Note: After you activate a template, you must assign it to a Skillport event for it to be used by the 
system. 

To activate a template 

1. Click Configuration > Notification Management on the navigation bar. 

2. Click the Manage Templates tab. 

3. Find the template that you want to activate and select it. 

4. Click Activate. 

5. Click Yes to confirm the action. 
 

Create a Template 

You create a template by copying an existing one. This allows you to quickly change just the aspects 
that must differ. 

To create a template 

1. On the Notification Management page, click the Manage Templates tab. 
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A complete list of all templates display: 

 

2. Find the template on page 449 that you want to copy. 

3. Cick Copy. 

The Copy Notification Template dialog box displays. 

 

4. On the Basic Information tab, enter the information about the new template: 
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 Active: If you do not want the template to be used, keep this check box cleared to keep 

the template inactive. If you want to be able to use the template, select this check box to 

activate the template. Activating the template allows you to assign the template to a 

Skillport event, so that it is sent whenever that event occurs. 

 Template Name: (Required) The name of the template. Change this value to differentiate 

your custom template from the original on which it was based. All template names must 

be unique. 

 Template Description: The purpose and contents of the template. You can also change 

this value to differentiate the template from the original. 

You cannot change a custom template's template group, type, feature, or language. 

5. Click the Notification Content tab. 

 

Note: The From and Reply To fields are not editable. These fields use the values specified in 
the following two notification settings: 
- Default 'From' email address for notifications 
- Default 'Reply To' email address for notifications 

In the next steps, you specify the recipients and the content for the email. In all of the fields, 
you can select variables to insert, which are populated with actual data when the email is sent. 
The system restricts the list of available variables to only those that are appropriate for the 
field. 

6. Specify the recipients: 

 To: The individuals to whom to send the email. 

 Cc: The individuals to whom to send a copy of the email. 



Skillport 8 Administrator Guide ©2015 Skillsoft  457 
 

Configuration   
 
 

 Bcc: The individuals to whom to send a blind copy of the email. 

To change a default value, do the following: 

a. Click To, Cc, or Bcc. 

The Select Variables dialog box displays. 

b. To add a variable to the field, select it in the Available Variables pane, and click . You 
can use Ctrl-click or Shift-click to select multiple variables. 

c. To remove a variable from the field, select it in the Selected Variables pane, and click 
Remove. You can use Ctrl-click or Shift-click to select multiple variables. 

d. Click OK. 

7. In the Notification Subject field, modify the text as necessary. 

8. In the Notification Body field, modify the text as necessary. The message can include a 
combination of plain text, formatted text, and symbols (accessible via the  button). 

Be aware that when using the Enter key to add line breaks, the text appears to be double-
spaced in the editor, but in the actual email is only single-spaced. It is recommended that you 
use Preview to view an example email and adjust the formatting if necessary. 

You cannot format a selection of text that includes a field (variable). To apply the formatting, 
first format the selection of text (without the field), then insert the field. This applies the 
formatting to both the text and the field. 

Note: You can add hyperlinks and fields (variables) to both the subject and body, and you can 

also add images to the body. 

9. To insert a field: 

a. Put the cursor in the desired location. 

b. Select the field from the drop-down list on the toolbar. 

c. Click . 

(To remove a field, select it, and click .) 

10. To add a hyperlink: 

a. Select the text to convert to a hyperlink, and click . 

The Insert/edit link dialog box displays. 

b. For Link URL, enter the URL. This value is required. The URL must be complete and, 
therefore, must begin with the following: 

http:// 

c. For Target, specify whether the URL should be launched in a new browser window or the 
existing browser window. If you do not specify a value, the link is launched in a new 
window. This setting affects browser-based email clients only, and the recipient’s own 
browser settings determine whether or not it is respected. Non-browser-based email 
clients always use a new window. 

d. For Title, enter a short description. In browser-based email clients only, this appears as a 
“tool tip” when the user moves the cursor over the link. 

Note: You do not have to configure the Class setting. It is not used. 
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e. Click Insert. 

(To remove a link, place the cursor inside it, and click .) 

11. To add an image: 

a. Put the cursor in the desired location, and click . 

The Insert/edit image dialog box displays. 

b. For Image URL, enter the complete URL for the location of the image. The image must be 
a JPEG or GIF file that is hosted on a web site elsewhere. In the recipient's email, the 
URL will render as a link that, if clicked, will render the image itself. This value is required. 

c. For Image description, enter a description of the image. In text-only environments 
(browsers that cannot display inline images), this text is displayed instead of the image. 
This value is required. 

d. For Alignment, select how to align the image relative to the line of text in which it is 
inserted. For example, select "Left" to align the image with the left margin and have the 
text wrap around the image's right side. 

e. For Dimensions, enter in pixels the size (width x height) of the image if you want it to be 
resized before being inserted into the email. 

f. For Border, enter in pixels the width of the border to add around the image. 

g. For Vertical space, enter in pixels the width of the padding to add before and after the 
image. 

h. For Horizontal space, enter in pixels the width of the padding to add to the left and right 
of the image. 

i. Click Insert. 

12. Click Preview to view an example of an email based on the template as it appears to a 
recipient. 

13. Make changes as necessary. 

14. Click Save, and then click OK. 

At this point, you may want to activate the template and then assign it to an event. 
 

Edit a Template 

You can only edit custom templates. To create a custom template, refer to Create a Template.  

You can edit an active or deactivated template at any time. However, be aware that instances of the 
email based on the old version of the template are still sent if they have already been queued by the 
system for delivery. 

To edit a template 

1. On the Notification Management page, click the Manage Templates tab. 
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A complete list of all templates display: 

 

2. Select the template you wish to modify, and click Edit. 

3. Change the template's properties and content as needed. 

4. Click Preview to view an example email based on the template. 

5. If the template requires no additional changes, click Save, and then click OK. 
 

Deactivate a Template 

Deactivating a template prevents it from being assigned to (used by) a Skillport event that triggers the 
delivery of notification emails to users. 

You can deactivate a template if it is not currently assigned to a Skillport event, and you can 
deactivate both custom templates and the system templates that are provided by default with Skillport. 

If you deactivate a template for which emails have already been queued by the system for delivery to 
recipients, the queued emails are still sent. 

To deactivate a template 

1. Click Configuration > Notification Management on the navigation bar. 

2. Click the Manage Templates tab. 

3. Find the template that you want to activate, select it, and click Deactivate. 

4. Click Yes to confirm the action. 
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Delete a Template 

If your site has been configured to support custom user privileges, company administrators can be 
granted the Delete Email Template privilege that allows them to delete templates. 

Deleting a template permanently removes it from the system. You can delete a template if it meets the 
following criteria: 

 It is a custom template. You cannot delete a system template. 

 It is not currently assigned to a Skillport event that triggers the delivery of emails. 

If you delete a template for which emails have already been queued by the system for delivery to 
recipients, the queued emails are still sent. As an alternative to deleting a template, consider 
deactivating it. 

To delete a template 

1. Click Configuration > Notification Management on the navigation bar. 

2. Click the Manage Templates tab. 

3. Find the custom template that you want to activate, select it, and click Delete. 

4. Click Yes to confirm the action. 
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Variables 

The topics in this section provide descriptions of the variables available for use in email templates. Be 
aware that the system only makes available to you the list of variables that are appropriate for the 
given template and field. 

When an email is sent, the variable is replaced with actual data from the system. If no data is 
available, the field is rendered blank (empty). 
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Variables in Development Plan Templates 
Development Plan Approval Request by Learner 

Dev Plan Note for Approval Manager: The comment entered by the user regarding the approval 
request  

Manager: The email address of the approval manager selected by the learner when he or she 
submitted the approval request 

SkillPort URL: The URL to the login page for SkillPort  

User First Name: The first name of the learner  

User Last Name: The last name of the learner  

User Name: The user name of the learner  

Development Plan Request Approved by Manager 

Approval Manager/Admin Name: The first name and last name of the person who approved or 
denied the development plan  

Note FROM Approval Manager: The comment about the reason for the approval or denial  

User Email ID: The email address of the learner  

Development Plan Request Denied by Manager 

Approval Manager/Admin Name: The first name and last name of the person who approved or 
denied the development plan  

Note FROM Approval Manager: The comment about the reason for the approval or denial  

User Email ID: The email address of the learner  

Learning Event Approval Request by Learner 

Approval Manager Link: The URL to directly access the Approval Manager UI after logging in to 
SkillPort  

Cost: The cost of the learning event  

Description: The description of the learning event  

Duration: The duration of the learning event 

End Date: The end date of the learning event  

Goal: The goal of the learning event  

Manager: The email address of the approval manager selected by the learner when he or she 
submitted the approval request  

Note for Approval Manager: The note supplied by the learner when he or she submitted the approval 
request  

Start Date: The start date of the learning event  

Status: The status of the learning event (Not Started, Started, Completed)  

Title of LE: The title of the learning event  

URL: The URL of the learning event  

User First Name: The first name of the learner 

User Last Name: The last name of the learner 

User Name: The user name of the learner 

Whether LE is Required: Whether the learning event is required (true for yes, false for no) 
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Learning Event Approval Revoked by Manager 

Notes: The comment about the revocation  

Title of LE: The title of the learning event  

User Email ID: The email address of the learner  

Learning Event Request Approved by Manager 

Approval Manager/Admin Name: The first name and last name of the approval manager or 
administrator who approved or denied the learning event  

Note FROM Approval Manager: The comment about the reason for the approval or denial  

Title of LE: The title of the learning event  

User Email ID: The email address of the learner  

Learning Event Request Denied by Manager 

Approval Manager/Admin Name: The first name and last name of the approval manager or 
administrator who approved or denied the learning event  

Note FROM Approval Manager: The comment about the reason for the approval or denial  

Title of LE: The title of the learning event  

User Email ID: The email address of the learner  
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Variables in Instructor Led Training (ILT) Templates 
Ad Hoc Email to a Course Watch List 

Classroom Name: The name of the classroom 

Course Description: The description of the course 

Course Title: The title of the course 

Course Owned by Email: The email addresses of the course administrators for the course 

Facility Name: The name of the facility 

Watch List Learners: The email addresses of the learners on the course's watch list 

Approval for Enrollment Request by Learner 

Approval Reminder Days: The number of days that have elapsed since the session 
approver/approval manager was notified to approve or deny the learner’s request to enroll in the 
session. This number is based on the value of the Approval Reminder Relative Date setting (see ILT 
Site Settings). 

Approver Email: The email address of the learner's approval manager 

Approver First Name: The first name of the learner's approval manager 

Approver Last Name: The last name of the learner's approval manager 

Approval Manager: The email address of the learner's approval manager 

Base SkillPort URL: The URL for the SkillPort login page 

Course ID: The ID of the course 

Course Title: The title of the course 

Go To Approval URL: The URL to directly access the Approval Manager UI after logging in to 
SkillPort 

Learner Email: The email address of the learner 

Session Approver: The email address of the session approver assigned to the session 

Session ID: The ID of the session 

Session Type: The type of session (physical classroom, online classroom, or Dialogue Live session) 

Target Approval Date: The date by which approval is required. The date and time are based on 1) 
when the enrollment request was made and 2) the value of the Approval Expires Relative Date setting 
(see ILT Site Settings). 

Target Approval Date Time Zone: The time zone of the target approval date. This value is set in the 
session's schedule. 

User First Name: The first name of the learner  

User Last Name: The last name of the learner  

User Login: The user name of the learner 

Course Activated 

Course Administrator(s): The email addresses of the course administrators for the course 

Course Title: The title of the course 

Course Url: The URL of the parent course's summary page 

Watch List Learner: The email addresses of the learners on the course's watch list 

Course Removal 
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Course Administrator(s): The email addresses of the course administrators for the course 

Course Title: The title of the course 

Watch List Learners: The email addresses of the learners on the course's watch list 

Course Updated 

Base SkillPort URL: The URL for the SkillPort login page 

Classroom: The name of the classroom 

Course Administrator(s): The email addresses of the course administrators for the course 

Course Interest List: The email addresses of the learners on the course's watch list 

Course Title: The title of the course 

Go To Sessions URL: The URL of the parent course's summary page 

Watch List Learner: The email addresses of the learners on the course's watch list 

Enrollment Request Approved by Administrator 

Approval Manager: The email address of the learner's approval manager 

Approver Email: The email address of the learner's approval manager 

Approver First Name: The first name of the learner's approval manager 

Approver Last Name: The last name of the learner's approval manager 

Course Title: The title of the course 

Learner Email: The email address of the learner 

Learner First Name: The first name of the learner  

Learner Last Name: The last name of the learner 

Number: The ID of the course 

Session Approver: The email address of the session approver assigned to the session 

Session ID: The ID of the session 

Session Time Zone: The time zone of the target approval date. This value is set in the session's 
schedule. 

Session Type: The type of session (physical classroom, online classroom, or Dialogue Live session) 

Student Login Name: The user name of the learner 

Enrollment Request Approved by Administrator/Approver 

Approved Students: The email address of the learner whose enrollment request was approved 

Approver Notes: The note entered by the person who approved or denied the request 

Course Title: The title of the course 

Learner Email: The email address of the learner 

Learner First Name: The first name of the learner 

Learner Last Name: The last name of the learner 

Learner Login: The user name of the learner 

Session Administrator Name 

Session ID: The ID of the session 
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Session Time Zone: The time zone of the target approval date. This value is set in the session's 
schedule. 

Session Type: The type of session (physical classroom, online classroom, or Dialogue Live session) 

Enrollment Request Awaiting Approval 

Approval Reminder Days: The number of days that have elapsed since the session 
approver/approval manager was notified to approve or deny the learner’s request to enroll in the 
session. This number is based on the value of the Approval Reminder Relative Date setting (see ILT 
Site Settings). 

Approver Email: The email address of the learner's approval manager 

Approver First Name: The first name of the learner's approval manager 

Approver Last Name: The last name of the learner's approval manager 

Approval Manager: The email address of the learner's approval manager 

Awaiting Approval Learner: The email address of the learner who is waiting for approval to enroll in 
the session 

Course ID: The ID of the course 

Course Title: The title of the course 

Elapsed Days since Request: The number of days that have elapsed since the session 
approver/approval manager was notified to approve or deny the learner’s request to enroll in the 
session. This number is based on the value of the Approval Reminder Relative Date setting (see ILT 
Site Settings).   

Learner Email: The email address of the learner 

Learner First Name: The first name of the learner 

Learner Last Name: The last name of the learner 

Learner Login: The user name of the learner 

Maximum request expiry days: The number of days remaining after which the enrollment request 
expires. This number of days is based on 1) when the enrollment request was made and 2) the value 
of the Approval Expires Relative Date setting (see ILT Site Settings). 

Session Approver Email: The email address of the session approver assigned to the session 

Session ID: The ID of the session 

Session Type: The type of session (physical classroom, online classroom, or Dialogue Live session) 

Enrollment Request by Learner 

Approval Expiration Days: The number of days remaining after which the enrollment request 
expires. This number of days is based on 1) when the enrollment request was made and 2) the value 
of the Approval Expires Relative Date setting (see ILT Site Settings). 

Approval Manager: The email address of the learner's approval manager 

Course ID: The ID of the course 

Course Title: The title of the course 

Expired Date: The date on which the enrollment request expires. This date is based on 1) when the 
enrollment request was made and 2) the value of the Approval Expires Relative Date setting (see ILT 
Site Settings). 

Learner: The email address of the learner 

Learner Email: The email address of the learner 
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Learner First Name: The first name of the learner 

Learner Login: The user name of the learner 

Learner Second Name: The last name of the learner 

Session Approver: The email address of the session approver assigned to the session 

Session ID: The ID of the session 

Session Type: The type of session (physical classroom, online classroom, or Dialogue Live session) 

Enrollment Request Denied by Administrator 

Approval Manager: The email address of the learner's approval manager 

Approver Email: The email address of the learner's approval manager  

Approver First Name: The first name of the learner's approval manager 

Approver Last Name: The last name of the learner's approval manager 

Approver Note to learner: The note entered by the person who approved or denied the request 

Course ID: The ID of the course 

Course Title: The title of the course 

Learner Email: The email address of the learner 

Learner First Name: The first name of the learner 

Learner Last Name: The last name of the learner 

Learner Login: The user name of the learner 

Session Approver: The email address of the session approver assigned to the session 

Session ID: The ID of the session 

Session Time Zone: The time zone of the target approval date. This value is set in the session's 
schedule. 

Session Type: The type of session (physical classroom, online classroom, or Dialogue Live session) 

Enrollment Request Denied by Administrator/Approver 

Approver Email: The email address of the learner's approval manager 

Approver First Name: The first name of the learner's approval manager 

Approver Last Name: The last name of the learner's approval manager 

Approval Manager: The email address of the learner's approval manager 

Approval Note: A comment about the reason for the denial of the enrollment request. 

Base SkillPort URL: The URL for the SkillPort login page 

Course Identifier: The ID of the course 

Course Title: The title of the course 

Declined Learners: The email addresses of the learners for whom the enrollment request was 
denied. 

Course Url: The URL of the parent course's summary page 

Learner Email: The email address of the learner 

Learner First Name: The first name of the learner 

Learner Last Name: The last name of the learner 
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Learner Login: The user name of the learner 

Session Approver: The email address of the session approver assigned to the session 

Session ID: The ID of the session 

Session Time Zone: The time zone of the target approval date. This value is set in the session's 
schedule. 

Session Type: The type of session (physical classroom, online classroom, or Dialogue Live session) 

 

Enrollment Status Change Notification 

Base SkillPort URL: The URL for the SkillPort login page 

Classroom: The name of the classroom 

Classroom Directions: The directions to reach the classroom 

Course Title: The title of the course 

Facility Name: The name of the facility 

Facility Directions: The directions to reach the facility 

Go To Registration URL: The URL of the parent course's summary page 

Learner: The email address of the learner 

Learner Enrollment Status: The learner's enrollment status 

 Pending Approval (if the learner's enrollment request has not yet been approved) 

 Pending Session (if the session has not been confirmed) 

 Confirmed (if the session has been confirmed) 

Waiting list (if the learner is on the waiting list because the session has reached its capacity) 

Session ID: The ID of the session 

Session Notes: The notes about the session 

Session Status: The status of the session (Unconfirmed or Confirmed) 

Enrollment Withdrawal Notification 

Approval Manager: The email address of the learner's approval manager 

Base SkillPort URL: The URL for the SkillPort login page 

Course ID: The ID of the course 

Course Title: The title of the course 

Go To Sessions URL: The URL of the parent course's summary page 

Instructor Email: The email address of the instructor assigned to the session 

Learner Email: The email address of the learner 

Session Admin: The email addresses of the session administrators assigned to the session 

Session Approver Email: The email address of the session approver assigned to the session 

Session ID: The ID of the session 

Student First Name: The first name of the learner 

Student Last Name: The last name of the learner 
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Instructor Change Notification 

Course Title: The title of the course 

Instructor First Name: The first name of the instructor 

Instructor Last Name: The last name of the instructor 

Instructor (New): The email address of the new instructor assigned to the session  

Instructor (Old): The email address of the old instructor assigned to the session 

Session Administrator(s): The email addresses of the session administrators assigned to the 
session 

Session ID: The ID of the session 

Session Time Zone: The time zone of the target approval date. This value is set in the session's 
schedule. 

Notify All Enrolled and Waitlisted Learners in a Session 

Course Title: The title of the course 

Session Notes: The notes about the session 

Session ID: The ID of the session 

Session Time Zone: The time zone of the target approval date. This value is set in the session's 
schedule. 

Status: The status of the session (Unconfirmed or Confirmed) 

Request for Enrollment Expired 

Awaiting Approval Learner: The email address of the learner who is waiting for approval to enroll in 
the session 

Course ID: The ID of the course 

Course Title: The title of the course 

Base SkillPort URL: The URL for the SkillPort login page 

Go To Registration URL: The URL of the parent course's summary page 

Session Cancelled 

Course Title: The title of the course 

Instructor: The email address of the instructor assigned to the session 

Learners: The email addresses of the learners enrolled in the session 

Session ID: The ID of the session 

Session Owners: The email addresses of the session administrators assigned to the session 

Session Time Zone: The time zone of the target approval date. This value is set in the session's 
schedule. 

Session Closed 

Approvers/Managers for Pending Approval Learner: The email address of the session approver 
and/or approval manager for the learner whose enrollment request is pending approval 

Course Title: The title of the course 

Pending Approval Learner: The email addresses of the learners whose enrollment requests are 
pending approval 

Session ID: The ID of the session 
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Waiting List Learner: The email addresses of the learners on the session's wait list 

Session Closed - Roster Listing 

Course Title: The title of the course 

Instructor: The email address of the instructor assigned to the session 

Instructor First Name: The first name of the instructor 

Instructor Last Name: The last name of the instructor 

Session Administrator(s): The email addresses of the session administrators assigned to the 
session 

Session ID: The ID of the session 

Session Notes: The notes about the session 

Session Time Zone: The time zone of the target approval date. This value is set in the session's 
schedule. 

Status: The status of the session (Unconfirmed or Confirmed) 

Session Confirmed 

Approval Manager: The email address of the learner's approval manager 

Course Title: The title of the course 

Facility Name: The name of the facility 

Instructor: The email address of the instructor assigned to the session 

Instructor First Name: The first name of the instructor 

Instructor Last Name: The last name of the instructor 

Pending Session Learner: The email addresses of the learners enrolled in the session that is no 
longer unconfirmed (pending) 

Session Administrator(s): The email addresses of the session administrators assigned to the 
session 

Session Approver: The email address of the session approver assigned to the session 

Session ID: The ID of the session 

Session Notes: The notes about the session 

Session Time Zone: The time zone of the target approval date. This value is set in the session's 
schedule. 

Session Created 

Base SkillPort URL: The URL for the SkillPort login page 

Course Title: The title of the course 

Course Watch list Learners: The email addresses of the learners on the course's watch list  

Instructor: The email address of the instructor assigned to the session 

Registration URL: The URL of the parent course's summary page 

Session Administrator(s): The email addresses of the session administrators assigned to the 
session 

Session ID: The ID of the session 

Session Notes: The notes about the session 
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Session Time Zone: The time zone of the target approval date. This value is set in the session's 
schedule. 

Session Deleted 

Course ID: The ID of the course 

Course Title: The title of the course 

Instructor: The email address of the instructor assigned to the session 

Learner: The email address of the learner enrolled in the session 

Session Administrator(s): The email addresses of the session administrators assigned to the 
session 

Session ID: The ID of the session 

Session Notes: The notes about the session 

Session Time Zone: The time zone of the target approval date. This value is set in the session's 
schedule. 

Status: The status of the session (Unconfirmed or Confirmed) 

Session Enrollment Limit 

Course Title: The title of the course 

Enrollment %: The percentage of enrollment based on the session's capacity 

Instructor First Name: The first name of the instructor 

Instructor Last Name: The last name of the instructor 

Session Administrator(s): The email addresses of the session administrators assigned to the 
session 

Session ID: The ID of the session 

Session Notes: The notes about the session 

Session Time Zone: The time zone of the target approval date. This value is set in the session's 
schedule. 

Session Re-Opened for Enrollment 

Course Title: The title of the course 

Instructor First Name: The first name of the instructor 

Instructor Last Name: The last name of the instructor 

(parent) Course Admin(s): The email addresses of the course administrators assigned to the parent 
course 

Session Admin(s): The email addresses of the session administrators assigned to the session 

Session ID: The ID of the session 

Session Instructor: The instructor assigned to the session 

Session Notes: The notes about the session 

Session Status: The status of the session (Unconfirmed or Confirmed) 

Session Time Zone: The time zone of the target approval date. This value is set in the session's 
schedule. 

Session Seats Become Available - Watch List 

Course Title: The title of the course 
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Session ID: The ID of the session 

Watch List Learners: The email addresses of the learners on the course's watch list 

Session Updated 

Course Title: The title of the course 

Enrolled Learner: The email address of the learner(s) enrolled in the session 

Instructor: The email address of the instructor assigned to the session 

Session Administrator(s): The email addresses of the session administrators assigned to the 
session 

Session ID: The ID of the session 

Session Notes: The notes about the session 

Time Zone: The time zone of the target approval date. This value is set in the session's schedule. 
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Variables in Learning Program Templates 
Enrollment Approval by Manager 

LP Name: The name of the learning program  

LP Status: The user’s status in the learning program  

Notes: The comment entered by the approval manager indicating the reason for the approval or denial  

User Email ID: The email address of the learner  

Enrollment Approval Request 

Approval Manager Link: The URL to directly access the Approval Manager UI after logging in to 
SkillPort  

LP Name: The name of the learning program  

Manager: The email address of the approval manager selected by the learner when he or she 
submitted the approval request  

Notes: The note for the approval manager supplied by the learner in the enrollment request  

User First Name: The first name of the learner 

User Last Name: The last name of the learner 

User Name: The user name of the learner  

Enrollment Denial - Automated to Learner 

LP Name: The name of the learning program  

SkillPort URL: The URL to the login page for SkillPort  

User Email ID: The email address of the learner  

User Name: The user name of the learner  

Enrollment Denial - Automated to Manager 

Approval Days since request: The number of days that have elapsed since you were notified to 
approve or deny the learner’s request to enroll in the learning program  

Course Name: The name of the course  

Manager: The email address of the approval manager selected by the learner when he or she 
submitted the approval request  

username: The user name of the learner  

Enrollment Request Denied by Manager 

LP Name: The name of the learning program 

LP Status: The user’s status in the learning program 

Notes: The comment entered by the approval manager indicating the reason for the approval or denial 

User Email ID: The email address of the learner  

Learner Withdrawal 

Learning Program Name: The name of the learning program  

User Email ID: The email address of the learner  

Learning Enrollment Request Withdrawal 

Learning Program Name: The name of the learning program  
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Manager: The email address of the approval manager selected by the learner when he or she 
submitted the approval request  

User Name: The user name of the learner  

Learning Program Enrollment 

Learning Program Name: The name of the learning program  

SkillPort URL: The URL to the login page for SkillPort  

User Email ID: The email address of the learner  

Learning Program Status Change 

Learning Program Name: The name of the learning program  

Learning Program Status: The user's status in the learning program (Pending Approval or Enrolled)  

User Email ID: The email address of the learner  

Pending Approval - Learner Reminder 

Elapsed Days since Request: The number of days that have elapsed since the approval manager 
was notified to approve or deny the learner’s request to enroll in the learning program  

Learning Program Name: The name of the learning program  

Learning Program Number: The ID of the learning program  

Manager Email: The email address of the approval manager selected by the learner when he or she 
submitted the approval request  

User Email ID: The email address of the learner  

Pending Approval - Manager Reminder 

Elapsed Days since Request: The number of days that have elapsed since the approval manager 
was notified to approve or deny the learner’s request to enroll in the learning program  

Manager: The email address of the approval manager selected by the learner when he or she 
submitted the approval request 

Learning Program Name: The name of the learning program 

Learning Program Number: The ID of the learning program 

User First Name: The first name of the learner 

User Last Name: The last name of the learner  
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Variables in Learning Plan Templates 
Completion of Course 

 Admin Email ID: The email address of the administrator who assigned the asset  

Learner Personal Reminder 

Course Title: The title of the course  

Delete Course Reminder: The hyperlink learners can click if they no longer want to receive reminders 
for this course. 

Due Date: The due date for completing the learning asset  

Goal: The goal for taking the learning asset  

Summary Page URL: The URL of the learning asset's summary page 

User Email ID: The email address of the learner  

Learner's Learning Plan Assignment Updated by Administrator 

User Email ID: The email address of the learner  

Overdue Notice to Administrator 

Admin Email ID: The email address of the administrator who assigned the asset  

Overdue Notice to User 

Course Name: The name of the course  

Due Date: The due date for completing the learning asset  

Goal: The goal for taking the learning asset  

User Email ID: The email address of the learner  

Pending Due Notice 

Admin: The email address of the administrator who assigned the asset  

User Reminder for Administrator-assigned Courses 

Course Title: The title of the course  

Delete Course Reminder: The hyperlink learners can click if they no longer want to receive reminders 
for this course. 

Due Date: The due date for completing the learning asset  

Goal: The goal for taking the learning asset  

Summary Page URL: The URL of the learning asset's summary page  

User Email ID: The email address of the learner  

Waiver Approval Request by Learner 

Course ID: The ID of the course  

Course Name: The name of the course  

Manager: The email address of the approval manager selected by the learner when he or she 
submitted the approval request  

URL: The URL to directly access the Approval Manager UI after logging in to SkillPort 

User First Name: The first name of the learner  

User Last Name: The last name of the learner  

User Name: The user name of the learner  
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Waiver Request Note: A note explaining the reason for the waiver request, approval, denial, or 
revocation  

Waiver Request Approved by Manager 

Approval Manager/Admin Name: The first name and last name of the approval manager or 
administrator who approved, denied, or revoked the waiver  

Course ID: The ID of the course  

Course Name: The name of the course  

User Email ID: The email address of the learner 

Waiver Request Note: A note explaining the reason for the waiver request, approval, denial, or 
revocation 

Waiver Request Denied by Manager 

Approval Manager/Admin Name: The first name and last name of the approval manager or 
administrator who approved, denied, or revoked the waiver  

Course ID: The ID of the course  

Course Name: The name of the course  

User Email ID: The email address of the learner 

Waiver Request Note: A note explaining the reason for the waiver request, approval, denial, or 
revocation 

Waiver Revoked by Manager 

Approval Manager/Admin Name: The first name and last name of the approval manager or 
administrator who approved, denied, or revoked the waiver  

Course ID: The ID of the course  

Course Name: The name of the course  

User Email ID: The email address of the learner  

Waiver Request Note: A note explaining the reason for the waiver request, approval, denial, or 
revocation  
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Variables in User Management Templates 
Ad-hoc Email 

The Ad-hoc Email template supports the Send Email feature that is accessible by clicking Users & 
Groups | Send Email on the navigation bar. There are no variables available in the template. Instead, 
administrators specify the recipients directly using the Send Email page. 

The "system" Ad-hoc Email template contains no text in the subject or body. However, if desired, you 
can prepopulate the Send Email page with some default text in either field. To do so, create a copy of 
this template, customize the copy, and assign it to the Ad-hoc Email event. 

 

Approval Manager Deletion 

First Name: The first name of the learner  

Last Name: The last name of the learner  

User Email ID: The email address of the learner  

Approval Manager Updated 

Approval Manager First Name: The first name of the learner's approval manager  

Approval Manager Last Name: The last name of the learner's approval manager  

Approval Manager User Name: The user name of the learner's approval manager  

User Email ID: The email address of the learner  

User First Name: The first name of the learner  

User Last Name: The last name of the learner  

User Name: The user name of the learner  

New User Notification 

Approval Manager First Name: The first name of the learner's approval manager  

Approval Manager Last Name: The last name of the learner's approval manager  

Approval Manager User Name: The user name of the learner's approval manager  

First Name: The first name of the learner  

Last Name: The last name of the learner  

Password: The learner's password  

SkillPort URL: The URL to the login page for SkillPort  

User Email ID: The email address of the learner 

Username: The user name of the learner  

Self-registration Approved by Administrator 

Password: The learner's password  

SkillPort URL: The URL to the login page for SkillPort  

User Email ID: The email address of the learner  

User First Name: The first name of the learner  

User Last Name: The last name of the learner  

User Name: The user name of the learner  

Self-registration Confirmation 
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Approval Manager First Name: The first name of the learner's approval manager 

Approval Manager Last Name: The last name of the learner's approval manager 

Approval Manager User Name: The user name of the learner's approval manager 

First Name: The first name of the learner 

Last Name: The last name of the learner  

Password: The learner's password 

SkillPort URL: The URL to the login page for SkillPort 

User Email ID: The email address of the learner  

Self-registration Denied by Administrator 

User Email ID: The email address of the learner  
 

Notification Settings 

Use Notification settings to specify the From and Reply to email addresses in the email templates that 
support the notification management system. Note that you cannot change these addresses on a per-
template basis. 

To configure notification settings 

1. Click Configuration > Notification Settings on the navigation bar. 

2. Enter values for the following settings: 

 Default 'From' email address for notifications: (Required) The email address to use in 

the From field of all email templates, except those for Instructor Led Training (ILT). 

 Default 'Reply-to' email address for notifications: The email address to use in the 

Reply To field of all email templates. 

 Default 'From' email address for ILT notifications: The email address to use in the 

From field of all ILT email templates. 

Note: You can specify any email address, even if the associated individual does not have an 

existing Skillport user account. 

3. Click Save. 

 
 

Learning Plan Settings 

Learning Plan settings allow you to enable or disable certain Learning Plan features in Skillport. 

To configure Learning Plan Settings 

1. Click Configuration > Learning Plan Settings on the navigation bar. 

2. Configure the settings as needed: 

Setting Description 

Allow Learning Plan Allows learners and administrators to set up reminders regarding Learning Plan 
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Reminders 

Allow Learning Plan 
Overdue Notices 

assignments. 

Select yes to show the following reminder-related settings in the Learning Plan 
dialog boxes in both the Learner UI and the Administrator UI: 

 

Alternatively, to hide these settings, select no. 

Note: This setting controls only the display of the settings. In order for the 
related reminder emails to be sent, you must also activate the corresponding 
Learning Plan emails in the Notification Management UI. 

Allow Learning Plan 
Due Dates 

Select one of the following: 

 required: Learning assets added to the Learning Plan must have an 

associated due date. 

 no: Learning assets added to the Learning Plan do not have 

associated due dates. 

 optional: Learning assets added to the Learning Plan can have 

associated due dates, but they are not required. 

Default Learning Plan 
View 

Select one of the following: 

 Default to Basic: When learners first open their Learning Plan, all sets 

within the Learning Plan are collapsed.  

 Default to Expanded: When learners first open their Learning Plan, all 

sets within the Learning Plan are expanded to show all assets.  

1. Click Save. 
 

Search 

You can control the way search results display in the following types of searches: 

 Searches performed by learners in Skillport Learner 

 Catalog searches performed by administrators in Skillport Administrator 

To configure Search settings 

1. Click Configuration > Search on the top navigation bar. 
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2. Configure the setting as needed: 

 Search Categories – Order of Appearance: The order that categories are returned 

within search results. To change the order, select a category, and then use the Up and 

Down arrows to change its location. 

3. Click Submit. 
 

Self-Registration 

You can configure self-registration to allow learners to create their own Skillport accounts. When you 
enable this functionality, the self-registration page is available to learners. 

To configure self-registration 

1. Click Configuration > Self-Registration on the navigation bar. 

2. In Enable Self-Registration, click Yes.  

3. If you enable self-registration, you must also enable one of the following options: 

 Use external security for Self-Registration: Specifies whether external measures are 

used to limit access to the self-registration form. As an example, you might specify that 

the site be limited to a list of allowed IP addresses. This setting is read-only unless you 

are a super administrator. Note that, if you set this to Yes, the User Management - New 

User Notification event is not triggered when a user self-registers; therefore, the user does 

not receive a notification email. 

 Comma separated list of allowed email suffixes: Specifies a comma-separated list of 

allowed email suffixes. Only a user with an email address that contains a listed suffix is 

allowed to self-register without approval. If no list is specified, any user is allowed to self-

register, but either approval is required or external security measures must be used. 

Example: company1.com,company2.com 

Allowed characters (maximum 1,500): abcdefghijklmnopqrstuvwxyz0123456789 - _ . * ^ + 
= @ ' 

Be aware that email suffixes are case-sensitive; for example, MyName@Skillsoft.com is 
considered a different email address than myname@skillsoft.com. Also be aware that this 
setting takes precedence over the Require admin approval for Self-Registration 
setting. That is, if you specify a list of allowed email suffixes, but you also set Require 
admin approval for Self-Registration to Yes, a user who registers with an email address 
containing an allowed suffix is automatically approved and can log in to Skillport without 
administrator approval. 

 Require admin approval for Self-Registration: If you select Yes, users are allowed to 

self-register, but they are unable to log in until an administrator approves their registration, 

activating their accounts. If you select No, administrator approval is not required. A self-

registered user's account is automatically activated, and he is notified via email. 

Be aware that this setting is ignored if you have specified a list of allowed email suffixes 
for Comma separated list of allowed email suffixes, and a user registers using an 
email address containing an allowed suffix. That is, the user is automatically approved 
and can log in to Skillport without administrator approval. 

4. Configure the remainder of the settings: 



Skillport 8 Administrator Guide ©2015 Skillsoft  481 
 

Configuration   
 
 

 Select Email Notification Template: (Read-only) Identifies the template that is assigned 

to the User Management - New User Notification event on the Notification Management 

page. To change the template, you must assign a different one to the event. The default 

site language of your Skillport site determines which language-specific template is 

displayed in this setting and is used to send emails. 

 Send username in Self-Registration email: Specifies whether to include the learner's 

user name in a self-registration email that is sent to the user. 

If you select Yes, the system programmatically includes the user name in all User 
Management - New User Notification email templates (see View Existing Templates on 
page 449). If you select No, the system programmatically removes the user name from all 
User Management - New User Notification email templates. As a result, you do not need 
to manually insert or remove a Username field from these templates. 

If you select No, ensure that you have not inadvertently manually included a Username 
field in any self-registration-related email templates. Since the user name should not be 
included or shown, this results in the following in the actual email: 

Username: $user.username 

 Comma separated list of Admin e-mail addresses: Specifies a comma-separated list of 

email addresses for administrators with the Administrator role or higher (managers cannot 

approve pending registrations). If Require admin approval for Self-Registration is set to 

Yes, nightly notifications of registrations that are pending approval are emailed to these 

email addresses. The notification email contains a link to the Sign In page, which then 

redirects the administrator to the Pending Registrations page after sign in. 

Allowed characters (maximum 1,500): abcdefghijklmnopqrstuvwxyz0123456789 - _ . * ^ + 
= @ ' 

 Select Email Pending Approval Template: (Read-only) Indicates the template that is 

assigned to the User Management - Self-registration Confirmation event on the 

Notification Management page. To change the template, you must assign a different one 

to the event. The default site language of your Skillport site determines which language-

specific template is displayed in this setting and is used to send emails. 

 Allow user defined password: Specifies whether users can create their own passwords 

when they self-register. 

If you select No, when an administrator approves the user's registration (thereby 
activating the account), the user's password is set to a random value. In addition, the 
system programmatically includes the random password in all User Management - New 
User Notification email templates (see View Existing Templates on page 449). As a 
result, you do not need to manually include a Password field in these templates. 

If you select No, do not manually include a Password field in any User Management - 
Self-registration Confirmation email templates. This is because the user does not receive 
a random password until after an administrator approves his registration. If one of these 
templates does include a Password field, this results in the following in the actual email: 

Password: pending 

If you select Yes, the system programmatically removes the password from all User 
Management - New User Notification email templates. This is done because user-defined 
passwords are saved in encrypted form in the database. As such, they cannot be 
retrieved and displayed in an email. For this same reason, if you select Yes, do not 
manually include a Password field in any self-registration email templates. 

5. Click Submit. 
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User Profile Fields 

User profile fields are used to collect and store information about users. You can also include specific 
user profile fields in report filters to run reports on certain user demographics.  

There are two types of user profile fields: 

 Standard: Fields that are provided by Skillport. You cannot modify standard field definitions. 

For more information about these fields, refer to User CSV Template. 

 

 Custom: Fields that you can create to gather additional user information that is not captured 

in the standard fields. You can create a maximum of 30 custom fields per site. If applicable for 

your site, you can also create localized prompts and localized select lists for the custom fields. 

For more information, refer to Create a Custom Field. 
 

Edit a Standard User Profile Field 

You can edit the access to standard user profile fields. 

To edit a standard user profile field 

1. Click Configuration > User Profile on the navigation bar. 

The Manage User Profile Fields page displays. 

2. In the Standard Fields section, select the field you want to edit. 

3. Click Edit. 

The Edit Standard Field dialog box displays the information for the selected field. 

 

4. In the Access From section, select one of the following options for each Skillport page listed: 

 User Profile: 

 Hidden: The selected user profile field does not display on the My Profile page.  

 View Only: The selected user profile field displays as view-only on the My Profile page. 

 View and Edit: The learner can view and edit the selected user profile field on the My 

Profile page. 

 Required: The learner must enter a value for the selected user profile field on the My 

Profile page. 

 Self Registration: 

 Hidden: The selected user profile field does not display on the Self Registration page.  
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 View Only: The selected user profile field displays as view-only on the Self Registration 

page. 

 View and Edit: The learner can view and edit the selected user profile field on the Self 

Registration page. 

 Required: The learner must enter a value for the selected user profile field on the Self 

Registration page. 

 User Manager:  

 Hidden: The selected user profile field does not display on the User Management page.  

 View Only: The selected user profile field displays as view-only on the User Management 

page. 

 View and Edit: The administrator can view and edit the selected user profile field on the 

User Management page. 

 Required: The administrator must enter a value for the selected user profile field on the 

User Management page. 

 Batch Add/Update Users:  

 Hidden: The selected user profile field does not display in the Batch Add/Update CSV file. 

 View and Edit: The administrator can view and edit the selected user profile field in the 

Batch Add/Update CSV file. 

 Required: The administrator must enter a value for the selected user profile field in the 

Batch Add/Update CSV file. 

 Reports Filter Options: 

 Hidden: The selected user profile field does not display in the reports filter. 

 View Only: The selected user profile field displays as view-only in the reports filter. 

 Change Password (Only available in the Email Address user profile field): 

 Hidden: The Email Address user profile field is hidden from learner access. 

 View Only: The Email Address user profile field displays as view-only and cannot be 

edited by the learner. 

 View and Edit: The learner can view and edit the Email Address user profile field in 

Skillport. 

1. Click Save.  
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Create a Custom User Profile Field 

You can create custom user profile fields to collect additional information about users. You can create 
a maximum of 30 custom fields for each Skillport site. 

When you create a new custom field, the user CSV template is automatically updated to include the 
field. 

To create a custom user profile field 

1. Click Configuration > User Profile on the navigation bar. 

The Manage User Profile Fields page displays. 

2. In the Custom Fields section, click New Field. 

The New Custom Field dialog box displays. 

  

3. (Required) In ID, enter a unique identifier for the custom field. You can enter a maximum of 
256 single-byte characters. Valid characters are a-z, A-Z, 0-9, and ‘_’ (underscore). This ID is 
included in the user CSV template and is also displayed in the learner UI if no label is 
specified for the field. 

Note: The prefix _sys is reserved for standard fields and cannot be used for custom fields. 

4. (Optional) Enter the Label to display in the UI for the custom field.  

Ensure that you enter a meaningful label since it is displayed in several places in Skillport, 
including the Self-Registration page, the Manage User Profile Fields page, the New User and 
Edit User dialog boxes in User Management, and in reports. 

Note: If localization is available for your site, see Specify localized labels. 

5. To allow the field to be configured for display in the user interface, select Enabled. By default, 
this option is selected. 

6. In Type, select the data type for the field. Valid options are Text, Integer, Date, Boolean, 
Select List, and Localized Select List. 
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7. If you selected the Type as Select List or Localized Select List, specify the following 
options, if desired: 

 Select Validate to have the pre-defined data in the user CSV template validated during a 

batch add/update. 

 Select Multiselect to allow selecting multiple list items at once. 

8. If you selected the Type as Select List or Localized Select List, specify the values to include 
in the list: 

Note: If localization is available on your site, see Specify localized list values. 

a. Click Edit Select List Values. 

b. In the Values dialog box, click Add. 

c. In the Add Value dialog box, enter the desired list value. 

d. To add another list value, click OK and Add Another, then enter the desired value. 

e. Click OK, then click OK again. 

9. In Access From, click the desired option for displaying the field in Skillport. See Configure 
User Profile Settings for more information. 

10. To save the custom field and keep the dialog box open to create another field, click Save & 
Add Another. Otherwise, click Save.  

 

Edit a Custom Field 

You can edit an existing custom user profile field to modify its properties. 

To edit a custom user profile field 

1. Click Configuration > User Profile on the navigation bar. 

The Manage User Profile Fields page displays. 

2. In the Custom Fields section, select the custom field you want to edit. 

3. Click Edit. 
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The Edit Custom Field dialog box displays the information for the selected custom field. 

 

4. Edit the information as desired.  

For details about each field, see Create a Custom Field. 

5. In the Access From section, select one of the following options for each Skillport page listed: 

 Hidden: Field does not display. 

 View Only: Field displays but cannot be edited. 

 View and Edit: Field displays and can be edited. 

 Required: Field displays and requires a value. 

6. Click Save.  
 

Specify Localized Values for Custom User Profile Fields 

If your site is configured to support it, you can specify localized labels for custom user profile fields. 

In addition, if your site supports localized labels, you can also specify localized values for drop-down 
lists. 

To specify localized labels 

1. Click Configuration | User Profile on the navigation bar. 
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2. Find the field for which you want to enter localized labels. 

 

3. Click the corresponding Edit link in the Label column. 

4. Enter the values as shown below. 

 

5. Click OK. 

To specify localized values for drop-down lists 

1. Click Configuration | User Profile on the navigation bar. 
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2. Find the drop-down list for which you want to enter localized values. 

 

3. Click the corresponding Edit link in the "Text for option field" column. 

4. Enter the values as shown below. As discussed in User Profile (on page 491), you must 
separate each value with a # character, and you can enter a maximum of 3,500 characters 
including the # symbols. 

 

5. Click OK. 
 

Delete a Custom User Profile Field 

You can delete an existing custom user profile field only if no users have a value specified for that 
field. 

To delete a custom user profile field 

1. Click Configuration > User Profile on the navigation bar. 

The Manage User Profile Fields page displays. 

2. In the Custom Fields section, select the field you want to delete. 

3. Click Delete. 
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4. In the Confirm dialog box, click Yes. 
 

Change the Display Order 

You can change the order in which the custom user profile fields display in the Skillport user interface. 

To change the display order 

1. Click Configuration > User Profile on the navigation bar. 

The Manage User Profile Fields page displays. 

2. In the Custom Fields section, click Change Display Order.  

3. Select the desired custom field. 

4. To move the field up one position in the list, click Up. Repeat as necessary until the field is in 
the desired position. 

5. To move the field down one position in the list, click Down. Repeat as necessary until the field 
is in the desired position. 

6. Click Save. 
 

Batch Add/Update Custom User Profile Fields 

You can use a batch process to add, delete, or edit multiple custom user profile fields at the same 
time. This is typically done to save time instead of having to add or update custom fields one at a time 
in the user interface. 

To batch add/update custom user profile fields 

1. Click Configuration > User Profile on the navigation bar. 

The Manage User Profile Fields page displays. 

2. In the Custom Fields section, click Batch Add/Update Fields. 

The Batch Add/Update Custom User Profile Fields page displays. 

 

3. Click Download Field Definition Report. 

4. In the Download Field Definition Report dialog box, select which custom user profile fields to 
include in the downloaded file. Valid options are All Fields or All Enabled Fields. 

5. Click OK.  
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6. Open the downloaded file, modify it as desired, and then save the file.  

7. On the Batch Add/Update Custom User Profile Fields page, click Browse to navigate to the 
modified .csv file. 

8. Click Upload.   

9. Click Back to User Profile Management. Any updates made to the .csv file are reflected in 
the Custom Fields section. 

 

Configure User Profile Settings 

You can edit settings for both standard and custom user profile fields to specify how the fields display 
in Skillport. 

 User Profile: Specify the fields available to users when editing the My Profile page. 

 Self Registration: Specify the fields available on the Self-Registration form. 

 User Manager: Specify the fields available when adding new users. 

 Batch Add/Update Users: Specify the fields to include when performing a batch 

add/update. 

 Reports Filter Options: Specify the fields available as a filter for reports that include user 

profile data. 

Note: It is best to enable only Custom Profile Fields for Report Filter Options if the field will 
contain a limited number of unique values.  The User Profile Report Filter was designed to 
let you easily filter data such as Region, Job Code, Country or Business Unit.  The filter 
presents a drop-down list of the first 200 alphabetically-sorted values that exist in the 
data.   If the Custom Field has more than 200 values, you should Save the report and filter 
it in Excel.  Be sure to include the Custom Field in Display Options. 
 
Please carefully consider which user profile fields you enable for reporting purposes. If a 
user profile field is included in a saved Personal Report template, and you subsequently 
disable the field or clear Report Filter Options, the report templates that use this filter will 

no longer filter correctly for that field.  

To edit user profile field display settings 

1. Click Configuration > User Profile on the navigation bar. 



492 ©2015 Skillsoft Skillport 8 Administrator Guide 

 

 Configuration 
 
 

The Manage User Profile Fields page displays. 

 

2. In either the Custom Fields section or the Standard Fields section, select the desired user 
profile field.  

3. Click Edit. 

Either the Edit Custom Field dialog box or the Edit Standard Field dialog box displays, 
depending on which field type you selected. 

4. In the Access From section, select one of the following options for the corresponding 
location. 

 Hidden: Field is not displayed. 

 View Only: Field is displayed, but cannot be edited. 

 View and Edit: Field is displayed and can be edited. 

 Required: Field is displayed and a value is required. 

5. Click Save. 
 

Language 

The Configure Language Settings page allows you to set the default language for Skillport Learner 
and for Search. These settings apply to all users accessing your company's Skillport site for the first 
time. However, depending on the configuration of your site, users may be able to change their 
language settings from within the Skillport end user interface. 

Note: User-defined language settings override company-wide settings. 
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To configure language settings 

1. Click Configuration > Language on the navigation bar. 

2. Select the language in which you want Skillport Learner to display: 

a. In the UI Language Setting section, select the language in which the interface text, help 
system, and system messages display to learners. 

b. Click Change Language. 

Note: By default, the interface language is set to English.  

3. Select the default Search language in which you want your learners' search results to display: 

a. In Search Language Setting, select the default language used by Search. (During a 
search, users can change the language by selecting a new one from the Language drop-
down list.) 

b. Click Change Language. 

Note: By default, Search is set to English (United States).  

Note: The browser language setting affects the appearance of some screens and links. The text 
displayed may be different in some screens. For example, the Forgot your user ID? link on the Sign 

In page may be displayed as "forgotyouruserid" for a different language setting. 

 

Report Configuration 

If you are using the Reporting feature, you can use the Configure Report Parameters page to modify 
the Certificate of Completion settings. 

To access this page, click Configuration > Report Configuration on the top navigation bar. 

Click Certificate of Completion to open the Certificate of Completion - Attribute Modifications form. 
Use this form to change the appearance and content of completion certificates. 

Field Description  

Allow users to generate 
certificates 

Enable or disable the ability of users to generate completion 
certificates. If enabled, completion certificate links display in any 
reports that track completable assets. 

Header Image URL Specify an alternative graphic that is used as the top background 
graphic for the completion certificate. 

Footer Image URL Specify an alternative graphic that is used as the bottom background 
graphic for the completion certificate. 

CSS (Cascading Style Sheet) 
URL 

Customize the text font size and color of the certificate by modifying the 
style sheet. 

To preview changes to your certificate's style and graphic, click Test Modifications. 
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Web Site Switches 

Web site switches are settings to enable or disable certain features of Skillport. 

Note: If you need to change these settings after the release of the site, please consult your Skillsoft 
representative. 

To configure web site switches 

1. Click Configuration > Web Site Switches on the navigation bar. 

2. Configure the settings. 

 Enable LP Enrollment/Withdrawal Emails: Allows administrators the ability to control the 

learning program enrollment/withdrawal emails to users. 

Note: This setting is only applicable if you've activated the learning program emails on the 

Manage Notifications page in Skillport. 

 Select Yes to show the email-related prompts when enrolling and withdrawing users: 

 

 Select No to hide these prompts; emails are sent automatically. 

 Enable Credentials: Enables Credentials for the site. 

 Enable Forced Restart: Affects all instances of the following 2 types of assets: 

 Any course with the Allow Multiple Completions setting enabled.  

 Any asset that's been assigned to a learning plan as a Recurring by completion date or 

Recurring by due date. 

If your site supports either or both of these types of assets, you can set this switch as follows: 

 Select No to present the learner with a prompt to either restart the asset (launches the 

asset from the beginning, and the progress is recorded) or continue the asset (launches 

the asset from the last-accessed location, and progress continues to record). 

 Select Yes to allow the learner to launch a completed asset, and automatically create a 

new record in the learner transcript to count as the next completion. The learner is not 

given the option to continue (re-enter) the last completion. 

Note: For more information on restarting assets, see Recurring Assets (Compliance). 

 Enable Recommended for You Carousel: Allows administrators to control the display of the 

Recommended for You carousel, which shows recommendations for popular and related 

assets to the learner, on the What's New page.  

 Select Yes to enable the Recommended for You carousel for the site. This is the default 

setting. 



Skillport 8 Administrator Guide ©2015 Skillsoft  495 
 

Configuration   
 
 

 Select No to disable the Recommended for You carousel for the site. 

3. Click Submit Form. 
 

Additional Deployment Options 

The following additional options are also available. To enable these options, consult your Skillsoft 
representative. 

Dialogue Live Virtual Classroom 

This option adds the capability of Dialogue Live Virtual Classroom providing the ability to run blended 
learning training events for 25 students integrated with the Learning Management System (LMS) 
capability that the Skillport platform already offers.  

Password 

You can allow the learner to change his password by enabling this option. 

Password Security Settings 

You can enhance password security settings as follows: 

 Enforce strong passwords (for example, minimum length and valid characters) 

 Specify the length of time before a password expires 

 Specify whether a failed login attempt leads to an account lockout 

 Specify how users can retrieve forgotten user IDs or passwords 

Customer Support Message 

The Customer Support Message displays customer-specific support information and is used within 
error and/or warning messages. The Skillsoft Customer Support information is displayed by default. 

The Customer Support Message is displayed in the following areas: 

 Deactivated Users page 

 Locked User page 

 Reset Password page 

 Send User ID 

Note: The setting is site-wide; it cannot be customized differently for advanced groups. 
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R e p o r t s  
Use the Reporting features to gather data on all aspects of your Skillport learning management 
system. To access Reports, click Reports in the navigation bar.  

In This Chapter 

Getting Started with Reporting ........................................... 498 

Managing Reports .............................................................. 503 

Managing Schedules .......................................................... 510 

Managing Templates .......................................................... 517 

Managing Charts ................................................................ 553 
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Getting Started with Reporting 

Reporting Overview 

The following is a high-level overview of the reporting process.  

1. Identify your reporting requirements. 

2. Run several reports by previewing the default templates to determine if they meet your needs. 
The default templates are designed to quickly show the last month of activity and display the 
most commonly used data fields.  

Note: For a detailed explanation of all fields, filters, and display options included in each 
template, see Report Definitions. 

3. For those default templates that meet your reporting needs you can save the results and you 
can create schedules to automatically run the report in the future. 

4. If you need to further define the results you can create personal templates by modifying the 
default templates, and then, if desired, create schedules for those templates. 

Reporting Overview Diagram 
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Reporting Interface 

The Reports menu includes a link for each section of the reporting feature. 

 

The following windows display for each menu option pictured above. 

My Dashboard 

The My Dashboard tab contains two predefined reports displayed in chart form.  

The Total Completions chart displays the number of course and Learning Program completions that 
have occurred during the specified time frame. 

The Total Logins chart displays the number of users that have logged in to the system during the 
specified time frame.  
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Templates 

The Templates tab contains a list of all report templates available in the Reporting feature.  Templates 
are forms used to determine what dates, filter options, and display options should be included in report 
results. 

Default templates are pre-defined templates that are standard with all SkillPort implementations.  

Personal templates are customized templates you create by modifying default templates.  

 

Schedules 

The Schedules tab contains a list of all schedules associated with report templates. Schedules are 
used to automatically run reports in the future. 

There are no default schedules included with Reporting.  All schedules are created by the user. 
Schedules can be created for both Default and Personal Templates. 

 



Skillport 8 Administrator Guide ©2015 Skillsoft  501 
 

Reports   
 
 

Results 

The Results tab displays a list of all saved reports.   

Reports are manually saved when you click the Save Results button, and automatically saved when a 
scheduled report is run. 

 

 

 

 

 

 

 
 

User and Admin Privileges 

User and Administrator privileges impact Reporting in two ways: 

 by controlling which groups and users are visible in the Group/ User filter 

 by controlling the report results returned in terms of student activity 

Groups Visibility 

The display of groups within the Group/Users filter is controlled by the User/Group Filter Scoping 
option in the Skillport Administrator UI.  
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When this option is enabled (checked), the standard Skillport user privileges apply. Visibility of groups 
and users is controlled by the user's role. For more information see User Privileges by Role on page 
22.   

When this option is disabled (unchecked), users have greater visibility of the company’s group 
(organizational) structure within the Group/Users filter. The following rules apply: 

 Company Administrator - Can see all Groups (including Assignment and Advanced Groups), 

and All users 

 Administrator – Can see all Groups (including Assignment Groups) and users within their 

organizational scope. 

 Manager – Can see all Groups (including Assignment Groups) and users within their 

organizational scope. 

Report Results 

The User/Group Filter Scoping option has no affect on the results returned for student activity. 
Results are always controlled by the standard Skillport reporting privileges.  Report results will include 
only data for those students a user has permission to view. 

In other words, it is possible to see particular users in the Group/Users filter, but still not be able to see 
data for those users. Running a report with only these users selected can cause an empty result set.  

Note: Only Super Administrators can change the scoping rules. As with all User / Group modifications, 

changes made to this setting will not take effect until after the next database refresh. 

About inGenius Reports 

When running an inGenius report, Community Administrators can only see results for their 
communities.  Company Administrators can see results for all inGenius communities. 
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Managing Reports 

Understanding Reports 

In the Reporting documentation, 'report' refers to the formatted and organized presentation of the data, 
or results, returned when a query is sent to the database. You can: 

 Run a report.  When you run a report, the results display in a preview screen. This view is 

temporary and you must save the results in order to maintain the data. 

 Save the report results.  Saving results stores them on the Results window as shown below. 

 Schedule a report to automatically run in the future. When a report is generated from a 

schedule, the results are automatically saved to the Results window. 

 Create a Personal template to customize the report results. 

The Results Window 
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Results are listed in the order the report was run with the most recent at the top.  The Results window 
includes the following columns: 

 Name - If generated from a scheduled report, this field displays the name of the report that 

generated the result.  If a user runs a report and saves the result, this field displays the name 

entered by the user in the Save Result dialog.  If a report has a recurring schedule associated 

with it, there may be more than one report result with the same name.  

 Description - Can be modified by the user when the result is saved, or when the schedule for 

the report is created.  

 Format - HTML, CSV, Excel, or PDF.  Determined by the user when the result is saved, or 

when the schedule for the report is created. 

 Created By - The name of the user that ran the report, or created the schedule. 

 Last Activity - The date and time the report was run, reported in GMT. 

 Run time - The length of time in hh:mm:ss it took for the report to run.  

 Delete On - The date the results will automatically be deleted from the Results window. 

 Status - The status of the result. ie: In Progress, Completed, etc. This field also displays 

warning messages. For example, if an email notification fails, a message will indicate which 

user(s) did not receive the notification.  

From the Results window you can: 

 Refresh the screen to update the list of saved results. 

 Download the report results.  Downloading results saves them to your hard drive or external 

storage device. 

 Delete a saved report result. 

 Delete All report results. 

Note: The results of each report reflect the current data held in Skillport as of the last successful 
database refresh which occurs automatically.  It is Skillsoft’s commitment to ensure that customer 
reporting data is updated within 24 hours. In general, database refreshes (ETL’s) run several times a 
day. This includes group structure, user status, asset status, assignments, enrollments, approvals, and 
data from other platforms.   

 

Run a Report 

When you manually run a report you are actually previewing the results. This allows you to determine 
whether or not the report meets your needs before you save the results, or create a schedule to run 
the report in the future.  The preview is temporary and you must save the results in order to maintain 
the data.  You can also manually run a report from a schedule in the Schedules tab. 

To run a report 

1. From the Reports menu, click Templates. 

2. In the Templates window select either the Default or Personal tab. 

3. Select the desired template. 
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4. Click Preview.  The results displays in the Preview window. 

 

5.  In the Preview window you can: 

 Sort the data by clicking the column headers. 

Note: Changes to the sort order are not maintained when saving results. 

 Edit the template to modify the dates, filters and display options in order to create a 

personal template. 

 Save Template if this template has been modified. 

 Save Result of the report to the Results tab. 

To manually run a scheduled report 

1. From the Reports menu, click Schedules. 

2. Select the desired schedule. 

3. Click Run Now. The report will be saved to the Results window at the top of the list. 

Notes:  

 Reports with a large amount of data may take several minutes to generate a preview.  

 In some instances, if the report contains no data the column headers will still display, but with 

empty rows. 

 Reports can also be previewed from a Template window. 

 Reports run from schedules do not display in the Preview window.  

 Some Content Activity and Learning Activity reports contain a 'Completion Status' column. If 

the Completion Certificate option is enabled in Skillport, a Completed value in this column will 

be a hyperlink that allows you to view the certificate in a separate window. You can print the 

certificate from the File menu of the new window. 
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Save a Report 

Saving a report allows you to view the results at a later date without the need to re-run the report.  

To save a report 

1. Click Templates and select either the Default or Personal tab. 

2. Select the desired template. 

3. Click Preview. The Preview window displays the results. 

4. Click Save Result.  

You can also save the result from the Edit Template window. 

The Save Result dialog displays with a Properties tab and an Email tab. 

 

5. In the Properties tab, complete all fields as described below.  

 Name - (Required) Modifiable field pre-populated with the name of the saved template. 

Max character limit is 120. Cannot contain the following characters: \ / : * ? " < > |; {} 

 Description - Modifiable field pre-populated with the description from the saved template. 

Field can be blank. Max character limit is 512. 

 Format - Available options: HTML, CSV (default), PDF, Excel. Chart templates can only 

be saved in the PDF format. 

 Delete In - Determines when the report will be automatically deleted from the Reporting 

interface. Choices include: 7 Days (default), or 30 Days. To store a report for longer than 

30 days, use the Download option. 

 Include Report Parameters - When checked, parameters such as template name, 

description, date generated, input options, and last successful database refresh will 

display in the results. Default is unchecked. You cannot include parameters in reports 

saved as a CSV file.  

Note: Saving a report in the Excel format with Include report parameters checked 

causes columns to merge and the output is difficult to read.  

 If desired, click the Email tab to configure the Email Notifications feature. 

6. Click OK. The Results window opens with the saved report displayed at the top of the list. If 
you are saving the result of a chart template accessed from the dashboard, the Results 
window will not open.  
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Note:  If you are saving the results from the Edit Template window, the template changes will not be 
saved. You must save the template first in order to maintain the changes.  

 
 

Email Notifications 

When saving report results or creating or editing a schedule, you can configure the Email Notification 
feature to automatically send an email to the Skillport users of your choice, each time the report runs.  

About the Recipients 

 Any users with an active Skillport email address can be selected to receive a notification 

email, regardless of user privileges.  

 Users without a Skillport email address display in red and cannot be selected. 

 If a recipient's email address is subsequently removed from an account, the next time the 

report runs a warning will display in the Status column of the Results page.  

 The Email Notification feature stores the User ID of selected recipients. Therefore, if a user’s 

email address changes, the user will receive the email notification at the new address. 

 If the Administrator account you are using to create the report has an email address, your own 

account is automatically added to the distribution list, but can be removed. 

About the Email 

 The email will include a link to the report results. 

 Access to the report is controlled by Skillport user id. 

 If the recipient is already logged into Skillport, the user will have immediate access to the 

report results.  

 If the recipient is not logged in, the Skillport login interface will display. After login, the user will 

have access to the results.  

 Only the users selected to receive the link will be able to use it to access the report.   

 If an unauthorized user attempts to use the link: 

 If the user is already logged in to Skillport, the message, "User is not authorized to 

download this report" displays. 

 If the user is not logged in to Skillport, the login page will display. After login, the Home 

page will remain open and the user will not have access to the results. 

The Email Notification feature is unchecked by default. 
 

Configure Email Notifications 

To configure Email Notifications for Reports 

1. In the Skillport Admin menu, click Reports > Templates. 

2. Select a template from the list. 

3. Click Schedule. 
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4. In the Save Schedule dialog, click the Email tab.  

5. Click Deliver report results to selected users to display the Users and Groups selector. 

Note: This check box is unchecked by default. 

 

If desired, use Search to display specific users in the Users and Groups pane. 

6. In the Users and Groups pane, select the desired user(s). The Add arrow enables. 

Note: You can select multiple users to add to the list, but you cannot select Groups of users. 

Users listed in red do not have an email address and therefore cannot be added to the list.  

7. Click Add. The selected users are added to the list. 

8. Click OK. 

To remove users from the list 

1. In the Send Email to... pane, click the users' name. 

2. Click Remove. 

Note: The Email Notification feature is also available in the Save Results dialog.  

 

 

 
 



Skillport 8 Administrator Guide ©2015 Skillsoft  509 
 

Reports   
 
 

Download a Saved Report 

Reports saved on the Results tab can be saved for a maximum of 30 days. To save the report past the 
delete date you can download it to your hard drive or external storage device.  

To download a report 

1. From the Reports menu, click Results. 

2. Select the desired report result. 

3. Click Download. 

4. Use your browser's save options to save the results to your local storage device. 

Note: When downloading a CSV report, the file name (including the file path) should be a maximum of 

218 characters. CSV file names with more than 218 characters may not open in some browsers. 

 

Delete a Saved Report 

Saved reports will automatically delete according to the Delete On date that was created when the 
report was saved. However, you can manually delete a report from the Results tab as needed. The 
corresponding template and schedule (if one exists) are not deleted. 

Note: The maximum amount of time a report can be stored in the Results tab is 30 days.  If you need 
to access a report past the Delete On date, use the Download option to save the report to your hard 

drive or external storage device. 

To delete a report  

1. From the menu click Results. 

2. Select the desired report result.  

3. Click Delete.  

4. Click Yes in the confirmation message. The report is removed from the list.  

Optionally, you can delete all the results simultaneously by clicking the Delete All button. 
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Managing Schedules 

Understanding Schedules 

Schedules are used to automatically run a report in the future.  Schedules can be created for both 
Default and Personal templates. Each schedule can have only one template associated with it at a 
time. You can create a schedule to run once, or on a daily, weekly, or monthly basis.  

Saved schedules display in the Schedules window. 
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Schedules are listed in order by Next Occurrence date, with the schedule set to run next at the top of 
the list. The Schedules window includes the following columns: 

 Name - The name of the schedule also determines the name of results created by the 

schedule. 

 Description - User defined. 

 Template - The default or personal template associated with the schedule. 

 Created By - The name of the user who created the schedule. 

 Active - Whether or not the schedule is currently active. You can check or uncheck to modify 

the setting. 

 Recurrence - Reflects if the report is scheduled to run once, daily, weekly, or monthly. 

 Last Occurrence - The last date the report was run from this schedule. If the results have not 

been deleted, this value will be a hyperlink to the report on the Results tab. 

 Next Occurrence - The next date the report is scheduled to run. 

From the Schedules tab you can:  

 Sort the list by clicking the Schedule Name, Schedule Description, or Template Name column 

headers. 

 Click Run Now to run the report immediately and save the results to the Result window.  

 Edit the schedule. 

 Activate, or deactivate a schedule by checking or unchecking the associated check box. 

Active schedules will run reports at the scheduled time.  Inactive schedules will not run 

reports. 

 Delete a schedule. Expired schedules must be deleted manually. A schedule is considered 

expired if the End by date has passed. 

 Delete All schedules simultaneously. 
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Understanding Date Settings 

Before creating a schedule there are several important factors to consider when selecting the 
schedule start and end dates.  

 The start date determines when the schedule becomes active.  The start date combined with 

the frequency of the schedule may cause an unexpected result. For instance, if you create a 

weekly schedule to run a report every Monday, but the start date is a Wednesday, then no 

report will be created in that first week. 

 Activity Date filters will also affect the results of a scheduled report. For instance, if the 

schedule determines the report should run monthly, but the Activity filters are set to the 

"Previous 2 Weeks", then the report will not include data for the two missing weeks.  

 In order to generate current data each time the report is generated, make sure the Activity 

Date filters are set to one of the "Previous" options. If you select the From/To options and 

include both a start and end date, each time the report runs the results will be the same since 

the dates will not update. 

 The time zone for all schedules is the standard UTC time.  If you select a different time zone in 

the template display options, the results generated from a schedule may not reflect the most 

recent activity. 
 

Create a Schedule 

Before creating a schedule, it is important to understand how the schedule dates and the template 
date filters relate to each other. See Understanding Date Settings on page 512 for more information. 

To create a schedule 

1. Click Templates and select either the Default or Personal tab. 

2. Select the desired template. 

3. Click Schedule. The Save Schedule dialog displays with a Properties tab and an Email tab. 

 

4. In the Properties tab complete all fields as described below.    
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 Name - (Required) Modifiable field pre-populated with the name of the saved template. 

Creates the name of the schedule and the name of the report generated by the schedule. 

Max character limit is 256. Accepts alphanumeric characters only. Does not support the 

use of any special characters. 

 Description - Modifiable field pre-populated with the description from the saved template. 

Field can be blank. Max character limit is 512. 

 Format - Determines the format of the saved report generated by the schedule. Choices 

include: Excel, HTML, CSV (default), PDF.  When opened, a saved report displays in the 

viewer associated with the file type on the user's machine. 

Note: Reports saved in the Excel format may have an extra column in every row. You 
cannot hide this column in the report template, however you can remove the column once 
you open the report in Excel. 

 Delete In - Determines when the report generated by the schedule will be automatically 

deleted from the Results tab. Choices include: 7 Days (default), or 30 Days. To store a 

report for longer than 30 days, use the Download option. 

 Include report parameters - When checked, parameters such as template name, 

description, date generated, input options, and last successful database refresh will 

display in the report generated by the schedule. Default is unchecked. Cannot include 

parameters in a CSV file. 

Note: Saving a report in the Excel format with Include report parameters checked 

causes columns to merge and the output is difficult to read.  

5. In the Schedule section, select the type of schedule you want to create from the drop down. 
Complete all fields as described below.  

Note:  The time zone for all schedule Start times is UTC.   

One Time Schedule 

Create a one time schedule if you only need a snapshot of the data for one period in time.  

 

Complete all fields as described below. 

 Start - (Required) Determines the date the schedule should become active.  The schedule 

will run the report once and not reoccur. Default is current day's date. 

 Start Time - (Required) Determines the time of day the report will be queued for 

execution. Default is 2:00 AM UTC time. 

 

 

Daily Schedule 
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Create a daily schedule if you need the report to run on more than one day a week. 

 

Complete all fields as described below. 

 Start - (Required) Determines the date the schedule should become active. Default is 

current day's date. 

 End by - Determines the date the schedule becomes inactive and reports stop running. If 

left blank, the report will reoccur indefinitely. 

 On the following days - Determines which days of the week the report will run. Select 

one or more days. 

 Start Time -  (Required) Determines what time of day the report will be queued for 

execution. Default is 2:00 AM UTC time. 

 

 

Weekly Schedule 

Create a weekly schedule to run the report on only one day of the week.  

 

Complete all fields as described below. 

 Start - (Required) Determines the date the schedule should become active. Default is 

current day's date. 

 End by - Determines the date the schedule becomes inactive and reports stop running. If 

left blank, the report will reoccur indefinitely. 

 On the following day - Determines which day of the week the report will run. Select only 

one day. 

 Start Time - (Required) Determines what time of day the report will be queued for 

execution. Default is 2:00 AM UTC time. 

 

 

 

Monthly Schedule 
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Create a monthly schedule to run the report on the same day of each month. 

 

Complete all fields as described below. 

 Start - (Required) Determines both the date the schedule becomes active and the day of 

the month the report will run.  If the date is 29, 30, or 31 the report will not run for months 

that do not contain that date.  

 End by - Determines the date the schedule becomes inactive and reports stop running. If 

left blank, the report will reoccur indefinitely. 

 Start Time - (Required) Determines what time of day the report will be queued for 

execution. Default is 2:00 AM UTC time. 

 

If desired, click the Email tab to configure the Email Notifications feature. 

6. Click OK. The schedule displays on the Schedules window. 

 

 

 

 
 

Activate or Deactivate a Schedule 

You can make an existing schedule active or inactive on the Schedules window without opening the 
schedule. Inactive schedules will not run reports. Active schedules will run the associated reports as 
long as the End by date has not passed. 

To activate or deactivate an existing schedule 

1. From the Reports menu, click Schedules. 

2. Select the desired schedule. 

3. In the Active column click in the check box to modify the setting (add check for active, remove 
check for inactive). 

 
 

Edit a Schedule 

Existing Schedules can be edited to modify the name, description, format and frequency of the 
schedule. However, you cannot modify which template is associated with the schedule.  

To edit a schedule 

1. From the Reports menu, click Schedules. 

2. Select the desired schedule. 
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3. Click Edit Schedule. The Edit Schedule dialog opens with all fields populated with the current 
settings. 

4. Modify the settings as desired. See Create a Schedule on page 512 for a description of all 
fields. 

5. Click OK. 

Note:  If you change the name of the schedule, the name of any existing reports based on that 
schedule does not change. However, subsequently generated reports will use the new schedule 
name. 

 

Delete a Schedule 

If you no longer need a scheduled report to run, or a schedule expires, you can delete it from the 
Schedules window.  If a schedule is deleted, any corresponding results will not be deleted until the 
specified Delete On date. 

To delete a schedule 

1. From the Reports menu, click Schedules. 

2. Select the desired schedule. 

3. Click Delete. 

4. Click Yes in the confirmation message. 

Optionally, you can delete all schedules in the list by clicking the Delete All button. 
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Managing Templates 

Understanding Templates 

Templates are forms used to determine what dates, filter options, and display options should be 
included in report results. The Reporting tool includes several Default Templates that contain 
predefined filter and display options and are designed to provide the user with 'out of the box' reporting 
functionality.  

The Default templates can be edited in order to customize the data returned. You can save the 
customized templates to create Personal Templates, and you can share your Personal Templates. 

All templates are stored on the Templates window. 

 

The Templates window is divided into three tabs with system defined templates on the Default tab and 
user defined templates on the Personal tab.  Shared templates display on both the Personal, and the 
Shared tabs.  

Templates are categorized by the type of data they report on, such as Content and System data. 
These categories are further divided into subgroups. For instance, the User category includes 
template subgroups for reporting on specific User information such as Learning Activity, and User 
Participation.  

On the Default Templates tab you can: 

 Expand the category folders to see a brief description of each template. 

 Determine which charts are currently displayed on the dashboard. 

 Preview the report results to verify whether or not the report meets your specific needs. 

 Edit the template by customizing filters and display options in order to create a personal 

template. 

 Schedule a report to automatically run in the future. 

The Personal Templates tab provides options for deleting and sharing templates, and the Shared 
Templates tab provides options for deleting and unsharing templates. 

 

 

 



Skillport 8 Administrator Guide ©2015 Skillsoft  518 
 

Reports   
 
 

Create a Personal Template 

In order to meet your specific reporting needs, you can modify the input filters and display options 
included in a default template and then save the new template to create a personal template. There is 
no limit to the number of personal templates you can create from each default template. You can also 
create new personal templates from existing personal templates. 

To create a personal template 

1. From the Reports menu, click Templates. 

2. Select the desired template. 

3. Click Edit. The following page isplays: 

 

Note: Not all filter options are available in all templates. 

4. If desired, click the following tabs or drop downs to access the associated filters: 

 Activity Dates - specifies what period in time the report should include. 

 Group / Users - returns data only for the selected groups or users. 

 Asset Filter - returns data only for the selected asset types. 

 Filter Options - a variety of filters for selecting criteria such as assignment and access 

dates, specific Skillport user and group information, completion status, etc. 

Note: Template Properties is a read only list. 

5. If desired, click Display Options and determine what column headers the report will include, 
and how the data will display. 

6. Optionally, you can run the report to preview the results before saving the template to 
determine if it meets your needs, or you can save the results. 

7. To save the template, click Save As. The Save As dialog displays. 

8. Enter a Name for the personal template. Name field is mandatory and cannot contain more 
than 120 characters. The following characters are not allowed:  \ / : * ? " < > | ; {} 

9. Enter a Description of the template, if desired. Maximum character limit is 512.  

10. Click OK. The new template will be saved to the Personal tab and a message will prompt you 
to create a schedule for this template. 

11. Click Yes to create a schedule or No to display the Personal template tab. 
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Understanding Filters 

There are several different filters available to help refine and customize report results. Filters can be 
used to return very broad sets of data that give you an overview of your Learning Management 
System (LMS), and they can be used to return very specific sets of data within your LMS 
environment. For instance, you may want to get an overview of how many users actually log into the 
system each month, or you may want to see specific data on which assets user John Doe completed 
in the last month.   

All filters are accessed within the template window when you create a personal template.  

 Activity Date Filters - allow you to determine what period in time the results should include. 

 Group and User related filters - allow you to select specific groups, subgroups, or users and to 

filter by data such as user status. 

 Asset related filters - allow you to display results for specific assets, asset sub-types, and to 

filter by data such as completion status, Books and Videos collections, etc. 

 Additional Filter Options - a variety of filters including: 

 Custom filters on page 536 - allow you to select an option, enter a value, and use an 

operator to display only data that matches the specific criteria, such as times accessed > 

5. 

 Event Filter Date Ranges - allow you to select one event and then select a date range for 

that specific event. 

 User Profile Filters - allow you to filter data by selecting values assigned to user profile 

settings.  

 inGenius Community Filter - available for inGenius report templates only. Allows you to filter 

by one or more communities. 

Filters are report specific and not all filters display for every report. For a complete listing of all filters 
available for each report, see Report Definitions. 

Note:  It is possible to select filter options that will return an empty result. For instance, if you select 
the option First Accessed in the Filter Date Range filter and then select the option Not Accessed in the 

Completion Status filter, these filters will negate each other and return no data. 
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Understanding Report Activity Dates 
Report Activity Date filters determine the start and end dates for all activity included in the report 
results. These filter types are located under the Activity Dates tab in the report template window. 
There are two versions of the Report Activity Date filters: the Activity Date Range filter, and the Activity 
Date As Of filter. 

Activity Date Range 

The Activity Date Range filter allows you to select what time span the results include. For example, 
you can report on all activity that occurred during the previous month, or you can report on all activity 
that occurred between two specific dates. 

  

The Previous option allows you to select an interval of time that is relative to today, or the date the 
template is accessed.   The dates are dynamic and update each time the template is accessed either 
manually or from a schedule. This option is useful when you want to create recurring schedules that 
generate results with the most current data. This option is explained in detail below. 

The From/To option allows you to select specific start and end dates. If a value is entered for both the 
start and end date, the dates are static and do not update if the template is accessed in the future. 
Typically this option is useful when you want a one-time snapshot of data. This option is explained in 
detail below. 

Note: When the Previous option is selected, the dates that correspond to the 'Previous [n] [Units]' will 
display in the From/To option and will refresh accordingly.  This provides a valuable aid to help you 
understand the nature of the dates you are selecting.   
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Previous Option 

The intervals for the Previous option include Days, Weeks, Months and Years and each is bound by 
specific start and end dates, as well as times.  You can also select the number of intervals to include, 
for instance '3 Months' or '2 Weeks'.  Each interval has a maximum limit as defined below: 

 Years – 99 

 Months – 999  

 Weeks – 999  

 Days – 9999  

The Previous option also provides a To Date setting that allows you to include all activity up to the 
current date and time, regardless of the interval chosen. 

 If To Date is unchecked, the end date is the last day of the previous interval. For instance, if 

today is December 31, the ‘Previous [n] Months’ ends on November 30 and the ‘Previous [n] 

Years’ ends on December 31 of the prior year. 

 If To Date is checked, the end date is always the date the report is run, up to and including the 

most recent database refresh. 

The start and end dates for each interval are defined below. 

 Day intervals 

 Maximum number of intervals is 16. 

 Starts at 00:00:00 or 12 midnight, ends at 11:59:59.   

 Example:  If today is any time on October 31, then the 'Previous 3 Days' starts on October 28 

at 00:00:00 and ends on October 30 at 11:59:59. 

Note: For all intervals listed below, the start and end times are the same as those noted for 

Day intervals. 

 Week intervals 

 Maximum number of intervals is 16.  

 Starts on Sunday, ends on Saturday.  

 Examples with To Date Unchecked  

 If today is Sunday October 31, then the ‘Previous 2 Weeks’ starts on Sunday October 17 

and ends on Saturday October 30. 

 If today is Wednesday November 3, then the 'Previous 2 Weeks' starts on Sunday 

October 17 and ends on Saturday October 30. 

 Example with To Date Checked 

 If today is Wednesday November 3 then results for the 'Previous 2 Weeks' starts on 

Sunday October 17 and ends on Wednesday November 3. 
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 Month intervals 

 Maximum number of intervals is 12. 

 Starts on the first day of the month, ends on the last day of the month.  

 Examples with To Date Unchecked  

 If today is October 31, then the ‘Previous 3 Months’ starts on July 01 and ends on 

September 30. 

 If today is November 3, then the ‘Previous 3 Months’ starts on August 01 and ends on 

October 31. 

 Example with To Date Checked 

  If today is November 3 then the ‘Previous 3 Months’ starts on August 01 and ends on 

November 3. 

 Year intervals 

 Maximum number of intervals is 4. 

 Starts on the first day of the year, ends on the last day of the year. 

 Examples with To Date Unchecked  

 If today is October 31, 2010, then the ‘Previous 2 Years’ starts on January 1, 2008 and 

ends on December 31, 2009. 

 If today is any day in 2010, then the ‘Previous 3 Years’ starts on January 1, 2007 and 

ends on December 31, 2009. 

 Example with To Date Checked 

 If today is November 3, 2010 then the 'Previous 2 years' starts on January 1, 2008 and ends 

on November 3, 2010. 

Note: For all settings that have an end date of today, the results are dependent on the last successful 
automatic database refresh.  
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From/To Option 

The From/To option allows you to set specific dates. 

When using the From/To option you must adhere to the following guidelines: 

 The To date can be left blank. The From date cannot be left blank. 

 If the To date is blank, the end date is always the date the report is run, up to and including 

the most recent database refresh. 

 The From date is always the beginning of the day and starts at 00:00:00 or 12 midnight UTC. 

The To date is always the end of the day and ends at 11:59:59 UTC.  

 All dates must be entered in the format YYYY-MM-DD. For instance, 2010-01-01. 

 The To date must be later in time than the From date. 

Note: If you are modifying chart activity dates, there is a limit to the length of time that can be 
included in the Previous or From/To options. For more information, see Modify Chart Activity 
Dates on page 556. 

Example 

To generate a monthly, year-to-date report, schedule a monthly report that runs on the first of each 
month. Set the From Date to Jan 1 and leave To Date blank.  

Activity Date As Of  

The Activity Date As Of filter allows you to select the end date for all report activity. 

 

Selecting As of Today, sets the end date to the current date the template is accessed either manually 
or from a schedule. This option uses a dynamic date that automatically updates each time the report 
runs. This is useful if you want to capture a one-time snapshot of the current report activity, or if you 
want to schedule the report to run on a recurring basis.  

Selecting As of allows you to choose a specific date either in the past or the future. This option uses a 
static date that will not change, even for scheduled reports that run in the future. This is useful if you 
want to capture a one-time snapshot of report activity as of a past date, or if you want to create a one-
time schedule to run the report in the future.  
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About Learner Activity and Activity Dates 
In any report that includes the Activity Date Range Filter, learner activity for a specific asset is  
included in the results only if the learner launched the asset within the specified activity date range. 
Additionally, the data returned for certain fields is affected by the Activity Date Range. 

Example 1:  No activity 

Tom completes Course A in May and does not re-launch the course any time after that. 

In July, you run an activity report with activity dates of June 1 to June 30. 

 No data for Course A for Tom will appear in the report since Tom did not access Course A 

during the specified activity date range. 

First and Last Access Dates 

In activity reports such as Asset Activity by User or Course Activity by Content, the data returned for 
the following fields reflects only activity that occurs during the selected Activity Date Range: 

 First Access Date 

 Last Access Date 

 Times Accessed 

 Actual Duration 

Example 2:  First and Last Access Dates are only included for accesses within the Activity 
Date Range  

Tom accesses Course B for the first time on May 10th. He accesses it for the second time on June 
15th. 

In July, you run an activity report with an Activity Date Range of June 1 to June 30. 

 Course B displays First Access and Last Access Dates of June 15   

 Tom accessed the course for the first and only time within the specified activity date range 

on June 15. 
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Times Accessed and Actual Duration 

The Times Accessed and Actual Duration are also effected by the learner’s activity within the specified 
activity date range.  

Example 3: Accesses and Actual Duration are counted only for activity within the Activity Date 
Range 

Bill accesses Course A accordingly: 

 June - 1 access,  30 minutes duration 

 July - No accesses 

 Aug - 1 access, 15 minutes duration 

 Sept - 2 accesses, 60 minutes duration 

On September 30, you run a Q2 (June, July, and August) and a Year-To-Date report. 

Report 1 – Selected Activity Dates: June 1 to August 31 

 Number of Times Accessed = 2 

 Actual Duration = 45 minutes 

Report 2 – Selected Activity Dates: Jan 1 to Sept 30 (YTD) 

 Number of Times Accessed = 4 

 Actual Duration = 95 minutes 

Completion Date, Completion Status and Scores  

Completion Date, Completion Status and Scores are reported as of the last day of the Activity Date 
Range. 

Example 4: Completion Date, Completion Status and Scores 

Tom accesses Course A: 

 Jan 3 - 1 access, score of 65 

 Jan 10 - 1 access, score of 100, completed. 

Bill accesses Course A: 

 Jan 12 - 1 access, score of 77, need 80 or better to pass 

 Feb 5 - 1 access, score of 88, completed 

Report 1:  Activity Date Range of Jan 1 to Jan 31 displays: 

User First Access  Last Access 
Completion 
Status 

Completion 
Date 

High Score 

Tom 1/03/14 1/10/14 Completed 1/10/14 100 

Bill 1/12/14 1/12/14 In progress   

Report 2: Activity Date Range of Jan 1 to Feb 28 displays: 

User First Access  Last Access 
Completion 
Status 

Completion 
Date 

High Score 
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Tom 1/03/14 1/10/14 Completed 1/10/14 100 

Bill 1/12/14 2/05/14 Completed 2/5/14 88 

Report 3: Activity Date Range Feb 1 to Feb 28: 

User First Access  Last Access 
Completion 
Status 

Completion 
Date 

High Score 

Bill 2/05/14 2/05/14 Completed 2/5/14 88 

Since Tom’s only access to the course was in January, no data will show in the report.  

Completion Dates and Scores can be prior to the Activity Date Range 

Since Completion Status, Completion Dates and Scores are reported as of the End Date, these values 
could be from a prior period. 

George accessed a course: 

 Jan 2 - 1 access, score of 99, completed 

 Feb 15 - 1 access, no additional score 

Report 4:  Activity Date Range Feb 1 to Feb 28: 

User First Access  Last Access 
Completion 
Status 

Completion 
Date 

High Score 

George 2/15/14 2/15/14 Completed 1/22/14 90 

 
 

Select Report Activity Dates 

To modify the As of Today dates 

1. Click the Activity Dates drop down. 

 

2. Select either the As of Today, or the As of option. 

If you select As of, you must select a date in the date field. 

To modify the Activity Dates 

1. Click the Activity Dates drop down. 

 

2. Select either the Previous or From/To option. 

If you select the Previous option, enter a number and select the desired interval type. 

If you select the From/To option, select start and end dates in the date fields. 

See Understanding Report Activity Dates on page 520 for a description of the above options. 
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Select Groups and Users  
The Group / Users filter allows you to select specific groups, subgroups, or users. When the report is 
run, the results will only include data for the groups or users you selected. You can choose to filter by 
either Groups or Users, but not by both at the same time.  

Note: Visibility of groups and users within this filter is determined by the User/Group Filter Scoping 
option in the Skillport Administrator UI and your user privileges. See User and Admin Privileges on 
page 501 for more information. 

To access the Group/Users filter 

1. From the menu click Templates. 

2. Select the desired template. 

3. Click Edit.  The Template window displays. 

4. Click the Group / Users tab. The following screen displays: 

 

The Group/Users filter includes the following sections: 

1. Search Tool - Allows you to search for specific groups or users.  

2. Groups or Users list - Displays the list of groups or users you have permission to view. 

3. Selected groups or users - Displays the list of selected groups or users you want to include 
in your results. 

4. Additional Filters - Displays a variety of filters based on the template chosen. In Books and 
Videos reports, the Subscription ID filter displays above the search tool. 

Note: In some templates, the Group or the User option may not be available. For instance, the 
Group Learning Plan Assignments template does not allow you to filter by user, since this is a 
group specific report. 

Selecting Groups or Users 

To search for specific users or groups   

1. Select either the Users or Groups option. 
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2. Enter your search criteria in the text field. 

For Users, enter a login name, first name, or last name. 

For Groups, enter a group name or org code. 

3. Click Search. The users or groups that match your criteria display. 

 If no results were found, you are prompted to click Refresh to display the entire list. 

To select users or groups 

1. In the Groups or Users list (section 2 in the above graphic), select the desired Users or 
Groups.  Use the CTRL or Shift keys to select multiple rows.  

2. Click the selection arrow, or drag the selection to the right pane. The selected users or 
groups are added to the selected list (section 3 in the above graphic). 

To remove users or groups from the selection 

1. In the selected users or groups list, select the desired Users or Groups.  

2. Click Remove.  
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Using Additional Filters 

Depending on the Template type accessed, the following filters may be available on the Group/Users 
Filter tab. To select an option, choose from either a drop down or place a check in the corresponding 
check box. 

 Subscription ID - In Books and Videos reports, this filter allows you to select users based on 

their current Subscription ID. Only the users assigned the currently selected ID will display in 

the User filter.  

 User Status - Select users based on their current status of Activated or Deactivated. Select 

both options to include all users. 

 User Role - Provides the ability to filter users by their current role. You can select one, or 

multiple, roles of either End User, Manager, Administrator, Company Administrator, or Super 

Administrator. 

 Seat Status - Provides the ability to specify users' seat status. Select Any, Occupied, or 

Deleted. 

 Privilege - Provides the ability to filter users based on their current privilege. You can select 

one, or multiple privileges.  For a complete list see the User Privilege report in the Reports 

Definition document. 

 Only Show Assets Assigned Through Selected Group's Learning Plan - Only includes 

activity for assets in a group's Learning Plan, and only for groups explicitly selected. Does not 

include activity for assignments inherited by a group's parent group. 

The Select Subgroups and Rollup Members of Subgroups check boxes effect how your users and 
subgroups are displayed within the results. 

 Select Subgroups - Include all subgroups of a selected group. 

 Rollup Members of Subgroups - Include a subgroup's members and treat them as if they 

are members of the selected parent group. 

These two check boxes can work independently or together, and there are four scenarios for 
displaying the data. The example below demonstrates the effects of checking and unchecking these 
options. 

For this example, the groups and users are structured as follows: 

Group A is the selected group.  Group B and Group C are subgroups of Group A. 

Group A 

 User 1 

 User 2 

 Group B 

 User 3 

 User 4 

 Group C 

 User 5 
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 User 6 
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When you run reports based on these scenarios, the results will include the following rows of 
information for each user: 

If you select group A and leave both check boxes unchecked, only the users from Group A will be 
included. 

 User 1    Group A 

 User 2    Group A 

If you select group A and check only the Select Subgroups check box, the users from the selected 
group and the subgroups will display as follows: 

 User 1    Group A 

 User 2    Group A 

 User 3    Group B 

 User 4    Group B 

 User 5    Group C 

 User 6    Group C 

If you select group A and check only the Rollup Members of Subgroups check box, the users from 
the selected group and the subgroups will display, however the users will be listed as if they are all 
members of the parent group.  

 User 1    Group A 

 User 2    Group A 

 User 3    Group A 

 User 4    Group A 

 User 5    Group A 

 User 6    Group A 

If you select group A and check both check boxes, the users from each group will display as if they 
are members of their subgroup and the selected parent group.  Some users will be duplicated in the 
list.  

 User 1    Group A 

 User 2    Group A 

 User 3    Group A 

 User 4    Group A 

 User 5    Group A 

 User 6    Group A 

 User 3    Group B 

 User 4    Group B 
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 User 5    Group C 

 User 6    Group C 

 
 

Select Assets 
The Asset Filter tab provides options for including or excluding assets, and selecting assets by type 
and sub-type. You can search for specific assets and you can filter by options such as Learning 
Program status, Books and Videos Collections, etc.  

You can select a single asset, multiple assets, or an entire folder. If you select an entire folder of 
assets, all assets in the folder and its sub-folders will be included in the report results. For any 
templates that are saved with a folder selected in the asset filter, if the contents of the folder change at 
a later date then: 

 Any assets removed from the folder will not be included in the report results. 

 Any assets added to the folder will be included in the report results, if available. 

Note: Assets that are added with a folder can also be added individually.  However, data based on this 

asset will not be duplicated in the report results. 

To access the Asset Filters 

1. From the Reports menu, click Templates. 

2. Select the desired template. 

3. Click Edit.  The Template window displays. 

4. Click the Asset Filter tab. 

 

The Asset Filter can include the following sections: 

1. Asset Selector - Allows you to select specific assets.  Content specific templates, such as 
Learning Program or KnowledgeCenters, will only display assets associated with that content 
type. 
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2. Category/Sub-category Selector - Allows you to select assets by category and sub-
category. Referred to as type and sub-type in report results. 

3. Selected Assets - Displays the selected list of assets you want to include in your results. 

4. Additional Filters - Displays a variety of filters based on the selected template. 

 Note: The screen shot above is an example of filter types included on the Asset Filter tab. This is not 

a representation of an actual template. Not all asset filters are included in every template. 

Selecting Assets  

To search for specific assets 

1. Enter your search criteria in the Search text field. 

Note: Use the % character for a wild card search. The * character is invalid in the Reporting 

asset search filter.  

2. Click Search. If found, the assets matching your search criteria will display in the Asset 
Selector section (section 1 in the graphic above), replacing the assets displayed by default. 

To select specific assets 

1. From the Asset Selector, select the desired asset(s), or select an entire folder. The Add 
arrow enables. 

2. Click the Add Arrow, or drag and drop the assets. The assets, or folder, are added to the 
Selected Assets list. 

To select asset types or sub-types 

1. In the Category Selector expand or collapse the list as desired. 

2. Select one or more types, or sub-types. 

To remove selected assets 

1. In the Selected Assets list select the desired asset(s). The Remove button enables. 

2. Click Remove. 

Note: The Asset and the Category filters are not related and are applied to the results sequentially. 
For instance, it is possible to select a specific Course from the Asset filter, but a Book category from 
the Category filter. This will produce an empty result set. 
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Using Additional Filters 

Depending on the Template type accessed, the following filters may be available on the Asset Filter 
tab. To select an option choose from either a drop down or a multi-selection list. These filters may be 
the only filters on the tab, or they may display below the Asset and Category Filters. 

 Learning Program Status - Select  All, Enrolled (but not started),  Started, Completed, 

Declined, Pending, or Withdrawn 

 Live Learning Status - Select one or more live learning statuses. Started, Pending Approval, 

Completed, Declined, Withdrawn, Enrolled but not Started. 

 Books and Videos Subscription Selector - Select from one of the subscriptions available.  

 Books and Videos Collections Selector - Select  one or more collections (Books and 

Videos) the user is entitled to. 

 Evaluation - Select one evaluation from the list. Changing the selection may modify the 

assets displayed in the Asset Selector list. 

 

 

 

 
 

Apply Additional Filter Options 
The Filter Options tab includes a variety of filters for customizing the data returned in results.  

To access the additional filters 

1. From the menu click Templates. 

2. Select the desired template. 

3. Click Edit.  The Template window displays. 

4. Click the Filter Options tab. 
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5. If necessary click the Filter Options drop down. 

 

The Filter Options tab can include the following sections: 

1. Event Filter Options - The Event Filter Options, labeled 'Filter On' in the above image, allow 
you to select one event and then select a date range for that specific event. See Apply Event 
Filter Options on page 537 for more information. 

2. Custom Filters - The Custom filters are comparison filters that can be used together or 
individually.  See Apply Custom Filters on page 536 for more information. 

3. User Profile Filters - The User Profile filters allow you to filter data based on the values 
available in your organization's user profile settings. See Apply User Profile Filters for more 
information. 

4. Additional Filters - A variety of filters can display in the additional filters section. These filters 
are typically asset or user related, depending on the type of template selected. See the Report 
Definitions document for a list of filters in each report. 

Note: The screen shot above is an example of filter types included on the Filter Options tab. Not all 

filters are included in every template. 
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Apply Custom Filters 

Filter 1 and Filter 2 Custom filters 

The Filter 1 and Filter 2 controls allow you to select an option, enter a value, and use an operator to 
display only data that matches the specific criteria. You can use only one of the filters, or you can 
choose an option for Filter 1, and then further define the criteria by choosing 'and', or 'or' for the option 
selected in Filter 2. 

Each filter consists of a drop down with available options, a drop down with applicable operators, and 
a field for entering the appropriate value. Both the operator and the value field will automatically 
change depending on the type of option chosen.  

For example, in the screen shot below, the option selected for Filter 1 is numerical.  The operator drop 
down includes choices such as 'equal to', 'not equal to', 'less than', etc.  The value field is a text field 
for entering numbers.  The option selected for Filter 2 is date based. The operator drop down includes 
the choices 'on', 'on or before', and 'on or after'. The value field includes a calendar picker for entering 
a date. 

 

Note: For all fields that calculate a 'duration', such as Actual Duration or Average Duration per User, 

enter the value as a number of minutes. For example, 2:00 (2 hours) should be entered as 120. 

The 'and' / 'or' option determines if you want the data returned to match both filter criteria, or the 
criteria from either filter.  

When these filters are available, a minimum default list is included, but some templates also include 
report specific options. To see a list of options available for specific templates see Report Definitions. 

Warning:  Although the Custom filters are very powerful and flexible they are not the preferred way 
to filter general cases such as getting data for a specific user or asset.  The criteria in these filters 
are applied to the data after the query is sent to the database.  If these are the only filters applied, it 
may take several minutes for the report to run. Using the Group / Users filter or the Asset filter is 
much faster since these filters are applied before the query is sent to the database. 

To apply the Custom filters 

1. From the Reports menu, click Templates. 

2. Select the desired template. 

3. Click Edit.  The Template window displays. 

4. Click the Filter Options tab. 

5. If necessary, click the Filter Options drop down. 

6. Select an option from the Filter 1 drop down. 

7. Select an operator from those available. 

8. Enter a value in the value field.  

9. Optionally, select 'and' or 'or' from the drop down and repeat the above steps for the Filter 2 
fields. 
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Apply Event Filter Options 
Event Filter Dates - The Event Filter Options allow you to filter report results by selecting one event 
and then selecting a date range for that specific event. For example, you can filter the data to only 
include assets that have a Completion Date within the past two weeks.  

 

The Filter On drop down allows you to select an event such as Skillport Registration date, Last Login 
date, High Score, etc. The available events vary based on the template selected. 

The Previous option allows you to select an interval of time that is relative to today, or the date the 
template is accessed.   The dates are dynamic and update each time the template is accessed either 
manually or from a schedule. This option is useful when you want to create recurring schedules that 
generate results with the most current data. This option is explained in detail below. 

The From/To option allows you to select specific start and end dates. If a value is entered for both the 
start and end date, the dates are static and do not update if the template is accessed in the future. 
Typically this option is useful when you want a one-time snapshot of data. This option is explained in 
detail below. 

Note: When the Previous option is selected, the dates that correspond to the 'Previous [n] [Units]' will 
display in the From/To option and will refresh accordingly.  This provides a valuable aid to help you 
understand the nature of the dates you are selecting.   
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Previous Option 

The intervals for the Previous option include Days, Weeks, Months and Years and each is bound by 
specific start and end dates, as well as times.  You can also select the number of intervals to include, 
for instance '3 Months' or '2 Weeks'.  Each interval has a maximum limit as defined below: 

 Years – 99 

 Months – 999  

 Weeks – 999  

 Days – 9999  

The Previous option also provides a To Date setting that allows you to include all activity up to the 
current date and time, regardless of the interval chosen. 

 If To Date is unchecked, the end date is the last day of the previous interval. For instance, if 

today is December 31, the ‘Previous [n] Months’ ends on November 30 and the ‘Previous [n] 

Years’ ends on December 31 of the prior year. 

 If To Date is checked, the end date is always the date the report is run, up to and including the 

most recent database refresh. 

The start and end dates for each interval are defined below. 

 Day intervals 

 Maximum number of intervals is 16. 

 Starts at 00:00:00 or 12 midnight, ends at 11:59:59.   

 Example:  If today is any time on October 31, then the 'Previous 3 Days' starts on October 28 

at 00:00:00 and ends on October 30 at 11:59:59. 

Note: For all intervals listed below, the start and end times are the same as those noted for 

Day intervals. 

 Week intervals 

 Maximum number of intervals is 16.  

 Starts on Sunday, ends on Saturday.  

 Examples with To Date Unchecked  

 If today is Sunday October 31, then the ‘Previous 2 Weeks’ starts on Sunday October 17 

and ends on Saturday October 30. 

 If today is Wednesday November 3, then the 'Previous 2 Weeks' starts on Sunday 

October 17 and ends on Saturday October 30. 

 Example with To Date Checked 

 If today is Wednesday November 3 then results for the 'Previous 2 Weeks' starts on 

Sunday October 17 and ends on Wednesday November 3. 
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 Month intervals 

 Maximum number of intervals is 12. 

 Starts on the first day of the month, ends on the last day of the month.  

 Examples with To Date Unchecked  

 If today is October 31, then the ‘Previous 3 Months’ starts on July 01 and ends on 

September 30. 

 If today is November 3, then the ‘Previous 3 Months’ starts on August 01 and ends on 

October 31. 

 Example with To Date Checked 

  If today is November 3 then the ‘Previous 3 Months’ starts on August 01 and ends on 

November 3. 

 Year intervals 

 Maximum number of intervals is 4. 

 Starts on the first day of the year, ends on the last day of the year. 

 Examples with To Date Unchecked  

 If today is October 31, 2010, then the ‘Previous 2 Years’ starts on January 1, 2008 and 

ends on December 31, 2009. 

 If today is any day in 2010, then the ‘Previous 3 Years’ starts on January 1, 2007 and 

ends on December 31, 2009. 

 Example with To Date Checked 

 If today is November 3, 2010 then the 'Previous 2 years' starts on January 1, 2008 and ends 

on November 3, 2010. 

Note: For all settings that have an end date of today, the results are dependent on the last successful 
automatic database refresh.  
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From/To Option 

The From/To option allows you to set specific dates. 

When using the From/To option you must adhere to the following guidelines: 

 The To date can be left blank. The From date cannot be left blank. 

 If the To date is blank, the end date is always the date the report is run, up to and including 

the most recent database refresh. 

 The From date is always the beginning of the day and starts at 00:00:00 or 12 midnight UTC. 

The To date is always the end of the day and ends at 11:59:59 UTC.  

 All dates must be entered in the format YYYY-MM-DD. For instance, 2010-01-01. 

 The To date must be later in time than the From date. 

Note: If you are modifying chart activity dates, there is a limit to the length of time that can be 
included in the Previous or From/To options. For more information, see Modify Chart Activity 
Dates on page 556. 

To apply Event Filter options 

1. Click the Filter Options tab. 

2. Select an event from the Filter On drop-down.  

Note: The available events will vary depending on the template selected. For a description of 
each event see the Report Definitions and refer to the corresponding report.  Locate the event 
in the Display Options section. 

3. Select either the Previous or From/To option. 

4. To modify the dates, follow the guidelines above based on the option selected. 
 

Understanding User Profile Filters 
User Profile filters allow you to filter data based on the values available in your organization's User 
Profile Fields.  

In order for a filter to be available in Reporting, the View Only option must be selected for that specific 
filter in the Configure User Profile Settings (on page 491) page. These settings are disabled for 
reporting by default.  

Note: Changes made in the Configure User Profile page will not take effect until after a database 
refresh (ETL). It is Skillsoft’s commitment to ensure that customer reporting data is updated within 24 
hours. In general, database refreshes run several times a day. 
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In Reporting, User Profile filters appear on the Filter Options tab in report templates that include user 
information. Only fields that contain data will display in the list and you can add as many fields to the 
report as are available. When selected, each field provides options for defining conditions and criteria 
with which to filter the data.  

Localized User Profile Fields that do not include an English version will display the field ID in the filter 
and report results. If English is available, the English version will always display by default. 

User Profile Fields configured to appear in reporting will also be added to the Display Options tab 
under User Fields.  However, if the field is not a required or default display option, using it to filter data 
will not automatically set the option to display as a column header in the report results. If you want the 
field to display as a column header, you must select it in the Display Options tab. 

 
 

Apply User Profile Filters 

To apply a User Profile Filter 

1. From the Skillport Reports menu, click Templates. 

2. Select the desired template. 

3. Click Edit.  The Template page displays. 

4. Click the Filter Options tab. 

 

5. Under User Profile Filters, click Add Additional Criteria to display a drop down. 

 

6. Click the Filter drop down and select the desired filter.  

Options for selecting the filter conditions, the filter criteria, and for deleting the filter will display. 

Condition and Criteria Options 
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The data type of the selected filter determines which of the following condition and criteria fields 
display.  

Note: The data type for each custom user profile field is defined when you Create a Custom Field on 

the Configuration > User Profile page. 

 

Integer 

1. Conditional operators include: 

 equal to 

 not equal to 

 less than 

 greater than 

 less than or equal to 

 greater than or equal to 

 is blank 

 is not blank 

2. Criteria option displays as a text box and accepts numbers only. 

Date Field 

1. Conditional operators include: 

 on 

 on or before 

 on or after 

 is blank 

 is not blank 

2. Criteria option displays a calendar widget. Date must be in the format YYYY-MM-DD.  
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Boolean 

1. Conditional operators include: 

 equals 

 is blank 

 is not blank 

2. Criteria option displays a drop down with a Yes or No value. 

Text 

1. Conditional operators include: 

 matches 

 does not match 

 contains 

 is blank 

 is not blank 

2. Criteria option displays as a text box that accepts alphanumeric characters. 

Select List 

1. Conditional operators include: 

 does not match any of 

 matches any of 

 matches all of  

2. Criteria option displays a Select link. When clicked, the Select Values dialog displays. 

 



544 ©2015 Skillsoft Skillport 8 Administrator Guide 

 

 Reports 
 
 

The Valid Values included in the list are captured from actual data added to a user's profile rather than 
the definitions in the User Profile Fields.  The list is sorted alphabetically and the maximum number of 
values available is 200.  Select Not Specified to filter on users with a blank value in this field.  

To filter the data based on these criteria 

1. Select one or more values from the Valid Values list. 

2. Click Add, or drag and drop the item into the Values list. 

3. Click Save. 

The values will display in the report template.  

 

To edit the list, click Select and add or remove values. 

1. Complete all  fields as desired. 

2. Add additional filters if desired. 

Note: If you want the field to display as a column header, you must select it in the Display 

Options tab. 

User Profile filters are added to the reporting query as an ‘AND’ parameter. For example, if two User 
Profile filters are added, the results will only return users who meet the criteria of both filters. 

Note: Not all reports include the User Profile Filters. 

 

Select inGenius Communities 
The Community filter is available for inGenius report templates only. This filter allows you to filter data 
by one, several, or all communities in your organization. Your Skillport privileges will effect the results 
returned in your reports. Community Administrators can only see results for their specific communities.  
Company and Super Administrators can see results for all inGenius communities in the list. 

 

To filter by Community 

1. From the Templates window select any inGenius report type. 

2. Click Edit. 
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3. Select the Community tab. 

4. Select one or more communities from the list. 

5. Click the Add arrow. The selected communities will display in the right pane. 

You can sort either list by clicking the drop-down to the right of the pane. 

 

To remove a selected Community  

1. In the right pane select one or more Communities. 

2. Click Remove. 

Note: The Community filter also includes the User Status filter. 

 
 

Select Display Options 

Display Options allow you to control two aspects of report data:  

1. How the data displays within the rows.  These options are grouped together at the top of the 
Display Options tab. 

2. What column headers, or fields of data, are included in the output. Column header check 
boxes are grouped together in the lower portion of the Display Options tab. 

To access display options 

1. From the menu click Templates. 

2. Select the desired template. 

3. Click Edit.  The Template window displays. 
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4. Expand the Display Options tab. 

 

Displaying Data 

Several options allow you to control how the data within the rows and columns is displayed. Not all 
options are available in each template. The following list explains the affect of applying these options. 

 Select Time Zone - Although activity is always recorded in UTC time, choosing Select Time 

Zone allows you to display the times in your local time zone.  This does not affect the actual 

UTC time of the activity.   

 Include timestamp - Appends hours, minutes and seconds to any date strings displayed 

within the report. Format is YYYY-MM-DD hh:mm:ss  

 List Users within multiple groups in separate rows -  Used to determine the display of 

records for users that are in multiple groups.  If multiple is selected, a record will display for 

every group of which the user is a member. If single is selected, only one record for the user 

will display and group related fields will display a value of 'multiple'. This option is only 

applicable to reports that are sorted by user or asset and user.  This option is not applicable 

for reports that are sorted by group.  

 Include Empty Subgroups - When checked, empty subgroups will display in the results. 

 Include Users with no Approval Manager - When checked, users that don't have an 

Approval Manager assigned will display in the results. 

 Show Assets with no Activity - When checked, assets with no activity display in the results. 

To select display options 

1. At the top of the Display Options tab locate the check boxes. 

2. Check or uncheck the desired options.  
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Column Headers  

Column Headers determine what fields will be included in the report results. For each template, 
several column headers are selected by default, but can be selected and unselected as desired.  For 
convenience, many of the column headers are grouped by category according to the type of data they 
display. 

To select column headers 

1. At the bottom of the Display Options tab locate the Column check boxes. 

2. Check or uncheck the desired options.  

When the report is run, the results will contain a column for each option selected. 

Note: Each template contains at least one column header that is required.  However, these options do 
not display in the user interface since unchecking them would cause an error when running the report. 
See Report Definitions for a list of all column headers and display options included in each template. 

 
 

Edit a Personal Template 

You can edit a Personal template to modify the filters and display options.  

To edit a Personal template 

1. From the menu click Templates. 

2. Click the Personal tab. 

3. Select the desired template. 

4. Click Edit. The Template window opens. 

5. Modify the filters and display options as desired. 

6. Click Save. 

Optionally, you can copy the Personal template by clicking Save As and renaming the 
template. 

 

Delete a Personal Template 

Personal templates can be deleted, however you cannot delete a default template.  

To delete a Personal template 

1. From the menu click Templates. 

2. Click the Personal tab. 

3. Select the desired template. 

4. Click Delete.  

If a schedule is associated with this template, a message will display asking you to confirm 
whether or not you want to delete the template and its associated schedule. You must click 
Yes and delete the schedule in order to delete the personal template. 
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Both the personal template and the associated schedule will be deleted. 
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Sharing Personal Templates 

Understanding Shared Templates 

Personal Templates can be shared so that other users in your organization can use them to create 
schedules, preview reports, and save results. The following information explains important concepts 
about sharing templates.  

Sharing a Template 

 Only personal templates can be shared.  

 Once shared, the template will display in both the Personal tab for the template owner, and 

the Shared tab for all users.  

 Shared templates are only visible by other users in the same domain. 

 A 'shared' icon  appears next to the template in the Personal tab, and in the Shared tab. In 

the Shared tab, only templates belonging to the current user display the shared icon. 

 The Shared tab includes a column with the user name of the template owner.  

 An 'Owner' field with the template owner's user name will be added to the Template Properties 

panel in the Edit Template page, and to the Template Parameters table in the report output. 

 For template owners, all operations that are available in the Personal tab will also be available 

in the Shared tab. 

 If an administrator shares a template and their account is subsequently deactivated or deleted, 

the template will still appear in the Share tab for all users.   Note that the owner name for a 

deleted account is changed from userID to _userID_###.  Any user with administrator 

privileges can Preview, Edit or Schedule these Templates.  A company administrator can also 

delete or unshare these templates. 

See Share a Personal Template for more information. 

Editing a Shared Template 

 Template owners, and Super and Company Administrators can view, edit, save and delete all 

shared templates from the Shared Template tab.  

 Only the template owner, and super or company administrators can modify a shared template, 

however other users can click the Save As button in the template edit window to create a copy 

of the template in their Personal tab.  

 When a Super or Company Administrators saves a modified template owned by a different 

user, a message will appear asking whether he/she wants to take over the ownership of that 

template.  

 If yes is selected, the template owner will be changed to the current user, and the 

template will appear on their Personal tab.  

 If no is selected, no changes will be saved to the template. 
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 Once a shared template is saved as a personal template, any subsequent changes made to 

the shared template will not affect the personal template. 

See Edit a Shared Template for more information. 

Deleting and Unsharing a Shared Template 

 Shared templates can only be deleted, or unshared, by the template owner, super 

administrators, and company administrators. 

 When an owner deletes a shared template from either the Personal or Shared tab, a warning 

will appear asking the user for confirmation. Selecting yes will unshare, and delete, the 

template. 

 If an owner deletes a shared template which they have scheduled, a warning will appear that 

states the schedule will also be deleted, and asks the user for confirmation. 

 If an owner deletes, or unshares, a shared template that other users have scheduled, the 

other users receive a copy of the shared template in their Personal tab, and their schedules 

will be automatically reconfigured to utilize this template. Effectively, this means that other 

users’ schedules will be unaffected when a shared template is deleted, or unshared. 

 Dashboard charts based on a Shared Template will revert back to their Default Templates. 

See Delete a Shared Template, or Unshare a Template for more information. 

Disabling Shared Templates 

Shared Templates can be enabled or disabled in the Skillport > Admin > Configurations > Report 
Configurations page. Disabling Shared Templates will remove all references to the feature from the 
User Interface, including the Shared Templates tab and the Share/Unshare buttons. If Shared 
Templates already exist and the functionality is subsequently disabled, the delete and unshare 
template rules explained above will apply. Only users with Super or Company Administrator privileges 
can enable/disable Shared Templates.  
 

Share a Personal Template 

Before sharing a template, see Understanding Shared Templates for important information. 

To share a Personal template 

1. From the menu, click Templates and select the Personal tab.  

2. Select the desired template. 

3. Click Share. 

4. The template appears in the Shared tab and displays the share icon, and the owner's name. 

 

Note: The share icon also appears next to the template in the Personal tab. 
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Edit a Shared Template 

Before editing a shared template, see Understanding Shared Templates for important information. 

Note: Only a template owner, super administrator, or company administrator can edit a shared 

template. 

To edit a Shared Template 

1. From the menu, click Templates and select either the Personal tab, or the Shared tab.  

2. Select the desired template. 

3. Click Edit.  

4. Make the desired changes and click Save. 

Note: If you are a super or company administrator, but not the owner of the template, a 
message will appear asking if you want to take over ownership of the template. If you select 
No, you will not be allowed to save the template changes. 

 

Delete a Shared Template 

Before deleting a shared template, see Understanding Shared Templates for important information. 

Note: Only a template owner, super administrator, or company administrator can delete a shared 

template. 

To delete a shared template 

1. From the menu, click Templates and select either the Personal tab, or the Shared tab.  

2. Select the desired template. 

3. Click Delete. 

4. In the confirmation message that appears, click Yes. 

The template will be removed from both the Shared tab, and the Personal tab. 
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Unshare a Template 

Before unsharing a template, see Understanding Shared Templates for important information. 

Note: Only a template owner, super administrator, or company administrator can unshare a template. 

To unshare a template 

1. From the menu, click Templates and select either the Personal tab, or the Shared tab.  

2. Select the desired template. 

3. Click Unshare. 

4. In the confirmation message that appears, click Yes. 

The template will be removed from the Shared tab. 
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Managing Charts 

Understanding Charts 

The My Dashboard window displays reports in chart form. There are several default charts included. 
The Dashboard can display two charts simultaneously, and you can replace the default charts with any 
existing chart template.  

Personal chart templates can be created from the default templates, and you can share the personal 
charts with other users in your organization. 

In the Templates tab, an  icon indicates which charts are currently displayed on the dashboard.  

Each time My Dashboard is accessed, the charts auto-refresh to display the latest data available 
based on the most recent database refresh which occurs automatically. 

Note: It is Skillsoft’s commitment to ensure that customer reporting data is updated within 24 hours. In 

general, database refreshes (ETL’s) run several times a day. 

 

Stacked Bar Charts, such as the User Login Activity chart shown above, include a key for each activity 
reported on in the results. You can also hover over the chart results to see the exact number. 

In the My Dashboard window you can: 

 Click Show Parameters to see the parameters for each chart on the dashboard. 

 Edit a chart to create a personal chart template. 

 Replace a chart with a default, personal or shared chart template. 
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Show Chart Parameters 

In the My Dashboard window, you can view the parameters used to create the template for each of the 
charts displayed.  

To view chart parameters 

1. From the My Dashboard window, click a chart to select it. 

2. Click Show Parameters. The Chart Parameters window appears.  

 

3. Click OK to close the window. 

The Chart Parameters window is a read only dialog that includes the following information: 

 Template Properties 

 Report Title - displays the title of the chart template. 

 Report Description - displays the description of the chart template. 

 Template Owner field may display if the chart template is shared. 

 Results 

 Generated on - displays the date and time the report was run. 

 Generated by - displays the user that ran the report. 

 Activity Dates 

 Report Date Range  - displays the dates included in the results. 

 Filters 

 Displays the filters applied to the current chart template. Not all filters are included in all 

templates. 

 Latest ETL 

 Skillport - displays the most recent date and time that the data in the Skillport database 

was refreshed. 

 Books24x7 - displays the most recent date and time that the data in the Books24x7 

database was refreshed. 
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Note: It is Skillsoft’s commitment to ensure that customer reporting data is updated within 

24 hours. In general, database refreshes (ETL’s) run several times a day. 

 

 
 

Create a Personal Chart Template 

You can edit a chart template in order to create a personal chart. Charts displayed on the My 
Dashboard window can be edited directly from the dashboard. Other chart templates are accessed 
from the Templates tab. Default chart templates cannot be modified. To save changes you must use 
the Save As option. 

Editing a chart template is similar to editing templates for all reports, with a few minor differences: 

 The Activity Dates filter has an additional Display Units control. 

 When you save a modified Personal chart template that is currently displayed on the 

Dashboard, the new chart template will replace the dashboard template. Selecting Save As 

does not replace the current chart. If you modify a chart from the templates tab that is not 

currently displayed on the dashboard, you must manually add this chart to the dashboard, if 

desired. 

To create a personal chart template 

1. From the menu click My Dashboard.  

2. Click the desired chart to select it. 

3. Click Edit, or double click the chart.  

Optionally, you can select a chart from a templates tab, and click Edit. The Templates window 
displays the Edit Chart template. 

4. If available, click the following tabs to modify the associated filters: 

 Activity Dates - specifies what period in time the report should include. 

 Group / Users - returns data only for the selected groups or users. 

 Asset Filter - returns data only for the selected asset types. 

 Filter Options - a variety of filters for selecting criteria such as assignment and access 

dates. 

5. Optionally, you can Preview the chart before saving the template to determine if it meets your 
needs.  

6. To save the template, click Save As. The Save dialog displays. 

7. Enter a Name for the personal template. Name field is mandatory and cannot contain more 
than 120 characters. The following characters are not allowed:  \ / : * ? " < > |  ; {} 

8. Enter a Description of the template, if desired. Maximum character limit is 512.  

9. Click OK. The new template will be saved to the Personal tab and a message will prompt you 
to create a schedule for this template. 
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10. Click Yes to create a schedule or No to display the Personal template tab. 

Optionally, you can save the results from the Edit Template window. 

Note: The Preview window allows you to edit or save the template, and to save the template results. 

  

 

 

 

 

 
 

Modify Chart Activity Dates 

Functionality of the chart activity dates is similar to the activity dates in report templates, except for the 
addition of the Display Units control. This control determines the type of units used to display data on 
the chart. It also affects the length of time that can be set in the Previous and From/To dates. 
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The activity dates and the display units work together to produce the chart output. The Previous and 
From/To options determine the start and end dates for the data returned. The Display Units determine 
the type of data that displays on a chart, such as days or weeks, as highlighted in the image below.  

  

There are limitations on the maximum number of units that can be displayed for each unit type. This 
effects the length of time that can be included in the chart output. The maximum values for each 
display unit are: 

 16 days 

 16 weeks 

 12 months  

 12 quarters 

 4 years 

The time interval in the Previous option does not have to match the time interval selected in the 
display units.  In other words, it is acceptable to select 'Weeks' for the Previous time interval and 
'Days' for the Display Units, or any other combination. However, the time frame selected in the 
Previous option, or the dates entered into the From/To options, cannot exceed a length of time that 
would cause the display units to exceed these maximum values. 

For instance, in the example pictured below, a time frame of 3 weeks exceeds 16 days for display 
units. To correct the error, you can change the number of weeks to 2 (which would result in only 14 
days of data), or you can change the Previous option to 16 Day(s). 

 

When you click the Preview, Save, or Save Result button, if your dates have exceeded the maximum 
display units, a message displays with information about the acceptable values. 

To modify chart activity dates 

1. In the chart template window locate the Activity Dates controls. 

2. Select either the Previous or From/To option.   

Note: Use the Previous option to ensure the data is continually updated each time you access 
the My Dashboard tab. For more information on how to use the Previous and From/To date 
options see the section Select Date Ranges on page 520.  

3. Select a Display Unit. 
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The effect that Display Units have on the chart output is defined below: 

 Days 

Previous Option 

 To date checked - displays daily intervals through end of day today. 

 To date unchecked - displays daily intervals through end of day yesterday. 

From/To Option 

 Displays daily intervals for all days in the date range. 

 

 Weeks 

Previous Option 

 To date checked - displays weekly intervals through the end of the last complete Saturday up 

to and including today. 

 To date unchecked - displays weekly intervals through the end of the the range. Includes 

week to date if the date range does not end on a Saturday. 

From/To Option 

 Displays weekly intervals from Sunday to Saturday, starting with the first Sunday on or before 

the start date. Includes week to date if the end date is not a Saturday. 

 

 Months 

Previous Option 

 To date checked - Monthly intervals through the end of the last complete month up to and 

including today. 

 To date unchecked - Monthly intervals through the end of the date range. Includes month to 

date if the date range is not the last day of the month. 

From/To Option 

 Monthly for all months in the selected range, starting with the first day of the month that 

contains the start date. Includes month to date if the end date is not the last day of the month. 
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 Quarters 

Previous Option 

 To date checked - displays quarterly intervals through the end of the last complete quarter up 

to and including today. 

 To date unchecked - displays quarterly intervals through the end of the date range. Includes 

quarter to date if the date range is not the last day of the quarter. 

From/To Option 

 Displays quarterly intervals starting with the first day of the quarter that contains the start date. 

Includes quarter to date if the end date is not the last day of a quarter. Quarters are calendar 

based - ie: Jan-Mar, Apr-Jun, Jul-Sep, Oct-Dec. 

 

 

 Years 

Previous Option 

 To date checked - displays yearly intervals through the end of the last complete year up to and 

including today. 

 To date unchecked - displays yearly intervals through the end of the date range. Includes year 

to date if the date range is not the last day of the year. 

From/To Option 

 Displays calendar year periods starting with the first day of the year that contains the start 

date. Includes year to date if the end date is not the last day of a year. 

 

 

 

 
 

Replace a Chart 

Charts on the My Dashboard window can be replaced with any existing chart template. You can use a 
default chart, a personal chart, or a shared chart. You can also use the same template for both 
dashboard charts, if desired. 

To replace a chart on the My Dashboard window 

1. From the My Dashboard window, select the desired chart. 
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2. Click Replace Chart. The Replace Chart dialog displays with the currently selected chart 
highlighted.  

 

3. Select the desired template tab. 

4. Select the desired chart. 

5. Click OK. 
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Client Community 

The Skillsoft Client Community is an online resource center designed to assist you with your 
company’s strategic elearning program. It is Skillsoft’s goal to provide you with the tools you need to 
successfully implement and sustain an elearning program within your company. 

The Skillsoft Client Community contains hundreds of ideas and tools for marketing an elearning 
program. Additionally, the Client Community has resources for industry news, company news, 
technical specifications, competency mapping, and more. 

The Client Community is available to all Skillsoft customers, and registration is required to enter the 
site. You can access the site at http://community.skillsoft.com/, or by clicking Support > Client 
Community on the top navigation bar in Skillport Administrator. 

To obtain login credentials, contact your Skillsoft representative. 
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Diagnostics 

Run Active Sessions Report 

There are several diagnostic reports you can run to generate active session data. You can also output 
the report results in several formats. 

To run the active sessions report 

1. Click Support > Diagnostics > Run Active Sessions Report on the navigation bar. 

2. Click Active Sessions Report. 

The Active Sessions page displays in a new browser window.  

 

3. For a summary report that includes all sessions that had activity in a specific time frame: 

a. Click Generate a summary report for all session that have had activity in the last 
{number} minutes.  

b. If desired, enter the number of minutes in the {number} text box. For example, for a 
report of all sessions with activity in the last hour, enter 60. 

If you do not enter a value, a report is generated for all sessions by default.   

4. For a summary report only for a specific user: 

a. Click Generate summary report for the specific user. 

b. In the text box, enter the user ID. 

5. For a detail report listing all users with multiple active sessions: 

a. Click Generate detail report to list all users with multiple active sessions of the 
following type. 

b. Select the session type from the drop-down list. 

6. For  a detail report listing all sessions of a specific type in a specific time frame:  
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a. Click Generate detail report to list all sessions of the following type. 

b. Select the session type from the drop-down list.  

c. If desired, enter the number of minutes in the text box. For example, for all sessions with 
activity in the past hour, enter 60. 

If you do not enter a value, a report is generated for all sessions by default.   

7. In Select output format, select how you want the report to be formatted. Valid values are 
HTML, CSV, and CSV (UTF-16). The default value is HTML. 

8. Click Run Report. 
 

View Active Sessions Report 

Use the View Reports page to view active sessions reports, review report details, and delete reports.  

Note: Ensure you save critical reports offline after you generate them.  

To view the active sessions report 

1. Click Support > Diagnostics > View Active Sessions Report on the navigation bar. 

The View Reports page displays.  

 

2. Click the title of the report you want to view. 

Depending on the selected output format, the report displays either in a new browser window 
or in a Microsoft Excel spreadsheet. 

3. To view information about a report: 

a. Click the question mark in the corresponding row.  

The Report Details window displays the report title, user name of the person who ran the 
report, report status, date submitted, date completed, and execution time. 

b. In the Report Details window, review the report information.  

c. To view the report, click View Report. 

d. To close the Report Details window, click Close. 

4. To delete selected reports: 

a. Click the check box corresponding to the report(s) you want to delete. 
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b. Click Delete Report(s). 

5. To delete all reports: 

a. Click Select All.  

b. Click Delete Report(s). 
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Create a Blog 

As a blog administrator, you can create new blogs for Skillport users. There can be multiple blogs per 
Skillport site. 

To create a new blog  

1. Click Quick Links > Blog. 

2. Click Manage Blogs.  

The Manage Blogs page displays. 

3. Click Add New. 

The Create Blog page displays: 

 

4. Enter the following information: 

 Blog Title: The name of the blog. Max number of characters: 60. 

Note: Blog Title is mandatory. Failure to enter a blog title results in an error message. 

 Private: Select this to set the blog to Private, which makes it visible to assigned users on 

page 576 only. 

 About Blog: Enter basic blog information (such as a description). 
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 Reset: Click to clear all fields.  

 Add Blog: Click to create the blog. You are automatically redirected to the Manage Blogs 

page.  
 

Edit a Blog 

When editing a blog, you are able to update the Blog Title and About Blog fields which have been 
added when creating a blog. You can also set a blog to private or public. For more information about 
blog users, see Assign Members to a Private Blog and Assign Blog Roles to a User. 

To edit an existing blog 

1. Click Quick Links > Blog. 

2. Click Manage Blogs.  

The Manage Blogs page displays. 

3. Click the title of the blog you wish to edit. 

The Edit Blog page displays: 

 

4. Modify the information as necessary: 
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 Blog Title: The name of the blog. Max number of characters: 60. 

Note: Blog Title is mandatory. Failure to enter a blog title results in an error message. 

 Private: Select this to set the blog to Private, which makes it visible to assigned users on 

page 576 only. 

 About Blog: Enter basic blog information (such as a description). 

 Assign User: See Assign Members to a Private Blog. 

 Username: Enter a valid Skillport user name in the text box.  

 Role: Select one of the available Blog Roles in the drop-down list. 

 Blog Users:  See Assign Blog Roles to a User. 

 Username: Enter a valid Skillport user name in the text box.  

 Role: Select one of the available Blog Roles in the drop-down list. 

 Remove: Select to remove a user from the list. 

 Reset: Click to clear all fields and bring back the original text in the Blog Title and About 

Blog fields.  

5. Click Update to update and save your changes. 
 

Add a New Blog Page 

A page can be used to present static information to the reader. These pages are not displayed with 
the rest of your articles, but can be viewed individually. 

To add a new page 

1. Click Quick Links > Blog. 

2. Click Manage Blogs.  

The Manage Blog page displays. 

3. Locate the blog you wish to edit and click Manage this blog. 

The blog's Manage Blog page displays.  

4. On the left menu, click Pages > Add New. 



568 ©2015 SkillSoft Skillport 8 Administrator Guide 

 

 Blogs for Administrators 
 
 

The Add New Page page displays: 

 

5. In the top blank text field, enter the page title. 

6. Add the content for the page. 

Note: This content can be added using either the Visual tab or the HTML tab. 

7. Select the Allow comments option to allow discussions of the post on the blog. 

8. Select an Author from the drop-down menu. 

9. On the right panel, set the Status, Visibility, and schedule for the post. 

10. Set the page attributes: 

 Select a Parent if you want the page you're creating to be a child page. This is optional. 

 Select a Template from the list. 

 Enter the Order to determine where the page displays on the blog. This is optional. 

11. In the Discussion section, select the check box to allow comments for the page. 

12. Click Publish. 

The page publishes to your blog. 

 
 

Create Blog Categories 

Categories allow the classification of your articles into groups and subgroups.  

To create a new category for a blog 

1. Click Quick Links > Blog. 

2. Click Manage Blogs.  
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The Manage Blogs page displays. 

3. Locate the blog you wish to edit and click Manage this blog. 

The blog's Manage Blog page displays.  

4. On the left menu, click Categories. 

The Categories page displays. 

5. In the Add New Category dialog box, enter the following information: 

 Name: The name of the category must be unique, and displays in each of its assigned 

articles.  

 Parent: Selecting a Parent category makes the category you are currently creating a sub-

category of it. This is an optional field. 

 Description: Category descriptions are optional.  

6. Click Add New Category. 

The new category saves to your blog. 

 
 

Create Blog Tags 

Tags are keywords you might assign to each article. Tags provide another means to aid you in 
accessing information on your blog. 

To create a new tag for a blog 

1. Click Quick Links > Blog. 

2. Click Manage Blogs.  

The Manage Blogs page displays. 

3. Locate the blog you wish to edit and click Manage this blog. 

The blog's Manage Blog page displays.  

4. On the left menu, click Post Tags. 

The Post Tags page displays. 

5. In the Add New Tag section, enter the following information: 

 Name: The tag name must be unique and displays in each of its assigned articles.  

 Description: A description for the tag. 

6. Click Add New Tag to save your new tag.  

Note: This tag is added to the Popular Tags section of the blog page. 
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View Existing Blogs 

All existing blogs display in the Manage Blogs page. 

To view existing blogs  

1. Click Quick Links > Blog. 

2. Click Manage Blogs.  

The Manage Blogs page displays and lists all existing blogs: 

 

 Add New: Click to create a new blog. 

 Bulk Actions: After selecting one or more blogs from the list, select: 

 Enable: Makes the blog available to all users (if public) or assigned users (if private). 

 Disable: Makes the blog unavailable to all users. 

 Apply: Click to enable or disable the selected blogs.  

 Path: The blog title, the management page for the blog, and the link to the blog. 

 Last Updated: Date of the last blog update. 

 Created: Date the blog was created. 

 Is Private: Denotes if the blog is public (available to all) or private (available to assigned 

users on page 576 only). 
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Manage Blog Themes 

The Manage Themes section enables you to set a theme of your choice. The theme you choose 
changes the look of your blog. 

To set a theme 

1. Click Quick Links > Blog. 

2. Click Manage Blogs.  

The Manage Blogs page displays. 

3. Locate the blog you wish to edit and click Manage this blog. 

The blog's Manage Blog page displays. 

4. On the left menu, click Themes > Appearance. 

The Manage Themes page displays, showing the current theme applied to the blog. 

5. Select a theme from the Available Themes section. 

6. Click Preview to preview the blog using the selected theme before activating it. 

7. Click Activate to activate the new theme. 
 

Moderate Blog Comments 

You are able to manage and moderate all comments entered by users. This uses a variety of functions 
for ease of use. 

To moderate comments 

1. Click Quick Links > Blog. 

2. Click Manage Blogs.  

The Manage Blogs page displays. 

3. Locate the blog containing the comments you wish to moderate and click Manage this blog. 

The blog's Manage Blog page displays.  

4. On the left menu, click Comments.  
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The Comments page displays: 

 

The Comments page lists all the comments for a particular blog, so you can manage the 
comments listed.  

 Author: The name and details of the author of the comment. 

 Comment: The comment that's been flagged for moderation. 

 In Response To: The article associated with the comment. 

5. Find the comment you want to modify: 

 Search: At the top right of the page, enter the comment title  and click Search 

Comments.  

All: Click to view all available comments for the blog. 

Pending: Click to see only comments requiring moderation. 

Approved: Click to see only approved comments. 

Spam: Click to see only comments marked as spam. 

Trash: Click to see only comments marked for deletion. 

Search text field: Enter a specific comment title and click Search comments. 

 Bulk Actions: Select the comments you wish to manage and select one of the following 

Bulk Action options: 

Approve: Approves the comments as acceptable for the discussion/article. 

Unapprove: Removes the approval of the comment, marking it as unacceptable for the 
blog post. 

Mark as Spam: Marks the comment as a spam comment and removes it from the blog 
post. 

Move to Trash: Adds the comment to the trash.  

 Apply: Click to apply the selected Bulk Action to the selected comments.  
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 Select Comment Types: Select a comment type to display those types. 

6. Modify the comment using one of the following options: 

 Unapprove: Hides the comment from the blog post. The comment still exists in the list. 

 Approve: Displays the comment on the blog post. 

 Reply: Posts a reply to the comment, which displays on the blog post. 

 Quick Edit: Edits the comment itself. The comment displays on the blog post as Edited. 

 Edit: Opens the Edit Comment page for further edits to the comment. The comment 

displays on the blog post as Edited. 

 Spam: Marks the comment as spam. These comments display when filtering for spam but 

do not display to the contributors and readers. 

 Trash: Deletes the comment. 
 

View Blog Reports 

Blog reports allow you to view the following information: 

 Average number of articles per blog. 

 Average subscribers per blog. 

 Average number of comments per blog. 

 Average number of comments per blog article. 

 Total number of subscribers to blogs. 

To view reports  

1. Click Quick Links > Blog at the top of the page. 

2. On the Blog page, click Blog Reports. 
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The Blog Reports page displays. 

 

 

 

Managing Blog Users 

Assign a User as Blog Administrator 

When the blog site is first implemented, one user is initially assigned as the blog administrator. That 
administrator can then subsequently assign other users as blog administrators. There can be multiple 
blog administrators per site, and each has permission to administer any blog on the site, including 
Private blogs. 

To assign a user as blog administrator 

1. As a blog administrator, click Quick Links > Blog. 

2. Click Manage Blogs. 

3. Click the Manage this blog link below the title of the blog you want to administer.  

The Edit Blog page displays.  

4. In the Assign Users section, enter a valid Skillport Username, then 
select Administrator from the Role drop-down. 

5. Click Assign Users.  

The specified user now has administrator privileges over all blogs, and will continue to do so 
until his username is removed or his role is changed.  
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Assign Blog Roles to a User 

You can assign blog roles to users. 

To assign blog roles to a user 

1. Click Quick Links > Blog. 

2. Click Manage Blogs.  

The Manage Blogs page displays. 

3. Click the title of the blog you wish to edit 

The Edit Blog page displays. 

 

4. In the Blog Users section, enter a valid Skillport Username in the text box.  

5. Select one of the available blog roles in the Role drop-down list. 

6. Click Update.  

The usernames are checked against the system, and once verified, the blog roles are 
assigned. 
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Assign Members to a Private Blog 

You can assign specific members to a private blog, which provides access to members only. 

To assign members to a blog 

1. Click Quick Links > Blog. 

2. Click Manage Blogs.  

The Manage Blogs page displays. 

3. Click the title of the blog you wish to edit. 

The Edit Blog page displays: 

 

4. In the Assign User section, enter a valid Skillport Username in the text box.  

5. Select one of the available Blog Roles in the Role drop-down list. 

6. Click Assign User. 

7. Click Update.  

The username is checked against the system, and once verified, the user is added as a 
member of the private blog and can now see all posts. 
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Remove Members from a Private Blog 

You can remove specific members from a blog. 

To remove members from a blog 

1. Click Quick Links > Blog. 

2. Click Manage Blogs.  

The Manage Blogs page displays. 

3. Click the title of the blog from which you wish to remove members. 

The Edit Blog page for the selected blog displays: 

 

4. In the Blog Users section, select the check box next to the user(s) you wish to remove. 

5. Click Update.  

The selected users are removed from the member list and can no longer view the blog posts 
or content. 
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Wiki Workflow 

The wiki workflow indicates the order of events and tasks that the wiki administrator performs. To get 
started with using wikis, follow the order indicated in the workflow.  

Workflow for Wiki Admin 

1. Create a wiki. Wikis can be Public or Private.  

Note: If the wiki is Private, only assigned users can access the wiki. 

2. View existing wikis to view the properties of a wiki. 

3. Set up user roles for Skillport users in a wiki by enabling a particular set of users to access the 
wiki and perform various tasks based on their user privilege. 

c. Assign user roles as wiki administrator, author, or contributor. All users who have access 
to a wiki are contributors by default. 

d. Change the user role for a particular user.  

4. Protect an article to prevent it from being edited. 

5. Block an article to prevent certain users from viewing it. 

6. Moderate discussions. This involves moderating comments or discussions by replying to an 
author, editing comments, and deleting comments. 

7. View wiki reports. 
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Create a Wiki 

As a wiki administrator, you can create new wikis for Skillport users. There can be multiple wikis per 
Skillport site. 

Unless you select the Private option, the wiki is Public and can be contributed to and viewed by all 
users. If you specify the wiki as Private, only those users that you assign to the wiki will have access to 
it. 

To create a new wiki 

1. Click Quick Links > Wiki. 

2. Click Manage Wikis.  

3. On the Manage Wikis page, click Add New.  

The Create Wiki page displays. 

 

4. Enter details about the wiki: 

 Wiki Title: (Required) The name of the wiki. The title displays on the Skillport Wikis page 

and the Manage Wikis page.  

 Private check box: Select this option to indicate the wiki is Private (available only to 

assigned users). Leave unchecked to indicate the wiki is Public (available to all users). 

 About Wiki: A brief description of the wiki. You can enter a maximum of 300 characters. 

This description displays below the Wiki title on the Skillport Wikis page. 

5. Click Add Wiki. The wiki is added to the list of wikis on the Manage Wikis page. 
 

View Existing Wikis 

All existing wikis display in the Manage Wikis page.  

To view existing wikis 

1. Click Quick Links > Wiki. 

2. Click Manage Wikis.  
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The Manage Wikis page displays a list of the existing wikis.   

 

 Add New: Click to create a new wiki.  

 Bulk Actions: After selecting one or more wikis from the list, select Delete to delete one or 

more wikis.  

 Apply: Click to delete the selected wikis.  

 Path: Displays the wiki title, a link to the management page for the wiki, and a link to the wiki 

itself.  

 Created: Displays the date and time the wiki was created.  

 Last Updated: Displays the date and time the wiki was last modified.  

 Private: When selected, indicates the wiki is private (available to assigned users only). If 

cleared, the wiki is public (available to all users). 

Note: The Add New button and the Bulk Actions drop-down list are only visible to wiki 

administrators. 
 

Edit Wiki Details 

Wiki administrators can modify all the details for a wiki. If you have author privileges for a wiki, you can 
edit the About Wiki description only. 

To edit wiki details 

1. Click Quick Links > Wiki. 

2. Click Manage Wikis.  

The Manage Wikis page displays.  

3. Click the Manage Wikis link for the desired wiki. 

The Edit Wiki page displays. 
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4. Click the desired wiki name to display the Edit Wiki page. 

 

5. Edit the wiki details as desired: 

 Wiki Title: (Required) The name of the wiki. The title displays on the Skillport Wikis page 

and the Manage Wikis page.  

 Private check box: Select this option to indicate the wiki is Private (available only to 

assigned users). Leave unchecked to indicate the wiki is Public (available to all users). 

 About Wiki: A brief description of the wiki. You can enter a maximum of 300 characters. 

This description displays below the Wiki title on the Skillport Wikis page. 

6. Click Update Wiki. 

7. Click the Manage Wikis link in the upper right corner of the page to return to the Manage 
Wikis page. 

 

Delete a Wiki 

You can delete one or more wikis at a time.  

To delete a wiki 

1. Click Quick Links > Wiki.  

2. Click Manage Wikis.  

The Manage Wikis page displays.   

3. Select the check box next to the wiki(s) you want to delete. 

4. In the Bulk Actions drop-down list, select Delete.  

5. Click Apply.  

6. In the message asking if you want to permanently delete the wiki(s), click OK.  

The wiki(s) no longer display in the list on the Manage Wikis page.  

 
 



Skillport 8 Administrator Guide ©2015 Skillsoft  583 
 

Wikis for Administrators   
 
 

Moderate Wiki Content 

If you are an author or a wiki administrator, you can moderate wiki comments and discussions by 
replying to an author, editing comments, and deleting comments. 

To moderate wiki content 

1. Click Quick Links > Wiki. 

2. Click Manage Wikis. 

The Manage Wikis page displays.  

3. Locate the desired wiki in the list and click View.  

The wiki's Main Page displays. 

4. Click the Discussion tab. 

5. Click the Edit tab. The Edit page displays. 

6. Enter/modify the desired text. 

7. Click  on the toolbar to insert your signature and timestamp. 

8. Click Save Page.  

The edits are published and details of the edit are listed on the View history tab. 

 

 
 

Protect an Article 

You can protect an article from being edited or moved by specifying access for certain groups of 
users. You can apply these two methods of protection separately. 

 Edit: Specify users who are authorized to modify the article. 

 Move: Specify users who can only rename the article. 

You can also specify when the article protection expires. The default expiration value is infinite (never 
expires). 

To protect an article 

1. Click Quick Links > Wiki. 

2. Click Manage Wikis.  

The Manage Wikis page displays. 

3. Locate the desired wiki in the list and click View .  

4. Navigate to the article you want to protect. 

5. Select Protect from the Arrow drop-down menu. 
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The Change Protection Level page displays. 

 

6. Apply the desired protection settings. 

7. Click Confirm. 

Note: Once the article is protected, the Protect menu option changes to Unprotect, which you can 

subsequently select to modify the protection or change the expiration date. 

 

Block Users from an Article 

You can block a user from editing an article and create reasons as to why you want to block the 
particular user. 

To block a user from an article 

1. View the Wiki Main page. 

2. In the left pane, click Recent changes. 
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The Recent Changes page displays a list of all recent changes made to several articles. Each 
of the changes displays the user name of the author who modified the article. 

 

3. Click the block link that displays within the brackets next to the author name.  

The Block user page displays. 

 

4. Enter the following information: 

 IP address or username: Enter the IP address or the name of the registered user 

account to be blocked.  
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Note: Nonexistent authors can also be blocked; therefore, ensure you have entered the 

author’s name correctly.  

 Expiry: Select when the block should expire, or manually enter an expiration time.  

 Reason: Select the reason for blocking an author. 

Note: You can also edit an existing reason or create a new reason. For more information, 

see the procedure below. 

 Other/ additional reason: (Optional) Select one or more options. These options are 

based on whether an author or an IP address is being blocked.  

5. Click Block this user. The author is blocked and is not authorized to comment on or discuss 
an article. 

To edit or create block reasons 

1. Click Edit block reasons in the lower-right corner of the Block user page. 

2. In Edit, enter the reason for blocking the author. 

3. Click Save. The block reason displays in the Reason drop-down list. 

Note: The block reasons will not be localized if you want to localize a particular wiki. To ensure that 
the block reasons are also localized, enter the block reasons in the corresponding language, by 
installing the relevant language package and pasting the reasons in the required language. 

 

View Wiki Reports 

You can view various reports about a specific wiki. You view a report of the most linked-to categories, 
files, pages, and templates, pages with the most categories and most revisions, popular pages, and 
wiki statistics. 

To view wiki reports 

1. View the Wiki Main page. 

2. In the left pane, click Special pages. 

Note: The Special pages link is not available for contributors. 

3. In the Wiki data and tools section and the High use pages section, click the desired link to 
display the corresponding report. 
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Managing Wiki Users 

Assign a User as Wiki Administrator 

When the wiki site is first implemented, one user is initially assigned as the wiki administrator. That 
administrator can then subsequently assign other users as wiki administrators. There can be multiple 
wiki administrators per site, and each has permission to administer any wiki on the site, including 
Private wikis. 

To assign a user as wiki administrator 

1. As a wiki administrator, click Quick Links > Wiki. 

2. Click Manage Wikis. 

3. Click the Manage Wikis link below the title of the wiki you want to administer.  

The Edit Wiki page displays.  

4. In the Assign Users section, enter a valid Skillport Username, then select Administrator 
from the Role drop-down. 

5. Click Assign Users.  

The specified user now has administrator privileges over all wikis, and will continue to do so 
until his username is removed or his role is changed.  

 
 

Assign Users to a Private Wiki 

You can assign specific users and associated wiki roles for a private wiki. Available roles are 
Contributor, Author, and Administrator. For more information about these roles, see Wiki Roles.  

You can assign a maximum of five users at a time to a wiki.  

To assign users to a wiki   

1. Click Quick Links > Wiki. 

2. Click Manage Wikis. 

The Manage Wikis page displays. 

3. Click the Manage Wikis link for the desired wiki. 

The Edit Wiki page displays. 
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4. In the Assign Users section, for each user you want to add: 

 

e. Enter a valid Skillport Username. 

f. Select the desired Role from the corresponding drop-down list.  

5. Click Assign Users. 

The usernames and roles display in the Wiki Users section. 
 

Remove Users from a Private Wiki 

You can remove existing users from a private wiki.  

To remove users from a wiki 

1. Click Quick Links > Wiki. 

2. Click Manage Wikis. 

The Manage Wikis page displays. 

3. Click the Manage Wikis link for the desired wiki. 

The Edit Wiki page displays. 

4. In the Wiki Users section, select the Remove check box for each user you want to remove. 

 

5. Click Update. 

The selected users are removed from the Wiki Users list and can no longer view the wiki.  
 



Skillport 8 Administrator Guide ©2015 Skillsoft  589 
 

Wikis for Administrators   
 
 

Change a User's Role 

You can change a user's role for a specific wiki.  

To change a user's role 

1. Click Quick Links > Wiki. 

2. Click Manage Wikis. 

The Manage Wikis page displays. 

3. Click the Manage Wikis link for the desired wiki. 

The Edit Wiki page displays. 

Note: If the wiki is Public, any users that you change to a Contributor role will no longer 
display in the Wiki Users section after you click Update.  

 

4. In the Wiki Users section, for the desired user, select one of the available wiki roles in the 
Role drop-down list. 

5. Click Update. 
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Our Skillsoft Support Professionals are ready to answer your request 24 hours a day, 7 days a week. 

Access the site http://support.skillsoft.com/ to search our solution libraries and Frequently Asked 
Questions (FAQs), create a support case, or to obtain a list of our international phone numbers. 
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